<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0</td>
<td>Table of Contents</td>
</tr>
<tr>
<td>1.0</td>
<td>Biology/DNA Detail Overview</td>
</tr>
<tr>
<td></td>
<td>Forensic Biology Screening</td>
</tr>
<tr>
<td></td>
<td>Use of an Alternate Light Source</td>
</tr>
<tr>
<td></td>
<td>Phenolphthalein Presumptive Test for Blood</td>
</tr>
<tr>
<td></td>
<td>Tetramethylbenzidine Presumptive Test for Blood</td>
</tr>
<tr>
<td></td>
<td>HemaTrace test for Higher Primate Blood</td>
</tr>
<tr>
<td></td>
<td>Acid Phosphatase Overlay Presumptive Test for Semen</td>
</tr>
<tr>
<td></td>
<td>Microscopic Identification of Spermatozoa</td>
</tr>
<tr>
<td></td>
<td>PSA Semiquant Test for Semen (p30)</td>
</tr>
<tr>
<td></td>
<td>RSID – Presumptive Saliva Test</td>
</tr>
<tr>
<td></td>
<td>Microscopic Examination of Hair</td>
</tr>
<tr>
<td></td>
<td>Sampling Tissue for DNA Analysis</td>
</tr>
<tr>
<td></td>
<td>SAK Flow Chart – Single Male Assailant</td>
</tr>
<tr>
<td></td>
<td>SAK Flow Chart – Multiple Male Assailants, Victims Under Age of 18, and/or Loss of Consciousness</td>
</tr>
<tr>
<td></td>
<td>SAK Flow Chart – Digital Penetration</td>
</tr>
<tr>
<td>2.0</td>
<td>Sample Extraction, Purification, and Concentration</td>
</tr>
<tr>
<td></td>
<td>Chelex Extraction</td>
</tr>
<tr>
<td></td>
<td>Sample Preparation: Blood, Saliva, Cigarette Butts, Fresh Tissue, “Touch” Evidence, and Buccal Swabs for Organic</td>
</tr>
<tr>
<td></td>
<td>Sample Preparation: Differential Lysis for Organic</td>
</tr>
<tr>
<td></td>
<td>Sample Preparation: Neat Semen for Organic</td>
</tr>
<tr>
<td></td>
<td>Sample Preparation: Cellular Material from Microscope Slides for Organic</td>
</tr>
<tr>
<td></td>
<td>Sample Preparation: Hair for Organic</td>
</tr>
<tr>
<td></td>
<td>Sample Preparation: Paraffin-embedded Tissue for Organic</td>
</tr>
<tr>
<td></td>
<td>Sample Preparation: Whole/Fresh Tissue for Organic</td>
</tr>
<tr>
<td></td>
<td>Organic Extraction Procedure</td>
</tr>
<tr>
<td></td>
<td>Qiagen Extraction Procedure (QIAmp)</td>
</tr>
<tr>
<td></td>
<td>Qiagen Purification/Clean-up</td>
</tr>
<tr>
<td></td>
<td>Non-Differential Extraction of Questioned Samples on the EZ1</td>
</tr>
<tr>
<td>Section</td>
<td>Title</td>
</tr>
<tr>
<td>---------</td>
<td>-------</td>
</tr>
<tr>
<td>4.0</td>
<td>Differential Extraction of Questions Samples on the EZ1</td>
</tr>
<tr>
<td></td>
<td>Extraction of Hair on the EZ1</td>
</tr>
<tr>
<td></td>
<td>Extraction of Known Reference Standards on the EZ1</td>
</tr>
<tr>
<td></td>
<td>Running the EZ1 Advanced XL Robot</td>
</tr>
<tr>
<td></td>
<td>Concentration of DNA Extracts using Microcon DNA Fast Flow Tubes</td>
</tr>
<tr>
<td></td>
<td>Concentration of DNA Extracts using the CentriVap</td>
</tr>
<tr>
<td></td>
<td>Microcon Buffer Exchange Clean-up of Qiagen-Extracted Samples</td>
</tr>
<tr>
<td></td>
<td>Database Processing and Analysis</td>
</tr>
<tr>
<td></td>
<td>Rack-Pack-Label of Databasing Samples</td>
</tr>
<tr>
<td></td>
<td>Amplification and 3130XL Set-up using dazedNconFUSION Workbook</td>
</tr>
<tr>
<td></td>
<td>Amplification Set-up using Extracted DNA</td>
</tr>
<tr>
<td></td>
<td>Amplification Set-up using Samples Processed with SwabSolution</td>
</tr>
<tr>
<td></td>
<td>Amplification Set-up of Punched FTA Samples</td>
</tr>
<tr>
<td></td>
<td>Rehydration of EasiCollect Sponge to Facilitate DNA Transfer</td>
</tr>
<tr>
<td></td>
<td>Direct Amplification Set-up using the Hamilton easyPunch Robot</td>
</tr>
<tr>
<td></td>
<td>Set-up of PunchSolution Protocol using the Hamilton easyPunch Robot</td>
</tr>
<tr>
<td></td>
<td>Sample Set-up - 3130XL Instruments</td>
</tr>
<tr>
<td></td>
<td>Data Analysis, Review and Second Reads using GeneMapper ID-X</td>
</tr>
<tr>
<td>5.0</td>
<td>Real-Time Quantitative PCR</td>
</tr>
<tr>
<td></td>
<td>Quantitation with Quantifiler Trio</td>
</tr>
<tr>
<td></td>
<td>7500 HID v1.2 Instrument Operation</td>
</tr>
<tr>
<td></td>
<td>Running the 7500 Instrument</td>
</tr>
<tr>
<td></td>
<td>Data Analysis in HID v1.2</td>
</tr>
<tr>
<td></td>
<td>Interpretation of Quantifiler Trio Results</td>
</tr>
<tr>
<td>6.0</td>
<td>PCR Amplification</td>
</tr>
<tr>
<td></td>
<td>Amplification Set-up using Qiagen Investigator 24plex QS</td>
</tr>
<tr>
<td>7.0</td>
<td>Capillary Electrophoresis</td>
</tr>
<tr>
<td></td>
<td>Sample and Plate Naming/Information</td>
</tr>
<tr>
<td></td>
<td>Daily or Weekly 3130XL Instrument Maintenance</td>
</tr>
<tr>
<td></td>
<td>Using the Genetic Analyzer</td>
</tr>
<tr>
<td>8.0</td>
<td>GeneMapper ID-X and Data Analysis</td>
</tr>
<tr>
<td></td>
<td>Creating Projects in GeneMapper ID-X</td>
</tr>
<tr>
<td>Review of Size Standards</td>
<td>Allelic Ladders</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Positive Amplification Controls</td>
<td>Reagent Blank and Negative Amplification Controls</td>
</tr>
<tr>
<td>Allele Designation</td>
<td>Injection of Controls</td>
</tr>
<tr>
<td>Identification of Non-Allelic Peaks</td>
<td>Stutter</td>
</tr>
<tr>
<td>Non-Template Nucleotide Addition (-A)</td>
<td>Non-Specific Amplification Artifacts</td>
</tr>
<tr>
<td>Spikes</td>
<td>Raised Baseline</td>
</tr>
<tr>
<td>Migration and Pull-up</td>
<td>Off-Scale Indicators (Saturated Data)</td>
</tr>
<tr>
<td>Evaluation of Quality Sensors QS1 and QS2 Investigator 24plex QS</td>
<td>Loss of Resolution/Poor Resolution</td>
</tr>
<tr>
<td>Required Casework Documentation of Interpretation on Electropherograms</td>
<td>Exporting for STRmix Interpretation and ALLELEigator Tables</td>
</tr>
<tr>
<td>GeneMapper ID-X Comparison Tools</td>
<td>GeneMapper ID-X Audit Record Maintenance</td>
</tr>
<tr>
<td>Troubleshooting GeneMapper ID-X Database Connection Failures</td>
<td>Amplification Kit-Specific Stutter Values</td>
</tr>
<tr>
<td>Interpretation Guidelines and STRmix</td>
<td>Single Source Profiles</td>
</tr>
<tr>
<td>Preliminary Evaluation of Data and Application of Thresholds</td>
<td>Tri-Alleles</td>
</tr>
<tr>
<td>Manual Comparison of References to Outsourcing or Legacy Data</td>
<td>Mixture Profiles</td>
</tr>
<tr>
<td>STRmix Interpretation</td>
<td>Manual Comparison to Full Single Source Profiles</td>
</tr>
<tr>
<td>Profiles Suitable for STRmix</td>
<td></td>
</tr>
<tr>
<td>-----------------------------</td>
<td></td>
</tr>
<tr>
<td>Determination of Inclusion, Exclusion, and Inconclusive with STRmix</td>
<td></td>
</tr>
<tr>
<td>Assumed Contributors</td>
<td></td>
</tr>
<tr>
<td>Setting-up Propositions for the Calculation of the Likelihood Ratio</td>
<td></td>
</tr>
<tr>
<td>Deconvolution of Investigator 24plex QS Profiles in STRmix v2.4</td>
<td></td>
</tr>
<tr>
<td>Using Batch Mode for the Deconvolution of Multiple Profiles</td>
<td></td>
</tr>
<tr>
<td>Calculation of Likelihood Ratios from Previously Deconvoluted Investigator 24plex QS Profiles</td>
<td></td>
</tr>
<tr>
<td>Review of the Investigator 24plex QS STRmix Output File</td>
<td></td>
</tr>
<tr>
<td>Dealing with Uncharacterized Variants, Allelic and Chromosomal Abnormalities, Allele Resolution, and Technical Issues in STRmix v2.4</td>
<td></td>
</tr>
<tr>
<td>Off-Ladder Alleles and OMRs</td>
<td></td>
</tr>
<tr>
<td>Backwards Compatibility and Supplemental Analysis</td>
<td></td>
</tr>
<tr>
<td>Use of DNA Profile Searcher for Single Source Unknown Profiles</td>
<td></td>
</tr>
<tr>
<td>Deconvolution of Identifiler Plus Profiles in STRmix v2.3</td>
<td></td>
</tr>
<tr>
<td>Calculation of Likelihood Ratios from Previously Deconvoluted ID Plus Profiles</td>
<td></td>
</tr>
<tr>
<td>Review of Identifiler Plus STRmix Output</td>
<td></td>
</tr>
<tr>
<td>Dealing with Uncharacterized Variants, Allelic and Chromosomal Abnormalities, Allele Resolution, and Technical Issues in STRmix v2.3</td>
<td></td>
</tr>
<tr>
<td>Interpretation of a Contaminated Control or Sample</td>
<td></td>
</tr>
</tbody>
</table>

10.0 Creation of Allele Tables and Use of Ribbon Accessories

11.0 Statistics

| Statistical Guidelines using STRmix |
| Statistical Guidelines for Outsourced Cases |
| Number Conversions |
| Popstats Parentage Calculations |
| Mutation Rates |

12.0 Reporting Guidelines

<p>| Serology Reporting Statements |
| Additional Summary Result Table Statements |
| STR Analysis Report Conclusions |
| Reporting of STRmix Interpretations |</p>
<table>
<thead>
<tr>
<th>Statistical Report Statements using Popstats for Outsourced Cases</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amended Reports</td>
</tr>
<tr>
<td>Supplemental Reports</td>
</tr>
<tr>
<td>Modification of Identity Statements</td>
</tr>
<tr>
<td>Evidence Disposition and Case File Disclaimers</td>
</tr>
<tr>
<td>Parentage Report Statements</td>
</tr>
<tr>
<td>Mutation Statements</td>
</tr>
<tr>
<td>Contamination Report Statements</td>
</tr>
<tr>
<td>CODIS Report Statements</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CODIS Policies and Procedures</th>
</tr>
</thead>
<tbody>
<tr>
<td>CODIS Policies</td>
</tr>
<tr>
<td>Casework Samples</td>
</tr>
<tr>
<td>Database Samples</td>
</tr>
<tr>
<td>CODIS Searches</td>
</tr>
<tr>
<td>CODIS Hit and Match Confirmation Procedures</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>13.0</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>GeneMapper ID-X and STRmix Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALLELEigator Table Settings</td>
</tr>
<tr>
<td>General Plot Settings</td>
</tr>
<tr>
<td>GeneMapper ID-X Settings for Investigator 24plex QS</td>
</tr>
<tr>
<td>GeneMapper ID-X Settings for Fusion 6C</td>
</tr>
<tr>
<td>Run Parameters for Investigator 24plex QS in v2.4 of STRmix</td>
</tr>
<tr>
<td>Run Parameters for Identifiler Plus in v2.3 of STRmix</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Appendix A</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Use of the DNA Workbooks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing Labels for Tubes, Slides, or P30/Hematrace/RSID-saliva</td>
</tr>
<tr>
<td>CONFIRMadactyl</td>
</tr>
<tr>
<td>EXTRACTasaurus and DB EXTRACTasaurus</td>
</tr>
<tr>
<td>TRIOceratops</td>
</tr>
<tr>
<td>makeiTWORK</td>
</tr>
<tr>
<td>AMPalatypus &amp; cattyRUNpas</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Appendix B</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Appendix C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instrument and Equipment Maintenance</td>
</tr>
<tr>
<td>7500 Maintenance using HID v1.2 Software</td>
</tr>
<tr>
<td>Thermalcyler Maintenance</td>
</tr>
</tbody>
</table>
## Appendix D

### 3130XL Instrument Maintenance

- Maintenance of Mini-Crime Scope MCS-400
- Maintenance of Crime-Lite 80S

### The Use of FRED (LIMS)

- Screening Worksheets
- When and How to Make Sub-Items
- Adding Reagents to Worksheets
- Requirements for Results in Worksheets
- Sexual Assault Kits in Worksheets

#### Packages Containing Uninventoried Items Without Impound Item Numbers (Backpacks, Bedding, Clothing, Gun/Magazine/Ammunition, etc.)

#### Packages Containing Multiple Impound Items Not Requested

- Buccal Swab Kits and Reference Standards
- Cross-Referencing Items from Different Cases
- Outside Jurisdictions (OJs)
- Printing or Saving
- Additional Notes
- Report Headers
- Report Results Table
- Report Results, Opinions, and Interpretations
- Table of Items Received, Not Examined
- Technical and Administrative Reviews

**NOTE:** Hyperlinks were accurate at the time of manual publication.
1.0 Title: Biology/DNA Detail Overview

In this manual the Biology/DNA Detail defines the technical procedures for examining DNA on forensic evidence and reference samples. In conjunction with the Biology/DNA Quality Manual and LVMPD Forensic Handbook, this manual also outlines some quality assurance measures that comprise the quality program of the Biology/DNA Detail to ensure the quality and integrity of the data generated by the laboratory. This manual is not designed to be an all-inclusive collection of every possible procedure or variation of procedure which might be used in the recovery and examination of biological samples. Due to the wide variety of evidence received by the analyst, flexibility is sometimes required in the analytical approach. The procedures presented in this manual are intended to provide a sound framework upon which to build.

In accordance with the section 1/100.4 of the LVMPD Department Manual, the following construction and terminology will be followed:

- “Shall”, “must”, and “will” are mandatory.
- “May” is permissive.
- “Should” is used where it is intended that while a procedure is not mandatory, it should be followed in the interest of the Detail.

1.1 General Principles of Forensic DNA Analysis

Forensic DNA analysis is the process of identification and evaluation of biological evidence in criminal matters using DNA technologies. Forensic DNA analysis involves several steps including screening, extraction, quantitation, amplification, and separation, focusing on specific chromosomal locations that vary widely between individuals. These specific locations are used to generate a DNA profile from evidentiary items or from known source samples.

1.2 Overview of the Forensic DNA Testing Process

Evidence and DNA

Law enforcement personnel who submit crime scene evidence for DNA analysis must package and seal the evidence and then arrange for its secure delivery to the Evidence Vault. The LVMPD utilizes the Property Connect Module associated with the LIMS in order to request and initiate the laboratory testing process. All outside jurisdictions must submit a completed Forensic Laboratory Examination Request form (LVMPD 63) to initiate the laboratory testing process. The Forensic Scientist will then request the evidence from the Vault.

Upon receipt of the evidence, Forensic Scientists must first determine if the evidence might contain DNA by visually examining the item for indications of body fluid stains, and then performing testing to determine whether specific body fluids that might contain DNA are present. Some items of evidence are analyzed for the purposes of identifying “touch” DNA. The Forensic
Scientist collects possible skin cells from areas which may have been handled or come into physical contact with an individual, despite visible staining not being present.

**DNA Extraction**

When possible, Forensic Scientists analyze only a portion of the stains on the evidence and save the remainder in case future testing is necessary. Generally, stains on fabric are cut out of the item and the DNA is extracted from the cuttings. If the stains are on a hard object, such as a knife, some of the dried body fluid is removed from the object with a moist cotton swab (known as swabbing an item) and the DNA is extracted from the cotton swab. The process used to extract the DNA varies depending on the organic source of the stain and the material containing the stain.

**Quantitation**

Once the DNA is extracted from the evidence, the amount of DNA must be quantified. This is an important step to estimate how much DNA is present in a sample so that the optimal input can be targeted during the amplification process and for the subsequent detection and analysis.

**DNA Amplification**

The normalized DNA is subjected to polymerase chain reaction (PCR), which is also referred to as amplification. This process, often analogized as biological photocopying, allows scientists to make copies of specific chromosomal segments. The amplification process gives Forensic Scientists the ability to analyze minute DNA samples. Current technology utilizes PCR amplification with STRs. Short tandem repeat (STR) analysis is a method of determining an individual's DNA profile by counting the number of times a small DNA sequence (short tandem repeat unit) is repeated at a specific chromosomal location. STR analysis consists of three processes: amplification, electrophoresis, and interpretation.

**Amplified DNA Product Separation – Capillary Electrophoresis**

After amplification is complete, the DNA is analyzed using an instrument that separates the DNA fragments present in the sample. This process is known as electrophoresis. Capillary electrophoresis is the DNA technology used to separate the small fragments that were amplified during the PCR processing. Capillary electrophoresis is an automated process that analyzes many DNA samples and requires minimal involvement by DNA scientists after the initial set-up procedures are completed. These procedures include cleaning and calibrating the electrophoresis instrument and preparing the amplified DNA for analysis. Special software then measures the length of the DNA fragments, determines the alleles that correspond to the fragments, and compiles a DNA profile for the sample.

**1.3 DNA Laboratory Work Streams**

The Biology/DNA Detail of the LVMPD Forensic Laboratory has two work streams: Databasing and Casework.

**Databasing**

Databasing refers to the DNA analysis of database samples for entry into the Local DNA Index System (LDIS) of CODIS and, if eligible, for upload to the State DNA Index System (SDIS) or National DNA Index System (NDIS).

- A database sample is a sample obtained from an individual who is legally required to provide a DNA sample for databasing purposes and whose identity is established at the time of collection of the sample (e.g. felony arrestees, convicted offenders, etc.).
• Database samples are not required to undergo all the processing steps. They may be amplified directly after extraction using a ½ reaction amplification procedure, or amplified directly using sample extracts or FTA sample cards and a direct amplification procedure.

Casework
Casework refers to DNA analysis of evidentiary items submitted by law enforcement personnel. There are several types of casework samples, for example:

• Questioned or unknown samples collected from the crime scene may be any biological sample deposited on virtually any surface.
• Samples collected from unidentified bodies can include: blood, buccal swabs, hairs, bone, teeth, fingernails, tissues from internal organs (including brain), muscle, and skin.
• Reference samples from known individuals including blood, oral/buccal swabs, and/or plucked hairs (e.g. head, pubic).
2.0 Title: Forensic Biology Screening

2.1 Principle
Prior to performing DNA analysis on evidence from casework, examination and reconciliation of evidence package contents must be completed and recorded. Probative areas of the evidence item(s) are identified and recorded as additional evidence and screening tests are performed in order to determine if biological material is suitable for DNA extraction.

2.2 Controls and Quality Assurance
Following preparation or receipt of any chemical screening reagent (with the exception of the Christmas Tree Stain), testing must be performed to ensure that the reagents are performing as expected. The results from each lot must be documented in the Resource Manager of the LIMS.

Screening rooms and/or work benches in the primary DNA casework laboratory are utilized for the examination of items of evidence and the collection of samples that may be subjected to PCR analysis. A variety of equipment and supplies are used, including but not limited to:

- Scissors, forceps, scalpels and scalpel blades
- Disposable gloves
- Individually wrapped sterile cotton-tipped applicators
- Racks and sterile tubes
- Presumptive and confirmatory test reagents
- Alternate light source or Crime Scope
- Lab coat (white pre-amp)
- Evidence Tape
- Biosafety cabinet

Special Precautions:
Diluted bleach (10%) or stabilized bleach solution (e.g. Dispatch) shall be used to wash all exposed work areas and any tools/resources used during examination and/or analysis (e.g. re-usable scales or rulers used during photodocumentation). At minimum, decontamination of all exposed work areas should be performed prior to the initiation of screening, between screening of different items of evidence and at the conclusion of all daily screening activities.

Gloves, a mask, and a lab coat will be worn during forensic biology screening. At minimum, gloves should be changed between the handling of different items of evidence and whenever there is the possibility that transfer could occur between different stains and/or areas of interest on a single item.

2.3 Evidence Marking/Specimen Numbering
Evidence examined by members of the Biology/DNA Detail must be marked in some manner so that it can be identified in court. Physical items examined must bear the initials of the examining
analyst, an item designator, the event number, and the lab number on the physical item of evidence, if practical. All markings or identifiers will be made in such a manner that the evidentiary value of the item is not compromised. It is not necessary to mark items of evidence which are received, but not examined.

2.3.1 Evidence Package and Sample Designations
Evidence package designations consist of item numbers automatically assigned by the LIMS (e.g. Item 1, Item 2). If there are multiple samples or packages within a package, a sub-item is created with dot numbers assigned as needed (e.g. Item 1.1, Item 1.2 – sample naming will be designated as a subset of the naming applied to the parent item/package).

If multiple areas of an evidentiary item are being tested, each area does not need to be given a unique identifier if numerous attempts yield negative results. It is possible to annotate in the analyst’s laboratory notes and report “multiple areas examined” and cite the results.

All items examined, the areas tested, the types of tests performed and the results of the tests will be documented in the LIMS. Notes should be descriptive and include information such as how much of a swab or clothing item is stained (or if no visible staining is present), the color of the staining, and how much of each stain was consumed for analysis. Documentation of color and amount of staining present on buccal swabs is not required but amount of sample being cut for analysis must be noted. These notes will be retained within the screening portion of the Biology/DNA worksheet in the LIMS.

The descriptor “as received” should be used in the custom description or in the manual description added to the report of areas swabbed when arbitrarily defining outside vs. inside for an item that has an ambiguous orientation that cannot be readily identified (e.g. latex gloves, condoms, etc.). The “as received” designator will then carry with designated orientation (i.e. “outside, as received”) when describing the location of stains or areas tested.

Paperwork contained in Sexual Assault Kits is not considered biological evidence and does not need to be designated or reflected in the DNA report. Refer to Screening Casework Worksheets in Appendix D for additional information regarding screening and the use of the LIMS.

2.4 Securing Package Contents/Evidence Sealing
Evidence containers and packages (including known reference samples for casework) must be sealed in a manner to preserve the integrity of the evidence and to prevent inadvertent addition or removal of items.

2.5 Photodocumentation
Photodocumentation of physical items of evidence is not required. However, when photodocumentation occurs, the following guidelines should be followed:
1) A scale/ruler must be placed in the field of vision next to each item of evidence being photographed. It is recognized that some close-ups may not be conducive to the use of a scale/ruler. In such situations, an overview photo of the item must include a scale/ruler in the field of vision. Photos intended to document the packaging of items and/or photos taken of serological results (P30, Hematrace, RSID-saliva, and microscopy) do not require the use of a scale/ruler.
2) The Lab Case #, Lab Item #, analyst’s initials and the date must be placed on a placard or otherwise designated in the field of vision for each photo. It is recognized that some close-ups may not be conducive to the required information. In such situations, an overview photo of the item must include all required information in the field of vision. 

**Note:** In the event a photo is being taken of an outer package that contains several other designated Lab Item #s inside, the Lab Item # may be omitted. The outer package itself does not have an associated Lab Item #.

3) Overviews should be taken of each item of evidence to document its overall features.

4) Close-ups of staining and/or areas of interest should be taken if not already visible in the overview photo(s).

5) Each photo file must be made available for discovery by upload into the Object Repository of LIMS. At minimum, photos must be named to include “DNA”, the Lab Case # and Item #. An additional description of the photo is optional (e.g. DNA_14-11953_Item 1 Outside Front Overview).

If the analyst wishes to enhance a photo manually after printing (e.g. adding designations for the areas tested during screening, screening results, etc.), the analyst must initial and date next to any additions made to the printed photo.

### 2.6 Collection of Touch DNA

Touch DNA commonly refers to the analysis of DNA from skin cells left on an object after it has been touched or casually handled.

#### 2.6.1 Swabbing Touch DNA Samples from Handles, Surfaces, etc.

Collect a DNA sample using one swab moistened with molecular grade water or digest buffer, using the entire surface area of the swab to apply vigorous pressure. Additional swabs may be used for collection depending on the amount of staining transferred to the swab.

#### 2.6.2 Swabbing Touch DNA Samples from Firearms

In the absence of a request for latent print analysis or when blood may be present, firearms may be swabbed in their entirety. Avoiding areas which appear to be stained with blood, collect a DNA sample with one swab moistened with molecular grade water or digest buffer, using the entire surface area of the swab to apply vigorous pressure focusing on the following areas:

- Revolvers: trigger, hammer, cylinder release, ridged surfaces on cylinder, and grip
- Semiautomatic handguns: trigger, slide serrations, hammer, and grip
- Weapon magazines: bottom of magazine and the feeding area
- Rifles and shotguns: trigger, stock, and forestock
- Other textured surfaces such as the magazine release, safety, and other buttons present may also be swabbed

Additional swabs may be used for collection depending on the amount of staining transferred to the swab.
2.7 DNA Screening Overview for Sexual Assault Kits

The LVMPD Biology/DNA Detail utilizes a streamlined process based on the specific case scenario for the analysis of evidence contained within a Sexual Assault Kit. Refer to the flow charts at the end of this chapter for how to select and process samples based on each case scenario.

Based on the provided case documentation and/or scenario, samples collected directly from a body cavity or genitals should be tested for the presence of possible semen (acid phosphatase and P30) and/or using the confirmatory test for sperm. Presumptive testing is not required for these samples.

Note: Based on case scenario, it may not be necessary to test penile swabs collected in male/female sexual assaults for the presence of semen and/or sperm due to the female epithelial cells being the probative fraction. In such situations, a differential extraction may be performed without the completion of serological testing. Documentation of the case scenario and the analyst’s decision to not perform serological testing on the penile swabs will be included in the case file.

Samples collected from clothing that indicate an inconclusive presumptive semen result or a positive presumptive semen result must be confirmed by identifying sperm or indicated with P30 in the absence of sperm. Samples collected from clothing that indicate a negative presumptive semen result do not have to be subjected to further confirmatory semen/sperm tests.

The following guidelines should be followed when screening sexual assault cases utilizing P30 and microscopy:

1) If P30 testing is performed first, microscopy must take place regardless of the positive or negative P30 result.
2) If microscopy is performed first and sperm is identified, then P30 testing does not have to be performed on the positive sample.
3) If microscopy is performed first and sperm is not identified, then P30 testing must be performed. If the subsequent P30 testing is positive, the sample should be moved forward for differential extraction and a second microscopic sperm search must be performed as outlined in the differential extraction protocol. Refer to Microscopic Identification of Spermatozoa for additional information.

Note: There may be instances in which a sample may result in a weak positive or inconclusive P30 test and a negative microscopic sperm search. Depending on the case scenario, a regular non-differential extraction of the sample may be warranted, rather than a differential extraction. An explanation for the reason why a sample will be moved forward with a non-differential extraction will be documented in the analyst’s notes and/or the CONFIRMadactyl workbook.

A sample tested that indicates an inconclusive presumptive or confirmatory blood or semen/sperm result(s) must have an explanation in the notes as to why it is being called inconclusive and cannot be reported as a positive or negative result. For presumptive tests, this must be documented in the screening section of the Biology/DNA worksheet in the LIMS. For confirmatory tests, this must be documented on the CONFIRMadactyl workbook or screening section of the Biology/DNA worksheet in the LIMS. The reason for the inconclusive will be stated on the report.

2.8 Requests for Termination of Analysis After Sampling
At times, requests may be received to terminate analysis after screening/sampling has already commenced (e.g. case is adjudicated, etc.). In the event a portion of an item has been sampled into a tube in anticipation of additional analysis when the request for termination is received, the sampled portion will be returned to the original sample packaging. The outside of the package will be physically marked by the Forensic Scientist or Forensic Laboratory Technologist to indicate what has been re-packaged inside (e.g. swabbings, hairs in petri dish, portion of sampled swabs, etc.), and the date/intials of the individual placing the items inside. Alternatively, a split may be performed in WinACE with an Officer’s Report to individually book the sampled portion of the item.

2.9 Use of an Alternate Light Source (ALS) in Evidence Examination

Body fluids like semen, saliva, and vaginal fluids naturally fluoresce under certain wavelengths and the use of an alternate light source offers a unique method for locating them. The user can narrow down the specific locations of stains for collection instead of testing entire, large pieces of evidence. It is necessary to tune to visible wavelengths to eliminate any background interference from the article that is examined.

Blood does not fluoresce; it absorbs at 415 nm and reflects at 254 nm. Stain contrast against the substrate background can be observed.

Warning! ALS units can produce bright and intense light. Do not look directly into the light unit.

The Biology/DNA Detail uses the following ALS equipment:
- Mini-CrimeScope MCS-400
- Crime-Lite 80S
- Crime-Lite 82S

2.9.1 Mini-CrimeScope MCS-400

Refer to Maintenance of Mini-Crime Scope MCS-400 for maintenance.

Settings
- **UV** - The UV setting or light, along with clear or yellow goggles, can be used when examining dark colored items or in searching for the presence of saliva.
- **445/455/CSS/515** - These settings, along with the orange goggles, can be used in searching for the presence of body fluids on items of evidence. The 515 nm setting is the optimal setting for white colored items.

Method
1) Turn on main switch (in the back). Check to make sure there is air circulation on both exhaust top holes and on the fan located above the light guide connection.
2) Aim the wheel towards a wall and turn on the lamp switch (on the front of the unit). Within 1-2 minutes a bright spot will appear. If the spot is weak, verify that the intensity knob on the front of the unit (located below the light guide connection) is open all the way.
3) When finished, turn off the lamp first (front switch). Let the fan run for 3-5 minutes and then turn off the main switch (back switch).
4) Do not restart the lamp when the bulb is still hot. It will shorten the life of both the lamp and the power supply. An arcing noise may be heard when re-starting too early.
2.9.2 Crime-Lite 80S
Refer to Maintenance of Crime-Lite 80S for maintenance.

Settings
The Crime-lite 80S has a fixed nominal wavelength of 485 nm with a 10% bandwidth incorporated (460-510 nm). This setting, along with the orange goggles, can be used in searching for the presence of bodily fluids on items of evidence for longer (over one minute) periods of time. For shorter periods of time (one minute and under), the orange glasses can be used to identify the presence of bodily fluids on items of evidence.

Method
1) Connect the battery adaptor (teal with cord and plug) to the battery (blue and white) by sliding the battery adaptor onto the top of the battery until it “clicks” into place. While the unit is OFF, connect the cord from the battery adaptor into the base of the Crime-lite handle. Note: Inside the storage case there are both a wall adaptor and power cord to use in lieu of the battery. There is a second battery and a carrying case with a shoulder strap in case you would like to mobilize the unit around the room/elsewhere. The battery also has a waist belt clip built in to the teal adaptor portion so that it can be clipped if desired.

2) Ensure that a battery is charged prior to use to guarantee the best output from the light. In order to remove the battery from the charger or the Crime-lite unit, push the white retaining catch down and slide in the opposite direction.

3) In the storage case for the unit is a yellow camera filter lens that screws on to the front of the FujiFilm S100FS camera. The filter can be used on the camera while analyzing evidence in order to photographically document any fluorescence found on the evidence itself. Please handle with care as it is fragile glass and avoid leaving any residue (fingerprints) on the lens. To clean the filter lens, wipe clean with a dry KimWipe.

4) If the unit is used for an extended period of time, allow the unit to cool prior to replacing it back into the storage case.

2.9.3 Crime-lite 82S
Each Crime-lite 82S features sixteen LEDs along with narrow bandwidth light sources, fluorescence viewing filters (anti-glare viewing goggles), and optional attachments to a 5MP Vis-IR camera with optical filters. A tablet PC utilizes image-capture software for visualization and recording of evidence undergoing infrared examination. The Crime-lite 82S can be operated with a compatible rechargeable portable battery or can be AC-powered when connected to the camera and software feature.

Important! Parts may only be cleaned with alcohol wipes—do not use bleach or Dispatch on any part of the 82S!

Select the light source you wish to use based on the type of body fluid you are searching for:
- Blood: IR (keep the room lights on)
- Semen and/or saliva: Blue and UV (turn the room lights off)

Safety eyewear must be worn when operating the light source manually or attached to the camera. When operating the camera, the appropriate viewing filter must also be used:
- UV 350-380nm, UV GG420 safety glasses and camera filter II
- Blue 420-470nm, GG495 viewing goggles and camera filter III
- Infrared 800-900nm, IR blocking safety glasses and camera filter IIII

**Manual Operation**

1) Attach the light to the battery adaptor and then to the rechargeable battery. The light source may also be attached directly to the wall outlet.

To use the portable battery:

To use the wall outlet:

2) When using the UV or IR light source, ensure the key is inserted into the bottom of the unit. If the key is parallel with the 0, the light is locked off; turn it perpendicularly to unlock it:
3) When operating the crime-lite manually and without the use of the camera, use the appropriate goggles to view fluorescent staining (blue and UV lights).

**Note:** IR light source *must be* connected to the camera in order to see any possible absorption staining.

**Using the Camera**

Camera assembly:

---

**Using the Camera and Software**

1) A set of viewing filters are located on one side of the camera. Depending on the light source being utilized, position the wheel to correspond to the side that holds the descriptions.
2) Turn on the laptop.
3) Click the Crime-lite Cam software. Upon launch of the software, a live display from the camera will appear.

4) When the user is in live mode, the button will appear yellow (default). Clicking on the yellow Live button changes it to green, allowing the user to view select stored images.

5) Use of the Exposure Control enables or disables automatic exposure.
   - Automatic exposure attempts to produce an image of acceptable brightness. When Auto is enabled, the lettering is yellow. The More and Less buttons are manual exposure controls that increase or decrease the image brightness.

6) The camera is equipped with a motorized lens. The Auto button will initiate the auto-focusing procedure. Manual focus can be performed using the Cam controller or by moving the toggle.

7) The Annotate button displays the annotation toolbar, which enables text and graphics to be added to the image.
   - This function may be used to add the Lab Case #, Item number and any other notes directly onto your image.
8) The Grab Image button moves the live image into the image-store located on the C: drive (or desktop shortcut named “Grab Folder”) and as a thumbnail on the bottom of the screen in the Crime-lite Cam software. The image-store is temporary storage and will only grab up to 20 images before the older images are deleted to make room for new ones. In order to save images:

- Right-click an image in the image-store area to select options to Delete, Delete All, Delete All But This, Save or Save All.
- To save, highlight your desired image and click Save.
- Click the Save As button to save images directly to a specified location on the computer or thumb drive.
- Alternatively, launch the Grab Folder on your desktop and cut and paste the image to the Working Folder.

Note: Unlike the Grab Folder, the Working Folder does not have a capacity for the number of images it can save.

9) The Capture Evidence button will capture the image viewed directly into the Working Folder if all information has been filled out for the Device Settings and Case Details window.

- Enter the information into each field and then select the white box in the upper righthand corner for the information to populate onto the image.

- When using this option, the font size, color, etc. can be adjusted and the text may be edited via Annotate.
- The information entered will be stamped onto the image.
Click Capture Evidence. And then save. The captured evidence consists of two files: a .tif image file and a .set text file. If necessary, the .set text file can be opened with a Notepad application.

2.10 Chemical Tests for Blood

After locating a suspected bloodstain, or area in question, the stain should be tested with a preliminary chemical color test to determine if possible blood is present. The results of the test shall be noted. The examiner may choose to conduct general surface rubbings with a swab or filter paper. If the test is positive and blood is indicated, record the results and further DNA testing should be conducted.

Of the several presumptive tests that have been used in the field of Forensic Biology for the detection of blood, phenolphthalein has high sensitivity and relatively low cross reactivity. A commercially available tetramethylbenzidine (TMB) presumptive blood test kit can also be used as an alternative to the phenolphthalein reagents. Use of TMB allows for more visible discernibility of a positive color-change reaction on red and pink substrates than is attainable with the PT reaction.

It is analyst discretion, and dependent upon case scenario, whether to use a test for higher primate blood following the results of the presumptive test.

Note: If a sample is going to be reported as “inconclusive” for a chemical test for blood, then an explanation as to why must be detailed in the notes and a statement must be included on the report (refer to reporting Inconclusive Serological Results).

A second test that may be used to detect the presence of hemoglobin is the OneStep ABAcard® HemaTrace® Immunochromatographic Test for the Forensic Identification of Human Blood. This test is optional, however it should be utilized when the case documentation and/or scenario indicates the possibility for a presumptive false positive result.

2.10.1 Phenolphthalein (Kastle-Meyer) Presumptive Test

The basic principle behind the phenolphthalein test is that the heme portion of hemoglobin has peroxidase-like activity which can break down hydrogen peroxide into free hydroxyl radicals. In the presence of an oxidizable compound such as phenolphthalein (Kastle-Meyer reagent), the radicals will oxidize the colorless phenolphthalin into the fuchsia-pink phenolphthalein (PT), thus indicating the presence of blood (heme).
Refer to Appendix A of DNA Quality Manual for Reagent Preparation.

Controls and Quality Assurance Check
A known bloodstain and a negative control must be tested each day before reagents can be used for casework samples. The results must be documented in the exam notes. Should a reagent fail to perform as expected, that lot number must be discarded and the Technical Leader should be notified.

Method and Interpretation
1) A small cutting, swabbing, filter paper rubbing, or extract of the suspected bloodstain is taken.
2) Two drops of PT Step 1 are added to the stain.
   • In the event a color change occurs, the results of the test will be reported as inconclusive (refer to reporting Inconclusive Serological Results).
3) Add two or three drops of 3% hydrogen peroxide.
4) A positive result is indicated by the development of an intense pink color within several seconds. A very weak reaction from a stain which is brown is an indication that the stain is aged or diluted and the heme molecules are less likely to be removed from the substrate.
5) An absence of color change, especially on repeated tests, is an indication that there is no or insufficient hemoglobin present and should be recorded as negative.

Note: This is not a confirmatory test for blood.

2.10.2 Tetramethylbenzidine (TMB) Presumptive Test
The tetramethylbenzidine (TMB) presumptive test for blood is a catalytic test which is based on the peroxidase-like activity of hemoglobin. Hemoglobin has the ability to cleave oxygen molecules from hydrogen peroxide (H₂O₂) and catalyze the reaction from the reduced form of 3,3',5,5'-tetramethylbenzidine to the oxidized blue-green colored product, thus indicating the presence of blood (heme).

Controls and Quality Assurance Check
A known bloodstain and a negative control must be tested each day before the reagents can be used for casework samples. The results must be documented in the exam notes. Should the kit’s reagents fail to perform as expected, immediately discontinue use of the reagents, notify the Technical Leader, and contact the manufacturer.

Method and Interpretation
1) A small cutting, swabbing or filter paper rubbing of the suspected bloodstain is taken.
2) A drop of TMB reagent is added to the stain.
   • In the event a color change occurs, the results of the test will be reported as inconclusive (refer to reporting Inconclusive Serological Results).
3) Add a drop of 3% H₂O₂.
4) A positive presumptive test result is indicated by the sample turning a deep blue color within several seconds. On a white substrate the developed color appears as a blue-green. On a red substrate the developed color appears more like a deep blue or indigo. This is a presumptive positive indication for the presence of blood. A very weak reaction from a brown stain is an indication that the stain could be aged or diluted and the heme molecules are less likely to be removed from the substrate.
5) An absence of color change, especially on repeated tests, is an indication that there is no or insufficient hemoglobin present and should be recorded as negative.

2.10.3 **OneStep ABACard® HemaTrace® Immunochromatographic Test for Human (Higher Primate) blood**

More specific than the phenolphthalein presumptive test, the **OneStep ABACard® HemaTrace®** is designed to be used as a screening test for human/higher primate blood in the forensic laboratory and at crime scenes. The **OneStep ABACard® HemaTrace®** is a rapid immunochromatographic test that is sensitive, capable of detecting trace levels of human (higher primate) hemoglobin, and can be performed on bloodstains that have been stored for many years. Test kits are stored below 82°F (28°C).

**Principle (from HemaTrace® product literature)**

In this test procedure, 200 µL of solution containing the sample is added to the sample well ‘S’, and allowed to soak in. If human (higher primate) hemoglobin (hHb) is present in the specimen, it will react with the mobile monoclonal antihuman (higher primate) Hb antibody, and a mobile antigen-antibody complex is formed. This mobile antibody-antigen complex migrates through the absorbent membrane device towards the test area ‘T’. In the test area, a polyclonal antihuman (higher primate) Hb antibody is immobilized. This immobilized antibody captures the complex so that an antibody-antigen-antibody sandwich is formed. The conjugated pink dye particles concentrate in a narrow zone on the membrane. When the hHb concentration in the sample exceeds 0.05 µg/µL, the pink dye particles will form a pink-colored band in the test area ‘T’ indicating a positive test result.

As an internal positive control, hHb antibody-dye conjugates cannot bind to the antibody in the test area ‘T’, but are captured by an immobilized anti-immunoglobin antibody present in the control area ‘C’, forming a complex. The captured pink dye particles will form a band in the control area ‘C’, indicating that the test has worked properly.

**Controls and Quality Assurance Check**

Upon receipt of a new lot, a known bloodstain positive control and a negative control must be tested before the lot can be released for use in casework.

Additionally, a known bloodstain positive control and a negative control must be run with each batch of casework samples. The results must be documented by notes or photos. Should a reagent or device fail to perform as expected more than once, then that lot must be discarded and the Technical Leader should be notified.

**Method and Interpretation**

1) Remove a small section of the stain or swab (approximately 3-5 mm²), place into a 1.7 mL tube, and soak in 200 µL of Phosphate Buffered Saline (PBS) until heme appears in the supernatant. Label additional tubes for the positive and negative controls and add buffer to the controls. The volume of PBS may be increased if the same sample will be tested for P30 as well.

**Note:** The supernatant will turn reddish-brown as heme is released from the stain.

2) Allow the stain to soak for 1-5 minutes before testing. Older stains may require longer incubation times. Also, if a sample is being soaked for both P30 and HemaTrace testing, the sample may follow the incubation requirements for P30 testing.
3) If retaining the sample for subsequent testing, place the substrate into a spin basket and centrifuge for 3-5 minutes. The substrate may be stored for future use at 2-8º C.

4) If necessary, remove a portion of the supernatant and dilute with additional PBS to obtain a straw-colored or colorless solution. Supernatants which are extremely dark in color may result in the high dose hook effect, thereby yielding a false negative result.

5) Remove the HemaTrace® device from the sealed pouch and label with the lab number and Lab Item #.

6) Pipette approximately 200 µL (4 drops from HemaTrace® dropper) of stain supernatant into the sample well.

7) Read results 10 minutes after adding the sample to the sample well. Positive results may be seen as early as 2 minutes, however a negative result requires a full 10 minutes.
   a. **Positive results**: Indicated by the presence of two pink lines, one each in the test area ‘T’ and in the control area ‘C’. The test is positive and indicates that the human (higher primate) hemoglobin level is at or above 0.05 µg/mL.
   b. **Negative results**: Indicated by only one pink line present in the control area ‘C’. This result may indicate that no human (higher primate) hemoglobin is present at detectable levels or that a very high level of human (higher primate) hemoglobin has resulted in what is termed a “high dose hook effect”. Both of these possibilities can be confirmed by concentration or dilution of the sample followed by a second test with a new device.
      Note: In the event blood is the body fluid of interest, samples with negative HemaTrace results do not require DNA analysis.
   c. **Inconclusive results**: Indicated by the absence of a pink line in the control area ‘C’. The test should be repeated. Make a note of the HemaTrace® device lot number of the inconclusive results.
      Note: If a sample is going to be reported as “inconclusive” then an explanation as to why must be detailed on the CONFIRMadactyl workbook or in the screening section of the Biology/DNA worksheet in the LIMS. A statement must also be included on the final report (refer to reporting **Inconclusive Serological Results**).

2.11 Chemical Tests for Semen

After locating a suspected semen stain, or area in question, the stain may be tested to determine if possible semen is present.

If a sample is going to be reported as “inconclusive” for a chemical test for semen, then an explanation as to why must be detailed in the notes and a statement must be included on the report (refer to reporting **Inconclusive Serological Results**).

During the acid phosphatase test, the acid phosphatase present in the semen enzymatically acts on sodium alpha-napthyl phosphate to release alpha-napthyl. The alpha-napthyl can then react with the dye napthanil diazo blue B to form a purple colored diazonium alpha-napthyl compound.

This test is a preliminary color test which, if positive, indicates the possible presence of semen. It is not a confirmatory test since acid phosphatase is found in other substances, including other body fluids. To conserve sample, this test can be optional if the analyst performs microscopic testing of the stain with a positive result or microscopic testing and P30 of the stain when the microscopic results are negative.
**Note:** Due to the age of the evidence being examined, AP tests may result in a negative or inconclusive result. A microscopic sperm search may be necessary to ensure that DNA testing is not warranted.

### 2.11.1 Acid Phosphatase Overlay Presumptive Test for Semen

Refer to Appendix A of DNA Quality Manual for Reagent Preparation.

**Controls and Quality Assurance Check**

The working solution must be tested against a known semen sample and negative control each day of use before the solution can be used for casework samples. The results must be documented in the exam notes. Should a reagent fail to perform as expected, that lot number must be discarded and the Technical Leader should be notified.

**Method and Interpretation**

1. Place a piece of Whatman No. 3 filter paper over the questioned stain. Put orientation marks on the paper. Spray the paper lightly with distilled water to thoroughly dampen it. Apply pressure to the paper so that it comes in contact with the semen stain for several seconds.
2. Hang the paper in a fume hood so that the side that contacted the stain is facing the front of the hood.
3. Using a spray bottle, or other spraying apparatus, spray the paper thoroughly with the AP overlay working solution.
4. A positive reaction is recorded upon development of a purple color (usually within 3 minutes) which is indicative of possible semen. Old and/or desiccated samples may require closer to 3 minutes of the reaction time for color development. If no color change occurs, the reaction is negative. Color changes which occur after 3 minutes will be reported as inconclusive (refer to reporting Inconclusive Serological Results).

**Note:** In the event semen is the body fluid of interest, samples with negative AP overlay results do not require DNA analysis.

### 2.11.2 Microscopic Identification of Spermatozoa

Once a stain has been located, the area can be examined for the presence of spermatozoa. The extraction technique and making of a stained smear slide are the same for identification of epithelial cells and/or spermatozoa.

Once the smear has been dried and heat fixed it can be examined for the presence of cells. Due to the relatively small size of sperm when compared with other cells and cellular debris, the smear must be treated with a differential biological stain. This process allows detection of small numbers of sperm. The specific staining method utilized is the Kernechtrot-Picroindigocarmine stain (KPIC) which is also referred to as the Christmas Tree stain. Specifically, nuclear material stains red and background material stains green so that the sperm head and cell nuclei will be seen as red and other biological material will be seen as green. Definitive identification of spermatozoa is made based on the approximate size and staining pattern in which the acrosomal cap will stain less intensely than the rest of the sperm head while the mid-piece and tail (if present) will stain green.

**Reagent Working Solutions:**

Solution A: SERI Xmas tree Kernechtrot stain (red).
Solution B: SERI Xmas tree Picroindigocarmine stain (green).
Method
1) Remove 1-3 µL of the re-suspended cell debris pellet sample and heat fix on a microscope slide bearing a thin smear of questioned stain extract for several minutes using a lamp, oven or heat block as a heat source (refer to P30 test instructions).
2) Add a sufficient amount of Solution A (Kernechtrot red reagent) to cover the smear. Allow the slide to stand at room temperature for 15-20 minutes.
3) Wash Solution A off the slide with gentle stream of DI water over an approved disposal container.
4) Add a sufficient amount of Solution B (Picroindigocarmine green reagent) to cover the smear. Allow the slide to stand at room temperature for 5-15 seconds.
5) Wash Solution B off the slide with a gentle stream of ethanol over an approved disposal container. Let the slide air dry at room temperature.
6) After the slide has dried, apply a small drop of mounting medium, such as Cytoseal™ 60, to the slide and top with a coverslip.
7) Once dried, the slide is now ready for viewing.

Estimating the Quantity of Spermatozoa and Epithelial Cells
Refer to Microscope Manuals on the H:drive for instructions on how to utilize the different microscopes available within the Biology/DNA Detail.

The relative amount of spermatozoa present in any evidence sample can be estimated by observing the average number of sperm present in several microscope fields at 40X magnification. A general guideline for this determination will be recorded in the associated notes as follows:

(-) no sperm present
+/- inconclusive
+1 one to a few; difficult to locate
+2 some in several fields
+3 some in many fields; easy to locate
+4 many in most fields

Note: All “inconclusive” results must include an explanation as to the qualitative reasons for that conclusion. The explanation must be detailed in the CONFIRMadactyl workbook or the screening section of the Biology/DNA worksheet in the LIMS and a statement must be included on the report (refer to reporting Inconclusive Serological Results).

An evaluation as to the relative amount of epithelial cells present in any evidence sample can serve as an aid in determining how a sample will be subsequently processed downstream during the analysis process (e.g. utilizing additional wash steps during differential extraction, etc.). The evaluation can also serve as a general predictor of the potential success of recovering a DNA profile from the sperm cells present in a sample (e.g. extremely high epithelial content present versus +1 sperm).

This evaluation can be estimated by observing the relative amount of epithelial cells present in several microscope fields at 40X magnification. A general guideline for this determination will be recorded in the microscopy notes of the CONFIRMadactyl workbook as follows:
neg or (-) no epithelial cells present
low or +1 small amount of epithelial cells present; little clustering
mod or +2 moderate amount of epithelial cells present; some clustering
high or +3 large amount of epithelial cells present; cells appear in large clusters making sperm search challenging
extreme or +4 extremely high amount of epithelial cells present; cells blanketed together making sperm search extremely difficult

2.11.3 SERATEC® PSA SEMIQUANT Test for Seminal Fluid (P30)
The Seratec PSA Semiquant test is a chromatographic immunoassay for the rapid semi-quantitative determination of prostate-specific antigen (PSA) in body fluids. The test was designed to be used clinically as a screening test for prostate-specific antigen, in blood serum, to allow the detection of elevated levels of PSA that might be an indication of prostatic cancer. Relevant to forensic investigations, the test can also be used for the detection of semen, as PSA is normally found in seminal fluid, regardless of cancer activity. The test is sensitive and capable of detecting trace levels of seminal fluid. Test kits are stored at room temperature.

Note: Other body fluids such as blood or urine can also contain PSA. In addition, PSA can be found in very low concentrations in female vaginal fluid. Normally the PSA concentrations in other body fluids are low; therefore p30 test interference with non-seminal fluid samples is not normally expected.

Note: Due to the age of the evidence being examined, p30 tests may result in a negative or inconclusive result. A microscopic sperm search may be necessary to confirm the absence of sperm.

Principle (from Seratec product literature)
In this test procedure, 200 µL of solution containing the sample is added to the test well and allowed to soak in. If prostate-specific antigen (PSA) is present in the specimen, it will react with mobile gold-labeled monoclonal murine anti-PSA antibody in the test well, and a mobile antigen-antibody complex is formed. This mobile antigen-antibody complex migrates through the absorbent membrane device towards the test area ‘T’. In the test area, another anti-PSA antibody is immobilized. This immobilized antibody captures the complex so that an antibody-antigen-antibody sandwich is formed. The sandwich formation is indicated by the appearance of a red line in the test area ‘T’, indicating a positive test result. Additional anti-PSA antibodies will be bound by immobilized polyclonal goat anti-mouse antibodies in the control area ‘C’ and internal standard area, located in between the control and test areas. The appearance of two red lines in the control and internal standard areas indicate the correct execution of the test.

Controls and Quality Assurance Check
Upon receipt of a new lot, a known semen positive control and a negative control must be tested before the lot can be released for use in casework.

A known semen positive control and a negative control must be run with each batch of casework samples. The results must be documented in the exam notes. Should a reagent or device fail to perform as expected more than one time, then that lot must be discarded and the Technical Leader should be notified.

Method and Interpretation
1) Remove a small section of the stain and place 750 µL of PBS in the tube. Label additional tubes for the positive and negative controls and add buffer to the controls. Incubate at room temperature for a minimum of 10 minutes, up to overnight depending on the age and quantity of the stain. Incubate at 2-8°C, if overnight incubation is used. Place substrate in a spin basket and centrifuge 3-5 minutes.

2) Label the test device with the lab number and Lab Item #. Add 3-5 drops (approximately 200 µL) of the supernatant to the test well.

3) Without disturbing the pellet, remove as much of the supernatant as possible using a sterile pipette tip. In cases involving limited sample size, save the supernatant in a separate tube. Re-suspend the pellet in the remaining liquid.

   Note: This pellet contains epithelial cells and sperm cells and is called the cell debris pellet (refer to the Microscopic Identification of Spermatozoa).

   Optional: The substrate may be stored and added to the tube for extraction.

4) Read the results 10 minutes after adding the sample to the sample well. Positive results may be seen as early as 1 minute after addition of the sample; however, a negative result requires the full 10 minutes. The internal standard for estimation quantity of PSA cannot be read until 10 minutes after the addition of the sample.

   a. Positive results: Indicated by the presence of three pink lines, one each in the test ‘T’, internal standard (unmarked on the device), and control ‘C’ areas. The test is positive and indicates that the PSA level is at least 2 ng/mL. The color intensity of the internal standard correlates to a PSA concentration of approximately 4 ng/mL. Therefore, a test result line lighter than the internal standard indicates the sample contains less than 4 ng/mL PSA. If the test result line is darker than the internal standard, the sample contains more than 4 ng/mL PSA.

   b. Negative results: Indicated by the presence of two pink lines, only in the internal standard (unmarked on the device) and control ‘C’ areas. This result may indicate that no PSA is present at detectable levels.

   c. Inconclusive results: Indicated by the absence of the two pink lines in the internal standard (unmarked on the device) and control ‘C’ areas. The test should be repeated. Results can also be considered inconclusive when there is a combination of no sperm observed and weak positive results are obtained. Make a note of the Seratec device lot number of the inconclusive results.

      If a sample is going to be reported as “inconclusive” then an explanation as to why must be detailed in CONFIRMadactyl or in the screening section of the Biology/DNA worksheet in the LIMS. A statement must be included on the report (refer to reporting Inconclusive Serological Results).

   d. False Negative results: This can occur when very high levels of PSA are present and there are no lines or only the presence of a strong ‘T’ line, known as the “high dose hook effect”. These results can be confirmed by dilution of the sample followed by a second test with a new device.

2.12 Rapid Stain Identification of Human Saliva (RSID™-Saliva)
Alpha-amylases (α-amylases) are present in almost all plants, animals and microorganisms. Different organisms have different chemical and catalytic properties of α-amylase, however each executes the same biochemical reaction in which digestive enzymes break down starches into simpler sugars. Human salivary α-amylase is the major protein component in human saliva which begins the digestion of starch. Human salivary α-amylase is synthesized in salivary gland acinar cells, which are responsible for producing, storing and discharging digestive enzymes. α-amylase
is released in large quantities from the salivary cells in response to the detection of food, certain smells and mastication. Studies have shown that α-amylase may vary significantly in concentration between individuals and may at times be at similar concentrations as that found in other body fluids. Therefore, a negative test does not indicate the absence of saliva.

The Rapid Stain Identification of Human Saliva (RSID-Saliva) test is a rapid immunochromatographic test that has been internally demonstrated to detect levels of human α-amylase to a sensitivity of up to 1:500 dilutions (whereas dilutions of up to 1:20,000 have been reported in literature). No cross-reaction has been observed with blood, semen, urine, vaginal secretions, or menstrual blood. Low-level detection of human fecal samples was observed during internal validation studies. Low-level detection of breast milk has been also observed in literature, however this cross-reaction was not observed during internal validation studies. RSID Running Buffer is stored at 2-8ºC and then brought to room temperature prior to use. The RSID Extraction Buffer received in the kit is not to be used. The RSID cassettes are stored at room temperature.

**Principle**
The RSID-Saliva test kit uses two mouse monoclonal antibodies specific for human salivary α-amylase. One of these antibodies is conjugated to colloidal gold and is deposited on a conjugate pad beneath the sample window. The other antibody is striped on the “test line” on a membrane attached to the conjugate pad. The “control line” on the membrane consists of anti-mouse IgG antibody and issued as a positive control.

In this test procedure, 100 µL of a solution containing the sample is added to the sample well ‘S’, and allowed to soak into the test strip. If human salivary α-amylase is present in the specimen, an antigen-colloidal gold conjugated antibody complex will form. Sample and antibodies (complexed and free) are transported by bulk fluid flow to the membrane section of the strip test. The immobilized anti-α-amylase antibodies on the test line capture the amylase-antibody-gold-complexes, producing a red line at the test position ‘T’, thereby indicating a positive result. If no human salivary amylase is present in the sample, then gold-conjugated antibody-antigen complexes cannot form, and colloidal gold will not be accumulated at the test line.

As an internal positive control, the anti-mouse IgG on the control line ‘C’ captures any mouse antibodies flowing past the test line, thereby producing a red line at the ‘C’ position and ensuring that the sample fluid was transported through the length of the test and that the components of the test strip are working correctly.

With the exception of cases involving loss of consciousness, the suitability of RSID-saliva testing will be determined on a case-by-case basis utilizing the available case information and scenario. Rectal swabs, which are known to produce RSID-saliva positive results, may be screened at the analyst’s discretion as they may not ultimately aid in the determination of which probative samples to move forward for DNA analysis.

In cases involving loss of consciousness in which semen has not already been identified, RSID-saliva testing may be suitable for samples collected from the external orifices (e.g. external genitalia, perianal, etc.), neck, breast, or other external areas of the body. All available case-related information (including prior and post-alleged assault activities such as showering, etc.) should be utilized when making the determination of the suitability of RSID-saliva testing and whether saliva may be possibly present (refer to flow charts for additional guidance).
Controls and Quality Assurance Check

Upon receipt of a new lot, a known saliva positive control and a negative control must be tested before the lot can be released for use in casework.

A known saliva positive control and a negative control must be run with each batch of casework samples. The results must be documented by notes or photos. Should a reagent or cassette fail to perform as expected more than once, then that lot must be discarded and the Technical Leader should be notified.

Method and Interpretation

1) Remove a small section of the stain or swab (about 3-5 mm$^2$), place into a 1.7 mL tube, and soak in 750 µL of Phosphate Buffered Saline (PBS) for a minimum of one hour, up to overnight at room temperature. Incubate at 2-8°C, if overnight incubation is used. Vortex the sample for approximately 10 seconds at the beginning and end of the incubation period.

**Note:** A note must be made in the analyst’s documentation if a sample may possibly contain fecal matter or breast milk (e.g. samples related to an alleged oral or anal assault or breast swabs taken from a lactating individual) as this may also influence a positive result.

1) Following incubation, perform a quick spin in order to remove any possible liquid present in the cap of the tubes.

2) Remove the sample substrate and place into a spin basket. Centrifuge the sample for 3-5 minutes at 11,000 to 13,000 RPM. The substrate may be stored for future use at 2-8º C.

3) Remove 20 µL of the supernatant and place into a new 1.7 mL tube containing 80 µL of the RSID Running Buffer. Vortex to ensure thorough mixing and then perform a quick spin in order to remove any possible liquid present in the cap of the tube.

4) Remove the RSID-saliva cassette from the sealed pouch and label with the lab number and Lab Item #.

5) Pipette the entire 100 µL of the dilution into the sample well of the RSID-saliva cassette.

6) Read results 10 minutes after adding the sample to the sample well. Positive results may be seen as early as 2 minutes, however a negative result requires a full 10 minutes.

   a. **Positive results:** Indicated by the presence of two pink lines, one each in the test area ‘T’ and in the control area ‘C’. The test is positive and indicates that the human α-amylase is present in the sample.

   b. **Negative results:** Indicated by only one pink line present in the control area ‘C’. This result may indicate that no human α-amylase is present at detectable levels. False negatives due to “high dose hook effect” from the presence of extremely high levels of human α-amylase is *not expected* to be observed under standard laboratory testing when using the RSID-Saliva test kit, however may be confirmed by diluting the sample in addition RSID Running Buffer and repeating the test using a new RSID-saliva cassette, if necessary.

   c. **Inconclusive results:** Indicated by the absence of a pink line in the control area ‘C’. The test should be repeated. Make a note of the RSID-Saliva cassette lot number of the inconclusive results.

   **Note:** If a sample is going to be reported as “inconclusive” then an explanation as to why must be detailed on the “Additional Screening Worksheet” and a statement must be included on the report (refer to reporting Inconclusive Serological Results).

2.13 Microscopic Examination of Hairs
Refer to the Microscope Manuals on the H:drive for instructions on how to utilize the different microscopes available within the Biology/DNA Detail.

1) Using a stereoscope or microscope, observe the hair to determine whether root material and/or a skin tag appears to be present.

2) If biological material appears to be present and the hairs were previously mounted, place several drops of the appropriate mounting media solvent around the perimeter of the coverslip. 

**Note:** 100% xylene will dissolve Permount; toluene will dissolve Cytoseal. Nitrile gloves must be worn while working with mounting media solvents. Inspect gloves every 5 minutes for wetness or spots from solvents and change immediately if observed on the glove. It may be necessary for the sample to incubate at room temperature for several minutes to allow the mounting media to dissolve.

3) Carefully remove the coverslip.

4) Using forceps, carefully remove hair(s) and place into a sterile, labeled microcentrifuge tube for extraction.

5) If biological material appears to be present and the hairs were not previously mounted, cut the hair(s) close to the end root and place into a sterile, labeled microcentrifuge tube for extraction.

6) Repackage the remaining hair shaft in glassine paper, a petri dish, or other suitable packaging and return with the original evidence.

7) If no biological material appears to be present and the hair is determined to be unsuitable for nuclear DNA analysis, repackage the hair in glassine paper, a petri dish, or other suitable packaging with the original evidence.

2.14 Sampling Tissue for DNA Analysis

1) Cross section the tissue to access the inner-portion (pink/red) of the tissue, then cut approximately a 3-5 mm$^3$ section of this inner-tissue into small pieces and place into a sterile, labeled microcentrifuge tube for extraction.

**Note:** If the tissue appears to be highly degraded or of poor quality, larger portions of tissue may be sampled. It may be necessary to cross-section the tissue multiple times to identify a portion that is pink/red. This portion should be sampled for analysis.

2.15 Evidence Return

Once analysis is complete or evidence is no longer needed by lab personnel, it will be returned to the evidence vault via a secure move. This requires two authorized ACE users with passwords.
ARCHIVED

Sexual Assault: Multiple Possible Male Contributors, Loss of Consciousness,

...Victims under the age of 18

- Without the use of a condom
- Consensual penetration for 72 hours
- Multiple assailants
- For cases involving:

Differential extraction
- Process using a specific tool or P30

If positive for RSD-saliva, proceed

If not already completed
- Perform P30 and RSD-saliva testing

If all negative for P30, RDS-saliva, and/or

If all negative for RSD, clothing, and unwashed

Differential extraction
- Process using a specific tool or P30

If positive for RSD-saliva, and/or P30

ARCHIVED
**Digital Penetration**

**Sexual Assault**
3.0 Title: Sample Extraction, Purification, and Concentration

Principle
Once samples are identified for DNA testing, they are batched according to extraction methodology.

Quality Assurance

Sample Set-Up and Organization
While extracting, question (Q) and known (K) samples shall be processed separately in both space and time. Questioned samples will always be processed prior to the known samples.

When extracting known samples, cases containing multiple individuals of the same sex should be alternated between cases. In addition, male and female samples may be alternated, if possible.

When utilizing the organic extraction fume hood, a maximum of 48 sample tubes (including reagent blanks) may be manually organically extracted at the same time. For samples that must undergo organic differential extractions, a maximum of 24 samples (including reagent blanks) may be manually extracted at the same time (for a total of 48 sample tubes including the epithelial and sperm fractions).

The maximum number of samples that may be processed on a single run of the EZ1 Advanced XL Robot is 14, including reagent blanks.

When necessary, extraction reagents may be doubled or tripled to completely submerge a sample substrate. Reagent blanks will be treated identically as the largest associated sample.

Extraction Sample Designations
Samples processed within the Biology/DNA Detail will follow a specific naming convention. All applicable designations will be retained throughout the duration of processing and reporting.

- Samples will be designated with the Lab Case #, and the Lab Item # (including the use of the word “Item”) with any dot numbers as needed (e.g. 18-12345 Item 1.1).
- If samples are re-extracted, the end of the sample will be appended with RI# to indicate “Re-Isolation” (e.g. 18-12345 Item 1.1-R11).
- When samples are differentially extracted, the end of the sample will be appended with EF to designate “Epithelial Fraction” or SF to designate “Sperm Fraction” (e.g. 18-12345 Item 1.1-SF).

For database samples, a sequential number beginning with the number 1 will be assigned to all re-extracted samples (e.g. 2015-012345-R11).

Prior to extraction, all tubes will be given a sequential tube number that is unique to the batch of samples being processed. This tube number will at least be carried through the duration of the extraction process which requires tube to tube transfers.
Controls and Standards
Evaluation and monitoring of controls in analytical procedures is essential to the proper interpretation of the test results. For interpretation guidelines that define acceptable results for reagent blank extraction controls, refer to Reagent Blank and Negative Amplification Controls.

Reagent Blanks
Reagent blanks associated with casework, references, and database samples are extracted concurrently with their associated samples and treated identically as their associated samples.

For questioned samples, each Lab Case # being processed will have at least one associated reagent blank per extraction type or run. The reagent blank control(s) shall be the last sample(s) set-up for the extraction and will serve as a control for the preceding samples having the same Lab Case #. Reagent blanks associated with questioned samples are named sequentially per case, as generated, along with the Lab Case # (e.g. 18-01234-RB1, 18-01234-RB2, etc.). The suffixes –EF and –SF are added to the end of the RBs used for epithelial and sperm fractions during differential extractions (e.g. 18-12345-RB1-EF and 18-12345-RB1-SF). In the event it is necessary to perform supplemental analysis for a previously processed case, new reagent blanks will be named with the next sequential number associated with that Lab Case #.

For known samples, at least one reagent blank will be generated for each extraction type or run and may be associated with reference standards from multiple Lab Case #s. Reagent blanks associated with known reference standards are named using the prefix RBK, the date the extraction is started, and the analyst performing the extraction (e.g. RBK-032518-JRC). The reagent blank control(s) associated with known reference standards shall be the last sample(s) set-up within an extraction batch and will serve as a control for all preceding samples.

In databasing, since known reference standards are the only type of extraction performed the prefix used for reagent blanks is only “RB”.
- For manual extraction sets for samples that fail the first time around or are being re-tested for match confirmations, the reagent blank is named according to the date the extraction is started and the analyst performing the extraction

For both casework known reference standards and databasing, extraction reagent blanks must be uniquely named. If more than one extraction is completed by an analyst per day, sequential numbers appended to reagent blank satisfies this requirement. Alternatively, the tube number may be carried through the entire testing process within the sample name due to all tube number/sample name combinations being inherently unique

The use of dashes between prefix, date, and analyst in reagent blank names are optional.

Extraction, Quantitation and Multiple Reagent Blanks
Multiple reagent blanks may be created during the extraction process, and all reagent blanks created must be subjected to the quantitation process.

In the event multiple reagent blanks are created during the extraction process that control for the same set of samples and all blanks are treated identically, then all reagent blanks will be subjected to the
quantitation process and the single reagent blank that demonstrates the greatest signal, if any, will be amplified.

**Clean-up & Concentration of Reagent Blanks**

Reagent blanks must be treated the same as, and parallel to, the forensic and/or casework reference samples being analyzed. The final volume of the blank should always be equal to or less than the lowest associated sample volume before proceeding to amplification.

If a sample needs to undergo clean-up, the associated reagent blank(s) must be cleaned-up as well. Similarly, if a sample needs to be filtered via microcon or CentriVap, the associated reagent blank(s) must also be filtered via microcon or CentriVap. If the reagent blank has already been filtered via microcon or Qiagen cleaned-up using the same reagent and microcon/spin column lot numbers, it is not necessary to re-microcon or re-Qiagen clean-up the associated reagent blank if the blank is already equal to or less than the lowest associated sample volume before proceeding to amplification.

**DNA Extraction Work Area**

This work area should be used for the extraction and isolation of DNA from items of evidence. A variety of equipment and supplies are used, including but not limited to:

- Adjustable pipettes
- Microcentrifuge tube racks
- Sterile microcentrifuge tubes
- Microcon concentrators
- Spin baskets
- Microcentrifuge
- Scissors, forceps, scalpels and sterile wooden sticks
- Sterile aerosol resistant barrier pipette tips
- Disposable gloves: latex/nitrile
- Refrigerator, freezer
- Heating block or incubator
- Vortex
- Lab Coat (white pre-amplification)
- Organic extraction fume hood (casework lab only)
- EZ1 Advanced XL Robots
- UV Crosslinkers
- CentriVap

**Special Precautions**

It is important that DNA extraction of evidence samples be performed according to accepted laboratory practices in order to prevent cross-contamination between evidence and reference samples and to minimize the potential for sample-to-sample contamination. During extraction, questioned samples are processed separately in time and/or space from known samples.

Diluted bleach (10%) or stabilized bleach solution (e.g. Dispatch) shall be used to wash all exposed work areas. At minimum, decontamination of all exposed work areas should be performed prior to the initiation of DNA extraction and at the conclusion of the daily analysis process.
Gloves, a mask, and a lab coat must be worn during DNA extraction. Gloves should be changed frequently when handling and manipulating different samples. Care should be taken by the analyst to continually monitor the integrity of their gloves and to ensure that transfer does not inadvertently occur between samples due to sample manipulation.

Phenol-Chloroform-Isoamyl Alcohol (PCIA) extractions and xylene processing must be performed in the organic fume hood.

Questioned stains/samples are manually organically extracted or extracted robotically using the Qiagen EZ1 Advanced XL. High-template DNA samples such as reference standards and database samples may be extracted manually using Qiagen, Chelex, or organic extraction chemistries, or robotically using the Qiagen EZ1 Advanced XL.

For manual extractions, only one reagent tube should be opened at a time. Special attention will be paid to the labeled identity and lot number of each reagent on the physical tube. The expiration date is located on the proximal container of small reagent tubes.

### 3.1 Chelex Extraction

Chelex extractions can be performed on high template DNA samples such as reference and/or database samples.

**Chelex Working Solution (5% weight/volume)**

- **Total Volume:** 10.0 mL
- **Expiration Date:** 5% Chelex working solution must be made fresh on a daily basis as needed.

**Equipment**

1. Balance
2. Pipette
3. Stir bar
4. Autoclaved 20-30 mL Beaker
5. Magnetic stirrer

**Reagents**

1. 0.5 g Chelex 100 resin
2. 10.0 mL Mol. Biol. Grade water

**Preparation**

1. Add 0.5 g of Chelex 100 Resin to a beaker with a stir bar.
3. Keep the Chelex actively mixing while in use by placing it on a magnetic stirrer.
4. After the extraction is complete, dispose of the remaining solution in the “Chelex Waste” glass bottle.

**Note:** The recipe may be increased proportionally as necessary. Chelex resin is highly inhibitory to PCR. Care must be taken not to transfer any resin beads into the quantitation or amplification tubes.
3.1.1 Chelex Extraction Sample Preparation

**Whole Blood or Bloodstain**
1) Add 3 µL whole blood or a bloodstain approximately 3 mm² to a sterile microcentrifuge tube. Label an additional tube as a reagent control. Pipet 1 mL molecular grade H₂O into the tubes. Vortex for approximately 2 seconds.
2) Incubate at room temperature for a minimum of 30 minutes or refrigerate for longer periods of time. Vortex for approximately 5-10 seconds.
3) Place the substrate in a spin basket (optional) and centrifuge for 3-5 minutes at maximum speed.
4) Without disturbing the pellet, carefully remove the supernatant, leaving enough behind to cover the pellet. If the sample is a bloodstain, return the substrate to the tube with the pellet.
5) **Continue to Chelex Extraction Procedure**

**Reference Buccal Swab**
1) Add the swab cutting or substrate to a sterile microcentrifuge tube.
2) Label an additional tube as a reagent control.
3) **Continue to Chelex Extraction Procedure**

3.1.2 Chelex Extraction Procedure
1) Add 200-400 µL 5% Chelex working solution to each tube (sufficient to submerge the sample).
2) Incubate at approximately 56°C from 30 minutes to overnight.
3) Vortex at high speed 5-10 seconds.
4) Incubate at approximately 100°C in a heat block or boil for 8 minutes.
5) Vortex at high speed for 5-10 seconds. Pulse spin.
6) Place the substrate in a spin basket (optional) and centrifuge 3-5 minutes at 11,000-13,000 rpm. Transfer the substrate to a labeled tube.
7) Store the remainder of the extract in the freezer and label accordingly.

3.2 Organic Extraction Procedure

3.2.1 Organic Extraction Sample Preparation

**Whole Blood/Bloodstains, Saliva Stains, Cigarette Butts, “Touch Evidence” Swabs and Buccal Swabs**

*Note:* If a Hematrace test and an extraction are to be performed on the same substrate, to conserve sample, return the substrate to the tube containing the cell pellet after the Hematrace test is completed.

*Note:* If evidence such as envelopes, stamps or tape is being extracted, 10-20 µL of 1M DTT may be added to help break up the adhesive.

1) Add 10-50 µL whole blood, a portion of stained material, cotton swab(s), portion of cigarette butt, or buccal swab into a sterile microcentrifuge tube. Label additional tubes as reagent blank controls, as necessary.
2) Pipette 500 µL of Digest Buffer.
3) Add 10-20 µL of 20 mg/mL Proteinase K solution or 10-20 µL of 600mAU/mL Qiagen Proteinase K solution (provided with the QIAmp and DNA Investigator extraction kits). Vortex briefly.

4) Incubate samples at 56°C for at least one hour to overnight in a heat block, incubator, or thermomixer.

5) Proceed to Organic Extraction Procedure.

**Differential Lysis of Evidence Potentially Containing Spermatozoa**

1) Label additional tubes as reagent blank controls, as necessary.

2) Add 500 µL Digest Buffer and 10-20 µL of 20 mg/mL Proteinase K or 10-20 µL of 600mAU/mL Qiagen Proteinase K solution (provided with the QIAmp and DNA Investigator extraction kits) to the tubes containing the cell debris pellet and substrate and reagent blank(s). Vortex. Incubate at approximately 56°C for at least 15 minutes to lyse epithelial cells.

3) Vortex, pulse spin, and then remove the substrate and place into a spin basket insert. Centrifuge for 3 - 5 minutes at 11,000-13,000 rpm. Remove spin basket containing the substrate to a new microcentrifuge tube, label accordingly, and store.

4) Transfer all but 50 µL of the supernatant to a fresh microcentrifuge tube for epithelial DNA analysis being careful not to disturb the pellet. Save for epithelial DNA analysis and proceed to Step 3 of the Organic Extraction Procedure.

**Sperm Fraction**

5) To the original tube add 500 µL Digest Buffer and 10-20 µL Proteinase K or 10-20 µL of 600mAU/mL Qiagen Proteinase K solution (provided with the QIAmp and DNA Investigator extraction kits). Incubate at 56°C in a heat block, incubator, or thermomixer for approximately 45 minutes. Spin in microcentrifuge for 3-5 minutes at 11,000-13,000 rpm. Discard all but the last 50 µL of fluid.

6) Wash the pellet as follows: Re-suspend the pellet in 500 µL to 1000 µL Digest Buffer by vortexing briefly. Spin the sample tube in a microcentrifuge for 5 minutes at 11,000-13,000 rpm. Using a sterile 1 mL pipet tip, remove as much of the supernatant as possible without disturbing the pellet.

7) Repeat wash step 5 an additional 1 to 2 times as needed. The number of wash steps can be altered depending on the estimate of the sperm to epithelial cell ratio based on microscopic examinations done during confirmatory testing. The number of wash steps can be increased if a high epithelial cell to sperm cell ratio is observed. The number of wash steps can be decreased if a low epithelial cell to sperm cell ratio is observed. Note: if sperm have already been identified on the first microscopic exam performed during the initial serological screening, performing an additional microscopic exam is optional. If sperm have not been identified, refer to Microscopic Identification of Sperm within the Forensic Biology Screening section.

8) Add 500 µL Digest Buffer to the re-suspended sperm pellet. Add 20 µL of 1 M DTT. Add 10 µL of 20 mg/mL Proteinase K solution or 10-20 µL of 600mAU/mL Qiagen Proteinase K solution (provided with the QIAmp and DNA Investigator extraction kits). Vortex.

9) Incubate at approximately 56°C in a heat block, incubator, or thermomixer for at least 1 hour to overnight. Vortex and pulse spin

10) Proceed to Organic Extraction Procedure Step 3.

**Neat Semen Stain**
1) Pipette 500 µL of Digest Buffer into a sterile microcentrifuge tube. Add 10-50 µL neat semen, a 3-5 mm² section of stained material, or cotton swab(s).

2) Label sterile microcentrifuge tubes as reagent blank controls, as necessary. Pipette 500 µL of Digest Buffer into each tube.

3) Add 10-20 µL of 20 mg/mL Proteinase K solution or 10-20 µL of 600mAU/mL Qiagen Proteinase K solution (provided with the QIAmp and DNA Investigator extraction kits).

4) Add 20 µL of 1.0 M DTT and vortex briefly.

5) Proceed to Organic Extraction Procedure.

Note: A stain suspected of being "neat" should be previewed microscopically by use of Christmas Tree staining for determination of a "mixed" origin. Refer to Microscopic Identification of Spermatazoa for additional information.

Cellular Material from Microscope Slides (sperm and nucleated epithelial cells)

1) Microscopically examine the slide to assess the quantity of sperm and other biological material present in the smear.

2) Remove biological material from the slide using one of the following procedures:

Preparation without mounting medium or coverslip

1) Determine whether the slide was prepared with microscopic immersion oil. If so, wash the slide with stream of 95% or absolute ethanol from a pipette or a wash bottle.

2) Place slide in humidity chamber (Petri dish containing a sterile water-moistened filter paper disk). Add sufficient molecular grade water or PBS to the upper surface sufficient to cover the smear.

3) Incubate slide in chamber at 4°C overnight.

4) Swab the moistened biological material from the slide using a sterile cotton-tip swab.

5) Examine slide microscopically to determine whether material has been removed. If so, proceed to Step 2 of the procedure for Whole Blood/Bloodstains, Saliva Stains, Cigarette Butts, “Touch Evidence” Swabs and Buccal Swabs or the procedure for Differential Lysis of Evidence Potentially Containing Spermatazoa to begin the extraction process. Alternatively, the swab may be dried at room temperature if the material is to be stored.

Preparation when mounted with a coverslip

1) Freeze slide at -20°C for approximately 30 minutes.

2) Remove the cover slip by prying it off with a sterile scalpel. Repeat freezing if necessary.

3) Working in the organic fume hood, place the slide in a covered, glass beaker containing enough xylene to immerse the slide.

4) Incubate for 30 minutes at room temperature with intermittent gentle rocking.

5) Remove the slide and rinse with fresh xylene from a glass serological pipette (plastic may not be used) or glass beaker. Discard all xylene into a dedicated hazardous waste receptacle.

6) Allow slide to dry at room temperature.

7) Refer to preparation without mounting medium or coverslip and continue with extraction.

On occasion, the protocols for microscope slides with and without mounting medium or a coverslip do not adequately remove material from the slide and in such cases an alternative method may be employed:
1) Carefully scrape the smeared material from the slide using small quantities of xylene and a sterile, straight-edged scalpel. Elute material from scalpel blade into a microcentrifuge tube using xylene.

2) Centrifuge for 5 minutes. Remove xylene supernatant and discard into dedicated hazardous waste receptacle.

3) Xylene Wash: Wash the cell pellet with 500 µL of fresh xylene. Mix by hand inversion, then centrifuge for 5 minutes at maximum speed. Remove xylene and discard into an dedicated hazardous waste receptacle.

4) Repeat the xylene wash step at least twice for a total of three washes.

5) Wash the pellet with 1.0 mL 95% or absolute ethanol. Mix by inversion; then centrifuge for 5 minutes. Remove ethanol and discard into an organic waste receptacle.

6) Wash the pellet with 1.0 mL of 70% ethanol. Mix by inversion; then centrifuge for 5 minutes in a microcentrifuge. Remove ethanol and discard.

7) Add 500 µL of molecular grade water. Mix by inversion; then centrifuge for 5 minutes. Remove water and discard.

8) Blot the inside of the tube to remove excess liquid with a sterile swab taking care not to disturb the cell pellet. Proceed to Step 2 of the procedure for Whole Blood/Bloodstains, Saliva Stains, Cigarette Butts, “Touch Evidence” Swabs and Buccal Swabs to begin the extraction process.

**Cellular Material from Microscope Slides (Soft Tissue)**

Examine the slide microscopically to assess the quantity of tissue material present in the smear (i.e., nucleated cells).

**Remove biological material from the slide**

1) Freeze slide at approximately -20°C for approximately 30 minutes.
2) Pry coverslip off using a cold, sterile scalpel.
3) Working in the organic fume hood, place slide in a covered, glass beaker containing sufficient xylene to immerse slide. Incubate at room temperature for at least 30 minutes with agitation (if possible).
4) Remove slide and rinse with fresh xylene followed by a molecular grade water rinse.
5) Using a sterile scalpel, carefully scrape tissue material from the slide and transfer to a sterile microcentrifuge tube.
6) Label additional tubes as reagent blank controls, as necessary.

**Wash the biological material**

1) Perform three 1.0 mL xylene washes of the sample and reagent blank(s) at room temperature for a minimum of 5 minutes on a rocker platform. Centrifuge tissue sample for 2-3 minutes at 11,000-13,000 rpm between washes. Remove xylene supernatant and discard after each wash.
2) Perform one 95% or absolute ethanol wash at room temperature for a minimum of 5 minutes on a rocker. Centrifuge for 2-3 minutes at 11,000-13,000 rpm; then discard ethanol supernatant.
3) Perform one 70% ethanol wash. Centrifuge as above and discard supernatant.
4) Perform one 50% ethanol wash. Centrifuge as above and discard supernatant.
5) Add sterile TE Buffer to the pellet and re-suspend gently by use of a pipette. Draw up and down several times to dislodge pellet. Transfer re-suspended pellet from microcentrifuge to a sterile 15 mL conical polypropylene tube.
6) Perform two TE Buffer washes. Centrifuge for approximately 10 minutes at 2500-3000 rpm between washes. Fill tube to maximum volume with TE Buffer. Place tube on platform rocker for 30 minutes at room temperature for each wash. Following final wash, centrifuge to pellet tissue and discard supernatant.

7) Add 300 µL of TE Buffer to the pellet and vortex briefly to re-suspend pellet.

8) Centrifuge for approximately 3-5 minutes at 11,000-13,000 rpm to pellet. Remove supernatant and discard.

9) Add the following to the sample and reagent blank(s):
   - 500 µL Digest Buffer
   - 10 µL Proteinase K (20 mg/mL) or 10-20 µL of 600mAU/mL Qiagen Proteinase K solution (provided with the QIAmp and DNA Investigator extraction kits)
   - 20µL 1.0 M DTT (Dithiothreitol)
     a. Vortex briefly. Ensure that tissue material is completely submersed in the solution. Incubate at 56°C in a heat block, incubator, or thermomixer overnight.
     b. If tissue material is still visible following overnight incubation, add 25 µL of Proteinase K (20 mg/mL) or 10-20 µL of 600mAU/mL Qiagen Proteinase K solution (provided with the QIAmp and DNA Investigator extraction kits) and incubate at 56 °C in a heat block, incubator, or thermomixer for an additional 2 hours.
     c. Proceed to Organic Extraction Procedure.

Hair

The LVMPD Biology/DNA Detail does not perform microscopic hair comparisons. However, in those instances where hair samples are the only available evidence and/or is deemed critical to the case, the DNA laboratory will perform STR DNA analysis directly on any hairs which exhibit a suitable flesh tag or root material. Alternatively, the intact hairs or the portion of the hairs remaining following STR analysis can be sent to an outside laboratory for mitochondrial DNA analysis when warranted.

1) Cut off about 5 - 10 mm of the proximal (root) end.

2) In the event the hair appears to contain surface dirt or visible contaminants (such as possible blood), wash the hair twice in molecular grade water. If no visible staining or debris is present on the hair, continue to step 4.

3) For mounted hairs freeze the slide in a -20°C freezer for a minimum of 20 minutes. Remove the cover slip by using a scalpel. Alternatively, the coverslip may be removed by soaking the slide in xylene for several hours after cracking the coverslip with a scribe.
   a. Using a pipette, wash away the mounting medium using xylene. Pick up the hair with clean forceps and wash in 100% ethanol: then wash in sterile, deionized water.

4) Label microcentrifuge tubes for samples and reagent blank controls, as necessary.

5) Add 500 µL of Digest Buffer, 20 µL of 1 M Dithiothreitol (DTT) and 20 µL Proteinase K (20mg/mL) to each microcentrifuge tube. Add the hair sample to the appropriate microcentrifuge tube. Incubate at approximately 56°C for 2 hours to overnight. Hair may soften but not dissolve after incubation. Vortex approximately 30 seconds.

6) If hair root is not completely dissolved, add to the sample an additional 20 µL of 1 M DTT and 15 µL of 20 mg/mL or or 10-20 µL of 600mAU/mL Qiagen Proteinase K solution (provided with the QIAmp and DNA Investigator extraction kits). Incubate at approximately 56 °C in a heat block, incubator, or thermomixer for 6 - 8 hours to overnight.

7) Proceed to the Organic Extraction Procedure step 3.

Material from Paraffin-embedded Tissue
1) Cut out tissue from paraffin block with a sterile scalpel. Place the tissue in a glass or disposable petri dish and cut away excess paraffin. Cut tissue into small pieces. Transfer tissue to an appropriately labeled microcentrifuge tube.

2) Perform three 1.0 mL xylene washes at room temperature for a minimum of 5 minutes on a rocker platform. Centrifuge tissue sample for 2-3 minutes at 11,000-13,000 rpm between washes. Remove xylene supernatant and discard after each wash.

3) Perform one 95% or absolute ethanol wash at room temperature for a minimum of 5 minutes on a rocker. Centrifuge for 2-3 minutes at 11,000-13,000 rpm; then discard Ethanol supernatant.

4) Perform one 70% ethanol wash. Centrifuge as above and discard supernatant.

5) Perform one 50% ethanol wash. Centrifuge as above and discard supernatant.

6) Add sterile TE Buffer to the pellet and re-suspend gently by use of a pipette. Draw up and down several times to dislodge pellet. Transfer re-suspended pellet from microcentrifuge to a sterile 15 mL conical polypropylene tube.

7) Perform two TE Buffer washes. Centrifuge for approximately 10 minutes at 2500-3000 rpm between washes. Fill tube to maximum volume with TE Buffer. Place tube on platform rocker for 30 minutes at room temperature for each wash. Following final wash, centrifuge to pellet tissue and discard supernatant.

8) Add 300 µL of TE Buffer to the pellet and vortex briefly to re-suspend pellet.

9) Transfer tissue material to a microcentrifuge tube and spin at 11,000-13,000 rpm for 3-5 minutes to pellet. Remove supernatant and discard. Proceed with step 9 of the wash biological material portion of the cellular material from microscope slides (tissue) section.

Whole/Fresh Tissue

1) Carefully cut the thawed tissue sample to expose the inner portion of the tissue that contains the most pink/reddish color.

2) Cut a small section or sections of tissue that will be adequate for extraction, and place in a labeled microcentrifuge tube (refer to Sampling Tissue for DNA Analysis in the Forensic Biology Screening Section).

3) Label additional tubes as reagent blank controls, as necessary.

4) Add the following to the sample and reagent blank(s):
   - 500 µL Digest Buffer
   - 10 µL Proteinase K (20mg/mL) or 10-20 µL of 600mAU/mL Qiagen Proteinase K solution (provided with the QIAmp and DNA Investigator extraction kits)
   - 20 µL 1.0 M DTT (Dithiothreitol)

5) Vortex briefly. Ensure the tissue material is completely submersed in the solution. Incubate overnight at 56°C overnight.

6) If tissue material is still visible following overnight incubation, add 25 µL of Proteinase K (20mg/mL) or 10-20 µL of 600mAU/mL Qiagen Proteinase K solution (provided with the QIAmp and DNA Investigator extraction kits) and incubate at 56°C in a heat block, incubator, or thermomixer for an additional two hours.

7) Proceed to Step 3 of Organic Extraction Procedure.

3.2.2 Organic Extraction Procedure

1) Pulse spin microcentrifuge tubes containing lysed samples.

2) Transfer the substrate to a spin basket insert and centrifuge for approximately 3-5 minutes at 11,000-13,000 rpm. Remove the spin basket containing the substrate and store inside a new microcentrifuge tube.
3) In the organic hood add 500 µL buffered phenol-chloroform solution to the lysed cells. The volume may be scaled-up to ensure the phenol-chloroform solution is consistent with the lysis volume (1:1 ratio).

4) Rock at room temperature for 3 - 5 minutes and/or vortex for approximately 15 seconds. Spin in a microcentrifuge for 3 to 5 minutes at 11,000-13,000 rpm. Either transfer the upper aqueous layer to a new sterile microcentrifuge tube or remove and discard the bottom organic layer so a second phenol wash can be performed.

5) Repeat steps 3 and 4 one time for a second phenol wash. Additional phenol washes may be performed by repeating steps 3 and 4 until a clean interphase is obtained.

6) Transfer the upper aqueous phase to a Microcon DNA Fast Flow concentrator tube. Due to volume constraints, only 500 µL can be added to the Microcon tube at one time.

7) Spin the Microcon filter in a centrifuge at 0.5G (approximately 2,500 rpm) for 5-30 minutes, until all or most of the liquid has spun through.

8) Transfer the filter to a new tube or remove the wash from the tube, then add up to 500 µL of TE to the top of the Microcon.

9) Spin the Microcon filter in a centrifuge at 0.5G (500 rcf) for 5-30 minutes, until all or most of the liquid has spun through. Repeat step 8 if necessary.

10) If the filter was spun dry, add a minimum of 20 µL of TE to the filter for elution.

11) Collect the concentrated DNA by inverting the upper reservoir of the filter into a clean tube and centrifuge for 3 minutes at 1.0G (1000 rcf).

12) If the final volume is less than 20 µL, more TE may be added to the filter and then re-centrifuged as in step 11 or more TE can be added directly to the extract.

13) Store the extract at 2-8°C or frozen and label accordingly.

3.3 Qiagen Extraction Procedure (QIAmp Isolation)
QiAmp extractions can be performed on high template DNA samples such as reference and/or database samples. Before using Qiagen-QIAmp kits, absolute ethanol must be added to Buffers AW1 and AW2 according to the manufacturer's instructions.

1) Cut a portion of stained material or tip of buccal swab, and place into a microcentrifuge tube. Label sterile microcentrifuge tubes for reagent blanks, as necessary.

2) Add the following:
   - 200 µL Buffer ATL
   - 20 µL Proteinase K (20 mg/mL) or 20 µL Proteinase K solution provided with the Qiagen Kit (600 mAU/mL)

   When necessary, the above volumes may be doubled or tripled to ensure that there is enough total volume to complete submerse the substrate.

3) Incubate at 56°C in a heat block, incubator, or thermomixer for at least 1 hour to overnight. Lysis time will vary depending on the size and density of the source material.

4) Briefly centrifuged to remove drops from inside the lid. **Optional:** Place the substrate in a spin basket and centrifuge at approximately 13,000 rpm for 3 to 5 minutes.

5) Add 200 µL Buffer AL. Vortex gently and incubate at 56°C in a heat block, incubator, or thermomixer for at least 10 minutes. Briefly centrifuged to remove drops from inside the lid. Add 210 µL of ethanol (200 proof). Vortex vigorously.

6) Unpack the QiAamp columns.

7) Briefly centrifuged the sample tube to remove drops from inside the lid. Carefully remove liquid from the microcentrifuge tube and add to the QiAmp column without wetting the rim. Due to volume constraints, only 750 µL of sample can be added to the QiAmp spin column at one
If there is more than 500 µL of sample to be added, then the remainder can be added after the first 500 µL is spun through the filter and the collection tube is replaced with a new one.

8) Close the cap and centrifuge at approximately 8000 rpm for at least 1 minute. Place the QIAamp spin column in a clean collection tube and discard the tube containing the filtrate.

9) Carefully open the spin column and add the 500 µL Buffer AW1 without wetting the rim.

10) Close the cap and centrifuge at approximately 8000 rpm for at least 1 minute. Place the QIAamp spin column in a clean collection tube and discard the tube containing the filtrate.

11) Carefully open the spin column and add 500 µL Buffer AW2 without wetting the rim.

12) Close the cap and centrifuge at approximately 13,000 rpm for at least 3 minutes.

13) Place the QIAamp spin column in a clean microcentrifuge tube (not provided in kit) and discard the tube with the filtrate. The new tube will be the final collection tube. Carefully open the spin column and add 50 - 200 µL of Buffer AE.

14) Incubate at room temperature for at least 1 minute.

15) Centrifuge at approximately 8000 rpm for at least 1 minute. Save the extract, label accordingly, and store at 2-8°C or frozen. Discard the spin column.

3.4 Qiagen Purification/Clean-up

1) If the samples and blanks being cleaned-up are less than 200 µL, bring the volume of each up to 200 µL with TE.

2) Add 200 µL of AL buffer to the samples and blanks being processed. If the starting volume of a sample or blank is higher than 200 µL, add an equal volume of the AL buffer to the tube (ex: If the volume of a sample is 250 µL, add 250 µL of AL buffer to the sample.) Vortex briefly and incubate at 56°C in a heat block, incubator, or thermomixer for at least 10 minutes. Vortex briefly and pulse spin.

3) Add 200 µL of absolute ethanol to the tube(s), or an amount equal to half the total volume of each sample or blank with the AL buffer added (ex: If the total volume of a sample extract plus AL buffer is 500 µL, add 250 µL of absolute ethanol.) Vortex vigorously and pulse spin.

4) Unpack the QIAamp spin column and collection tube. Add the above mixture to the column. Centrifuge at 8,000 rpm for at least 1 minute. Discard the filtrate and replace the collection tube.

5) Add 500 µL of AW1 buffer to the column. Centrifuge at 8,000 rpm for at least 1 minute. Discard the filtrate and replace the collection tube.

6) Add 500 µL of AW2 buffer and centrifuge at approximately 13,000 rpm for at least 3 minutes. Discard the filtrate and the collection tube.

7) Place the QIAamp spin column in a clean microcentrifuge tube (not provided in kit) and discard the tube with the filtrate. The new tube will be the final collection tube. Carefully open the spin column and add 50-200 µL of AE buffer to the column. Incubate at room temperature for at least 1 minute. Centrifuge at 8,000 rpm for at least 1 minute. Discard the spin column. Save the extract, label accordingly, and store at 2-8°C or frozen.

3.5 Qiagen EZ1 Advanced XL Extraction using the DNA Investigator Kit

3.5.1 EZ1 Extraction Sample Preparation
Non-Differential Extraction of Questioned Samples

This protocol is for the EZ1 non-differential extraction processing of questioned samples including but not limited to the following: bloodstains, cigarettes, envelope flaps, swabbings taken of “touch” samples.

1) Add sample cutting to labeled Eppendorf 2.0 mL Safe-Lock or sterile microcentrifuge tube and initiate a reagent blank.
   **Note:** At least one reagent blank must be initiated per Lab Case # with each EZ1 run.

2) Add the following to each sample tube and reagent blank:
   - 475 µL of Digest Buffer
   - 25 µL of Qiagen Proteinase K
   Vortex the sample for 5-10 seconds to ensure thorough mixing.

3) Incubate tubes at 56°C for at least 60 minutes in a heat block, incubator, or on a thermomixer set to 900 rpm. Perform a quick spin of the tubes in order to remove any liquid from the caps.

4) Place the substrate in a spin basket and spin the sample down for 3-5 minutes at 11,000 to 13,000 rpm.

5) Store spin basket and substrate in a dolphin-nose tube.

6) The lysate may be transferred to a labeled EZ1 flat-bottomed screw-cap tube or may remain in the labeled Eppendorf 2.0 mL Safe-Lock tube based on analyst preference. Add the following to each sample tube:
   - 400 µL MTL buffer
   - 1 µL of thawed hydrated cRNA

7) Vortex for 5 seconds to ensure thorough mixing. Perform a quick spin of the tubes in order to remove any liquid from the caps.

8) Proceed to **Running on the EZ1 Advanced XL Robot**.

Differential Extraction of Questioned Samples

This protocol is for the EZ1 differential extraction of questioned samples containing epithelial and sperm cells.

1) Add sample cutting to labeled Eppendorf 2.0 mL Safe-Lock tube or sterile microcentrifuge tube and initiate a reagent blank
   **Note:** At least one reagent blank must be initiated per Lab Case # with each EZ1 run.

2) Add the following to each labeled sample tube and reagent blank:
   - 500 µL of Digest Buffer
   - 20 µL of Proteinase K
   Vortex the sample for 5-10 seconds to ensure thorough mixing.

3) Incubate tubes at 56°C for at least 15 minutes in a heat block, incubator, or on a thermomixer set to 900 rpm. Perform a quick spin of the tubes in order to remove any liquid from the caps.

4) Place the substrate in a spin basket and spin the sample down for 3-5 minutes at 11,000 to 13,000 rpm.

5) Being careful to not disturb the sperm pellet, transfer all but 50 µL of the supernatant to a labeled Eppendorf 2.0 mL Safe-Lock tube or EZ1 flat-bottomed screw-cap tube. Store spin basket and substrate in a dolphin-nose tube.
   **Note:** This is your epithelial fraction. Proceed to **step 6** of the non-differential extraction of questioned samples.

Sperm Fraction:

6) Add the following to each labeled Eppendorf 2.0 mL Safe-Lock tube and reagent blank:
   - 500 µL of Digest Buffer
20 µL of Proteinase K  
Vortex the sample for 5-10 seconds to ensure thorough mixing.

7) Incubate tubes at 56°C for at least 45 minutes in a heat block, incubator, or on a thermomixer set to 900 rpm. Spin the samples for 3-5 minutes at 11,000 to 13,000 rpm.

8) Being careful to not disturb the sperm pellet, remove and discard all but 50 µL of the supernatant.

9) Add 500-1000 µL of Digest Buffer to each of the remaining sperm pellets and vortex for 5-10 seconds to ensure proper resuspension.

10) Spin the samples for 3-5 minutes at 11,000 to 13,000 rpm.

11) Being careful not to disturb the sperm pellet, remove and discard the supernatant.

12) Repeat steps 9 through 11, one to two additional times.

13) If necessary, perform a second microscopic sperm search by referring to Microscopic Identification of Sperm in the Forensic Biology Screening section.

14) Add the following to each labeled Eppendorf 2.0 mL Safe-Lock tube and reagent blank:

   - 500 µL of Digest Buffer
   - 20 µL of Proteinase K
   - 20 µL of 1 M DTT

   Vortex the sample for 5-10 seconds to ensure thorough mixing.

15) Incubate tubes at 56°C for at least 1 hour to overnight in a heat block, incubator, or on a thermomixer set to 900 rpm.

16) At the end of the incubation period, the lysate may be transferred to a labeled EZ1 flat-bottomed screw-cap tube or may remain in the labeled Eppendorf 2.0 mL Safe-Lock tube based on analyst preference.

17) Proceed to Step 6 of the Non-Differential Extraction of Questioned Samples.

**Hair**

1) Cut the root-end of hair to approximately 0.5 cm – 1 cm in length and place in a labeled Eppendorf 2.0 mL Safe-Lock tube or EZ1 flat-bottomed screw-top tube and initiate a reagent blank.

   **Note:** At least one reagent blank must be initiated per Lab Case # for each EZ1 run

2) Add the following to each labeled sample tube and reagent blank:

   - 160 µL of buffer ATL
   - 20 µL Qiagen Proteinase K
   - 20 µL of 1M DTT

   Vortex the sample for 5-10 seconds to ensure thorough mixing.

3) Incubate tubes at 56°C for at least one hour in a heat block, incubator, or on a thermomixer set to 900 rpm.

   - At the end of the incubation period, visually inspect each tube to determine whether the hair has completely dissolved. If necessary, increase the incubation time to ensure complete lysis. An additional 20 µL Qiagen Proteinase K and 20 µL of 1M DTT may be added if necessary.

4) Perform a quick spin of the tubes in order to remove any liquid from the caps.

5) Proceed to Running on the EZ1 Advanced XL Robot.

**Known Reference Standards**
This protocol is for the EZ1 extraction processing of reference samples including but not limited to the following: FTA blood cards, buccal swabs, easiCollect FTA cards, easiCollect sponges.

1) Add sample cutting to labeled Eppendorf 2.0 mL Safe-Lock tube or EZ1 flat-bottomed screw-top tube and initiate a reagent blank

**Note:** At least one reagent blank must be initiated for each EZ1 run

2) Dilute a stock solution of G2 buffer 1:1 using TE in a conical tube.

3) Add the following to each labeled sample tube and reagent blank:
   - 190 µL of diluted G2 buffer stock solution
   - 10 µL of Qiagen Proteinase K

Vortex the sample for 5-10 seconds to ensure thorough mixing.

4) Incubate tubes at 56°C for at least 15 minutes in a heat block, incubator, or on a thermomixer set to 900 rpm. Perform a quick spin of the tubes in order to remove any liquid from the caps.

**Note:** The “Trace TD” protocol utilized by the EZ1 instrument is designed to help mitigate the chances of a small substrate being inadvertently picked up by a tip during the isolation process. In the event the reference sample is bulky in nature (e.g. more than ½ of one swab or a large cutting of material), substrates should be removed prior to placing the sample on the instrument. This may be achieved via the use of an autoclaved wooden applicator, a sterile pipette tip or a spin basket spun for 3-5 minutes at 11,000 to 13,000 rpm. Reference standard substrates may be discarded.

5) Proceed to **Running on the EZ1 Advanced XL Robot**.

### 3.5.2 Running the EZ1 Advanced XL Robot

1) Power the instrument on (located in the back left by the power cord).

2) Perform optional daily maintenance:
   - b. Wipe down the inner surfaces of the instrument using 70% ethanol ONLY.
   - c. Perform a UV run as described in the [Daily Maintenance Section](#).

3) Press “Start”.

4) Analyst will be prompted “Create a report file?” Press “ESC” for No.

5) Select Protocol (dependent upon extraction type).
   - a. Press “2” for Trace TD (Tip Dance) for hair extraction or known extraction.

6) Select Elution Buffer – Press “2” for TE.

7) Select Elution Volume – Press the number corresponding with the desired final elution volume. The elution volume is selected per EZ1 run and is analyst discretion.

8) The screen will then show a review of the parameters – Press “ENT”.

9) Analyst will then be prompted to set up the instrument as follows:
   - a. Place Reagent Cartridges in the cartridge rack located in the back of the instrument
   - b. Place the following in the front rack:
     - Row 1: Labeled sterile microcentrifuge tubes or EZ1 screw-cap elution tubes
     - Row 2: Tips and tip holders
     - Row 3: Labeled sample tube containing sample lysate (either Eppendorf 2.0 mL Safe-Lock or EZ1 flat-bottomed screw-cap tube)

10) Press “Start” to begin run.

11) Once run is complete:
   - a. Discard reagent cartridges and tips/tip holders in the biohazard
   - b. Discard the sample lysate tubes in the biohazard

   **Optional:** Sample tubes containing sample lysate may be capped for storage.
c. Close labeled microcentrifuge tubes or screw cap elution tubes containing the extract for downstream processing
d. Store the labeled extracts at 2-8°C or frozen.
e. Wipe down inside of instrument with 70% ethanol ONLY

12) Upon completion of your last run of the day perform maintenance as notated in the Daily Maintenance Section.

3.5.3 Daily Maintenance
The following maintenance protocols only require completion on the days that the instrument is in use.
1) Clean the piercing unit
   a. From the main menu on the EZ1 instrument, Press “2” to select the manual function
   b. Press “3” to select the cleaning function.
      Note: The door to the EZ1 Advanced XL must be closed in order for the cleaning run to initialize.
   c. Press “Start” to begin the cleaning operation. The instrument will then lower its piercing unit and instruct you to “open door and clean the piercing unit”.
   d. Wipe the piercing unit using a soft laboratory wipe moistened with 70% ethanol.
      Caution! The piercing unit is sharp – wearing two pairs of gloves is recommended.
   e. Once complete, press “ENT”. The piercing unit will return to its original position.
   f. Wipe the O-rings of the tip adapters with a lint-free tissue.
      Note: To maintain good contact between the tip adapters and filter-tips and to prevent liquid from leaking from the tips, the O-rings of the tip adapters should be greased monthly using a small amount of silicon grease.

2) Perform a UV run
   a. From the main menu, press “1” for UV to perform a UV decontamination of the inside of the instrument. The door to the EZ1 must be closed in order to initiate this function.
   b. Set the time for at least 20 minutes and press “ENT”
   c. Press “Start” to initiate the UV lamp
      Note: For user safety, the UV lamp cools for approximately 3 minutes. The door to the EZ1 Advanced XL instrument cannot be opened until after the cooling time has elapsed. After cooling, the main menu appears. UV runs may also be performed in between instrument runs if desired.

3) Power off the instrument.

3.6 Concentration of DNA Extracts
DNA extracts may be concentrated before or after quantitation using Microcon DNA Fast Flow Tubes and/or the Labconco CentriVap DNA Concentrator. Sample extracts must contain ≤ 100 µL of EZ1 TE or ≤ 200 µL of Teknova TE (organic extracts) in order to be concentrated using the CentriVap. Depending on the volume of TE contained in the sample, it may be necessary to concentrate a sample extract via Microcon prior to completing the concentration using the CentriVap.

3.6.1 Concentration of DNA Extracts using Microcon DNA Fast Flow Tubes
Microcon DNA Fast Flow Tubes may be used to concentrate database samples extracted in SwabSolution or evidence samples to a lower final volume of extract. Alternatively, evidence sample extracts containing ≥ 100 µL of EZ1 TE or ≥ 200 µL of Teknova TE (organic extracts) may
be first concentrated via Microcon DNA Fast Flow followed by final concentration using the CentriVap.

The suffix -MC will be used to designate when samples have been concentrated using the Microcon in the DNA workbook “makeiTWORK” (refer to Appendix B).

1) Transfer the DNA extract to a Microcon DNA Fast Flow concentrator tube. Due to volume constraints, only 500 µL can be added to the Microcon tube at one time.
2) Spin the Microcon filter in a centrifuge at 0.5G (500 rcf) for 5-30 minutes, until all or most of the liquid has spun through.
3) If the filter was spun dry, add the desired elution volume of TE.
4) Collect the concentrated DNA by inverting the upper reservoir of the filter into a clean tube and centrifuge for 3 minutes at 1.0G (1000 rcf).
5) Store the extract at 2-8°C or frozen and label accordingly.

3.6.2 Concentration of DNA Extracts using the CentriVap

Sample extracts must contain ≤ 100 µL of EZ1 TE or ≤ 200 µL of Teknova TE (organic extracts) in order to be concentrated using the CentriVap. Higher volumes of TE may cause inhibition once concentrated.

The suffix –VAP will be used to designate when samples have been concentrated using the CentriVap in the DNA workbook “makeiTWORK” (refer to Appendix B).

1) Turn on the instrument using the rocker switch on the right side.
2) Open the lid and place samples in the rotor wells with the caps open, ensuring the rotor is balanced. All caps should be placed in the same orientation for all samples. Close the lid.
3) Select from the following list of programs based on the desired run time and temperature:

<table>
<thead>
<tr>
<th>Program Number</th>
<th>Run Time and Temperature</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prog 1</td>
<td>35 minutes at 37°C</td>
</tr>
<tr>
<td>Prog 2</td>
<td>30 minutes at 56°C</td>
</tr>
<tr>
<td>Prog 3</td>
<td>10 minutes purge</td>
</tr>
<tr>
<td>Prog 4</td>
<td>60 minutes at 21°C (room temperature)</td>
</tr>
</tbody>
</table>

- Programs 1-3 may be accessed using the quick start button. Program 4 (and Programs 1-3) may be selected by using the up and down arrows to toggle to the desired program on the digital display when the CentriVap is first powered on.
- Press the “Run/Stop” button to begin or discontinue the CentriVap run.

4) The CentriVap will run for the designated amount of time, which should bring the sample to dryness.

Note: Additional time may be added to the run if the desired volume has not been reached at the end of the run. Alternatively, the time may be shortened if concentration to dryness is not desired or if dryness is achieved prior to the end of the run.

5) Press the “Run/Stop” button at any time to remove samples.

6) The CentriZap strobe light can be used during the run to monitor the amount of liquid present in the tubes. Point the gun through the glass chamber while the samples are spinning and pull the trigger. Samples will appear to be standing still.

7) Once the run has completed, immediately reconstitute the sample in the desired volume of molecular grade water by pipetting the water up and down over the pellet 5-10 times. The minimum volume for reconstitution is 15 µL if amping only or 17 µL if quanting and amping.
8) The extract may be amplified immediately or stored in the refrigerator until amplification takes place.

**Daily Maintenance**
The following maintenance protocols only require completion on the days that the CentriVap is in use.

1) Open the CentriVap lid and select Prog 3 to perform liquid purge. In 10 seconds, the pump will operate and draw air through the system. The rotor will not turn with the lid open.
2) Wipe inner surfaces with Dispatch.
3) Record completion of maintenance in “CentriVap Maintenance Log”.

**Monthly Maintenance**

1) Check all rubber hoses and gaskets and replace any that show signs of hardenting, permanent set, or deterioration.
2) If liquid present, empty and replace the trap.
3) Record completion of maintenance in “CentriVap Maintenance Log”.

### 3.7 Microcon Buffer Exchange Clean-up of Qiagen-Extracted Samples

Microcon DNA Fast Flow Tubes may be used to perform a buffer exchange of samples extracted using either the QIAmp kit or QIAGEN DNA Investigator Kit when inhibition is suspected.

The suffix -MC will be used to designate when a buffer exchange clean-up has been performed on samples using the Microcon in the DNA workbook “makeiTWORK” (refer to Appendix B).

1) Transfer the DNA extract to a Microcon DNA Fast Flow concentrator tube. Due to volume constraints, only 500 µL can be added to the Microcon tube at one time.
2) Spin the Microcon filter in a centrifuge at 0.5G (500 rcf) for 5-30 minutes, until all or most of the liquid has spun through.
3) Add a minimum of 100 µL of TE to the filter.
4) Spin the Microcon filter in a centrifuge at 0.5G (500 rcf) for 5-30 minutes, until all or most of the liquid has spun through. Repeat step 3 if necessary.
5) If the filter was spun dry, add the desired elution volume of TE. *Note: In most cases, the final elution volume should be the same or similar as the original volume of extract as this procedure is intended for buffer exchange and clean-up of potential inhibition, rather than sample concentration*
6) Collect the concentrated DNA by inverting the upper reservoir of the filter into a clean tube and centrifuge for 3 minutes at 1.0G (1000 rcf).
7) Store the extract at 2-8°C or frozen and label accordingly.
4.0 Title: Database Processing and Analysis

Background
The Databasing section is responsible for processing whole blood/bloodstain cards, buccal swab samples and FTA cards submitted from southern Nevada as a result of felony arrests, and felony and most gross misdemeanor convictions. These specimens are collected from several jails, prisons and law enforcement agencies throughout southern Nevada, funneled to the LVMPD for DNA processing, and entered into the Convicted Offender or Arrestee Index of CODIS in accordance with Nevada Revised Statutes.

4.1 Rack-Pack-Label of Databasing Samples
1) Obtain a box of samples for rack/pack/label
2) Count the samples to ensure there is 90/box.
3) Open FRED. Begin by clicking on the Evidence module > CODIS > New Lab Requests. The list will contain all samples which are ready to be accessioned in FRED. Highlight each of the desired samples and click on “Receive Evidence” on the top tool bar.

4) Fill out this evidence transfer to ensure that the samples are available for the correct processing in the correct areas. Click “Transfer” and then enter your password on the next screen. When it’s finished transferring, click “OK”. Transferring evidence will automatically trigger the transfer of the Unit Record.
5) Opening only one envelope at a time, remove the bi-fold and two barcode labels. Open the bi-fold and use a letter opener (if needed) to open the inner envelope containing the Whatman EasiCollect Device.

6) Remove the EasiCollect Device. Compare the NV barcode on the back side of the FTA card to the NV barcode on the front side of the bi-fold. The CODIS Administrator must be notified in the event these numbers do not match.

7) Open the device and place the foam applicator-end into a manila coin envelope.

8) With the foam applicator in the manila envelope, remove the FTA card from the device and place the 1st barcode label onto the card as shown below.

**IMPORTANT!** Ensure the barcode is placed squarely across the top of the FTA card and is aligned with the top and sides of the card as best as possible and does not hang off of the card. Press down on both ends of the barcode to ensure it does not peel away from the FTA card backing.

9) Depending on the type of rack being used, place the barcoded FTA card into the rack using the following orientations:
   a. For the long white rack with 40 slots, place the cards into the rack with the barcode facing upward and toward you.
b. For the short white robot racks with 12 slots, place the card upside down with the barcode facing in the direction of the black arrow.

10) While holding the foam applicator end inside the manila envelope, cut the EasiCollect device where it bends and discard the remainder of the device into the trash.

11) Close the manila envelope, tape it shut, and place the second barcode across the top flap of the envelope.

12) Place the bi-fold and manila envelope back into the outer envelope and place into a long brown cardboard box.

13) When all samples are finished, label the brown cardboard box to denote whether the samples are Arrestee or Offender and the sample range. You may also add the date and your initials.
   a. Each of the 3-8 racks that holds the batch of samples will also be numerically labeled in the order of the samples. A batch of 90 samples will consist of three long white racks or eight short white robot racks.

14) Place the brown cardboard box containing Arrestee/Offender envelopes along with their associated racks on the shelves opposite of the analyst’s lab benches in the Database Lab. The cardboard boxes go on the middle shelf and the racks go on the shelf below. The cards are typically placed in order from oldest to newest (from left to right).

15) The samples are now ready to be electronically transferred in FRED to the CODIS area:
   a. Step 1: Under Case Processing > My Work: highlight all Unit Records to be transferred back to the general hold so they may have the database analysis completed. Click “Transfer Unit Record”.
Select the following fields:
- Lab: CODIS
- Examiner: Unassigned
- Reason: Exam
- Include a note in the Comments field that rack, pack, label was completed with the date and initials. When finished, click “OK”.

These unit records can now be found under Case Processing: CODIS > CODIS-Databasing for the next examiner to choose from and assign to themselves. BE SURE to choose the CODIS section again for this transfer.

b. Step 2: Under Evidence > My Personal Custody: highlight all of the samples to be transferred out of your custody and click on “Transfer Evidence”.
Select the following fields:

- Transfer type: Returned to Lab Vault
- At Lab: CODIS
- At Section: CODIS – Databasing
- Storage Area: CODIS Section Hold
- Transfer Reason: Other
- Include a note in the Comments field that rack, pack, label was completed with the date and initials.
- Click “Transfer” > enter your password > click “OK”.

The evidence can now be found under Evidence: CODIS > CODIS – Databasing for the next examiner to choose from and assign to themselves. BE SURE you choose the CODIS section again for this transfer.
4.2 Amplification and 3130XL Set-up using Fusion 6C Workbook (dazedNconFUSION)

1) Launch the DNA workbook located on the H:drive

   **Note:** Refer to Use of DNA Workbooks Appendix introduction to set up Excel for DNA workbook use

2) Select “Amp & Inj list” tab

3) Select from drop-down menu whether creating amp worksheets, run worksheets, or combined amp and run worksheets (listed as Amp only, Run only, or Amp + Run)

4) Select sample type from drop-down menu (listed as Punch or Extracts or Swabs)

   **Note:** Depending on user selection, the worksheet (“LAB Worksheet” tab) will hide/reveal pertinent sections for processing. If opting to run multiple sample types on the same plate, select the option that represents the majority of the sample types present. Note on the worksheet which samples deviate from the chosen option.

5) Enter the date(s) on the “LAB Worksheet” tab to automatically populate all resource drop-down lists—you can then select a 3130XL instrument on the “LAB Worksheet” tab

6) Enter the run name where indicated on the “Amp & Inj list” tab (only required if creating run worksheet or combined amp and run worksheet; this name will be automatically updated to include the ID for the 3130XL chosen on the “LAB worksheet” tab)

7) Enter the amp ID where indicated (only required if creating amp worksheet or combined amp and run worksheet). Record the amp ID on the Database PCR Run# Log worksheet.

   **Note:** The “Amp well” column automatically creates amp location ID’s by appending wells with the amp ID (useful for reloads later); the amp ID will also be automatically added to APC/ANC controls.

8) Enter LADDER, APC, ANC and Custom Control on the list in the appropriate cell where you want these on the plate. The Custom Control is required on full 96-well plates containing only FTA punch samples. Record the Custom Control on the Database PCR Run# log worksheet if applicable.

9) Enter the sample names onto the list by either entering manually or using a barcode reader to scan the STaCS barcode label.

   **Note:** Samples that are being re-processed must include the following designators to their sample names (in all instances in which # is listed, substitute # with the next sequential number starting with 1). Re-amplification is designated with RA#, re-load is designated with RL# using the drop-down lists next to the sample names on the “Amp & Inj list” tab, re-injection is designated RJ# and re-isolation is designated with RI#. If a sample is processed multiple times on first amp, the ending designator will be sequential (eg. AMP1, AMP2).

   **Note:** Be sure to skip over those cells where ladder/controls were previously entered.

   **Note:** When samples are added to the list, the workbook uses “manual” setting for manual set-up and “calculator” for robotic set up to calculate the appropriate master mix amount.

10) Select “LAB worksheet” tab

   a. Use the drop-down menus to update analyst info, TC#, reagent lot numbers and pipettes on the worksheet. The analyst can type this information if not available in the drop-down menu but will be prompted to confirm these values

   b. Reload sample names should be designated using the reload drop-down menus corresponding to each reload sample.

      **Note:** Entering the amp location ID from the original amplification worksheet into the “Amp Well” will automatically transfer this information to the worksheet for cherry-picking during 3130XL set up (copy/paste special values)
11) The workbook is now ready to begin amplification processing. The analyst has the option to amplify a plate of FTA punch samples, SwabSolution samples or DNA extracts.

### 4.3 PowerPlex Fusion 6C Processing of FTA Samples, Swabs, and Extracts

The PowerPlex Fusion 6C kit allows for direct amplification of samples from FTA storage cards, swabs processed with SwabSolution and extracted DNA. Quantitation is not required of FTA sample punches or swabs incubated in SwabSolution. Extracted samples will require quantitation prior to amplification (refer to [Extraction of Known Reference Standards on the EZ1](#)).

As a quality check when amplifying full 96-well plates of FTA punches, one Custom Control should also be punched and placed on the amplification plate. There are five custom controls available with DNA known profiles. The Custom Control will ensure that plates have not been switched during processing by providing a means to identify each plate processed on the same day.

#### 4.3.1 Amplification Set-up using Extracted DNA

The maximum volume of extract that can be added to the reaction is 7.5 µL. Extracts that have been quantitated using Quantifiler® Trio may be diluted with molecular grade water to target approximately 4 ng in a total volume of 7.5 µL OR a dilution can be prepared within the plate so that DNA/H₂O totals 7.5 µL.

1) Prepare the amplification master mix according to the workbook
   - # samples X 2.5 µL Fusion 6C 5X Master Mix
   - # samples X 2.5 µL Fusion 6C 5X Primer Pair Mix

2) Pipet 5 µL of prepared mix into each well
3) Add extracts to the appropriate well
4) To the APC well add 7.5 µL H₂O and 1µL of 2800M
5) To the ANC well add 7.5 µL of H₂O
   **Note:** Water added to above wells can be water provided in amplification kit or molecular biology grade water that has been QC tested.

6) Cover wells with strip caps
7) Place plate on the thermal cycler and select “6C-24” or “6C-25” using the settings below:

<table>
<thead>
<tr>
<th>Initial incubation step</th>
<th>Cycle 24 or Cycle 25</th>
<th>Final extension</th>
<th>Final hold</th>
</tr>
</thead>
<tbody>
<tr>
<td>HOLD</td>
<td>CYCLE</td>
<td>HOLD</td>
<td>HOLD</td>
</tr>
<tr>
<td>96 °C 1 min</td>
<td>96 °C 5 seconds</td>
<td>60 °C 1 minute</td>
<td>60 °C 10 minutes</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4 °C ∞</td>
</tr>
</tbody>
</table>

8) To export the plate click **Export 3130 plate record!** and follow the prompts to save the workbook

#### 4.3.2 Amplification Set-up using Samples Processed with SwabSolution

---

Uncontrolled Copy if not located in Qualtrax  Page 59 of 298
1) Add 200 µL to 500 µL of SwabSolution to tubes containing cut swabs or foam applicators. Initiate a reagent blank. The reagent blank should be named “RBSS-<date>-<Analyst’s initials>”. In the event an analyst initiates more than one reagent blank in the same day, a sequential number should be added to the end of the initials in order to distinguish between blanks.
2) Incubate @ 70°C for at least 30 minutes. Substrates may remain in the tubes after incubation.
3) Prepare the amplification master mix according to the workbook
   # samples X 2.5 µL  Fusion 6C 5X Master Mix
   # samples X 2.5 µL  Fusion 6C 5X Primer Pair Mix
4) Pipet 5 µL of prepared master mix into each well
5) Add 2 to 7.5 µL of SwabSolution substrate to the appropriate well
6) Add water to the SwabSolution samples if necessary to achieve a final volume of 7.5 µL
7) To the APC well add 7.5 µL H₂O and 1 µL of 2800M
8) To the ANC well add 7.5 µL H₂O

4.3.3 Amplification Set-up of Punched FTA Samples
While punching a sample from the FTA paper, it is best to target the white areas as the color change indicates where the DNA is most likely to be deposited.

Option: The analyst may wish to use a 96-well freezer block to hold the plate while setting up so that reagents remain chilled while punching into the plate. Steps 1 and 4 below may be omitted when processing match confirmation samples.
1) Pipette 10 µL of PunchSolution Reagent into each well of a 96-well plate that will contain an FTA punch, APC, or ANC.
2) Punch one 1.2 mm sample from the FTA paper and eject into the appropriate well. Repeat for each sample.
3) Punch one 1.2 mm sample from the custom control into the appropriate well.
4) Incubate the plate at 70°C for 30 minutes or until the wells are completely dry. Do not cover the plate as this will prevent evaporation.
5) Prepare the amplification master mix according to the workbook
   # samples X 2.5 µL  Fusion 6C 5X Master Mix
   # samples X 2.5 µL  Fusion 6C 5X Primer Pair Mix
   # samples X 2.5 µL  5X AmpSolution™ Reagent
   # samples X 5.0 µL  Water, Amplification Grade
6) Pipet 12.5 µL of prepared master mix into each well.
7) To the APC well add 1 µL of 2800M.
   Note: the ANC well already contains master mix/H₂O
8) Visually check the plate to ensure that the 1.2 mm punches are in the liquid at the bottom of each well.
9) Cover wells with strip caps.
10) Place plate on the thermal cycler and select “6C-24” or “6C-25” using the settings below:

<table>
<thead>
<tr>
<th>Initial incubation step</th>
<th>Cycle 24 or Cycle 25</th>
<th>Final extension</th>
<th>Final hold</th>
</tr>
</thead>
<tbody>
<tr>
<td>HOLD</td>
<td>CYCLE</td>
<td>HOLD</td>
<td>HOLD</td>
</tr>
</tbody>
</table>
11) To export the plate click Export 3130 plate record! and follow the prompts to save the workbook

4.3.4 Rehydration of EasiCollect Sponge to Facilitate DNA Transfer
In the event there appears to be an insufficient amount of DNA deposited onto an FTA card due to the lack of white area being present or due to an inconclusive DNA profile being previously generated, sperm wash buffer or SwabSolution may be used to rehydrate the sponge.
1) Pipette 125 µl of sperm wash buffer or SwabSolution onto the sponge portion of the easiCollect device and allow the sponge to rehydrate for 10 minutes.
2) Press the sponge firmly onto the FTA paper for 10 seconds.
3) After 10 seconds, lock the sponge into place within the device. The paper should be allowed to dry overnight while being in contact with the sponge. The FTA card is now ready to be punched either manually.

4.4 Direct Amplification Set-up Using the Hamilton easyPunch Robot

Quality Assurance
To minimize the risk of contamination within the lab and between samples, as well as maintain the instrument, perform the following precautions:
1) Wipe down work area with 70% ethanol before starting a run.
2) Perform and document maintenance daily, when the Hamilton easyPunch is used. Maintenance is not required on the robot on days it is not in use.

To perform the daily maintenance click on the maintenance icon on the desktop screen. Once the maintenance wizard has begun, select the weekly maintenance wizard to perform the daily maintenance process required. It is not necessary to also run the daily maintenance wizard as all of those steps are included in the weekly maintenance wizard. Follow the prompts given through the maintenance process to complete instrument maintenance with these added instructions:
1) When prompted to clean the punch head, remove it from the instrument and wipe down all surfaces with a kimwipe moistened with 70% ethanol.
2) When prompted to clean the card gripper, use a kimwipe moistened with 70% ethanol to wipe the top and bottom of the gripper as well as in between the gripper arms in a very gentle flossing motion.

4.4.1 Set-up of PunchSolution Protocol using the Hamilton easyPunch Robot
1) Obtain pre-loaded magazines or add sample cards to the magazines.
   Note: Be sure to place the barcoded FTA cards in the card magazine facing to the left so that it can be read by the easyPunch imaging software. When looking at the card magazine, the “Rack #” barcode is on the right (back) side and the arrow faces forward pointing to the left.
2) Pull all carriers out so that they are resting on the instrument loading tray.
3) Ensure the instrument is turned on and proceed to open the easyPunch® Start software.
4) Choose the following settings, including the “HID_easyCollectPlus_PunchSolution.med”. Select the “Play” arrow:
5) On the following screen select ‘Start method using input dialogs with last used settings’.

6) On the following screen, enter the number of FTA cards to be processed in the ‘Number of cards’ field. Then enter the number of card magazines used in the ‘Number of magazines’ field. The next nine (9) fields should default to the correct settings and should not be altered unless they deviate from the image below. Modify the last two (2) fields to indicate ‘Positions of controls per plate’ and ‘Positions of empty wells per plate’ to be used for allelic ladders. The following screen shot is an example for one plate set-up of 90 database samples, one custom control, three allelic ladders, and a positive and negative control.
7) The following screen should default to the correct setting and should not be altered unless it deviates from the image below.

![Method Settings](image)

8) Select ‘Columnwise’ as the method setting to be used. Then click ‘Ok’ to continue.

![Columnwise Method Setting](image)

9) Follow the prompt to load the card magazines starting at the top of the leftmost rack, and load racks as you move down the carrier from position 1 to position 10 as shown in the image. For a plate set-up for one batch of 90 database samples, the 5th magazine rack will contain 10 database samples in slots 1-10 and one custom control in slot 11.

Magazines are directional and can only be loaded with the blue arrow facing to the left. Load the carrier racks onto the black loading tray of the easyPunch® and set them directly down into the tray.

If the barcode reader is unable to read the rack barcodes, a barcode error message will pop up on the screen indicating that a barcode could not be read on the rack. Click “Barcode” and enter a name for the rack. Click “Execute” and then ‘OK’ to continue.
10) Load a new 96-well PCR plate onto the plate carrier indicated as position 4 in the window. Place the PunchSolution in position 3.08 – 3.12.

11) Click ‘OK’ to continue. A barcode error message will pop up on the screen indicating that a barcode could not be read on the 96-well plate. Click “Barcode” and enter a name (PCR Run #, e.g. DB15-123) for the plate. Click “Execute”.

12) The tip carrier will be on the instrument. If tips are needed, the protocol will prompt the user to replace the tips during the run.
13) Ensure the plate transporter is empty and in the correct position, as indicated by the solid white border, on the light box. If the transporter is out of position, move it into place until you feel the magnetic stand ‘snap’ into place.

14) The easyPunch® robot will now perform the PunchSolution setup and distribute the samples into the 96-well plate.  
**Note:** Unknown errors may occur during plate processing. Follow prompts on screen if available to attempt to continue the run. If the run cannot be continued after clearing the error the remainder of the set-up may need to be finished manually.

15) Once the run has finished, visually check the plate to ensure that the 1.2 mm punches are in the liquid at the bottom of each well and that no sample card was discarded into the metal recovery trays.  
**Note:** If a sample card was discarded into the recovery tray, check the plate to verify if it was punched prior to being discarded. If a punch was not taken, the sample card will need to be manually punched into the empty well position containing PunchSolution.
16) Add a clear adhesive cover to the plate, spin down in a centrifuge, uncover, and place on 70°C heat block for at least 30 minutes until evaporated.

17) Prepare PowerPlex Fusion 6C amplification master mix according to the “Manual” drop-down under the “Amp Reaction Mix” on the “Lab Worksheet” of the workbook if hand dispensing or the “Calculator” drop-down under the “Amp Reaction Mix” on the “Lab Worksheet” of the workbook if utilizing the robot. Click on the Master Mix calculator tab to enter the number of samples.

- # samples X 2.5 µL Fusion 6C 5X Master Mix
- # samples X 2.5 µL Fusion 6C 5X Primer Pair Mix
- # samples X 2.5 µL 5X AmpSolution™ Reagent
- # samples X 5.0 µL Water, Amplification Grade

18) Manually pipette 12.5 µL of master mix to each well, custom control, amplification positive control (APC), and amplification negative control (ANC).

19) Add 1 µL of 2800M positive control to the APC well.

20) Cover wells with strip caps.

21) Place plate on the thermal cycler and choose either the 24 cycle or 25 cycle option for PowerPlex Fusion 6C (“6C-24” or “6C-25”) according to the tables below:

<table>
<thead>
<tr>
<th>Initial incubation step</th>
<th>Cycle 24 or Cycle 25</th>
<th>Final extension</th>
<th>Final hold</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Denature</td>
<td>Anneal/Extend</td>
<td></td>
</tr>
<tr>
<td>HOLD</td>
<td>96 °C</td>
<td>60 °C</td>
<td>4 °C</td>
</tr>
<tr>
<td>1 min</td>
<td>5 seconds</td>
<td>1 minute</td>
<td></td>
</tr>
<tr>
<td>CYCLE</td>
<td>96 °C</td>
<td>60 °C</td>
<td>4 °C</td>
</tr>
<tr>
<td>HOLD</td>
<td>1 minute</td>
<td>10 minutes</td>
<td>∞</td>
</tr>
</tbody>
</table>

4.5 Utilizing the dazedNconFUSION Workbook to Import Sample from Hamilton Output File

1) Open the dazedNconFUSION workbook from H:\drive and click on the “Amp & Inj List” tab
2) Select the “Import from Hamilton Robot” button.
3) Navigate to H:\Forensic Data\InstrumentArchive\Instrument Shortcuts\Rocky\Data1 and select the Hamilton output file from the dialogue box. Click “Open”.
4) The “Amp & Inj List” will populate and a window will display to remind you to save and commit the populated worksheet.
5) Select the button “Save and Commit” to save the workbook.
6) Fill in all information regarding the date, analyst, amp ID, run name, and instrument into the appropriate fields within the workbook.
7) To export the plate click Export 3130 plate record! from the “Amp & Inj list” tab and follow the prompts to save the workbook.

4.6 Sample Set-up - 3130XL Instruments

See the table below. The following items are minimally required per initial 3130XL run.

<table>
<thead>
<tr>
<th>Chemistry</th>
<th>3130XL Run Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>PowerPlex Fusion 6C</td>
<td>• Two Allelic Ladders</td>
</tr>
<tr>
<td>-Can use manually extracted DNA,</td>
<td>• Positive Control (APC) – 2800M</td>
</tr>
<tr>
<td>swabs or FTA punches</td>
<td>• Negative Control (ANC)</td>
</tr>
<tr>
<td></td>
<td>• Custom Control for full FTA punched plates only</td>
</tr>
<tr>
<td></td>
<td>• Reagent Blank (RB) for manual extracts and SwabSolution samples only</td>
</tr>
</tbody>
</table>
For an acceptable run, all controls must yield expected results. The Custom Control (FTA punch plate) is not required to yield a full profile; however, a partial profile consistent with the expected results is required. Each Custom Control will be checked in GeneMapper ID-X using the Comparison Tool to ensure that the profile is only consistent with the one staff member it originated from (refer to GeneMapper ID-X and Data Analysis section). In the event the Comparison Tool identifies multiple individuals that could match to the partial DNA profile from a Custom Control, the Technical Leader must review the Custom Control data and sign off on its use prior to releasing the associated data on the amplification plate.

All homozygous autosomal STR peaks in the amplification positive control for PowerPlex Fusion 6C must achieve the minimum designated analytical and/or stochastic thresholds required for their associated sample’s interpretation as outlined in this manual in order to be considered “passing”. For PowerPlex Fusion 6C, homozygous autosomal STR peaks must achieve a stochastic threshold of 100 RFU for 24-cycle data and 115 RFU for 25-cycle data to be considered “passing”. All typed peaks within a ladder must also reach at least 40 RFU to be included in data analysis. All Y-STR haplotypes must be detected above the 40 RFU analytical threshold to be considered “passing”.

4.7 Analysis Run - 3130XL Instruments
Follow the procedures in the Capillary Electrophoresis section of this Manual.
4.8 Data Analysis, Review and Second Reads using GeneMapper ID-X

1) Follow GeneMapper ID-X and Data Analysis section of this Manual. Samples that do not yield complete profiles for the CODIS core loci will be re-injected, re-amplified, re-isolated, or microconed along with the reagent blank using an appropriate validated extraction or direct amp method. Off-ladders will be measured against the Ladder and renamed appropriately after confirmation by re-injection, re-amplification, or re-isolation.

Note: Off-ladder alleles at the Penta E locus which fall approximately 0.5 bp short of the 11 or 12-allele do not require confirmation. These alleles may be manually assigned to the 11 or 12-bin without re-injection, re-amplification, or re-isolation.

Note: In the event an allele appears as an OMR falling between two loci or as a possible OL falling into a neighboring locus, it may be possible to determine which locus the allele belongs to using the following criteria:

- Evaluate the expected peak heights at the two neighboring loci to determine whether homozygous vs. heterozygous alleles are believed to be present. Homozygotes are expected to have approximately double the peak height as heterozygous alleles.
- Evaluate the number of peaks present at the two neighboring loci. With the exception of rare tri-alleles, no more than two peaks are typically expected to be present within a single source databasing sample.
- Calculate the number of repeat units the OMR or OL falls from the last allele (physical or virtual) at each locus to determine whether the ambiguous peak is one full repeat unit from either locus’ ladder.
  - If it does not fall within one full repeat from either ladder, calculate whether the base pairs are consistent with a true OL microvariant (.1, .2, or .3, etc.).
- In the event the allele is still ambiguous, the sample may be extracted using the EZ1 Advanced XL and amplified using Investigator 24plex QS in order to resolve the allele calls for the neighboring loci. Only the data associated with the Fusion 6C profile will be uploaded to CODIS. Alternatively, both loci may be excluded from CODIS upload.
- Documentation for the assignment of the allele call and the reasons why will be maintained in the database packet.

2) Projects in GeneMapper ID-X will be named with analyst initials-date-instrument (e.g., JB-080115-CAL).

3) CODIS will only accept allele designations, and those alleles that are below (designated as “<”) and above (designated as “>”) the Allelic Ladder range. During import into CODIS, any alleles outside of the CODIS acceptable range of alleles will be converted to a “<” or “>” of the first or last acceptable allele in the range, respectively.

4) Allele calls: The first reader will delete all spikes, pull-ups, excess stutter or artifacts. For Fusion 6C, alleles must be above the analytical threshold of 40 RFU. The stochastic threshold is 100 RFU at 24 cycles or 115 RFU at 25 cycles. Homozygous autosomal peaks must meet the stochastic threshold. Heterozygous peaks between the stochastic and analytical thresholds may be used. A 20% global filter is applied to all samples. Y-STR haplotypes must be above the analytical threshold of 40 RFU.

In the event that Amelogenin only has an “X” below the stochastic threshold, a gender verification step may be performed. The analyst can look at the documentation accompanying the offender/arrestee sample to verify the gender as a female. Further, when using Fusion 6C, the analyst may examine the three Y chromosome markers (DYS391, DYS576 and DYS570).
for other indications of a presence/absence of male DNA. The analyst should note which information they used for gender verification. If any ambiguity remains, the analyst will reprocess the sample to raise Amelogenin and/or the Y markers above the stochastic threshold.

In the event a sample appears to contain a null X-allele at Amelogenin while a Y-allele is present above analytical threshold, the other Y markers (DYS391, DYS576 and DYS570) should be examined for indications that the sample is originating from a male.

In the event of a null Y-allele (deletion) affecting Amelogenin, it would be expected that DYS576 and DYS570 will also be absent due to their proximity to Amelogenin on the Y chromosome. An allele should still be present at DYS391.

Off-ladder alleles in single source databasing samples can be confirmed through reinjection, reload, or re-amplification.

Single source databasing samples containing suspected tri-alleles can be confirmed through reinjection, reload, or re-amplification with the understanding that if an Offender/Arrestee hit occurs the sample will be re-extracted during the match confirmation process.

5) Reviews are documented using the form “Database Tech Review Form”.

6) The second reader will assess and confirm each of the allele calls. Any peaks that are not true alleles must be removed before CODIS Export file creation.

7) Repeated samples will be documented and subjected to a second read.

8) The second reader will indicate approval on the Technical Review checklist. Samples that have passed second review can be added to the CODIS Export Table function of GeneMapper ID-X which will create the CMF (Common Message Format) file format required by CODIS.

4.8 Data - CODIS Export

1) From the GeneMapper ID-X Project which is opened, change the Table Setting view in the drop-down list to CODIS Export.

2) Looking at the list of samples, under Specimen Category, change passing samples to Convicted Offender or Arrestee as appropriate. Use Fill Down to add more, careful to label the ladders and controls as No Export. Double check these designations.

3) For any samples that were re-processed, remove any added suffixes (e.g. -RL, -RI, -CF, etc) and/or tube numbers in the Sample Name column so that only the specimen ID (SN#### or ####-#####) will be exported.

4) Select File > Export Table for CODIS. Select H:\Forensic Data\DNA\1-CODIS\CMF's for Upload as the location to save to. The file name is the same as the GeneMapper ID-X Project name, e.g., “JB-080115-CAL”. Select “CMF 3.2(.xml)” from the “Export File As” drop-down menu. Leave the CODIS Laboratory IDs set to “NV0022632.” Export.

4.9 CODIS Import

1) The CODIS Administrator or alternate will complete CODIS Import and searching. Refer to Chapter 13 of this manual

2) The CODIS Administrator or alternate will verify that each sample has been second read prior to the upload to SDIS.
4.10 Incomplete Profiles
Database samples with fewer than the complete CODIS core loci cannot be uploaded to NDIS, however these samples are allowed at the LDIS and SDIS levels.

4.11 Databasing Processing Forms
1) Forms in the Data Packet are: Technical Review Checklist-Database Knowns, Extraction Form(s) (if applicable), Quant Set-up Form (if applicable), Quant Run Printouts (if applicable), Amplification Forms (if applicable), 3130XL Run Forms (if applicable), and sample electropherograms when needed to show low samples, artifacts, OL or tri-allele confirmation, etc.
2) Forms in the data packet generated outside of the LIMS that do not have an electronic signature (e.g. password-protected username printed on electropherograms) must be initialed by the analyst taking ownership of the packet.
Principle
Quantitation involves measuring the quantity and quality of the DNA extract. Prior to nuclear DNA amplification, forensic samples will be quantified to determine the amount of total human DNA and male DNA present. The Biology/DNA Detail of the LVMPD currently uses the Quantifiler® Trio (Trio) quantitation kit in conjunction with a 7500 Sequence Detection System (SDS) and HID software v1.2 for quantitation. The Trio assay utilizes the "TRIOceratops" workbook to produce laboratory worksheets, interface with instrumentation/analysis software, and summarize quantitation results. These results summaries are interpreted by the analyst to direct and document the next laboratory processing step(s) prior to amplification and serve as documentation for the case file.

Quality Assurance
Quantitation Documentation
Quantitation run names must include the date of the run and the analyst’s initials as well as the identifier “Trio”, which represents the Quantifiler® Trio chemistry used to quantitate samples (e.g. 072115-CDM-TRIO). There should also be additional unique identifiers (such as Q for question samples or K for known samples and/or additional letters or numbers added to the quantitation run name if more than one run is performed in the same day (e.g. 041312-CDM-TRIO-K, 041312-CDM-TRIO2, etc.).

The unique identifier for the quantitative PCR instrument used for each run must be documented on the associated lab-processing worksheets (e.g. Palms, Hoops, Yoyo, Aria, etc.). In the event an unaltered sample extract is requantified, the identifier “RQ” and a sequential number (e.g. RQ1, RQ2, etc.) must be placed at the end of the sample name. Samples which have been concentrated and then subsequently requantified are not required to include the “RQ” identifier.

Special Precautions
Diluted bleach (10%) or stabilized bleach solution (e.g. Dispatch) shall be used to wash all exposed work areas. At minimum, decontamination of all exposed work areas should be performed prior to the initiation of DNA quantitation and at the conclusion of the daily analysis process.

Gloves, a mask, and a lab coat must be worn during DNA quantitation. Gloves should be changed frequently when handling and manipulating different samples. Care should be taken by the analyst to continually monitor the integrity of their gloves and to ensure that transfer does not inadvertently occur between samples due to sample manipulation.

Only one reagent tube should be opened at a time. Special attention will be paid to the labeled identity and lot number of each reagent on the physical tube and not the color-coded lids. Expiration dates can be found on the proximal containers.
5.1 Quantitation Set-Up
Quantitation set-up for forensic casework samples or casework reference samples occurs in the main DNA lab or in the PCR room. Quantitation set-up for database samples may take place on the benchtop in the DNA Database lab. Questioned samples may be processed on the same optical plate as known samples during quantitation; however, the questioned samples must always be loaded into the plate prior to loading the known samples and should be physically separated by a row/column of the plate when possible.

Inclusion of Standards in Each Run
Five quantitation standards (known DNA concentration samples) are loaded in duplicate in every Quantifiler® Trio quantitation run.

Refer to the Biology/DNA Quality Manual for quality control testing of new lots of Quantifiler Trio and the quality control of the Quantifiler Trio Standard Curve QC.

5.2 Quantitation with Quantifiler® Trio
Background
The Quantifiler® Trio (Trio) DNA quantitation kit simultaneously estimates quantities of both total human DNA and human male DNA in a single, highly sensitive real-time PCR reaction. Trio also incorporates the use of a Degradation Index (DI) in order to estimate the overall quality of the DNA extracts through the use of two separate target sequences – one small autosomal (SM) target, whose amplicon is 80 basepairs in length and one large autosomal (LG) target, whose amplicon is 214 basepairs in length. This kit is used in conjunction with the AB 7500 Real-Time PCR System for Human Identification and the HID v1.2 software. The results from using this integrated quantitation system can aid in determining the following:
- If sufficient human and male DNA is present to proceed with short tandem repeat (STR) analysis.
- How much sample to use in STR analysis applications.
- The potential presence of amplification inhibitors.
- The potential presence of sample degradation.
- Based on the results of quantitation, the following values are targeted in the amplification process if possible. Analysts may choose to target more or less template as appropriate.
  - For Investigator 24plex QS, the target amount of human DNA for analysis is between 750 pg and 3.0 ng based on the quantitation value obtained from the large autosomal target.
  - In databasing, the target amount of DNA for analysis with PowerPlex Fusion 6C is between 2.5 and 5 ng based on validation studies.

QPCR Amplification
Quantitation standards are included in every quantitation run. When portions of DNA extracts are diluted prior to quantitation, the diluent used for the dilution, the lot number, and the volumes of DNA extract and diluent utilized will be recorded and maintained in the case file.
5.2.1 Preparing the Quantifiler® Trio Standard Dilution Series

**Background**

The dilution series utilizes a stock solution which is used to prepare quantitation standards comprising five samples ranging in concentration from 50 ng/µL to 0.005 ng/µL (5 pg/µL). The lowest concentration sample contains on average 1.5 diploid human genome equivalents.

**Required Materials**

- Thawed Quantifiler® Trio DNA Standard (store at 2-8°C after initial use)
- Adjustable Pipettes
- Thawed DNA dilution buffer (store at 2-8°C after initial use)
- Sterile aerosol-resistant barrier pipette tips
- Low-bind tubes

**Note:** DNA quantitation standards can be stored for up to one month at 2-8°C.

**Procedure**

1) Label five low-bind microcentrifuge tubes: Std. 1 through Std. 5. Label an additional low-bind microcentrifuge tube for the negative control.
2) Dispense the required amount of DNA dilution buffer into each standard tube and the negative control tube (at least 90 µL for the negative control).
3) Vortex the Quantifiler Trio DNA Standards for 3-5 seconds. Using a new pipette tip, add the required amount of Quantifiler Trio DNA Standard to the tube labeled Std. 1 and mix thoroughly. Centrifuge briefly.
4) Using a new pipette tip, add the appropriate amount of the prepared standard from the tube labeled Std. 1 to the tube labeled Std. 2 and mix thoroughly. Centrifuge briefly.
5) Repeat Step 4 for the tubes labeled Std. 3-5. See chart below.

<table>
<thead>
<tr>
<th>Standard</th>
<th>Concentration ng/µL</th>
<th>Standard Dilution Amount</th>
<th>Dilution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Std. 1</td>
<td>50,000</td>
<td>50 µL DNA Standard Stock + 50 µL DNA Dilution Buffer</td>
<td>2X</td>
</tr>
<tr>
<td>Std. 2</td>
<td>5,000</td>
<td>10 µL (Std. 1) + 90 µL DNA Dilution Buffer</td>
<td>10X</td>
</tr>
<tr>
<td>Std. 3</td>
<td>0.500</td>
<td>10 µL (Std. 2) + 90 µL DNA Dilution Buffer</td>
<td>10X</td>
</tr>
<tr>
<td>Std. 4</td>
<td>0.050</td>
<td>10 µL (Std. 3) + 90 µL DNA Dilution Buffer</td>
<td>10X</td>
</tr>
<tr>
<td>Std. 5</td>
<td>0.005</td>
<td>10 µL (Std. 4) + 90 µL DNA Dilution Buffer</td>
<td>10X</td>
</tr>
</tbody>
</table>

**Note:** The standard dilution amount may be increased or decreased depending on need; however, the relative proportions of DNA solution to buffer should remain the same as described above. There should be a minimal input volume of 10 µL of DNA for dilutions.

5.2.2 Preparing the PCR Reactions

**Required Materials**

- Thawed Quantifiler® Trio Primer Mix (store at 2-8°C after initial use, protected from light)
- Thawed Quantifiler Trio PCR Reaction Mix (store at 2-8°C after initial use, protected from light)
- Microcentrifuge tubes or low-bind microcentrifuge tubes
- 96-well optical plate (do not UV crosslink plate)
• Extracted DNA samples and appropriate dilutions
• DNA quantitation standard dilution series
• Optical Adhesive Cover
• Adhesive Seal Hand Sealer

**Note:** During plate set-up keep the 96-well optical plate in its base without allowing the optical plate to touch the lab bench.

**Procedure**

1) Calculate the volume of each component needed to prepare the desired number of reactions using the following equations:
   - **Quantifiler® Trio Primer Mix** - 8 µL x # of samples including standards and negative controls
   - **Quantifiler® Trio PCR Reaction Mix** - 10 µL x # of samples including standards and negative controls
   **Note:** The export worksheet will automatically include one reaction plus 10% additional overage. If using a multi-channel pipette, include 7-10 additional reaction volumes per run to ensure there is enough PCR mixture remaining in the trough for the final dispensing.

2) Vortex the thawed primer mix tube for approximately 3 seconds, and centrifuge briefly before opening the tube. Gently vortex the thawed reaction mix tube before using.

3) Pipette the required volumes into a microcentrifuge tube or low-bind microcentrifuge tube. Vortex the PCR mix for 3-5 seconds and centrifuge briefly.

4) Dispense 18 µL of the PCR mixture into each reagent well to be used being careful to prevent bubbles.

5) Add 2 µL of sample, standard, or control to the appropriate wells. All standards will be loaded in duplicate.

6) Seal the reaction plate with the Optical Adhesive Cover using the hand sealer.

7) Centrifuge the plate at 3000 rpm for about 20 seconds in a table-top centrifuge, equipped with plate holders, to remove any bubbles. If necessary, lightly tap the plate to remove bubbles in wells.

### 5.3 7500 HID v1.2 Instrument Operation

**Creating a Plate Record**

**Note:** Instructions for setting up a plate record using the TRIOceratops workbook is described in Appendix B. Instructions for setting up a plate record using a desktop computer is described in Chapter 3 of the “HID Real-Time PCR Analysis Software Version 1.2” user guide.

**Note:** A plate record can be set-up on the instrument laptop computer or a desktop computer that has the 7500 HID software loaded on it.

**5.3.1 Using the Instrument Laptop Computer to Import from the TRIOceratops Workbook**

1) Ensure the power is on for the instrument laptop computer and the 7500 SDS instrument. Launch the 7500 HID software from the laptop computer. When prompted, enter the logon ID “DNA” and click ok.

2) Select the Quantifiler® Trio icon from the home page. Alternatively, click on File>New Experiment>New Quantifiler Trio Experiment. The default settings in the Assays tab (on the
toolbar) should be default checked to Quantifiler Assay.

**Note:** The default setting in the Analysis tab (on the toolbar)>Analysis settings>C\textsubscript{T} Settings for Threshold, Baseline Start, and Baseline End should be (respectively):

- T. IPC: 0.1, 3, 15
- T. Large Autosomal: 0.2, 3, 15
- T. Small Autosomal: 0.2, 3, 15
- T.Y: 0.2, 3, 15

If everything is correct click cancel.

The default setting in the Tools tab (on the toolbar)>Preferences >Defaults for sample reaction volume should be 20 µL. If everything is correct click cancel.

3) Enter the experiment name (the same name on the TRIOceratops workbook’s plate map) in the appropriate box, click Plate Setup under the Experiment Menu section in the left hand pane.

4) To import a plate set-up which was exported directly to the instrument from TRIOceratops or that was exported to an external thumb drive, select File>Import> and then browse for your plate record and choose import.

5) To save the document, select **File>Save As**.
   a. If using the instrument laptop computer, save the file under: AB SW&DATA(D) \DNA\Lab Runs\Analyst. Name the file with a minimum of the date and analyst initials in the filename.

5.3.2 Using the Instrument Laptop Computer to Manually Set-up a QPCR plate

1) Follow Steps 1 through 3 of [Section 5.3.1]

2) Select **Define Targets and Samples Tab**

3) To assign a sample to the experiment, click Add New Sample and type in the name of the sample. Check that the correct sample type is chosen (Standard or Unknown). Negative controls assigned to the plate should have the sample type listed as Unknown.

4) Repeat Step 3 for remaining samples

5) If there will be any empty wells on the plate, assign a generic sample name to them (e.g. “sample”). This should be done in the event a sample is mis-loaded during plate set-up to ensure data is collected from that well during the run.

**Note:** If a well does not have any detectors assigned to it at this Step no quantitation data will be collected during the run.

**Note:** If a standard is accidently removed/unchecked from a well, no matter which well it is assigned to (even if the same one), the quantities (under the Assign target(s) to the selected wells section) must be re-entered for that standard.

6) Select Assign Targets and Samples tab

7) To assign a sample to the plate, highlight the well the sample needs to be added to and select the appropriate check box from the Assign sample(s) to the selected wells window. Scroll down to find the appropriate sample name you entered in Step 3. Repeat for the remaining samples.

8) To save the document, select **File>Save As**.
   a. If using the instrument laptop computer, save the file under: AB SW&DATA(D) \DNA\Lab Runs\Analyst. Name the file with a minimum of the date and analyst initials in the filename. The file can then be copied onto a removable thumb drive to transfer onto the desktop computer.
5.3.3 Using a Desktop Computer to Manually Set-up a QPCR plate

1) When manually setting up a plate using a **desktop computer**, launch the HID software from the virtual desktop portal, choose the appropriate log-on user and click **OK**. Click **Continue without Connection** when an Instrument Connection error window pops up.

2) Select the Quantifiler Trio icon from the home page. Alternatively, click on File>New Experiment>New Quantifiler Trio Experiment.

3) Repeat Step 3 from Section 5.3.1, and Steps 1 through 7 from Section 5.3.2

4) Highlight the entire plate under View Plate Layout tab.

5) Choose Export (on the toolbar). Under the Export Properties tab check the Sample Setup box **only**. Under the Customize Export tab check the All Sample Setup Fields box.

6) Choose the location the exported file will be saved, the name for the export file, and change the file type to *.txt (Export Properties tab). Click Start Export when complete.

7) Open the newly exported .txt file using Excel. Highlight row 7 and delete. Save as to a removable thumb drive.

8) Repeat Step 2 from Section 5.3.1 on the instrument computer using the logon "DNA"

9) Select file>Import>Browse and choose the file that corresponds to the plate map that is to be run. Click Start Import then option yes if you are ready to import. Click ok once the message box appears stating the plate setup import was successful.

10) Repeat Step 3 from Section 5.3.1 and ensure the plate map that was imported is correct. Then repeat Step 5 from Section 5.3.1 once the plate is ready to run.

5.4 Running a Plate on the 7500 Instrument

1) Push the tray door to open it and load the plate into the plate holder. Ensure the plate is properly aligned in the holder.

2) Close the tray door. Apply pressure to the right side of the tray door at an angle.

3) In the HID software, open the experiment that you set up for the run if not already open.

4) Select the Run or Setup tab in the left hand pane>Run Method

5) Verify thermal profile for Quantifiler Trio (should all be default setup based on selecting Quantifiler Trio icon from the homepage)

   - Stage 1: Reps: 1  95.0 for 2:00
   - Stage 2: Reps: 40 95.0 for 0:09  60.0 for 0:30

6) Click **Start Run**. The run time is approximately one hour.
### 5.5 Data Analysis in HID v1.2

#### 5.5.1 Saving the Analyzed Plate Document

It is important that the analyzed plate document be saved prior to turning off the instrument. Transfer the saved run file to a removable thumb drive if performing data analysis on a desktop computer.

**Note:** Analysis can be performed on a desktop computer once the run has been saved. To use a desktop computer, open the HID software, choose the appropriate logon and click ok. Choose Continue without Connection when the instrument connection error message appears. Choose File>Open and select the file you wish to analyze (.eds file).

1. Select **Analysis Settings** (on the toolbar) to open the Analysis Settings dialog box.
2. Verify that the settings are as described in section 5.3.1
3. Highlight all cells that are to be omitted from the analyzed plate. Right click>omit>well.
4. Select **Analyze** or click the green icon at the top of the screen.
5. To save the document, select **File>Save As**. Save the document to the instrument computer: AB SW&DATA(D) \DNA\Lab Runs\Analyst. Click Yes to overwrite when a message window pops up.

#### 5.5.2 Analyzing the Plate Document

Viewing analysis results can involve one or more of the following:

**Viewing the Standard Curve**

1. In the Analysis tab in the left hand pane, select **Standard Curve**.
2. Highlight only the wells containing the standard curve.
3. In the Target drop-down list, select the Target that you wish to view. Each target can be chosen separate of the others or all three can be shown at the same time. Use the up/down arrows (below the standard curve plot) to scroll through the standard curve data when all three are selected at the same time.
4. View the Cₚ values for the quantitation standard reactions and the calculated regression line, slope, Y-intercept, and R² values for each of the three targets.
5. To omit a standard – highlight the well, right click>omit>choose an option (well, T. large autosomal, T. small autosomal, or T.Y) depending on whether the entire standard needs to be deleted from all curves or just one. Click “analyze” in order to re-analyze the standard curve with the omitted value.

   **Note:** Only one (1) well/standard value may be rejected as an outlier in each individual target standard curve (T. large autosomal, T. small autosomal, T.Y) in order for the standard curve to be deemed passing.

6. To re-include a standard which was previously omitted – highlight the well, right click>include>choose an option (well, T. large autosomal, T. small autosomal, or T.Y) depending on whether the entire standard needs to be re-included for all curves or just one. Click “analyze” in order to re-analyze the standard curve with the included value.

**Viewing the Amplification Plot**

The amplification plot can display one of the following:

1. Plot of change in normalized reporter signal (ΔRₚ) versus cycle number for each reaction.
2. Plot of normalized reporter signal (Rₚ) versus cycle number for each reaction.
3) $C_T$ versus well position on the assay plate.
   a. In the Analysis tab in the left hand pane, select Amplification Plot. Choose the Plot Type, Graph Type, and Plot Color.
   b. Select the appropriate sample(s) in the View Plate Layout tab.

**Viewing the Results**
1) In the analyzed plate document, select the View Well Table tab.
2) For analyst preference for ease of viewing results on the instrument: click the Show in Table tab and choose which items to be shown or not shown in the table. Click the Group By tab and choose a view.

5.5.3 Printing and Exporting the Results

**Print Standard Curve (two options)**

*Option 1*
1) In the View Plate Layout tab within the Analysis tab (left hand pane), select the wells that need to be printed, to include standards, negative controls, and/or samples.
   
   **Note:** Only the standard curves must be printed from the HID software for the case file. The printing of the negative controls and/or samples is optional.
2) Select Print Report in the top toolbar.
3) Select only Standard Curves (and Results table (By Well) if you would also like to print the sample results). Click Print Report. This .pdf will provide a print out of all standard curves (as well as data for each sample selected).
   
   **Note:** Only selected wells will be included in the Print Report. Any wells that have been selected which do not contain any detectors cannot be printed using this function and an error box will appear.

**Note:** The standard curves for only the T. large autosomal, T. small autosomal, and T.Y targets must be included in the case file for casework. At minimum, the T. large autosomal standard curve must be included in the case file for databasing. The HID software also prints a blank standard curve for the IPC, however this may be discarded.

*Option 2*
1) In the View Plate Layout within the Analysis tab (left hand pane), select only the wells containing the standard curve
2) Click on the icon in the top of the window that has four colored squares and four lines
3) Click on the icon with a pen and four lines to input the name of the plate to show on the standard curve page
4) Click on the print icon to print your standard curve. You can also choose Print to Cute PDF Write to save the file as a .pdf on your H:drive. This setting will allow all three standard curves needed for the file and the plate name to appear on one page for the case file.

Export Results
1) In the View Plate Layout tab within the Analysis tab (left hand pane), highlight the entire plate.
2) To export, select export in the top toolbar and check the box for Results, within the Export Properties tab.
3) Modify the Export file name as needed (should be the quantitation plate name).
4) Choose the location for which the file is to be exported to. **This must be done every time a file is to be exported.**
5) File type should be .xls
6) Select The Customize Export tab and select the following boxes *in this order*: Well, Sample Name, Target Name, Quantity, C_T, Degradation Index and Task. Confirm the orientation matches the screen shot below. All samples should be in well order (by row).

7) Return to the Export Properties tab and click Start Export once all fields have been appropriately filled out.

5.6 Interpretation of Quantifiler® Trio Results

About the Standard Curve Results
The standard curve is a graph of the C_T of quantitation standard reactions plotted against the starting quantity of the standards. The software calculates the regression line by calculating the best fit with the quantification standard data points. The regression line formula has the form: C_T = m [log (Qty)] + b

Where m is the slope, b is the Y-intercept, and Qty is the starting DNA quantity. The values
associated with the regression analysis can be interpreted as follows:

R^2\text{ value} - Measure of the closeness of fit between the standard curve regression line and the individual C_T data points of quantitation standard reactions. A value of 1.00 indicates a perfect fit between the regression line and the data points.

**Regression coefficients:**
Slope - Indicates the PCR amplification efficiency for the assay. A slope of -3.3 indicates 100% amplification efficiency.

The acceptable range is the following for each target:

<table>
<thead>
<tr>
<th>Target</th>
<th>Small Autosomal</th>
<th>Large Autosomal</th>
<th>Y-Target</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range</td>
<td>-3.0 to -3.6</td>
<td>-3.1 to -3.7</td>
<td>-3.0 to -3.6</td>
</tr>
</tbody>
</table>

If the standard curve in any of these targets has a value outside the acceptable range, use caution when interpreting results. However, it is not necessary to repeat the quantitation procedure. The analyst will circle the slope value to indicate they noticed the value was out of target range.

Y-intercept: Indicates the expected C_T value for a sample with Qty = 1 (for example, 1 ng/µL).

**Note:** The Y-intercept for the large autosomal target is typically lower than the Y-intercept for the small autosomal target or the Y target. This is due to the higher copy number of the large autosomal target relative to the copy number of the small autosomal and Y targets. The Y-intercept value is evaluated during the quality control testing and monitored as each new standard curve is created to ensure it is not drifting over time. Refer to the quality control criteria in “Quantitative PCR Kit” in the Biology/DNA Quality Manual for additional information.

**R^2 Value**
An R^2 value ≥ 0.99 indicates a close fit between the standard curve regression line and the individual C_T data points of quantitation standard reactions.

If the R^2 value is ≤ 0.98 check the following:
1) Quantity values entered for the quantitation standards in the plate document setup.
2) Making of serial dilutions of quantitation standards.
3) Loading of reactions for quantitation standards.
4) Failure of reactions containing quantitation standards.

**Note:** It is permissible to delete one “outlier” from the standard curve and re-analyze the data. Should the R^2 value still not be ≥ 0.98, the quantitation results must be discarded and the quantitation procedure for all samples on the affected plate must be repeated.

For additional information on potential problems encountered in interpreting the standard curve see the “Quantifiler HP and Trio DNA Quantification Kits User Guide” under “Troubleshooting the Standard Curve”, Chapter 5.

**Using the Internal PCR Control System**
Acceptable IPC C_T values for each sample should be between 25.0 and 30.0. Quantitation values
with elevated IPC values may indicate that inhibition is present in the sample. Such a sample may need to be diluted and re-quantified. Use the Internal PCR Control (IPC) system to distinguish between true negative sample results and reactions affected by:

- The presence of PCR inhibitors
- Assay setup
- A chemistry or instrument failure

Select the Analysis tab (left hand pane) and then Amplification Plot tab of the HID software. Select Plot Type: $\Delta R_n$ vs Cycle, Graph Type: Log, and Plot Color: Target to observe amplification of the VIC dye (Human Target, small autosomal), ABY dye (Human Target, large autosomal), and FAM (Human Male Target), and the JUN dye (IPC detector). Guidelines for the interpretation of the results are as follows:

<table>
<thead>
<tr>
<th>Quantifiler Trio (VIC, ABY, and/or FAM)</th>
<th>IPC (JUN)</th>
<th>Interpretation</th>
</tr>
</thead>
<tbody>
<tr>
<td>No amplification</td>
<td>Amplification</td>
<td>True negative</td>
</tr>
<tr>
<td>No amplification</td>
<td>No amplification</td>
<td>Invalid result</td>
</tr>
<tr>
<td>Amplification, Quantity &gt;5 ng/µL</td>
<td>Amplification appears reduced relative to the average IPC $C_T$ value for standards</td>
<td>High sample concentration may contribute to suppression of IPC amplification. This may occur independently or in combination with PCR inhibitors yielding inconclusive IPC results</td>
</tr>
<tr>
<td>Suppressed Amplification (high $C_T$ and low $\Delta R_n$)</td>
<td>No amplification</td>
<td>Possible Inhibitor present</td>
</tr>
</tbody>
</table>

**Note:** Positive amplification is when the $C_T$ value for the target is <40. Because samples contain unknown amounts of DNA and inhibitors, a large range of $C_T$ values is possible. Because the IPC system template DNA is added to the reaction at a fixed concentration, the IPC $C_T$ should be relatively constant across all the DNA standards.

**Evaluation of the IPC:**

1) **Determining the Normal Range for IPC**

To determine the normal range of $C_T$ values for the IPC, view the JUN dye signal for the quantitation standards under the Analysis tab (left hand pane) in the View Well Table Tab. If the assays were set up properly and the buffer used to dilute the quantitation standards was free of PCR inhibitors, the reactions should show normal IPC amplification across the range of input DNA.

2) **True Negative Result**

VIC (small autosomal), ABY (large autosomal), and/or FAM (male) dye signal not detected in conjunction with a normal IPC signal.

3) **Invalid IPC Results:** JUN dye (IPC target) amplification does not occur ($C_T$ JUN should be consistent with that of the DNA standards)

If the human-specific target, male-specific target, and the IPC target fail to amplify, it is not possible to distinguish between the absence of DNA and inhibition. The sample quantitation must be repeated. This failure to amplify can be observed in the Analysis tab (left hand pane) under the View Well Plate tab or the Amplification Plot tab.
4) **Disregarding IPC Results**  
With high concentrations of human genomic DNA (>5 ng/µL), competition between the human and/or male-specific and IPC PCR reactions may suppress IPC amplification for that sample. In these cases, samples may be diluted and re-quantified in order to confirm a lack of inhibition.

5) **Partial PCR Inhibition**  
Weak amplification (high \(C_T\) and low \(\Delta R_n\) value) of the human and/or male-specific targets and no amplification of the IPC may indicate partial or complete PCR inhibition.  
**Note:** For additional information on potential problems when evaluating IPC amplification refer to the Chapter 5 of the “Quantifiler HP and Trio DNA Quantification Kits User Guide” under “Troubleshoot amplification plots”

---

**Inhibition**  
If the IPC amplification for certain samples appear reduced relative to IPC amplification for quantitation standards, the decreased IPC amplification may be interpreted as partial PCR inhibition. If the IPC \(C_T\) for a sample is greater than 0.5 cycle from the average IPC \(C_T\) values for Standards 2-5 and the negative controls, this may indicate PCR inhibition. The IPC results can help you decide the next step(s):

- Samples that demonstrate inhibition after quantitation (elevated IPC \(C_T\) or Undetected IPC \(C_T\) using Real Time PCR quantitation) can be subjected to Qiagen “clean-up”, as described in the Qiagen Extraction (QIAmp Isolation) procedure.
- If a sample needs to undergo Qiagen clean-up, the associated reagent blank(s) must undergo Qiagen cleaned-up as well. Any sample treated with a Qiagen “clean-up” procedure must be re-quantified to ensure that inhibition was removed from the extract and a more accurate quantitation value was obtained.
- Or, samples can be diluted prior to amplification to attempt to dilute any inhibitors in the sample. Inhibitors may also be removed via microcon washes.
- Or, the analyst may choose to amplify the sample first and then assess if further action is needed.

**Degradation**  
Refers to the data observed when a sample displays a decrease in measured amount for large DNA fragments compared to small DNA fragments. The Degradation Index (DI) is used as a general indicator of whether large DNA fragments may perform poorly relative to small DNA fragments in STR reactions. The DI is calculated by dividing the small autosomal target DNA concentration (ng/µL) by the large autosomal target DNA concentration (ng/µL).

- DI can be affected by both degraded and inhibited DNA.
- QIAGEN Investigator 24plex QS samples that demonstrate a DI greater than 1.5 can be considered to be degraded and may not fully amplify with STR amplification. STR amplification may need to be based on the small autosomal target instead of the large autosomal target depending on both the amount of DNA present in the sample and the degree of degradation.
- Samples which are degraded can be subjected to concentration in order to maximize the template/µL available for amplification. Refer to **Concentration of DNA Extracts**.

**Determining the Quality Index of a Sample**

- If the IPC \(C_T\) is not flagged as possibly inhibited and the DI < 1.5 then there is no indication of degradation or inhibition present in the sample
- If the IPC \(C_T\) is not flagged as possibly inhibited and the DI is > 1.5 then there is an indication
of slight to moderate degradation present in the sample. While inhibition is possible, it is not likely.

- If the IPC C\text{F} is not flagged as possibly inhibited and the DI is > 3.5 then there is an indication of significant degradation present in the sample. While inhibition is possible, it is not likely.
- If the IPC C\text{F} is flagged as possibly inhibited and the DI >1.5 or blank then there is an indication of degradation and/or inhibitors present in the sample.

Evaluating the Reagent Blanks

- Check the reagent blank values. If the small autosomal target yields a quant result > 0.0005 ng, the quantitation may be repeated if sufficient volume is available. A quantitation value should not be obtained for the large autosomal target in the absence of a quantitation value for the small autosomal target for true DNA contamination and therefore instances in which this occurs may be ignored.
  
  **Note:** All reagent blanks are amplified at target max regardless of quantitation value if the associated sample extracts will be amplified. It is therefore not necessary to troubleshoot the quantitation value ahead of amplification. In the event the associated sample extracts will not be amplified, it is necessary to either repeat the quantitation or amplify the reagent blank at target max in order to troubleshoot.

- In the event the re-quantitation still exhibits values >0.0005 ng in the small autosomal target, the reagent blank will be amplified at target max in an effort to determine the source of the possible contamination.
- If the resultant DNA profile is clean, the analyst must place a note on the electropherogram or on the original quantitation forms documenting that the reagent blank is clean despite having a quant value >0.0005 ng.
- If a Reagent Blank exhibits an elevated IPC result of > 1 cycle from the AVG IPC target, then the quantitation results are considered to be invalid, possibly due to the presence of inhibition. The Reagent Blank must be diluted and re-quantitated in order to assess the presence of inhibition. If the re-quantitation results confirm the lack of inhibition, both the dilution and the neat Reagent Blank must be amplified at maximum template input.
  
  **Note:** If the Reagent Blank is associated with any samples requiring Qiagen clean-up, then the Reagent Blank does not require dilution and re-quantitation.

- If a Reagent Blank exhibits an undetermined IPC result and an evaluation of the raw data shows that the JUN dye did not amplify, then the quantitation results are considered to be invalid, possibly due to the presence of inhibition. The Reagent Blank must be diluted and re-quantitated in order to assess the presence of inhibition. If the re-quantitation results confirm the lack of inhibition, both the dilution and the neat Reagent Blank must be amplified at maximum template input.
  
  **Note:** If the Reagent Blank is associated with any samples requiring Qiagen clean-up, then the Reagent Blank does not require dilution and re-quantitation.

Dropping Low or No Quant Samples Prior to Amplification

- Samples which are low template can be subjected to concentration in order to maximize the template/µl available for amplification. Refer to Concentration of DNA Extracts.
- Samples which have been concentrated/eluted in a final volume of 32 µL or below and obtain duplicate quantitation values of ≤ 0.0005 ng (one order of magnitude below the lowest point on the Quantifiler® Trio standard curve) may be terminated and not moved forward with
In the event samples were not concentrated/eluted in a final volume of 32 µL or less prior to the first quantitation event, the samples must be concentrated to a final volume of at most 32 µL and then re-quantified in duplicate to confirm that a loading error did not take place during the quantitation set-up.
6.0 Title: PCR Amplification

Principle
The amplification process involved in Short Tandem Repeat (STR) analysis makes millions of copies of specific areas on the non-coding region of the DNA strand where small portions of the DNA are repeated multiple times, one right after another. Amplification is a necessary step in DNA analysis to generate enough DNA so that it may be later visualized. In order for a DNA profile to be submitted to the National DNA Index System (NDIS) of CODIS there must be at least 13 core areas identified for convicted offenders and felony arrestees and at least 8 core loci for forensic samples. The amplification run itself does not produce resultant data, but rather is used to prepare for the electrophoresis step which allows the visualization of the DNA profile.

Quality Assurance

PCR Set-up Lab (Pre-Amp PCR Lab)
This lab is used for amplification procedures. All casework STR amplification work is conducted under the hoods. Quantitation procedures may also be conducted in this lab. A variety of equipment and supplies are used including but not limited to:
- Adjustable pipettes
- Sterile aerosol resistant barrier pipette tips
- Microcentrifuge tube and plate racks
- Disposable gloves, latex and nitrile
- Microcentrifuge tubes
- Microcentrifuge(s)
- Vortex mixer(s)
- Lab coat (white pre-amp)
- Refrigerator(s)
- 96-well plates
- Optical caps
- Reservoirs

Special Precautions for Pre-Amp PCR Lab
1) Hoods may be exposed to UV light for 30 minutes before PCR set-up and must be exposed for 30 minutes after PCR set-up.
2) Consumables may be UV cross-linked as described in Biology/DNA Quality Manual.
3) Change pipette tips after each sample or control.
4) Only one reagent tube should be opened at a time. Special attention will be paid to the labeled identity, lot number, and expiration date of each reagent on the physical tube and not the color-coded lids.
5) Diluted bleach (10%) or stabilized bleach solution (e.g. Dispatch) shall be used to decontaminate all work areas. At minimum, decontamination of all exposed work areas should
be performed prior to the initiation of DNA amplification and at the conclusion of the daily analysis process.

6) Gloves, a mask, and a lab coat must be worn during DNA amplification. Gloves should be changed frequently when handling and manipulating different samples. Care should be taken by the analyst to continually monitor the integrity of their gloves and to ensure that transfer does not inadvertently occur between samples due to sample manipulation.

7) Remove white lab coat before entering amplified DNA work area. Do not re-enter the pre-amp work areas.

**Investigator 24plex QS:** Store tubes of positive control (control DNA 9948), primers, and master mix in the refrigerator in the casework pre-amp lab when in use. Store tubes not yet in use in the freezer in the casework main lab.

**Amplified DNA Work Area (Post-Amp PCR Lab)**
This work area is a physically separate room used only for those activities that involve the handling of amplified DNA. This includes DNA quantitation, DNA amplification, electrophoresis of amplified DNA, waste disposal of amplified DNA solutions and storage of amplified DNA. A variety of equipment and supplies are used including but not limited to:

- Thermal Cyclers (9700s)
- Adjustable pipettes
- Latex/nitrile disposable gloves
- Microcentrifuge tube racks
- Sterile, aerosol-resistant barrier pipette tips
- Genetic Analyzer/CE and supplies
- Refrigerator and freezers
- Lab coat (blue or disposable post-amp)
- Real-time PCR Quantitation systems
- Plate centrifuge

**Special Precautions for Post-Amp PCR Lab**
1) Always remove gloves when leaving the Amplified DNA Work Area to avoid the transfer of amplified DNA into other work areas.
2) Wear only blue or disposable post-amp lab coat while working in amplified DNA work area.
3) Reduce the unnecessary dispersal of DNA around the work area by changing and/or bleaching gloves as needed, particularly if they may have become contaminated with amplified DNA.
4) 10% Diluted bleach or a stabilized bleach solution (e.g. Dispatch) shall be used to wash the exposed work areas.
5) Use the thermal cycler only for amplification.
6) Store tubes and/or trays of amplified DNA in this work area.
7) Store all amplified DNA and associated waste in biohazard bags before removing from the Amplified DNA Work Area through the main hallway.
8) To prevent introduction of amplified DNA into pre-amplification work areas, use one-way passage through the post-amplification work area. Remove coat and gloves. Wash hands. Exit only into the main hallway. Entry into the capillary electrophoresis lab from the main hallway is permissible.

**Investigator 24plex QS:** Freeze tubes of ladder in their foil pouches for long term storage in the casework post-amp lab. Remove the tube of ladder from its foil pouch and refrigerate until consumed
in the casework post-amp lab. Store tubes of BTO size standard in casework post-amp lab freezer.

6.1 **Amplification of Reagent Blanks**
Reagent blanks are amplified at the maximum concentration conditions (i.e. 15 µL for Investigator 24plex) with their associated samples. Reagent blanks are amplified at all loci using the same primers as their associated samples and concurrently in the same instrument. Reagent blanks shall be amplified in the same extraction tube number order as their associated samples and in the same batch on the same amplification plate.

It is not necessary to re-amplify the reagent blank when an associated sample is re-amplified provided the following criteria are met:
- The reagent blank produced acceptable results during the first amplification.
- The sample is re-amplified with the same amplification test kit.
- The sample is re-amplified using the same concentration or less as that of the original reagent blank.
- The amplification parameters have not been altered to increase sensitivity.

The new amplification must include an amplification positive and negative control.

**Depletion of Reagent Blanks**
If a reagent blank has been depleted or cannot be located, the associated samples cannot be re-amplified with a different amplification test kit unless the samples and their associated reagent blank(s) were originally extracted and typed prior to July 1, 2009. While it is not advisable to amplify and type samples using a different technology and/or methodology without an appropriate reagent blank, the Biology/DNA detail recognizes the LVMPD has DNA extracts remaining from older cases where the evidence has been destroyed or all biological material was consumed during the initial extraction process. The pros and cons of such an approach will be discussed with the DNA Technical Leader, the DNA Lab Manager, and the Forensic Lab Director. Approval to proceed will be a last-resort effort to resolve a case. Such approval will be documented by the DNA Technical Leader in the case file prior to amplification.

6.2 **Amplification of Known Reference Standards**
Known reference samples may be amplified in the same batch as questioned forensic samples. Questioned forensic samples must be loaded onto the amplification tray prior to the addition of reference standards.

6.3 **Amplification of Positive and Negative Controls**
A positive and a negative control shall be amplified with each batch. The positive and negative controls shall be amplified concurrently with their associated samples at all loci using the same primers and instrument. The negative control shall be the last reaction added to the plate, regardless of well location.

6.4 **Work Product Defined**
PCR product is defined as work product, and is stored frozen in the post-PCR laboratory. It may be discarded upon case completion.
6.5 Amplification Run and Sample Naming

Run Names
Assign a run number to each batch from the PCR run log spreadsheet. Run numbers begin with the current year followed by a dash and a sequential batch number, e.g. 18-009. Name the amplification positive control (APC) and amplification negative control (ANC) with this number, e.g. APC 18-009 and ANC 18-009.

Multiple Amplifications and Re-Amplifications
If a sample is amplified multiple times on a plate during the first amplification attempt, the end of the sample will be designated with “AMP” and a sequential number (e.g. Item 1.1.1-AMP1, Item 1.1.1-AMP2). These designations will be retained throughout the duration of processing.

If samples are re-amplified, the end of the sample will be designated with “RA” and a sequential number to indicate “Re-Amplification” (e.g. Item 1.1.1-RA1 or Item 1.1.1-RA2). These designations will be retained throughout the duration of processing. The reason for re-amplification will be included in the case file.

6.6 Amplification Set-up using Qiagen Investigator 24plex QS
The Qiagen Investigator 24plex QS Amplification Kit is a short tandem repeat (STR) multiplex assay that co-amplifies 22 polymorphic STR markers and the Amelogenin gender-determining marker in a single PCR amplification. All twenty of the required CODIS core loci are included in this kit. The loci amplified in this kit are: D1S1656, D2S441, D2S1338, D3S1358, D5S818, D7S820, D8S179, D10S1248, D12S391, D13S317, D16S539, D18S51, D19S433, D21S11, D22S1045, CSF1PO, FGA, TH01, TPOX, vWA, SE33, DYS391, and Amelogenin. The kit also contains an internal PCR control (Quality Sensor QS1 and QS2) which provides helpful information about the efficiency of the PCR reaction and the possible presence of PCR inhibitors.

Based upon validation studies for Quantifiler® Trio, the ideal range is 750 pg to 3 ng based on the large autosomal target quantitation value. The Investigator 24plex QS amplification kit accepts up to 15 µL of extract within the amplification reaction. DNA samples may be normalized in molecular grade water or TE-4 to target the desired amount of total DNA input based on the quantitation value obtained. Analysts may target more or less DNA template as case circumstances dictate.

You may calculate dilutions according to \( V_1 \times C_1 = V_2 \times C_2 \) where \( C_1 \) is the concentration obtained from quantitation and \( C_2 \) is the desired target concentration (total target DNA divided by 10). Select the smallest volume for \( V_1 \) that will give at least 10 µL for \( V_2 \). Typically, \( V_1 \) is 10 µL for casework. Subtract \( V_1 \) from \( V_2 \) to calculate the volume of molecular grade water or TE-4 to add to the \( V_1 \) volume of extract.

Note: The Investigator 24plex amplification kit allows up to 15 µL of extract or normalized extract to be added to the amplification reaction. Therefore 5 µL of molecular grade water or TE-4 must be added to all amplification reactions where the normalizations are made to 10 µL.
Alternatively, you may make your dilution directly in the reaction well. Select 15 µL for V2 and solve for V1. Subtract V1 from V2 to calculate the volume of molecular grade water or TE-4 to add to the well along with the V1 volume of extract.

If your extract is below the target range you may concentrate it via CentriVap by estimating a concentration factor. Sample extracts must contain ≤ 100 µL of EZ1 TE or ≤ 200 µL of Teknova TE (organic extracts) in order to be concentrated using the CentriVap. Depending on the volume of TE contained in the sample extract, it may be necessary to concentrate a sample extract via Microcon prior to completing the concentration using the CentriVap. Proceed with caution when attempting to concentrate your extract if you have less than 25 µL. Note that the associated reagent blank must be similarly concentrated. Up to 15 µL of concentrated extract may be added to the Investigator 24plex amplification reaction as “Target MAX”.

6.6.1 Amplification Plate Set-up

1) UV- irradiate a 96-well plate, if desired. Label it with the Amp Run Number, the date and your initials.
2) Use the table below to calculate the volume of each component needed to prepare the reaction mix.

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume per reaction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fast Reaction Mix 2.0</td>
<td>7.5 µL</td>
</tr>
<tr>
<td>Primer Mix</td>
<td>2.5 µL</td>
</tr>
<tr>
<td>Nuclease-free water</td>
<td>Variable</td>
</tr>
<tr>
<td>Template DNA</td>
<td>Variable</td>
</tr>
<tr>
<td>Total volume</td>
<td>25 µL</td>
</tr>
</tbody>
</table>

*Note: Include additional reactions in your calculations to provide excess volume for the loss that occurs during reagent transfers. The AMP and Run Workbook will automatically do this for you. The information from the workbook assumes that a repeat pipettor is used for the distribution of reaction mix. Add 7-10 volumes of additional master mix if using a multi-channel pipette. Discard excess, unused reaction mix.*

3) If frozen, thaw the Investigator 24plex QS Kit Fast Reaction Mix and the Investigator 24plex QS Primer Mix completely, then vortex 3-5 seconds and centrifuge briefly before opening the tubes. 

*Note: Thawing is required only during first use of the kit. After first use, reagents are stored at 2 to 8 °C and, therefore, do not require subsequent thawing. Do not refreeze the reagents.*

4) Pipette the required volumes of components into a microcentrifuge tube.
5) Vortex the reaction mix for approximately 5 seconds, then centrifuge briefly.
6) Dispense 10 µL of the master mix into each reaction well of a 96-well plate that will contain sample, reagent blank, or control.
7) Pipette 10 or 15 µL of normalized sample, concentrated sample, or reagent blank into the corresponding row/column of the 96 well plate. If normalizing directly in the well or if normalizations were performed to 10 µL of input, add sample plus molecular grade water or TE-4 for a total of 15 µL. The final reaction volume (sample, reagent blank, or control plus reaction mix) must be 25 µL.
8) Add 10 µL of control DNA 9948 (approximately 1 ng) to the Amplification Positive Control (APC) well. Add molecular grade water or TE-4 to bring the sample to a total volume of 15 µL.
9) Pipette 15 µL of molecular grade water or TE-4 into the Amplification Negative Control (ANC) well. The ANC shall always be loaded as the last reaction on the plate.

10) Place a strip cap over each column that contains sample and reaction mix. Firmly press down on each cap to ensure the cap is properly seated on the well and there is a tight seal between the cap and the well.

11) When finished in PCR Set-Up, bleach the area and UV irradiate the hood for 30 minutes. Remove white lab coat before entering the post-amp lab.

12) Vortex and briefly centrifuge the plate. Check the wells for consistent volumes.

**Important!** The amplification tray must be vortexed prior to placing it on the thermal cycler. Failure to vortex may be detrimental to the RFU values across the plate due to the heavy salt content associated with the Investigator 24plex QS amplification kit.

13) Turn on the thermal cycler.

14) Select the 28-cycle Investigator 24plex program on the Applied Biosystems 9700 thermal cycler. This kit is validated to perform 28 cycles according to the table below.

```
<table>
<thead>
<tr>
<th>Temperature</th>
<th>Time (s)</th>
<th>Number of cycles</th>
</tr>
</thead>
<tbody>
<tr>
<td>95°C</td>
<td>20</td>
<td>20</td>
</tr>
<tr>
<td>60°C</td>
<td>30</td>
<td>20</td>
</tr>
<tr>
<td>60°C</td>
<td>30</td>
<td>20</td>
</tr>
<tr>
<td>72°C</td>
<td>15</td>
<td>30</td>
</tr>
<tr>
<td>4°C</td>
<td>30</td>
<td>20</td>
</tr>
</tbody>
</table>
```

*Hot-start to activate DNA polymerase.

15) After the amplification is complete, remove the tray from the thermal cycler and store protected from light. The amplified products can be stored in the CE lab refrigerator for short periods of time. For longer periods, the tray should be frozen. Care should be taken when using amplicons that have been frozen for more than 6 weeks since original amplification. Depending on the quality of the resultant data, it may be necessary to reamplify the samples.
7.0 Title: Capillary Electrophoresis

Principle

DNA Electrophoresis is the process which allows for the visualization of the DNA profile by utilizing the amplification product that was generated during the PCR reaction. Allelic ladders, which are a collection of common DNA alleles, are added to the electrophoresis run to be used as standards to identify the unknown alleles contained in the samples. The electrophoresis process separates the DNA by size, which in turn is compared to the ladders to determine the size of the alleles.

The raw data produced through PCR is analyzed using an AB PRISM 3130XL genetic analyzer and GeneMapper ID-X software to produce an electropherogram; which is a graphical representation of the DNA alleles. The run folder and project files produced using GeneMapper ID-X are stored on the instrument or in the analyst folders on the H:drive.

Injection parameters for each 3130XL instrument can be found on each of the 3130XL instruments and in the appropriate validation or performance check notebook. After capillary electrophoresis, injection parameters for each sample can be found in the “Info” tab of the GMID-X project file. The changes in the instrument injection parameters are tracked in a spreadsheet on the H:drive: H:\Forensic Data\DNA\OTHER\Technical Leader\Injection Parameters.

Quality Assurance

Special Precautions

Diluted bleach (10%) or stabilized bleach solution (e.g. Dispatch) shall be used to wash all exposed work areas. At a minimum, decontamination of all exposed work areas should be performed prior to the set-up of DNA electrophoresis plates and at the conclusion of the daily analysis process.

Only one reagent tube should be opened at a time. Special attention will be paid to the labeled identity, lot number, and expiration date of each reagent on the physical tube and not the color-coded lids.

Gloves must be worn during the set-up of DNA electrophoresis plates and should be changed frequently when handling and manipulating different samples. Care should be taken by the analyst to continually monitor the integrity of their gloves and to ensure that transfer does not inadvertently occur between samples during sample manipulation.

7.1 Capillary Electrophoresis Sample and Plate Naming/Information

Genetic analyzer runs must contain the following information: Initials of the examiner, the date the plate is set-up and the abbreviation of the instrument’s name being used (e.g. LMK-081017-HOB).

There should also be additional unique identifiers (such as Q for question samples or K for known samples and/or additional letters or numbers added to the run name if more than one run is performed in the same day (e.g. 041312-CDM-RIO-K, 041312-CDM-Q, etc.).
Re-Injection of a Plate
In the event a previously created plate will be re-injected, the plate name will be designated with RJ and a sequential number will be used (e.g LMK-012917-RJ1-HOB or LMK-012017-RJ2-RIO) to indicate that a “Re-injection” is occurring from the previously loaded/typed plate.

Re-Injection of a Sample
If samples are being re-injected, the end of the sample will be designated with RJ to indicate “Re-injection” and a sequential number (e.g. Item 1.1.1-RJ1 or Item 1.1.1-RJ2). These designations will be retained throughout the duration of processing.

Re-Load of a Sample
If samples are being re-loaded (re-load refers to the creation of a new set of samples from the same amplicon product previously loaded), the end of the sample will be designated with RL to indicate “Re-Load” and a sequential number (e.g. Item 1.1.1-RL1 or Item 1.1.1-RL2). These designations will be retained throughout the duration of processing. The reason the sample is re-loaded will be noted in the case file.

When multiple lab numbers are contained in a run, the lab number must be designated on the associated lab worksheets and the electropherogram for each sample.

Typing of Reagent Blanks
Reagent blanks are typed concurrently on the same instrument and are injected at the same injection conditions as their associated samples. Reagent blanks are also typed at the most sensitive volume conditions as their associated samples from extraction.

Note: Assuming the injection/sensitivity requirements are met, the reagent blanks do not have to be re-typed when their associated samples are re-loaded or re-injected.

Internal Size Markers and Allelic Ladders
Internal size standards are included with every sample. At least two ladders must be loaded per plate.

Note: Investigator 24plex data may be collected “by plate” or “by injection”. When selecting the data to be collected “by injection”, at least one ladder must be included within each injection.

7.2 Daily or Weekly Instrument Maintenance for the 3130XL Genetic Analyzer
All maintenance tasks are to be recorded in the individual log book specific to the instrument each time the maintenance is performed on an instrument. Refer to Appendix C.3 for maintenance instructions.

7.3 Saving Electronic Files
The GeneMapper ID-X files created during analysis of a particular run will be saved by electronic media and are located in the CE run folders and case-specific or batch folders created by the analyst. These electronic media folders will be maintained and stored on the H:drive which are backed up by the Information Technology Bureau (ITB). In addition, CE run folders on the instruments are automatically copied to an Instrument Archive folder on the H:drive. Data stored in this folder cannot be modified or deleted because it is write-protected by ITB. However, data contained in this folder may be copied into a different location on the H:drive for data analysis by members of the Biology/DNA Detail.
7.4 Using the Genetic Analyzer

7.4.1 Preparing Plate

1) Use the appropriate DNA workbook to create a 3130XL Setup worksheet and to export a 3130XL input .txt file. The workbooks will automatically calculate the necessary reagent quantities for setting up the plate and automatically export the correct 3130XL parameters for electrophoresis.

   **Note:** Investigator 24plex data may be collected "by plate" or "by run". When selecting the data to be collected "by run", at least one ladder must be included within each injection.

2) Thaw formamide at room temperature and thaw amplicon plate (if frozen); vortex and then centrifuge amplicon plate briefly to pool all liquid to the bottom of the wells.

3) In a clean microcentrifuge tube, add formamide and size standard according to the 3130XL setup worksheet, and then distribute this master mix into the appropriate wells of the 3130XL setup plate according to the setup worksheet.

4) Transfer the amplicons and the allelic ladders into the 3130XL setup plate as noted on the worksheet.

   - **Investigator 24plex QS master mix formula:** 12 µL Hi-Di formamide and 0.5 µL BTO 550 per sample; pipette 12 µL of master mix into each appropriate well
   - 1 µL of Ladder and 1 µL of sample.
   - **Fusion 6C master mix formula:** 9 µL of Hi-Di formamide and 0.5 µL WEN ILS 500 per sample; pipette 10 µL of master mix into each appropriate well
   - 1 µL of Ladder and 1 µL of sample.

5) Cover the plate with a septa and centrifuge the 3130XL plate briefly to pool all liquid to the bottom of the wells.

6) Denature the 3130XL plate for 3 minutes at approximately 95°C and then chill for 3 minutes using a frozen plate chiller.

   **Note:** For Fusion 6C: denature 3130XL setup plate for 5 minutes at approximately 95°C and then chill at least 3 minutes using a frozen plate chiller.

7) Assembling the "3130 plate sandwich"

   a. Place the plate in the black base, matching the notched corner orientation.
   b. Place the white retainer on top of assembly.
   c. Line up the retainer holes with the septa holes while pushing downward until the retainer locks into place.
7.4.2 Preparing Instrument
Change water/1X running buffer if needed; check polymer supply and replenish if needed; check for bubbles and remove if needed (refer to Equipment and Instrument Maintenance Appendix).

**OPTIONAL:** Pre-heat the oven to 60°C
1) Click “Manual Control” in the left navigation pane; select “Oven” from the upper drop down list.
2) Select “Set oven temperature” in the lower drop-down list then enter the value “60” and click the “Send Command” button.
3) Select “Turn On/Off oven” in the lower drop-down list, select the value “On” and click the “Send Command” button.

7.4.3 Importing the Plate Record and Mounting Plate
1) On the left-side navigation pane of the instrument window, under the folder tree, find and click on “Plate Manager”. Click on “Import” on the bottom of the window. Find the .txt file created by the 3130xl workbook and open it (Import-Shortcut).

**Note:** If using a USB: Insert USB drive and unlock its contents; click “Plate Manager” in the left navigation pane then click the “Import” button and choose the exported .txt file created by the 3130XL workbook.

2) Searching for the pending plate record
   a. Select “Plate View” under “Run Scheduler” from the left-side navigation.
   b. Select “Advanced” from the drop-down menu and then select “=” for Status/Condition and “pending” for Status/Value 1.
   c. Click the “Search” button to display the current list of pending plate records.

3) Press the instrument’s “Tray” button and wait for the autosampler to finish moving forward.
4) Load the assembled “plate sandwich” onto the autosampler deck (position A or position B).
5) Orient the “plate sandwich” notch away from you to match the deck (shown in orange in the diagram) and then lower into place.

7.4.4 Link Plate and Verify/Record Injections

1) Click the plate image of the corresponding deck position of the loaded plate first, then click its associated pending plate record. This may also be completed in reverse.

**Note:** The plate graphic will turn to green from yellow to indicate successful linkage; be sure to link the correct deck position if more than one plate is loaded onto the deck.

2) Select “Run View” from the left navigation pane; all currently linked runs and their corresponding instrument injection protocols and current status will be listed.

**Note:** Clicking each run in the list will display the corresponding wells/plate ID/deck position; the instrument’s automatically assigned run number is displayed at the end of the “runID” in the run list.

3) Verify that each pending run is linked to the correct plate/deck position and includes the correct wells by selecting the run from the list and observing the changing plate map graphic.
4) Record the associated run number(s) on the 3130XL Plate Setup worksheet and the run log spreadsheet.

7.4.5 Starting Instrument/Retrieving Completed Data

1) Select "Instrument Status" from the left navigation pane; click the "play" button near the top of the window after it changes to green.
   - The instrument will ask you to verify that you wish to begin processing. Click "ok".
   - The instrument's green status light will begin flashing until the run(s) are completed.
   - If the instrument generates an error, the yellow or red status lights may illuminate/flash and/or a red flashing icon may appear in the data collection software window (refer to Re-booting the instrument/software/computer in Appendix C).

2) After each run is completed, the raw data is extracted into .fsa files that can be analyzed using GeneMapper software.

3) To retrieve the files from the instrument: Open the desktop shortcut to the instrument’s data; data collected by injection will be grouped inside subfolders according to run # within the parent plate folder.
GeneMapper ID-X analysis software is used to analyze the raw data collected by the 3130XL Genetic Analyzer. A size curve is created using co-injected labeled DNA fragments of known size and the unknown peaks are assigned a size by interpolation. The sizes are compared to a ladder to assign allele designations.

Separate GeneMapper ID-X projects will be created during the course of case analysis when performing STRmix analysis. The injection lists for each of the projects will be printed for the case file. Each project will be edited to remove artifacts:

1) Project containing evidence samples and reference standards which are analyzed using the internally validated locus-specific stutter filters to aid in the determination of the number of contributors for both the analyst and the technical reviewer.

   Note: In the event a profile is determined to be unsuitable for STRmix analysis, the electropherogram will be printed for the case file.

   Note: Reference standards may be analyzed in the same project as the evidence samples using the locus-specific stutter filters, however must be exported for STRmix as detailed below.

2) Project containing only evidence samples which are eligible for STRmix interpretation. These electropherograms will be printed for the case file

8.1 Creating Projects in GeneMapper ID-X
Refer to Appendix A for GeneMapper ID-X settings.

1) Once the run is completed, transfer a copy of the run folder from the instrument to the appropriate location on the H:drive.

2) Launch the GeneMapper ID-X software using the user-specific user name and password (should be the same as CODIS user name)

   Note: GeneMapper ID-X requires access granted through a server. A user account will be set up by a member of the Biology/DNA Detail with administrative access to the appropriate Security Groups depending upon their detail assignment.

3) A blank project window should appear. If not, select File | New Project. Then select Edit | Add Samples to Project.

4) Separate GeneMapper ID-X projects will be created for evidence samples and reference standards if requiring different analysis parameters. Navigate to the run folder(s) for the data to be analyzed. Highlight the individual evidence or reference files and select Add to List. A ladder must be included in each run folder that is added to the project. Select Clear to remove unwanted files from the project. Select Add.

   Note: Once data has been generated by the 3130XL, do not manually modify, delete, or rename .fsa files electronically. Any changes required can be done manually by crossing out
and initialing the appropriate forms and electropherograms or electronically under the sample name column in the GMID-X software.

5) Click on the first cell in each of the following columns and select the appropriate setting for analysis according to the table below: **Analysis Method, Panel, Size Standard**

6) Highlight the column(s) and select **Edit → Fill Down** to apply the setting(s) to all samples in the table.

**Note:** If you used the DNA workbooks for amplification and 3130XL set-up, the following settings and sample type are automatically populated for you when the data is imported into the project.

<table>
<thead>
<tr>
<th>GeneMapper ID-X v1.6 Manual Interpretation and Reference Standards</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Settings</strong></td>
</tr>
<tr>
<td><strong>Table Setting</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Analysis Method</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Panel</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Size Standard</strong></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

The following settings will be used when utilizing STRmix for interpretation:

<table>
<thead>
<tr>
<th>Profile Detail</th>
<th>Analysis Method</th>
<th>Panel</th>
<th>Table Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Evidence</td>
<td>STRmix_INV24PLEX50_181130</td>
<td>STRmix_INV24PLEX_181130_panel</td>
<td>STRmix - EVIDENCE</td>
</tr>
<tr>
<td>Reference</td>
<td>INV24PLEX50_181130</td>
<td>INV24PLEX_181130_panel</td>
<td>STRmix - REFERENCES</td>
</tr>
<tr>
<td>Evidence</td>
<td>STRmix_IDPLUS40</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reference</td>
<td>HOB_3130_IDX_PLUS40</td>
<td>Identifiler_Plus_Panels_v1X</td>
<td>STRmix - REFERENCES</td>
</tr>
<tr>
<td></td>
<td>LUX_3130_IDX_PLUS40</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>RIO_3130_IDX_PLUS40</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

7) In the **Sample Type** column, each sample defaults to sample. For samples that are actually controls or ladders, click on each and select the sample type from the drop down menu.
a. Allelic Ladder: **Allelic Ladder** (must be selected for the ladders that will be used in genotyping)
b. Reagent blanks & ANC: **Negative control**
c. APC: **Positive control**
d. Sample: **Sample**

8) Click the **Green Arrow Analyze Button** on the tool bar. The **Save Project** dialog box opens. Name and save the project in the appropriate Security Group in the drop down menu.

At minimum, GeneMapper ID-X projects will use the following standardized naming convention, as applicable:

a. **Evidence (and References) with locus-specific stutter filtered:** Analyst’s initials–date–name of instrument or Analyst’s initials-Lab Case # (if combining multiple instrument runs into a single project)

   **Note:** If creating a single GeneMapper ID-X project which contains data from multiple instrument runs using the naming convention of Analyst’s initials-Lab Case #, the injection list must be printed using a table setting that captures the name of the original instrument run.

b. **Evidence for STRmix:** Analyst’s initials-date-name of instrument-STRmix or Analyst’s initials-Lab Case #-STRmix

In the event the original 3130XL run was set-up by a different analyst than the analyst performing the GeneMapper ID-X analysis due to multiple analysts sharing a single typing plate, a note must be included on the GeneMapper ID-X summary sheet that the project name has been changed to the initials of the analyst performing the analysis.

In the event any modifications are made to the naming convention such as changing the initials associated with the instrument run due to a different analyst analyzing the data than the individual who performed the instrument run, the specific naming convention used will be documented in the case file.

The project will be saved in one of the following Security Groups: Casework, Databasing, Practice, Validation, or GeneMapper ID-X.

**Note:** The **GeneMapper ID-X Security Group** is the default security group used when projects need to be accessible to multiple analysts with varied access.

9) An **Analysis Summary** tab will open with Process Quality Value (PQV) summaries of the allelic ladders, controls and samples. Clicking on the hyperlinked numbers in each sample type summary will filter relevant PQV flagged samples. To undo the filter, select the project name in the project navigation pane on the left side of the screen display.

10) Inspect the **SOS** (sample off-scale) and **SQ** (sizing quality) columns on the table. A green square indicates that the sample has passed sizing criteria. A yellow triangle indicates questionable data. A red octagon indicates poor quality data. Samples with these yellow or red flags need to be carefully examined. To examine a sample, ladder, or control, highlight the row and then click on the **Display Plots** icon on the button bar.
11) In the **Plot Setting** drop down menu, select the desired plot setting. If the electropherogram plot displays “No room for labels”, reduce the number of panes displayed or select only one color to view. To view the labels for the ladder, rescale the electropherogram by placing the cursor outside the X or Y axis and moving it until a magnifying glass appears. Drag it to obtain the desired scale. Alternatively, view the allele calls in table format by selecting the **Genotypes** tab.

**Note:** Analysts have the option to adjust settings depending upon personal preferences for analyzing data. If this is the case, the examiner needs to create their own plot settings template so the shared settings do not change.

12) Verify that correct allele calls have been made for **allelic ladders** and **controls** and that all peaks in the **ILS have sized properly**. Poor quality ladders will automatically be removed from analysis by the GeneMapper ID-X software. A poor quality ladder can be omitted manually as well by renaming it as a sample and then re-analyzing all samples in the project. All typed peaks within a ladder must reach at least 40 RFU for Fusion 6C to be included in data analysis. For Investigator 24plex, all typed peaks within the ladder must reach at least 50 RFU.

13) Delete and/or rename labels as needed (e.g. spike, pull-up or confirmed off-ladder alleles) by selecting the peak and right-clicking on the label.
   - To delete artifacts: Select **Delete Allele**.
   - To rename artifacts: right-click the peak and select **Rename Allele Label** and add the appropriate designation or select from the drop down list.
      a. When performing **STRmix data analysis of Investigator 24plex QS evidence**, remove all non-allelic peaks, with the exception of the single repeat unit reverse and forward stutter. These peaks must be remain labeled for export to STRmix.
      b. When performing **STRmix data analysis of Identifiler Plus evidence**, remove all non-allelic peaks, with the exception of the single repeat unit reverse stutter. These peaks must be remain labeled for export to STRmix.
      c. During the analysis of **reference standards**, remove all non-allelic peaks, to include all forward and reverse stutter peaks.
      d. **Important:** All peaks being interpreted in STRmix must be labeled using completely numerical values. Off-ladder microvariant peaks must be re-named as needed, including the kit-specific stutter peaks noted above.

14) Prior to printing, to allow room for the case number and page numbers using the paginator, verify that the bottom right margin is 0.5 inches. In the **Samples Plot** window, select:
   a. File>Page Setup>
   b. Click Page Setup
   c. Check that bottom print margin is 0.5.
   **Note:** This will need to be done once while in “Plot View” (for printing electropherograms) and once while in main project window (for printing injection lists) when setting up GeneMapper ID-X parameters for the first time for each client computer/user.

15) The electropherogram should be rescaled to ensure all loci are visible before printing. It is not necessary to print any controls for Investigator 24plex QS (ladder, APC, ANC, or Reagent Blanks).
Note: Raw data for samples that have failed to size should also be printed and included in the case file.

16) The **INV24PLEX print (rfu & bp) or Fusion 6C print with BP** plot setting can be selected from the drop down menu to print samples showing only the called alleles (deleted artifacts are not shown). This plot setting is the preferred setting for printing sample electropherograms for the case file.

**Note:** It is not necessary to include the orange channel with the BTO size standard when printing Investigator 24plex QS DNA profiles.

17) The **Fusion 6C Ladder for OL or INV24PLEX print (rfu & bp)** plot settings can be selected to print Ladder(s), when required. The **INV24PLEX print NEG** plot setting can be selected to print reagent blank and ANC samples, when required. These are the preferred plot settings for printing ladders and negative controls respectively.

**Note:** It is not required to print ladders unless an off-ladder allele is present in the GeneMapper ID-X project. The ladder utilized to size the sample containing the off-ladder allele should be printed. It is permissible to zoom in and print only the locus of interest on the ladder.

18) Print the electropherogram by clicking on **File>Print**.

19) After an entire project has been through technical review it should be removed from the shared project list by exporting to the analyst’s folder on the H:drive.

In the main project window, select:
- Tools>GeneMapper ID-X Manager
- Highlight project(s) to be exported and select Export
- Navigate to folder on H:drive and select Save
- After project(s) is saved, select Delete

20) Projects that were originally analyzed using GeneMapper ID v.3.2 software can be reviewed using GeneMapper ID-X v 1.6 software, but no allele changes can be made. Projects will need to be imported as follows:
- In the main project window, select Tools>GeneMapper ID-X Manager
- On Projects tab, click Import
- Navigate to project and select project .ser file. Click Import.
- Close GeneMapper ID-X Manager
- File>Open Project
- On Projects Tab, select project and click OK
- The first time a sample is selected for plot display a message will appear reminding the user that the project samples were analyzed using v. 3.X software and allele editing options are disabled. Click OK and proceed with reviewing data.
8.2 Data Analysis

8.2.1 Review of Size Standards

DNA Size Standard 550 (BTO) in Investigator 24plex QS
This pre-made, fluorescent tagged standard contains well-characterized fragments of dye-labeled plasmid DNA that are co-injected with the sample to estimate, by interpolation, the sizes of the STR alleles. The sizes of the DNA fragments contained in the size standard mixture in basepairs are: 60, 80, 90, 100, 120, 140, 160, 180, 200, 220, 240, 250, 260, 280, 300, 320, 340, 360, 380, 400, 425, 450, 475 and 500.

The BTO size standard is sufficient to continue with analysis when all defined DNA fragments are present and have sized appropriately, regardless of whether additional pull-up peaks are also present.

Size Standard (WEN ILS 500) in Fusion 6C
This pre-made, fluorescent tagged standard contains well-characterized fragments of dye-labeled plasmid DNA that are co-injected with the sample to estimate, by interpolation, the sizes of the STR alleles. The sizes of the DNA fragments contained in the size standard mixture in basepairs are: 60, 65, 80, 100, 120, 140, 160, 180, 200, 225, 250, 275, 300, 325, 350, 375, 400, 425, 450, 475 and 500.

The WEN ILS 500 size standard is sufficient to continue with analysis when all DNA fragments are present and have sized appropriately, regardless of whether additional pull-up peaks are also present.

8.2.2 Review of Allelic Ladder

The allelic ladder provided with the kits is used to determine the genotypes of samples by comparison with the nominal allelic types contained in the pre-made ladder mixture. While the ladder mixture supplied with the kit include the most common alleles, additional alleles do exist and may be detected and noted by the software in “virtual” bins.

In GeneMapper ID-X software, the common alleles are visualized in gray-shaded bins while additional alleles are visualized in pink-shaded “virtual” bins. The allelic ladder(s) in a project must be checked to ensure that the alleles are properly designated. GeneMapper ID-X aids in the performance of this check by verifying that the specific alleles designated within the panel and bins files are represented within the detected allelic ladder. All typed peaks within a ladder must reach at least 40 RFU for Fusion 6C to be included in data analysis. For Investigator 24plex QS, all typed peaks within a ladder must reach 50 RFU.
**Investigator 24plex QS Allelic Ladder:** Includes modifications to virtual and physical alleles at the D1S1656 locus.

<table>
<thead>
<tr>
<th>Locus</th>
<th>Dye label</th>
<th>Repeat numbers of allelic ladder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amelogenin</td>
<td>6-FAM</td>
<td>X, Y</td>
</tr>
<tr>
<td>TH01</td>
<td>6-FAM</td>
<td>4, 5, 6, 7, 8, 9, 9.3, 10, 10.3, 11, 13, 13.3</td>
</tr>
<tr>
<td>D3S1358</td>
<td>6-FAM</td>
<td>9, 10, 11, 12, 13, 14, 15, 16, 17, 18, 19, 20, 21</td>
</tr>
<tr>
<td>vWA</td>
<td>6-FAM</td>
<td>11, 12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24</td>
</tr>
<tr>
<td>TPOX</td>
<td>BTG</td>
<td>4, 5, 6, 7, 8, 9, 10, 11, 12, 13, 14, 15</td>
</tr>
<tr>
<td>DYS391</td>
<td>BTG</td>
<td>7, 8, 9, 10, 11, 12, 13</td>
</tr>
<tr>
<td>D1S1656</td>
<td>BTG</td>
<td>10, 11, 12, 13, 14, 14.3, 15, 15.3, 16, 16.3, 17, 17.3, 18, 18.3, 19.3</td>
</tr>
<tr>
<td>D1S391</td>
<td>BTG</td>
<td>14, 15, 16, 17, 17.3, 18, 18.3, 19.3</td>
</tr>
<tr>
<td>SE33</td>
<td>BTG</td>
<td>3, 4.2, 6.3, 8, 9, 10, 11, 12, 13, 13.2, 14, 14.2, 15, 15.2, 16, 16.2, 17, 17.2, 18.2</td>
</tr>
<tr>
<td>D10S1248</td>
<td>BTY</td>
<td>8, 9, 10, 11, 12, 13, 14, 15, 16, 17, 18, 19</td>
</tr>
<tr>
<td>D22S1045</td>
<td>BTY</td>
<td>8, 9, 10, 11, 12, 13, 14, 15, 16, 17, 18, 19</td>
</tr>
<tr>
<td>D19S433</td>
<td>BTY</td>
<td>6.2, 8.9, 10, 11, 12, 12.2, 13, 13.2, 14, 14.2, 15, 15.2, 16, 16.2, 17, 17.2, 18.2</td>
</tr>
<tr>
<td>D8S1179</td>
<td>BTY</td>
<td>7.8, 9, 10, 11, 12, 13, 14, 15, 16, 17, 18, 19</td>
</tr>
<tr>
<td>D2S1338</td>
<td>BTY</td>
<td>12, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26, 27, 28</td>
</tr>
<tr>
<td>D25441</td>
<td>BTR2</td>
<td>8.9, 10, 11, 12, 13, 14, 15, 16, 17</td>
</tr>
<tr>
<td>Q51</td>
<td>BTP</td>
<td>Q, 5</td>
</tr>
<tr>
<td>D165539</td>
<td>BTP</td>
<td>5.8, 9, 10, 11, 12, 13, 14, 15</td>
</tr>
<tr>
<td>CSF1RO</td>
<td>BTP</td>
<td>5.6, 7, 8, 9, 10, 11, 12, 13, 14, 15, 16</td>
</tr>
<tr>
<td>D3S1271</td>
<td>BTP</td>
<td>5.6, 7, 8, 9, 10, 11, 12, 13, 14, 15, 16</td>
</tr>
<tr>
<td>D5S818</td>
<td>BTP</td>
<td>6.7, 8, 9, 10, 11, 12, 13, 14, 15, 16, 17, 18</td>
</tr>
<tr>
<td>D7S820</td>
<td>BTP</td>
<td>5, 6, 7, 8, 9, 10, 11, 12, 13, 14, 15, 16</td>
</tr>
</tbody>
</table>
Fusion 6C Allelic Ladder: Includes custom additions of virtual bins at the D12S391 (15.1 and 16.1), D1S1656 (16.1), Penta E (15.4 and 18.4), and SE33 (17.3, 18.3, and 27.3) loci.

<table>
<thead>
<tr>
<th>STR Locus (dye color)</th>
<th>Ladder Allele</th>
<th>Size Range (bp)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amelogenin</td>
<td>X, Y</td>
<td>80-89</td>
</tr>
<tr>
<td>D3S1356</td>
<td>9 to 20</td>
<td>90 to 151</td>
</tr>
<tr>
<td>D1S1656</td>
<td>9 to 14, 15, 16, 17, 18, 19, 20</td>
<td>152 to 209.5</td>
</tr>
<tr>
<td>D2S441</td>
<td>8,9,10,11,12,13 to 17</td>
<td>211 to 252</td>
</tr>
<tr>
<td>D10S1248</td>
<td>8 to 19</td>
<td>254 to 302.5</td>
</tr>
<tr>
<td>D13S317</td>
<td>5 to 17</td>
<td>304.5 to 357.5</td>
</tr>
<tr>
<td>Penta E</td>
<td>5 to 15, 16, 17, 18, 19, 20 to 25</td>
<td>362 to 482</td>
</tr>
<tr>
<td>D16S539</td>
<td>4 to 16</td>
<td>74 to 129.4</td>
</tr>
<tr>
<td>D18S51</td>
<td>7 to 10, 12, 14 to 13, 13 to 27</td>
<td>131 to 217.5</td>
</tr>
<tr>
<td>D25S1338</td>
<td>10,12,14 to 26</td>
<td>221.5 to 304.5</td>
</tr>
<tr>
<td>CSF1PO</td>
<td>5 to 16</td>
<td>313 to 366.5</td>
</tr>
<tr>
<td>Penta D</td>
<td>2.2, 3.2, 5 to 17</td>
<td>373.5 to 470</td>
</tr>
<tr>
<td>TH01</td>
<td>3 to 9, 9, 10 to 11, 12.3</td>
<td>65 to 118</td>
</tr>
<tr>
<td>vWA</td>
<td>10 to 24</td>
<td>121 to 192</td>
</tr>
<tr>
<td>D21S11</td>
<td>24, 24, 25, 25, 26-28, 29, 29.2, 30,</td>
<td>197 to 266.5</td>
</tr>
<tr>
<td>D7S820</td>
<td>5 to 16</td>
<td>268 to 315.5</td>
</tr>
<tr>
<td>D5S818</td>
<td>6 to 18</td>
<td>317.5 to 380.5</td>
</tr>
<tr>
<td>TPOX</td>
<td>4 to 16</td>
<td>390 to 448</td>
</tr>
<tr>
<td>D8S1179</td>
<td>7 to 19</td>
<td>66 to 129.8</td>
</tr>
<tr>
<td>D12S391</td>
<td>14 to 15, 16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26, 27,</td>
<td>130.1 to 190.5</td>
</tr>
<tr>
<td></td>
<td>28, 29, 30, 21, 22, 23, 24, 25, 26, 27, 28, 29, 30, 31, 32, 33, 34, 35, 36, 37, 39</td>
<td></td>
</tr>
<tr>
<td>D19S433</td>
<td>5,2,6,8 to 12,12,2,13</td>
<td>192 to 255</td>
</tr>
<tr>
<td></td>
<td>13,2,14,14,15,15,2,16,2,17,2,18,2,19,2 to 27</td>
<td>130.1 to 190.5</td>
</tr>
<tr>
<td>SE33</td>
<td>4.2,6,3,8 to 17,17,3,18,18,19,20,21,21,22,23,24,25,26,27,28,29,30,31,32,33,34,35,36,37,39</td>
<td>270 to 429</td>
</tr>
<tr>
<td>D22S1045</td>
<td>7 to 20</td>
<td>430 to 478</td>
</tr>
<tr>
<td>DYS391</td>
<td>5 to 16</td>
<td>79.5 to 131</td>
</tr>
<tr>
<td>FGA</td>
<td>4.2,10,10,12,12,13,14,22,22,23,23,24,25,26,27,28,29,30,31,32,33,34,35,36,37,38,39</td>
<td>134 to 299</td>
</tr>
<tr>
<td>DYS576</td>
<td>11 to 23</td>
<td>302 to 370</td>
</tr>
<tr>
<td>DYS570</td>
<td>10 to 25</td>
<td>380 to 464</td>
</tr>
</tbody>
</table>

8.2.3 Positive Amplification Controls
DNA 9948 and 2800M are controls that serve to evaluate the performance of the amplification and typing procedure.

The DNA 9948 positive control exhibits the following typing results for Investigator 24plex QS:
For DNA 9948 associated with the Investigator 24plex QS kit, the sum total RFU per locus is expected to be approximately 750 to 2000 RFU based on the 1 ng of total template input. If the positive control DNA does not exhibit the single source STR typing results listed above, or the peak heights are not appropriate for the amount of template input for DNA 9948, the following steps must be taken:

1) If there appears to be an injection or electrophoretic problem, re-inject the control (unless attributable to an artifact).

2) If the profile appears low or does not contain a primer peak in the raw data or is missing the Q and S quality sensors in Investigator 24plex QS, re-load the control to ensure an error did not occur during set-up.

3) If the positive control has peaks below the stochastic threshold, but a second positive control sample has the expected peak heights (to include reference standards with a reasonable expectation to yield single source data consistent with peak heights of the target input), this may indicate inaccurate pipetting occurred during sample set-up. The interpretation of the associated samples may be made with caution based on a case-by-case assessment.

4) If the problems are not resolved, all samples set-up and amplified with this control will be considered inconclusive. DNA samples and reagent blanks co-amplified with a failed control should be re-amplified. If the control yields accurate typing results when re-amplified, then the re-amplified sample profiles associated with the passing positive control will be considered acceptable for comparison purposes and statistical calculations.

In the event samples are not available for additional processing due to concentration prior to the initial amplification and consumption during the original sampling, the case file must be annotated with a documented written acknowledgement of a qualitative review of the data. This review will include documentation of the following:

- The amplification positive control yielded all correct allele calls, despite having lower-than-expected overall RFU values.
- The Q and S quality sensors are present in each of the samples and their associated reagent blanks.
- Documented recognition that the associated evidentiary data may also be lower-than-expected.
- Acknowledgement that the data from this first amplification will be reported due to not having the option to re-amplify nor re-isolate the samples.

For all other situations where re-amplification and/or re-extraction is an option, the samples will be re-processed in order to generate amplification positive control data within the expected RFU range.
The 2800M positive control exhibits the following typing results for Fusion 6C:

<table>
<thead>
<tr>
<th>Control</th>
<th>Amelogenin</th>
<th>D3S1358</th>
<th>D1S1656</th>
<th>D2S441</th>
<th>D10S1248</th>
<th>D13S317</th>
<th>Pent E</th>
<th>D16S539</th>
<th>D18S51</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th></th>
<th>D2S1338</th>
<th>CSF1PO</th>
<th>Penta D</th>
<th>TH01</th>
<th>vWA</th>
<th>D21S11</th>
<th>D7S820</th>
<th>D5S818</th>
<th>TPOX</th>
<th>D8S1179</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>22,25</td>
<td>12</td>
<td>12.13</td>
<td>6.93</td>
<td>16.19</td>
<td>29.31</td>
<td>8.11</td>
<td>12</td>
<td>11</td>
<td>14.15</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>D12S391</th>
<th>D19S433</th>
<th>SE33</th>
<th>D22S1045</th>
<th>DYS391</th>
<th>FGA</th>
<th>DYS576</th>
<th>DYS570</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>18,23</td>
<td>13.14</td>
<td>15.16</td>
<td>16</td>
<td>10</td>
<td>20.23</td>
<td>18</td>
<td>17</td>
<td></td>
</tr>
</tbody>
</table>

All autosomal STR peaks in the amplification positive control for Fusion 6C must achieve the minimum designated analytical and stochastic thresholds required in order to be considered “passing”.

### 8.2.4 Reagent Blank and Negative Amplification Controls

A reagent blank is used as a processing control to represent the conditions on the workbench as the samples are handled and for the extraction chemicals and supplies themselves. A negative amplification control is a test for the possible presence of contamination occurring during amplification set-up. Contamination can be non-amplified DNA or PCR product.

After electrophoresis, the reagent blanks and negative amplification controls are evaluated. If a negative amplification control or reagent blank exhibit any true peaks indicative of a DNA profile above the kit-specific analytical thresholds for Investigator 24plex or Fusion 6C not attributable to an artifact (e.g. spikes, baseline, dye blobs, pull-up, spurious peaks), the data generated from analysis of DNA specimens amplified with the reagents contained in the reagent blank or negative amplification control must be further evaluated:

1) The control(s) containing possible contamination will be re-injected, re-loaded or re-amplified to determine whether actual contamination is present. Should the reagent blank or negative control show no evidence of contamination re-processing the samples associated with that control may be reported.

2) If the control does not contain a primer peak in the raw data or is missing the Q and S quality sensors in Investigator 24plex QS, re-load the control to ensure an error did not occur during set-up.

3) If the problems are not resolved, all samples set-up and amplified with this control will be considered inconclusive. DNA samples co-amplified with a failed control should be re-amplified. If the control yields expected results when re-amplified, then the re-amplified sample profiles associated with the passing reagent blank or negative control will be considered acceptable for comparison purposes and statistical calculations.

4) If the contamination is still present after additional lab work has been performed, refer to Interpretation of a Contaminated Control or Sample.

**Note:** The GeneMapper ID-X comparison tool can be used to compare possible contamination profiles to staff members and other samples processed in the same run.
8.3 Allele Designation

The goal of the evaluation and interpretation of amplified STR data is to determine the DNA profile(s) of the donor(s) of the questioned sample(s) and to allow comparison to the reference sample profile(s). The following guidelines should be applied in making that determination.

- A peak will be defined as a distinct, sharply pointed triangular area of an electropherogram.
- Genotypes are determined from the diagnostic peaks of the appropriate color and size range for a particular locus.

Alleles will be designated as numerical values in accordance with recommendations of the International Society of Forensic Genetics. Allele designation is based on the number of repeat sequences contained within the allele and by comparison to the allelic ladder.

For any off-ladder (OL) labeled peaks that are observed (even if the allele is below threshold or if comparisons are not going to be made), the GeneMapper sample file is examined to determine whether the peak(s) is attributed to an artifact (e.g., non-specific amplification product, spike or pull-up) or is indicative of a true off-ladder allele microvariant.

Any allele designated as off-ladder by GeneMapper and not determined to be an artifact must be verified by re-injection, re-loading, or re-amplification. If the microvariant appears in multiple evidence samples from the same case otherwise having the same profile, it is not necessary to verify the off-ladder.

Off-ladder peaks which fall into stutter positions of true/virtual parent alleles do not require confirmation prior to export into STRmix.

Because every measure should be taken to interpret evidence samples prior to reference samples, the presence of the microvariant in an associated known sample will not suffice for confirmation, as the evidence should be interpreted before and separate from any associated knowns in the case. As such, off-ladder alleles must always be independently verified in known reference standards and in cases in which only one evidence sample exhibits the microvariant in question.

The NIST STRbase can also be checked at the following website to verify if the allele has been observed by another laboratory: http://www.cstl.nist.gov/div831/strbase/var_tab.htm

Reference knowns and questioned samples are measured against the Ladder(s) to show consistent base pair sizes for each matching sample injected per case.

Off-ladder (OL) calls that are determined to be true peaks, not artifacts, are compared to the size of the appropriate ladder alleles, and the allelic designation is determined. If the OL allele is between two allelic ladder peaks of the same locus and is not a perfect (i.e. 4 bp) repeat, but rather varies by 1, 2, or 3 bp from a ladder allele, then it will be designated as an integer of that variation and considered to be a microvariant. For example, if a blue OL peak size is 238.39 bp, and the 36 allele of the D21S11 ladder is 236.32 bp, then the peak will be designated as a 36.2.

At least one (1) ladder printout containing base pair size data from each GeneMapper ID-X project containing the sample(s) with the OL allele(s) should be included in the case file.
If the allele is seen to the right (higher molecular weight (MW)) of the largest allelic ladder peak of a locus, it will be assigned the type of the largest physical allele of the allelic ladder at that locus with a greater than sign (>). If the allele is seen to the left of the smallest allelic ladder peak of a locus, the allele will be assigned the type of the smallest physical allele of the allelic ladder at that locus with a less than sign (<). The NIST STRbase website (referenced above) can also be checked to verify if the allele has been observed by another laboratory:

In a single-source sample, if an allele is between two loci and either the locus to the right OR left of the OL peak contains two peaks, the allele will be considered to belong with the locus not containing two peaks. If the allele is to the right of the largest allelic ladder peak of the locus not containing two peaks, it will be assigned the type of the largest physical allele of the allelic ladder with a greater than sign (>). If the allele is smaller than the smallest allelic ladder peak of the locus not containing two peaks, the allele will be assigned the type of the smallest physical allele of the allelic ladder with a less than sign (<). If an allele is seen between two loci and neither the higher nor lower molecular weight locus contains an allele or both contain two alleles, further evaluation is necessary. First, the base pair size for the OL allele in question will be compared to the base pair values of the largest allelic ladder peak of the lower molecular weight locus and to the smallest allelic ladder peak of the higher molecular weight locus. An evaluation of the physical location and/or peak height ratio of the allele in question with respect to the higher and lower molecular weight loci will be conducted. Generally, the allele in question will be considered to belong to the locus which is closest in proximity and falls within an appropriate size distance from the locus. If the sample is mixed, further evaluation is also necessary.

**Note:** For non-STRmix projects, the designation of greater than or less than (> or <) will be assigned according to the associated physical allele of the ladder as opposed to any virtual allelic bins at that locus; refer to chapter 9.0 for renaming alleles for STRmix.

### 8.4 Injection of Controls
Reagent blank controls, negative amplification controls and positive amplification controls must be injected at the same injection conditions as their accompanying samples. Each 3130XL has its own instrument-specific injection condition in order to maintain the same level of sensitivity across all instruments. In the event of an injection or failure associated with the controls, the reason the data is not being used must be included on the GeneMapper sample list (e.g. “DNU – injection failure; re-inject”) included in the case file.

### 8.5 Identification of Non-Allelic Peaks
Non-allelic peaks may be PCR products (e.g., stutter, non-template dependent nucleotide addition, and non-specific amplification product), analytical artifacts (e.g., spikes and raised baseline), instrumental limitations (e.g., incomplete spectral separation resulting in pull-up or bleed-through), or may be introduced into the process (e.g., disassociated primer dye). Generally, non-allelic data such as stutter, non-template dependent nucleotide addition, disassociated dye, and incomplete spectral separation are reproducible; spikes and raised baseline are generally non-reproducible.

It is possible that non-allelic peaks may fall above the analytical threshold or interpretation threshold. The analyst will use their experience and expertise to distinguish non-allelic peaks from true allelic peaks. LVMPD’s analytical threshold was established to filter out some non-allelic peaks but is based primarily on signal-to-noise considerations.
8.6 Stutter
In addition to an allele’s primary peak(s), minor stutter peaks can occur at four-base intervals. The most common stutter peaks observed in all loci are four bases smaller than the primary peak (N-4). It is also possible to see additional N+4 peaks (four bases larger) and/or N-8 peaks when excessive amounts of DNA and/or degraded DNA samples are amplified. N+4 stutter was observed in the Investigator 24plex validation. The analyst should be aware of the combined effects of the N +4/N-4 stutter between two alleles. Peaks of this type may be seen in both single source and mixed DNA samples, and a notation(s) can be made where appropriate on the electropherogram contained in the case file.

Stutter peaks are evaluated by examining the ratio of the stutter peak height to the height of the appropriate adjacent allele, expressed as a percentage. The height of stutter peaks will vary by locus, and allele-to-allele. In most cases it is a relatively simple task to determine whether a series of smaller peaks occurring one repeat unit less than the dominant alleles present in a sample are the result of the presence of DNA from more than one individual or are due to stutter.

The expected percentage of an N-4 peak as compared to the nominal allele normally should be less than those listed in the tables of locus-specific values. Peaks in the stutter positions greater than this value may indicate the presence of a mixture. However, peaks in the stutter position below the maximum percentage may be stutter or may be a minor allele and should be interpreted with caution in a mixed sample. The allele-specific stutter values may also be evaluated to determine if a peak is stutter or a true allele.

Stutter peaks may be elevated above established thresholds by the following:

- Overlap is occurring between a stutter peak and true allelic signal thereby resulting in allelic stacking.
- Analyzed peak heights above the optimal range (approximately 2000-4500 RFU) may be off-scale in the raw data, meaning that the CCD camera may be saturated. While the GeneMapper ID-X software will alert the analyst to any off-scale raw data peaks, if the “off-scale” box is checked within the display settings tab of a particular plot setting, the analyzed peak may be assigned a lower value due to smoothing and baseline functions. Therefore, the observed stutter percentage will be inaccurately high. If the stutter peak is greater than the maximum allowed and the primary peak is above 4500 RFU and/or has been labeled off-scale, the analyst should interpret the results with caution. The sample may be re-amplified with less DNA.
- Stutter peaks overlapping an area of elevated baseline or spectral pull-up may exhibit increased percentages. Elevated baselines may indicate an improperly functioning spectral calibration.
- Stutter peaks falling into the rocker position in the overlapping area of N+4 and N-4 stutter may result in increased stutter percentages.

8.7 Non-Template Nucleotide Addition (-A)
Amplification conditions have been set to maximize the non-template addition of a 3´ terminal nucleotide by DNA polymerase. Failure to attain complete terminal nucleotide addition results in band splitting (two peaks one base apart). This is most often seen when an excessive amount of DNA is amplified or amplification is performed under sub-optimal PCR conditions. Minus A peaks
that are called can be deleted in GeneMapper ID-X or can be indicated on the electropherogram by crossing them out.

The presence of a significant amount of minus A artificially reduces the true peak heights of the alleles due to the signal being split between the minus A peak and the fully adenylated form. Based on the severity, the presence of minus A peaks may affect STRmix modeling.

8.8 Non-Specific Amplification Artifacts
Non-specific amplification products are artifacts that may or may not look like true alleles. Typically they occur due to excessive template amplification and are present at smaller loci. Ultimately the analyst will evaluate the entirety of the profile and use their experience and expertise to distinguish these artifacts from true alleles.

Artifacts documented in official notices by Promega or QIAGEN may be deleted without independent confirmation. The presence of the artifact will be documented in the case file or database packet.

8.9 Spikes
Peaks of the same size and similar height (within an order of magnitude of each other) can occur in multiple colors, are not the result of dye-labeled DNA and do not represent a spectral problem. These are spikes typically due to urea crystal in the POP-4 polymer, dust, or particulates in the buffer. Spikes can also occur in a single color and are distinguished by their unique morphology as compared to true peaks. Multi-color spikes can be shown to be artifacts by overlaying all colors. Spikes that fall outside of the kit-specific analysis ranges are not significant.

8.10 Raised Baseline
A raised baseline will appear on an electropherogram as a horizontal line that is higher than the average baseline in the rest of the color channel. It is typically apparent on an electropherogram by noting that the raised baseline appears to be equal to the width between two true allele peaks from an adjacent color channel.

8.11 Migration and Pull-Up
In addition to amplification artifacts described above, the following anomalies can arise during electrophoresis and analysis and notation(s) can be made where appropriate on the electropherograms contained in the case file.

- Significant room temperature fluctuation may result in size variation or migration between injections such that allelic ladder peaks differ by more than approximately ±0.5 bp from allelic peaks in other injections. This will cause GeneMapper ID-X to assign these alleles as off-ladder alleles. Genotyping with a different injection of allelic ladder may alleviate this problem. Data from another amplification, injection, or evidentiary sample may also confirm the migration. If these methods don't resolve the issue, the sample(s) and an allelic ladder should be re-injected or re-loaded to confirm the typing. Migration at Amelogenin does not need to be confirmed.

- Small artifact peaks can appear in other colors under true peaks. This phenomenon is termed pull-up. Pull-up is a result of spectral overlap between the dyes which is normally corrected for by the spectral. If a pull-up peak is above the minimum peak height detection threshold, it will be sized at the approximate same size as the true peak from the other color channel. Amplification using excess input DNA can lead to off-scale peaks resulting in pull-up. These
“pull-up” peaks can be deleted in GeneMapper ID-X or noted on the electropherograms. Typically pull-up peaks are within approximately 10-15 data points of the originating peak.

8.12 Off-Scale Indicators (Saturated Data)
An off-scale indicator means a data point is saturated, and the sample may need to be evaluated. Alleles in other loci at the same data point that a blown out peak is observed must be confirmed by another injection to prove it is a true peak rather than pull up from the blown out peak. Samples exhibiting saturation may be re-amplified using less input DNA or may be diluted with formamide and re-loaded. Off-scale data must be interpreted carefully as it can distort mixture ratio and stutter filtering calculations.

8.13 Evaluation of Quality Sensors QS1 and QS2 in Investigator 24plex QS
The Investigator 24plex QS Kit primer mix contains two (2) internal PCR controls (Quality Sensor QS1 and QS2) to provide helpful information about the efficiency of the PCR and the possible presence of PCR inhibitors. The Quality Sensors are amplified simultaneously with the STR markers. The Quality Sensors are labeled with BTP and appear at fragment sizes of 74 bp (QS1) and 435 bp (QS2).

In general, the successful amplification of the small Quality Sensor (QS1) indicates that the PCR was set up and conducted correctly, regardless of whether DNA was present or absent in the sample. If no Quality Sensor is detected in the analysis of the amplification products, this may indicate that pipetting during PCR setup, or the PCR itself, were performed incorrectly or that the sample is suffering from extreme inhibition. The amplification should be repeated for improved results using either the same or different amount of template input.

In addition, the analysis of the two internal control fragments, QS1 and QS2, and of the STR target amplification products allow for the differential identification of the presence of inhibitors or the presence of DNA degradation in an amplification reaction.

In the case of sample degradation, the amplification of smaller target fragments is more efficient than the amplification of larger target fragments. However, degradation of the target template does not hamper amplification of the QS1 and QS2 internal controls. Thus, an equal ratio of QS1 and QS2, together with a ratio in favor of small STR target products suggests the presence of sample degradation.

A reduction in the height of the QS2 signal below 20% of the QS1 signal may indicate inhibition of the PCR reaction. Data should be scrutinized in conjunction with the quantitation data to determine if additional processing may be warranted in the form of sample clean-up.

The following table may serve as a useful reference while examining the quality sensors (QS1 and QS2):
8.14 Loss of Resolution/Poor Resolution

Loss of resolution occurs when there are instrumentation issues or impurities contained within a sample which results in poor sample migration through the capillary. This results in a broadening of peaks and a loss of peak height, typically at the larger sized loci. As loss of resolution typically affects the various-sized loci differently, the relationship between the amount of input DNA and peak heights is no longer linear. This can be problematic for quantitative-based interpretation methods such as STRmix, which utilizes this relationship during sample deconvolution. The presence of loss of resolution in samples will be notated on the electropherogram or GeneMapper ID-X injection list.

Low-level or mixed samples which exhibit loss of resolution will be re-injected, re-loaded, or re-amplified to resolve the peak broadening issues. Robust single-source samples (containing all heterozygous alleles above 100 RFU and homozygous alleles above 200 RFU) which do not exhibit any indications of containing a mixture may be interpreted with caution.

The resolution of peaks must be checked carefully, particularly at loci which contain single base pair microvariants (e.g. D1S1656 and D1S391). Poor resolution may result in shouldering and the loss of minor contributor or stutter peaks, which can affect STRmix deconvolution.

In the event reagent blanks or samples which fail to yield a DNA profile suffer from loss of resolution, documentation must be included in the case file to state that the lack of data is consistent with the expectation based on the item’s quantitation value, despite the loss of resolution. Amplification negative controls must also include documentation that the lack of data is consistent with expectation, despite the loss of resolution. Alternatively, these items may be re-injected or re-loaded in order to attempt to resolve the loss of resolution. Documentation may be made on either the printed electropherogram or in the GeneMapper ID-X injection list.

8.15 Required Casework Documentation of Interpretation on Electropherograms

All electropherograms will include documentation regarding the analyst’s observations and suitability for additional interpretation.

At minimum, the following will be documented on casework evidence electropherograms:

- Number of contributors
  - For mixtures, must include the name of at least one locus where the determination for the number of contributors was made
- If an indication of male DNA is present
- Suitability for STRmix interpretation or statistical calculation
- If the data is not being used for additional interpretation (i.e. inconclusive), the reason why (e.g. DNU due to loss of resolution, due to limited data, no additional conclusions, etc.)
In the event STRmix will be used for interpretation, the required documentation will be captured on the STRmix electropherogram that includes stutter labels. When replicates will be utilized in STRmix, documentation must only be included on one of the replicate electropherograms. Additional profiles which will be run as replicates will include a reference to the page number or sample ID of the documented electropherogram. If STRmix is not being performed, all documentation must be included on the electropherogram which will be reported.

The following will be documented on reference electropherograms:
- Whether the profile is a full or partial DNA profile
- The sex of the profile

8.16 Exporting GeneMapper ID-X Analysis for STRmix Interpretation and ALLELEigator Table for References
After analysis has been completed, evidence profiles contained in the STRmix project and reference standards are exported to the analyst run folders located within Y:\Forensic Data\STRmix\STRmix Run Files. In the main project window, select the appropriate Table Setting noted above. Click “File” then “Export Combined Table”. Select the desired destination and click “Export”.

Note: If evidence and reference standards are contained in the same stutter-filtered project, select only the injection folder(s) containing the reference profiles from the left-hand project pane prior to export to STRmix. It is permissible to create additional folders within the STRmix Run Files location (e.g. batch, year, etc.) to house the export files.

ALLELEigator tables will be generated for all reference standards. In the main project window, select the the “ALLELEigator” table setting. Click “File” then “Export Combined Table”. Select the desired destination and click “Export”.

8.17 GeneMapper ID-X Comparison Tools
The GeneMapper ID-X software has a comparison tool that can be used to compare possible contamination profiles to staff members and other samples processed in the same project. To open the Comparison Tool, go to Tools>Profile Comparison.

On the first Sample Concordance tab, samples with 100% concordance are listed.

On the Sample Comparison tab, after clicking Compare Profiles the profiles in the project are compared to each other and possible matches will be listed. The percent match threshold can be adjusted depending on how many possible matches are found.

On the Lab Reference Comparison tab, after clicking Compare Profiles the profiles in the project are compared to DNA Lab personnel, Custom Controls, and contaminant profiles reported in the forensic DNA community. The percent match threshold can be adjusted depending on how many possible matches are found.

The Control/QC Comparison is not currently utilized by the LVMPD Biology/DNA Detail.

Note: Samples containing off-ladder (OL) alleles will not be compared so all artifacts should be deleted even if the data isn’t going to be reported if the analyst wants them compared as
well. If an Allelic Ladder’s sample type is changed from Allelic Ladder to Sample due to poor sizing quality it will most likely be called a match to every sample in the project.

8.18 GeneMapper ID-X Audit Record Maintenance

Only a user with administrator rights or using the administrator login can access the GeneMapper ID-X server. The following procedures can only be performed by a user with administrative access.

**Note:** Currently this feature is turned off, but may be used at a future date when another copy of the server software is installed and the audit triggers can be appropriately applied and managed.

**Note:** An audit record is saved anytime a change (i.e. allele change, delete allele, etc) is made to a project while the audit feature is turned on. The software recommends that the audit records be backed up and deleted when there are over 60,000 records in order to free up space in the database.

To monitor the audit record count, navigate to the following in GMID-X:

**Admin>Audit Manager>Show Audit Record Count**

If the count is close to or exceeds 40,000 records, someone must log on as the administrator (user ID: gmidx) to back up and delete the records by navigating to the following:

To back up audit records:

**Admin>Audit Manager>Backup Audit Records**

The backup should be stored on a CD and stored in the safe in the DNA Lab.

To delete audit records:

**Admin>Audit Manager> Delete Audit Records**

8.19 Troubleshooting GeneMapper ID-X Database Connection Failures

At times, the connection to the GMID-X server is lost. An error message will pop up when the software is launched that says “The connection to the database has failed” and the user ID drop-down list on the log-in screen will be blank.

Copy/paste the “GMIDX Served Remote Control” icon found in the H:\Forensic Data\DNA\OTHER\Archive\GMID-X Server Remote Control folder to the computer desktop (this only needs to be done on the first occurrence).

Double-click the icon and log in with a normal LVMPD network login (not gmidx login). It might take a minute or so to load.

Navigate to: Start Menu>Administrative Tools>Services

Look for these two files:
For both, click the hyperlink on the left hand side that says Stop the service, then click Start the service.

When finished, Log Off (do not Shut Down). Usually within 5 minutes the connection should be re-established for logging in to GMID-X. If the database connection continues to fail, the LVMPD IT department should be notified so they can monitor for long-term solutions.

**Investigator 24plex QS locus-specific** stutter values included in GMID-X stutter files

Note: Additional N+1 stutter was observed at several loci during the internal validation of the Investigator 24plex kit, however due to the fairly low frequency for most loci in the dataset, these values were not included in the final stutter file.

Note: PowerPlex Fusion 6C utilizes a 20% global stutter filter.
Investigator 24plex QS *allele-specific* stutter percentages

The below values are used in the manual calculation of the expected amount of allele-specific stutter using the *ALLELEigator* workbook. Refer to “*Using tiffCAKE Ribbon Accessories in* *ALLELEigator*” for additional information.

**Important!** STRmix may use a different intercept and slope value than those in the allele-specific stutter percentage table, due to its ability to model the best explanatory variable (longest uninterrupted stretch (LUS), or average stutter). Therefore expected stutter values in STRmix may be different than those manually calculated in the LVMPD workbooks. The best explanatory variable per locus is noted below. Refer to the STRmix validation for the locus-specific slope and intercept values utilized by STRmix.

<table>
<thead>
<tr>
<th>Marker</th>
<th>Intercept</th>
<th>Slope</th>
<th><strong>Best Explanatory Variable used in STRmix</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>TH01</td>
<td>-0.04044</td>
<td>0.00932</td>
<td>LUS</td>
</tr>
<tr>
<td>D3S1358</td>
<td>-0.06767</td>
<td>0.01005</td>
<td>LUS</td>
</tr>
<tr>
<td>vWA</td>
<td>-0.09164</td>
<td>0.01023</td>
<td>Average</td>
</tr>
<tr>
<td>D21S11</td>
<td>-0.05667</td>
<td>0.00449</td>
<td>Allele</td>
</tr>
<tr>
<td>TPOX</td>
<td>-0.04372</td>
<td>0.00829</td>
<td>Allele</td>
</tr>
<tr>
<td>DYS391</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>D15S1656</td>
<td>0.02926</td>
<td>0.00453</td>
<td>LUS</td>
</tr>
<tr>
<td>D12S391</td>
<td>-0.11016</td>
<td>0.01059</td>
<td>Allele</td>
</tr>
<tr>
<td>SE33</td>
<td>0.05377</td>
<td>0.00235</td>
<td>Average</td>
</tr>
<tr>
<td>D10S1248</td>
<td>-0.03541</td>
<td>0.00896</td>
<td>Allele</td>
</tr>
<tr>
<td>D22S1045</td>
<td>-0.14609</td>
<td>0.016</td>
<td>LUS</td>
</tr>
<tr>
<td>D19S433</td>
<td>-0.06535</td>
<td>0.01005</td>
<td>LUS</td>
</tr>
<tr>
<td>D8S1179</td>
<td>0.00534</td>
<td>0.00558</td>
<td>Average</td>
</tr>
<tr>
<td>D25S1338</td>
<td>-0.00252</td>
<td>0.00408</td>
<td>Average</td>
</tr>
<tr>
<td>D2S441</td>
<td>0.08801</td>
<td>-0.00256</td>
<td></td>
</tr>
<tr>
<td>D18S51</td>
<td>-0.05094</td>
<td>0.00897</td>
<td>Allele</td>
</tr>
<tr>
<td>FGA</td>
<td>-0.0395</td>
<td>0.00556</td>
<td>Average</td>
</tr>
<tr>
<td>QS1</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>D16S539</td>
<td>-0.08413</td>
<td>0.01401</td>
<td>Allele</td>
</tr>
<tr>
<td>CSF1PO</td>
<td>-0.07014</td>
<td>0.01243</td>
<td>Allele</td>
</tr>
<tr>
<td>D18S517</td>
<td>-0.05627</td>
<td>0.01018</td>
<td>Allele</td>
</tr>
<tr>
<td>D5S818</td>
<td>-0.06066</td>
<td>0.01086</td>
<td>Average</td>
</tr>
<tr>
<td>D7S820</td>
<td>-0.05579</td>
<td>0.0105</td>
<td>Allele</td>
</tr>
<tr>
<td>QS2</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
</tbody>
</table>
The interpretation of results generated from casework samples is a matter of professional judgment and expertise. Not every situation can or should be covered by a pre-set rule. The Biology/DNA Detail will use appropriate procedures for test data interpretation. The laboratory has developed and adheres to general guidelines and minimum criteria for the interpretation and reporting of analytical results which are generally accepted in the scientific community. These criteria are based on validation studies, published scientific literature, and the experience of the analyst. It is to be expected that these interpretation guidelines will evolve as the collective experiences of the laboratory and forensic community in general continues to grow.

9.1 Sample Types
Samples are grouped into questioned samples which have an unknown origin and reference (known) standards. Questioned samples may yield single source, mixture profiles, or no results.

Types of Reference Standards:
Primary Standards are samples known to originate from a particular individual and are usually in the form of buccal swabs or blood. Pulled hair, tissue or bone may also be submitted as a primary standard if the originating individual is known. Primary standards are taken directly from the body for the purpose of being used as a reference standard, rather than as a questioned evidence sample.

Secondary standards are samples removed from the victim or a personal item known to belong to the victim (i.e., bloody clothing, toothbrush). Secondary standards may be used if a primary standard is unavailable or unusable. If used, the secondary standard will be noted in the report. Based on the circumstances of the case, a secondary standard may be processed as either a questioned or a reference sample.

A secondary standard submitted from a suspect may be used for comparison but not for statistical calculations. When it is necessary to use a secondary standard from a deceased victim, the secondary standard may be used for comparison and statistics.

Presumed standards are samples which are known to originate from a particular individual, however are typically processed as an evidence sample in order to first determine whether it contains probative evidential value (e.g. epithelial fraction of a vaginal swab, breast swab, etc.).

Under certain documented circumstances, a resultant single source DNA profile (or distinguishable component of a mixture) may be assumed to belong to the individual from whom it originated for comparison purposes. A presumed standard may be used if a primary standard is unavailable or unusable. The use of a presumed standard will be notated in the analyst’s notes and in the report.
Surreptitious standards are samples which are collected from physical items known to have been used or discarded by a person of interest (e.g. cigarette butts, drinking containers, etc.). Surreptitious standards will be processed in the laboratory as questioned samples.

Under certain documented circumstances, a resultant single source DNA profile may be assumed to belong to the person of interest who is known to have used or discarded the item for purposes of comparison. The DNA profile will be used as a reference standard in STRmix for comparison to other evidence items. Refer to the section for Manually creating of .txt files for unidentified contributors, DNA profiles of reference standards processed from outside vendors, and surreptitious standards.

Items submitted as surreptitious standards which yield mixture DNA profiles will be considered as unsuitable for comparison.

A surreptitious standard may be used if a primary standard is unavailable or unusable; however the DNA profile is not eligible for CODIS entry. The use of a surreptitious standard will be notated in the analyst’s notes and in the report. All reported comparisons will reference only the donor of the DNA profile to the surreptitious standard and will not make a direct association with an individual.

9.2 Preliminary Evaluation of Data and Application of Peak Height Thresholds

The analytical threshold (AT) was established through internal validation studies. The analytical threshold is set at 50 RFU for the blue, green, yellow, red, purple, and orange dye channels. Any peak detected less than 50 RFU does not reliably represent DNA template.

The interpretation (stochastic) threshold (ST) is set at 200 RFU for each of 3130XLs validated for use with Investigator 24plex QS. Peaks which are detected between 50 and 199 RFU are authentic signal and should be evaluated to discern alleles from artifacts. This threshold will be used as a qualitative assessment only and does not impact the ability to interpret or report evidence data analyzed using STRmix.

Reference standards must have all homozygous loci above the 200 RFU interpretation threshold and all heterozygotes above the 50 RFU analytical threshold to be considered complete.

9.3 Single Source Profiles

A sample is consistent with originating from a single source if one or two alleles are present at all loci for which typing results were obtained (although tri-allelic loci may occur). Loci with a single homozygous peak called below the 200 RFU interpretation threshold may indicate the possibility of allelic drop-out.

The sex of a male profile donor may be reported if the Y-allele at Amelogenin is between the analytical and stochastic threshold or if an allele is present at the DYS391 locus. In the absence of a Y-allele at Amelogenin, the DYS391 marker should be examined to confirm a null allele is not occurring. Reference standards may be amplified in PowerPlex Fusion 6C in an attempt to determine the presence of a null allele.

Note: Evidence samples may not be amplified using PowerPlex Fusion 6C.
9.4 Tri-Alleles
A locus is consistent with being tri-allelic if three alleles are exhibited and there are no other indications of the presence of a possible mixture.

Confirmation of Tri-Alleles
Questioned samples suspected of containing a tri-allele will be re-amplified to confirm the tri-allele peaks, when possible. If there is not sufficient extract remaining for re-amplification, the locus will not be used for interpretation.

If the suspected tri-allele exhibits a balanced PHR with each allele being greater than the expected 55% PHR for Investigator 24plex with one another and the tri-allele appears in multiple evidence samples from the same case otherwise having the same profile, it is not necessary to verify the tri-allele by re-amplification. All other non-balanced indications of a tri-allele must be independently re-amplified for verification purposes.

Because every measure should be taken to interpret evidence samples prior to reference samples, the presence of the tri-allele in an associated known reference sample will not suffice for confirmation. Suspected tri-alleles must always be independently verified in known reference standards and in cases in which only one evidence sample exhibits the tri-allele in question.

Currently, statistical calculations cannot be performed on loci containing tri-alleles using the Popstats or STRmix software.

9.5 Mixture Profiles
A mixture is a DNA profile which originates from two or more individuals. An individual’s contribution to a mixed biological sample is generally proportional to their quantitative representation within the DNA typing results.

The determination of a mixture is made by a collective evaluation of the electropherogram and all data which is present. Three or more loci with one or more of the following characteristics observed in a sample may be indicative of a mixture (could be three or more of the same characteristic):
- 4 peak pattern observed at a locus
- 3 peak pattern observed at a locus
- 2 or more peaks observed at the DYS391 locus
- Significant peak height imbalances of alleles for a heterozygous genotype at a locus with the exception of low template amplifications, which should be interpreted with caution
- The presence of elevated stutter at a locus
- Possible additional peaks falling into allelic bins below the analytical threshold

9.6 Manual Comparison of Reference Standards to Outsourcing and Legacy Data
A known individual is manually determined to be included in a single source sample or mixture sample if their alleles are present at all loci where DNA typing results were deemed interpretable. Though rare, it is possible that one allelic difference may exist due to mutation (in even rarer instances, two mutation events have been observed). The analyst must thoroughly document if the possibility of mutation is suspected in their case notes.
A known individual is excluded from a single source or mixture sample if their alleles are missing at any loci where the DNA typing results were deemed complete. Alleles that fall within a stutter position may be evaluated on a sample-by-sample basis, and may affect the conclusions in mixed samples.

9.7 STRmix Interpretation
STRmix is a fully continuous probabilistic genotyping software for the interpretation of autosomal STR DNA profiling results. STRmix can deconvolute a mixture into the individual contributor(s)/component(s) in the absence of reference standards. STRmix is also used to provide a statistical weight for comparisons of reference profile(s) to evidence profile(s).

The LVMPD Biology/DNA Detail is using STRmix v2.4 for the interpretation of Investigator 24plex QS profiles and v2.3 for the interpretation of Identifiler Plus profiles. STRmix is not available for use with data generated from other amplification kits or with data generated by an outsourcing vendor.

Interpretation protocols are not intended to be applied retroactively. The Biology/DNA Detail will re-evaluate previously reported DNA data and conclusions based on three scenarios:
1) Anytime a forensic DNA expert performs an evaluation of their previously reported data (preparing for court, writing a supplemental report, etc.), the expert has a right to retract or re-analyze data using STRmix that is no longer supported by significant evolution in technology or fundamental practices.
   • The original requestor will be notified via email that the Biology/DNA Detail will be issuing a supplemental report based on the re-evaluation of the case file. Documentation of this email communication will be maintained in the case file.
2) When a written request is received for STRmix analysis of an item which was previously reported as inconclusive (or portion thereof). Requests will only be considered when submitted from a Lieutenant or a person of equivalent or higher rank and must be approved by the DNA Laboratory Manager, Supervisor, or DNA Technical Leader.
   • The original requestor will be notified via email if additional DNA profiles are identified that may be suitable for STRmix re-interpretation outside of those specifically requested.
3) When issued a court order.

All requests for STRmix analysis must be within the capability and validated application(s) of the laboratory. In the event an item of evidence which was previously amplified and reported using Identifiler Plus will be re-amplified using QIAGEN Investigator 24plex QS for purposes of potential STRmix interpretation, the associated reference standards previously processed using Identifiler Plus will also be re-amplified using QIAGEN Investigator 24plex QS.

Information pertaining to the settings and interpretation of Identifiler Plus DNA profiles in v2.3 of STRmix may be found at the end of this protocol. All other information regarding the determination of the number of contributors, profile suitability, review of diagnostics, and reporting of Identifiler Plus data will be the same as outlined below.

9.7.1 Determination of the Number of Contributors to the Evidence Profile
The assignment of the number of contributors to a profile must be made by the analyst prior to the comparison of the profile to any reference samples. Evidentiary profiles will be
considered to be full single source when all homozygous loci are above the 200 RFU stochastic threshold and all alleles at heterozygous loci are above 100 RFU (the drop-in cap used for STRmix). The potential of peaks to be stutter should be considered. The number of contributors chosen for the analysis should be the most likely number required to reasonably explain the observed profile(s) which will be analyzed in STRmix.

Sometimes the number of contributors may be unclear. This could be because the profile is complex and may contain low-level indications of additional contributors, is too limited, or because case circumstance suggests that the possibility of additional contributors exists such as when it may be reasonable to assume the presence of a contributor. The analyst will use their professional judgment when assessing the number of contributors, and may take into account sub-analytical threshold (AT) peaks and high stutter.

If ambiguity exists in determining the number of contributors (e.g. three vs. four contributors), provision is made for an analyst to make an assignment of the number of contributors and then run a STRmix deconvolution without the use of reference standards (unless being used for conditioning). After review of the STRmix output, and prior to comparison with the reference profiles, it may then be determined that the deconvolution does not conform to scientific expectation and may be re-run under a different number of contributors. The review of the STRmix output and course of action must be thoroughly documented in the case file. The STRmix output of the first deconvolution will be retained in the case file along with documentation as to why it will not be used for reporting. Alternatively, an analyst may choose to report both interpretations if both produce viable deconvolutions and diagnostics.

Additional amplifications may be performed to confirm the presence or absence of drop-in/drop-out peaks to aid in the determination of the number of contributors.

In circumstances where the number of contributors cannot be determined due to the quality of the DNA profile obtained, the profile will be reported as too complex or too limited to interpret. Documentation will be included in the case file as to why a number of contributors cannot be assigned, to include reference to specific loci which highlight the ambiguity. These profiles will not be interpreted in STRmix.

Method for Assigning the Number of Contributors for a Profile
When assigning the number of contributors to a profile, the profile in its entirety will be reviewed. If replicate amplifications have been undertaken, all qualifying replicate profiles will be reviewed when determining the number of contributors (refer to Replicates section below).

The following steps will be followed in assigning the number of contributors to a profile:
1) Review the profile as a whole, assessing the level of degradation, presence of low level peaks, noisy or clean baseline and general quality (template) of the profile.
2) Find the locus with the highest number of unambiguous allelic peaks. If the number of allelic peaks present is an odd number, add 1. Divide this final number by 2 to obtain the initial proposal of the number of contributors to the profile.
3) Review peak height imbalances at the most informative locus (typically having the greatest number of alleles). Taking into account allele sharing/stacking, visually
attempt to “pair” alleles using the LVMPD’s validated stratified peak height ratio expectations (stronger/weaker sister allele). In the event there is too much imbalance between alleles, this may indicate the presence of an additional contributor above the value obtained by allele count alone.

4) If data is in the stochastic range, review the electropherogram for sub-analytical threshold (AT) peaks and high stutter, which may indicate the presence of additional contributor(s).

5) If one or more contributors at this locus is either trace or a clear major, check that this pattern is represented at other loci.

6) Apply the general pattern of contributors (number and proportion) to other loci in the profile. If it holds, assign this number of contributors to the profile. Otherwise consider the addition or subtraction of one contributor.

The assumed number of contributors will be documented on the STRmix electropherogram, to include whether there is an indication of male DNA being present. Documentation will include reference to the specific loci used to determine the number of contributors when applying steps #2, #3, and #4 above for mixture profiles. These same loci will be utilized to manually evaluate the mixture proportions, weights, and genotype combinations (to include the expectation for genotypes containing allelic drop-out) after the STRmix run.

All DNA profiles interpreted in STRmix must contain at least one locus which may be manually evaluated for mixture proportion, weights, and genotype combination expectations. Stochastic DNA profiles containing loci with sub-analytical threshold data indicative of a mixture may be evaluated for mixture proportions, when possible. For these stochastic profiles, the weights and genotype combinations are expected to demonstrate an increased uncertainty in the genotypes of the contributors. In the event that the quality of the profile is such that these evaluations cannot be made and compared against the STRmix output, the profile will be deemed unsuitable for STRmix analysis.

Notes:
- Discriminating loci such as FGA, D2S1338, D1S1656, and D12S391, and SE33 (where applicable) are likely to be the most informative when determining the number of likely contributors to a profile. Amelogenin and DYS391 may also be used.
- DYS391 will be used to increase the number of male contributors above “at least one” under the following conditions:
  - Two (or more) peaks are present which do not fall into stutter positions.
  - Two (or more) peaks are present and the peak in the N-4 stutter position is at least 20% or greater than the peak height of the other peak and the peak in N+4 stutter position is at least 15% or greater than the peak height of the other peak.
If a peak falls into the N-4 stutter position of a second peak and may possibly be the result of high stutter rather than true DNA, the number of males will not be increased from “at least one”.

In the event it is believed that a DYS391 duplication may be present due to the case scenario and the entirety of the profile data, the analyst must document this observation as the reason why the number of male contributors is not being increased for that particular profile.

- The presence of one or two trace peaks below 100 RFU may indicate the presence of drop-in and may not always require the consideration of an additional contributor.
- Peaks falling within bins below the AT may be useful to indicate the presence of low-level or trace additional contributors. When using the presence of peaks below AT to infer an extra contributor, there must also be low-level peaks below the ST in the profile to support this conclusion.
- Mixtures of DNA with four contributors should be interpreted with care as the possibility of misinterpreting the true number of contributors increases with each additional contributor. Mixtures which appear to contain five or more contributors will not be interpreted.

9.7.2 Replicates

A replicate amplification may help in determining the number of contributors. A replicate is defined as a repeat amplification of the same extract. The replicate may be amplified with different amounts of template DNA or the same amount of template. The use of replicates during STRmix deconvolution have been demonstrated during validation to improve the sensitivity and specificity of the interpretation. Replicates increase the LR when comparing to known contributors and lower the LR when comparing to non-contributors.

Not all replicate profiles are required to be included in the STRmix interpretation. For example, if a full profile was obtained from one amplification and no further information was obtained from previous or subsequent amplifications, it is not required to be included in the STRmix interpretation. In the event different replicate strategies are utilized within the same case file (e.g. some evidence profiles utilize replicates during interpretation, while others do not even though replicate profiles are available), a note will be made regarding the specific reason for choosing (or not choosing) to use the replicate amplifications for STRmix.

When analyzing replicates in STRmix, the highest likely number of contributors will be used for deconvolution if the replicate amplifications indicate a differing number of
contributors being present. The analyst will document on the electropherogram if replicates will be used for deconvolution.

9.7.3 Manual Comparison of References to Full Single Source Profiles
With the exception of reasonably assumed contributors, manual comparison of reference standards from the case may only be made between evidentiary full single source profiles where all homozygous loci are above the 200 RFU stochastic threshold and all alleles at heterozygous loci are above 100 RFU (the drop-in cap used for STRmix). All other comparisons of evidentiary profiles to reference standards will be based on the deconvolution of the item in STRmix.

9.7.4 Profiles Suitable for STRmix Interpretation
STRmix will be used to deconvolute and interpret the following qualifying profiles:

- Full single source evidence profiles where an inclusion with a reference standard is being reported. For multiple consistent single source evidence profiles within the same case, at least one of the profiles must be interpreted and a note included which references the Lab Case # and item number of all other items with the same interpretation. The least robust profile containing the most possible uncertainty should be used for STRmix interpretation.
- Two, three, and four-person mixtures deemed suitable for interpretation.
- Partial single source and partial mixture profiles containing data at at least three loci.

Note: Profiles with limited data are likely to result in low LRs for true contributors and provide an increased opportunity of an adventitious match (positive LR when comparing to a non-contributor). Caution must be exercised when used for interpretation.

Profiles which are determined to be eligible for STRmix interpretation will be documented on the electropherogram.

Exceptions for when STRmix interpretation may not take place or be necessary:

- If the number of contributors cannot be determined in the evidence profile.
- If there are indications of more than four contributors to the evidence profile.
- If there are fewer than three loci with DNA profiling data.
- If the profile does not contain at least one locus which may be manually evaluated for mixture proportion, weights, and genotype combination expectations for comparison against the STRmix output.
- If the inclusion of a reference standard does not provide probative value in the context of the case (i.e. an individual’s own single source DNA on their intimate body swabs or clothing).
- If carryover is determined to be present between the epithelial and sperm fractions of differentially extracted samples.

9.7.5 Determination of Inclusion, Exclusion, and Inconclusive with STRmix
Only qualifying full single source profiles (as noted above) which have been manually compared to a reference standard may be analyzed and have a likelihood ratio calculated within a single STRmix run. In the event a single source profile is determined to be from
an unknown contributor, it is analyst discretion as to whether to perform a STRmix interpretation in the absence of a reference standard.

With the exception of qualifying full single source profiles and the use of assumed contributors, STRmix deconvolution will take place prior to, and independently from, the comparison to reference standards and calculation of a likelihood ratio. After deconvolution, STRmix statistical analysis will be used to support the inclusion, exclusion, or inconclusive comparison for each individual reference standard.

Alternatively, if after STRmix deconvolution two or more loci have been fully resolved to a weight of 1.00 (or 100%), the genotypes for each contributor at the fully resolved loci may be used to perform a manual comparison to the reference standards for purposes of exclusion. Exclusions are required at two or more of the resolved loci. A note must be made on the STRmix deconvolution to document that the results will be used for manual exclusion.

- If the deconvolution contains only one unknown due to either being single source or the use of conditioning, the genotype resolution for the unknown can be found in the “Component Interpretation” section of the Advanced Report.
- When more than one unknown is being considered during deconvolution, the “Genotype Probability Distribution” of the “_AllSections” Advanced Report will be used to document the resolution of complete genotypes. When applicable, a copy of the relevant pages of the “Genotype Probability Distribution” exhibiting the full genotype resolutions will be retained as part of the case file.

If a reference standard is manually excluded, a LR will not be calculated. The reference standard will be reported as an exclusion.

In the event a manual comparison of a single locus results in an unexpected exclusion, additional troubleshooting may be required. Refer to the troubleshooting section of Reviewing a STRmix Output.

The following conclusions will be drawn based on the exponents of the calculated LR values:

<table>
<thead>
<tr>
<th>Calculated LR Value</th>
<th>Conclusion</th>
</tr>
</thead>
<tbody>
<tr>
<td>$10^4$ or greater</td>
<td>Inclusion</td>
</tr>
<tr>
<td>$10^3$ to $10^{-3}$</td>
<td>Inconclusive</td>
</tr>
<tr>
<td>$10^{-4}$ or lower</td>
<td>Exclusion</td>
</tr>
</tbody>
</table>

If a profile is determined to be unsuitable for interpretation, an explanation as to why the DNA evidence is uninterpretable must be documented (too limited or too complex) in the case file and in the report.

Any mixture which exhibits signs that it is from greater than four contributors based on maximum allele count, inconsistencies in peak height balance or percent contribution will be deemed as inconclusive due to the complexity of the data. No portion of these mixtures will be considered suitable for comparison.

### 9.7.6 Assumed Contributors
In certain circumstances, it may be reasonable to assume the presence of a contributor in a DNA mixture. Examples include:

- Intimate samples
- Reference standards received from consensual partners
- Items documented to have been removed directly from someone’s person
- Environmental samples in which individuals may have habitually touched or handled an item (e.g. bedding, steering wheel of car, items recovered from a domestic location where an individual is documented to reside, etc.)
- Contamination events having a known source (e.g. staff involved in evidence handling, collection, or testing)
- When there is written documentation that the defense has conceded the presence of an individual on an item of evidence

In these circumstances, the DNA profile from the assumed contributor(s) will be used to assist interpretation of the additional contributors' DNA profile during the deconvolution, when available. Assuming that someone is present in both Hp (prosecution hypothesis) and Hd (defense hypothesis) fixes their genotype during the deconvolution process (essentially forces an LR of 1 at every locus for their portion of the genotype set). This is known as conditioning the deconvolution.

The assumption of any contributor to a mixture must be supported by the data, regardless of case scenario. The assumption of the presence of one or more specific contributors may require the analyst to adjust a previously assumed number of contributors to the mixture once evaluating the data using the assumption.

It is analyst discretion to determine whether an assumption will be made during the interpretation of items documented to have been removed directly from someone’s person when staining is present (e.g. bloodstain on a victim’s shirt removed at autopsy) based on whether there is a potential probative association with that specific item. This determination will be made using the case information available. The reason(s) for the final determination regarding conditioning will be documented within the case file.

 Conditioning the deconvolution for non-environmental samples and calculating LRs
If an analyst determines that the data clearly supports the presence of a reasonably assumed contributor, this will be documented and can be used as a basis for using an assumption during STRmix deconvolution. This evaluation will take into account the alleles of the assumed donor being present, LVMPD-validated stratified peak height ratio expectations, apparent mixture ratios, and kit-specific stutter ratio expectations. In addition, information from associated fractions (i.e., epithelial and sperm fractions) of the same sample can be used in this evaluation as a means to assess the possibility of carryover. Alleles belonging to low-level contributors which are being assumed will be designated on the electropherogram.

If, based on the review of the profile data, it is ambiguous as to whether a reasonably assumed contributor may be present (contributor is low-level, etc.), a deconvolution will be performed using STRmix to statistically support whether an individual may be conditioned. The component interpretation contained in the STRmix output will be used to justify the assumption that a specific individual is a contributor to the mixture. Alternatively, an LR
supporting the assumption may be performed to the contributor in question and included in the case file. The subsequent LR must be $10^4$ or greater (the conclusive zone) to justify the use of the assumption to re-run the STRmix deconvolution using conditioning. It is analyst discretion as to whether to re-condition a deconvolution using the assumption of a contributor based on an inclusionary LR.

**Conditioning the deconvolution of environmental samples and calculating LRs**

Environmental samples in which individuals may have habitually touched or handled an item (e.g. bedding, steering wheel of car, items recovered from a domestic location where an individual is documented to reside, etc.), a deconvolution will be performed using STRmix to statistically support whether an individual may be conditioned. An LR supporting the assumption will be performed to the contributor in question and included in the case file. The subsequent unified LR must be $10^4$ or greater (the conclusive zone) to justify the use of the assumption to re-run the STRmix deconvolution using conditioning. It is analyst discretion as to whether to re-condition a deconvolution using the assumption of a contributor based on an inclusionary unified LR.

In the event a unified LR cannot be calculated due to having a difference of greater than one unknown contributor between the Hp and Hd propositions, the environmental sample will not be eligible for conditioning.

If an LR is performed to determine the potential inclusions of non-probative individuals (e.g., victims or consensual partners) for the purposes of conditioning a STRmix analysis, the individual likelihood calculations do not need to be included in the report, but must be available in the case file along with a note that the calculation was used to support conditioning the deconvolution.

### 9.7.7 Setting-up Propositions for the Calculation of the Likelihood Ratio (LR)

The likelihood ratio assesses the probability of the evidence given two alternate propositions or hypotheses; one that aligns with the prosecution (Hp) and one that aligns with the defense (Hd). Hp is typically inclusionary of the person of interest. The defense proposition typically aligns with the suspect’s innocence. When reasonable, the propositions are set to minimize the LR to grant conservatism to the defense. This can be undertaken by minimizing the number of unknowns within the different propositions.

Analysis should be set up with the first proposition (Hp in STRmix) comprising the person of interest, known individuals who may be assumed or conditioned, or unknown individuals, up to the number of contributors. The second proposition (Hd in STRmix) should consist of any assumed (or conditioned) individuals and then all unknown individuals up to the number of contributors.

**Examples**

Two-person mixture from intimate swab collected from victim. DNA profile corresponds to victim and suspect.

Hp: DNA originates from victim and suspect

Hd: DNA originates from victim and one unknown
Three-person mixture from firearm located at scene. One component corresponds to suspect.
Hp: DNA originates from suspect and two unknowns
Hd: DNA originates from three unknowns

Three-person mixture from firearm located at scene. One component corresponds to suspect 1 and another to suspect 2. Three LR s may be calculated:
Hp1: DNA originates from suspect 1 and two unknowns
Hp2: DNA originates from suspect 2 and two unknowns
Hp3: DNA originates from suspect 1, suspect 2, and one unknown
Hd: DNA originates from three unknowns

9.7.8 Deconvolution of Investigator 24plex QS profiles in v2.4 of STRmix
With the exception of conditioning a reasonably assumed contributor, all qualifying Investigator 24plex QS profiles will be deconvoluted in STRmix prior to the input of reference standards and the calculation of a LR statistic. Only single source profiles with all alleles above interpretation threshold may undergo an LR calculation with the included reference standard during a single STRmix run.
1) Log-on to the STRmix terminals from H:\Forensic Data\STRmix and launch STRmix from the Start Menu in the lower left hand corner.
   *Note:* Terminals STRMIX-2 H1-X38 to STRMIX-5 H1-X41 may be used for Investigator 24plex QS data.
2) To begin a new STRmix deconvolution and analysis, click “Start Analysis” from the Main Page.
3) Enter the Lab Case # and evidence item number into the “Case Number” and/or “Sample ID” field. Additional notes may be added to the “Sample ID” field such as “DECON” or into the free text “Case Notes” field, including whether conditioning is being utilized during the deconvolution.
   *Important! Do not use the “&” symbol in any of the fields. This will cause the software to error and a final report will not be accessible from the run.*
   *Note:* STRmix results folders are prefixed with the information entered into the Case Number field, followed by sample ID, then the date and time in the format yyyy-mm-dd-hh-mm-ss. The Analyst’s initials may also be added prior to the case number to assist in more quickly locating the results of the STRmix run.
4) Enter the “Number of Contributors” corresponding with the profile to be interpreted and click “Confirm”.

**ARCHIVED**
5) In the “Step 2: Add Evidence Profile Data” box, click “Add Profile” and then “Select Text File” in the box that appears. Navigate to H:\Forensic Data\STRmix\STRmix Run Files and select the file which contains the desired evidence profile for interpretation. The “Choose Profile Samples” box will appear listing all items contained within the text file. Select the evidence profile you wish to analyze and click “Add” and then “Add Profile Data”.

Note: Alternatively, the .txt file containing the desired evidence profiles may be dragged and dropped into the “Add Profile Data” screen, at which time the “Choose Profile Samples” box will appear listing all items contained within the text file. Select the evidence profile you wish to analyze and click “Add” and then “Add Profile Data”. If running replicates, all evidence profiles must be added to this box.

6) If utilizing the assumption of a reference standard to deconvolute the profile due to the reasonable expectation for their DNA to be present, from the “Add Reference Profile Data” box click “Add Profile” and then “Select Text File” in the box that appears. Navigate to H:\Forensic Data\STRmix\STRmix Run Files and select the file which contains the desired reference standards. The “Choose Profile Samples” box will appear listing all items contained within the text file. Select the reference standards you wish to analyze and click “OK” and then “Add EPG”.
Note: Alternatively, the .txt file containing the desired reference profiles may be dragged and dropped into the “Add Reference Profile Data” screen, at which time the “Choose Profile Samples” box will appear listing all items contained within the text file. Select the evidence profile you wish to analyze and click “Add” and then “Add Profile Data”.

- To fix the reference profile to both Hp and Hd, click on the desired reference standard and select “Change Hd”. Click “Confirm Settings”.

7) If a reference standard is being used during deconvolution, verify that the “NIST_Investigator_AA”, “NIST_Investigator_Cauc”, and “NIST_Investigator_Hisp” populations appear as follows in the “Step 3: Population Settings” box, along with all of the following settings:
8) If a reference standard is not being used during deconvolution, the “Step 3: Population Settings” box will be greyed out.

9) Click “Start” to begin the analysis.
10) Once the analysis is complete, click “Run Report” and then “Create Report” to generate the Advanced Report. Save the Advanced Report .pdf in the results folder by clicking “Save”. The Report will automatically open to be viewed. Close the Advanced Report box, and click “Finish”.

Caution! A .pdf report cannot be created after-the-fact without re-running the STRmix analysis.

9.7.9 Using Batch Mode for the Deconvolution of Multiple Profiles
Multiple profile deconvolutions may be set up using the “Batch Mode” of v.2.4 to be processed sequentially. From the main STRmix page, click “Batch Mode”.

1) Select “Change batch directory”
2) Navigate to the analyst’s “STRmix Run Files” folder on the H: drive and Select “Open”.

This will re-route the results of the current batch to ensure STRmix has the appropriate permissions to create the results folders.

3) Click “Add to Batch” to begin building a worklist of samples for analysis.
4) Refer to and follow the directions above to perform a deconvolution. Once each individual sample has been entered, click “Start”. The sample will be added to the “Samples in Batch” on the “Batch Mode Progress Screen”.

5) Repeat for each sample you wish to analyze. Once all samples have been added to the batch, click “Start Batch” to begin analysis.

6) The Advanced Reports will be automatically generated upon completion of all samples in the batch. The Advanced Reports may be found by navigating to the appropriate results folder.

7) Once all batched runs are finished (and prior to the completion of LR from Previous runs), manually copy and paste each of the results folders in their entirety to the location within the ++STRmix_Results_Folder for the terminal used. This will create a copy that is secured.  
   **Note:** The above steps must be completed each time a batch is run. The file directory path does not save between batches.
9.7.10 Calculation of Likelihood Ratios from Previously Deconvoluted Investigator 24plex QS profiles in v2.4 of STRmix

1) From the main STRmix page, click “LR from Previous Analysis”.
2) Navigate to desired STRmix Results folder and double click on the folder for the previously deconvoluted run. Select the “settings.ini” file contained in the run folder and click “Open”.
3) The “STRmix – Configure Analysis” box will automatically populate with the Case Number and Sample ID used during the previously run sample deconvolution.
4) Modify the “Sample ID” to include “_Compare to <insert reference Item #>”.
   Alternatively, you may use “_CT <insert reference Item#>” or “_LR to <insert reference Item#>”. You may type notes in the “Case Notes” field. All other fields will grey out. Click “Confirm”. 
5) The “Step 2: Add Evidence Profile Data” and the “Add Reference Profile Data” boxes will automatically populate with the profiles used during the previous deconvolution.

6) In the “Add Reference Profile Data” box click “Add Profile” and then “Select Text File” in the box that appears. Navigate to H:\Forensic Data\STRmix\STRmix Run Files and select the file which contains the desired reference standards which will be compared and used to calculate a likelihood ratio. The “Choose Profile Samples” box will appear listing all items contained within the text file. Select the reference standards you wish to analyze and click “OK” and then “Add EPG”. Click “Confirm Settings”.

   **Note:** Alternatively, the .txt file containing the desired reference profiles may be dragged and dropped into the “Add Reference Profile Data” screen, at which time the “Choose Profile Samples” box will appear listing all items contained within the text file. Select the reference profile you wish to analyze and click “Add” and then “Add Profile Data”.

7) Verify that the “NIST_Investigator_AA”, “NIST_Investigator_Cauc”, and “NIST_Investigator_Hisp” populations appear as follows in the “Step 3: Population Settings” box, along with all of the following settings:
8) Click “Start” to begin analysis.
9) Once the analysis is complete, click “Run Report” and then “Create Report” to generate the Advanced Report. Save the Advanced Report .pdf in the results folder by clicking “Save”. The Report will automatically open to be viewed. Close the Advanced Report box, and click “Finish”.

**Caution!** A .pdf report cannot be created after-the-fact without re-running the STRmix analysis.

### 9.7.11 Review of the Investigator 24plex QS STRmix Output

Upon completion of each STRmix interpretation, the Advanced Report will be generated and saved in .pdf format. The settings for the Advanced Report are given below. These setting can be found in the “Options” when first generating the Advanced Report at the completion of STRmix analysis:
Note: Two separate .pdf Advanced Reports will be generated and saved in the Results folder. One report will be abbreviated and will not include the Genotype Probability Distributions as noted in the settings above. A second report will be generated with the suffix “_AllSections” and contains the Genotype Probability Distributions. Only the abbreviated version will be printed and paginated for the case file, while the “_AllSections” version will be retained with the original Results folder for discovery and review.

Note: The Advanced Reports will be automatically generated for samples which are run in batch mode. The Advanced Reports associated with singular STRmix runs must be generated and saved manually at the completion of each run.

Note: It is not necessary to print or include the page(s) containing the evidence input file when printing the .pdf associated with “LR to Previous” analyses.

The Advanced Report includes the following sections, as applicable:

<table>
<thead>
<tr>
<th>Section Heading</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header</td>
<td>Versions of STRmix and Advanced Report used for analysis, date and time of analysis, case number, sample ID, and comments</td>
</tr>
<tr>
<td>Summary of Input Data</td>
<td>Kit used for analysis, number of contributors, input files, and propositions</td>
</tr>
<tr>
<td>Summary of Contributors</td>
<td>Per contributor: DNA amount, mixture proportion, degradation, and best fit contributor order (if applicable)</td>
</tr>
<tr>
<td>Run Information</td>
<td>Run diagnostics associated with deconvolution</td>
</tr>
<tr>
<td>Stutter Files Used in Run</td>
<td>Reverse, Forward, and Exceptions stutter .txt files used during deconvolution</td>
</tr>
</tbody>
</table>
Primary Run Diagnostics
The review and assessment of the primary run diagnostics will provide an indication as to how well STRmix has been able to describe the observed evidentiary data during deconvolution. Each of the following diagnostics must be evaluated using the locations within the profile with the most information (i.e. the greatest number of alleles present or where a known contributor has been conditioned). In the event that the quality of the profile is such that these evaluations cannot be made and compared against the STRmix output, the profile will be deemed unsuitable for STRmix analysis.

- **Review of Mixture Proportions**
  Where possible, the mixture proportions generated by STRmix must be assessed for their intuitiveness in comparison to the observed electropherogram. The percent contribution of the contributors can be calculated by applying the following formula:

  \[
  \text{Contributor percent contribution} = \frac{\sum \text{RFU values of the contributor alleles at the locus}}{\sum \text{RFU values of all alleles at the locus}}
  \]

  There may be times when stochastic DNA profiles contain sub-threshold data that is indicative of a possible mixture. These loci may be assessed to ensure the mixture proportions are appropriate given the quality and expected variability of the data present.

- **Review of Weights and Genotype Combinations**
  The weights and genotype combinations generated by STRmix must be assessed for their intuitiveness, where possible. The distribution of weights across the genotype combinations should be similar as to what the analyst would assign manually based on
pairing together alleles using the LVMPD-validated stratified peak height ratio expectations and mixture proportions.

**Secondary Run Diagnostics**

There are numerous diagnostics in the summary output of STRmix that may indicate that an interpretation has not completed as expected. These are found in the “Run Information” in the Advanced Report. An example is provided below.

### RUN INFORMATION

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Total Iterations</strong></td>
<td>742173.0</td>
<td><strong>Gelman-Rubin convergence diagnostic</strong></td>
<td>1.01</td>
</tr>
<tr>
<td><strong>(Acceptance Rate)</strong></td>
<td>(1 in 1.86)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Interreplicate efficiency</strong></td>
<td>PCR 1 - 100.00%</td>
<td>Allele variance (mode=2.156)</td>
<td>1.30</td>
</tr>
<tr>
<td><strong>Effective sample size</strong></td>
<td>25565.62</td>
<td>Stutter variance (mode=3.518)</td>
<td>2.30</td>
</tr>
<tr>
<td><strong>Average (log) likelihood</strong></td>
<td>54.29</td>
<td><strong>Seed value</strong></td>
<td>567167</td>
</tr>
<tr>
<td><strong>Mx prior mean</strong></td>
<td>n/a</td>
<td><strong>Mx prior variance</strong></td>
<td>n/a</td>
</tr>
</tbody>
</table>

- **Average (log) likelihood**
  This value shows the average log 10(likelihood) for the entire post burn-in during deconvolution. This is the log of the average likelihood (or probability) value created at each of the post burn-in iterations. The larger this value, the better STRmix has been able to describe the observed data. A negative value suggests that STRmix has not been able to describe the data very well given the information it has been provided (input file, number of contributors, stutter files, etc.).

  Reasons why this value may be low or negative include:
  - The profile is low-level and there is very little data making up the likelihood.
  - The number of contributors is incorrect and therefore STRmix must consider forced stochastic events to explain the profile (e.g. large heterozygote peak imbalances or variation in mixture proportions across the profile).
  - True data has been accidentally removed during GeneMapper ID-X analysis, particularly stutter peaks, and must now be described in STRmix by drop-out.
  - Artifactual peaks have been accidentally left labeled and must now be accounted for in STRmix by drop-in.

  A low or negative value for the average log10 (likelihood) may indicate that the analysis requires additional scrutiny.

  **Note:** High quality mixture DNA profiles are likely to give higher average log10 (likelihood) values than high quality single source profiles. Therefore low average log10 (likelihood) values alone are not necessarily an indicator of an issue.

- **Gelman-Rubin Convergence Diagnostic (GR Value)**
  This diagnostic informs the user whether the MCMC analysis has likely converged. STRmix uses eight (8) independent chains to carry out the MCMC analysis and ideally each chain will be sampling in the same space after burn-in.

  The following are reasons why the chains may have not converged during analysis:
Problematic GeneMapper ID-X analysis: an artifactual peak was accidentally left clicked on, a true allelic peak was accidentally removed, or smoothing/poor single bp resolution has resulted in the omission of a peak that STRmix expected to find in the input file.

- The assumed number of contributors is incorrect.
- The assumed contributor was incorrectly assigned.
- The complexity of the profile exceeds the capacity for STRmix to effectively describe the data.
- The analysis has not run long enough for the chains to converge in the same space.

Whether or not the chains have spent time in the same space can be gauged by the within-chain and between-chain variances. These two variances are used to calculate the variance of what is called the ‘stationary distribution’. If all chains have sampled the same space, then the within-chain variance and the variance of the stationary distribution will be approximately equal. If chains have spent time in different spaces, then the variation between the chains is likely to be larger than the variation within the chains. This is calculated by the Gelman-Rubin convergence diagnostic (GR), which is a ratio of the stationary distribution and within-chain variances.

For a converged analysis, the GR will be 1. If the GR is > 1.2, then there exists the possibility that the analysis hasn’t converged. If the GR value is > 1.2, the results of the analysis will be closely scrutinized as noted above in an attempt to determine if an issue with the data is resulting in the non-convergence.

GR values may be affected by run-to-run MCMC variability and therefore may differ slightly if the interpretation is re-run using the same parameters. Alternatively, when all other possible reasons for non-convergence have been eliminated, the analysis may be re-run increasing the number of required accepts for both the MCMC and burn-in by a factor of 10. Documentation will be maintained in the case file that the data was re-scrutinized to ensure that the above-referenced issues are not present which may have resulted in the non-convergence. This re-examination of the data must take place prior to re-running STRmix using the same parameters or for extended iterations.

Only the first page of the STRmix deconvolution must be printed and retained in the case file when an additional deconvolution will take place using extended iterations.
• **Allele Variance and Stutter Variance Constants**
  Each of these values represent the average value for allele variance and stutter variance constants across the entire post burn-in period. These values can be used as a guide as to the level of stochastic variation in peak heights that is present in the profile.
  o If the variance constant has increased markedly from the mode of the prior distribution (see below), then this may indicate that the DNA profile is sub-optimal or that the number of contributors is incorrect. Used in conjunction with the average log10 (likelihood), a large variance or stutter variance constant can indicate poor amplification.
  o If the sample is simply low-level, this may result in a low average log10 (likelihood) and an average variance constant.
  o If some data has been omitted, left on, or misinterpreted, this may result in a low average log10 (likelihood) and high variances.

• **Total Iterations**
  The value displayed in this section indicates the total number of post burn-in iterations that ran during deconvolution. This value, along with the number of accepts chosen for the analysis, can inform the user as to how often a new proposed set of parameters was accepted by STRmix. This is referred to as the acceptance rate.

  The acceptance rate is calculated by dividing the total number of iterations by the required 400,000 post burn-in accepts.
  **Note:** The acceptance rate is not displayed in the Run Information associated with version 2.3 of the STRmix software used for Identifiler Plus analysis.

  A very low acceptance rate (e.g. 1 in thousands to millions) may, in combination with the other diagnostics, indicate that the analysis needs to be run for additional iterations. However, on its own (and without any other indication of sub-optimal results), a low acceptance rate is not an indication that additional or re-work is required.

• **Effective Sample Size**
  Effective sample size (ESS) is the number of independent samples the MCMC has taken from the posterior distribution of all parameters. A low ESS in relation to the total number of iterations suggests that the MCMC has not moved very far with each step or has had a low acceptance rate. A low absolute value of ESS (e.g. 10s or 100s) will mean that there is potential for a large difference in weights if the analysis were to be run again in STRmix. This will be taken into account during HPD interval generation in any LR calculations.
(unless the genotype sets are completely resolved on a single combination, in which case there will be no effect of ESS on the HPD interval). A low ESS on its own is not an indication that additional or re-work is required.

**Reviewing the Run Diagnostics**

Each diagnostic will be reviewed in conjunction with the evidentiary profile, weights, and the other diagnostics. The review of the run diagnostics is an important part of the interpretation process. The values in the plots below give an indication of the range of values expected for some of the diagnostics for different contributors based on the LVMPDs internal Investigator 24plex QS validation data.

![Graphs](image)

**Troubleshooting**

It is important when a STRmix analysis is carried out, that the results are interpreted by examining the weightings of various genotypes and the DNA profile(s) observed. There are instances when the results obtained do not intuitively seem correct. Examples of this are:

- Large LRs (greater than 1) are obtained for all loci, except one locus where the LR is 0, and the reference standard is consistent with the evidence profile.
- The mixture proportions do not reflect what is observed.
- The degradation does not reflect what is observed.
- The interpreted contributor genotypes are not intuitively correct.

The following may have caused the observed issues:

- The incorrect input file was selected for analysis.
- The GeneMapper ID-X project was edited incorrectly.
- The number of contributors is incorrect.
- The assumed contributor was incorrectly designated.
- The PCR has been affected by inhibition.
- The MCMC has not run for enough iterations.
Should the weights and/or the diagnostics highlight to the analyst that further scrutiny is required, then a number of re-work options may be considered. A review will be conducted of the proposed number of contributors. Additional analytical work such as a re-run or a re-amplification may be performed to strengthen the assumption regarding the number of contributors or to assist with allele designation/sub-optimal amplification performance.

The total MCMC iterations and burn-in may be increased by a factor of 10 if the acceptance rate is low, the ESS is low, and/or the GR value is significantly above 1.2. This should only be performed after all potential sources of the problems have been eliminated by verifying the input file used during analysis, the selected reference standards used for assumptions, the designated number of contributors, etc.

The following table is meant as a quick reference guide to aid with troubleshooting:

<table>
<thead>
<tr>
<th>Observation</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The mixture proportions do not reflect what is observed in the electropherogram AND/OR the degradation does not reflect what is observed in the electropherogram AND/OR the interpreted contributor genotypes are not reasonably intuitive.</td>
<td>Verify that the correct table setting was used to export the samples from GeneMapper ID-X by reviewing the evidence input file(s) to ensure they contain allele, height, and size information.</td>
</tr>
<tr>
<td>A low or negative average (log) likelihood.</td>
<td>Re-evaluate the number of contributors used during deconvolution. Consider re-running the STRmix deconvolution using one more or one fewer number of contributors.</td>
</tr>
<tr>
<td>Gelman-Rubin value is &gt; 1.2.</td>
<td>Data has been removed from the GeneMapper ID-X project that is truly allelic and/or stutter. The data must be re-inserted and re-imported into STRmix.</td>
</tr>
<tr>
<td>Data has been removed from the GeneMapper ID-X project that is truly allelic and/or stutter. The data must be re-inserted and re-imported into STRmix.</td>
<td>Re-evaluate the number of contributors used during deconvolution. Consider re-running the STRmix deconvolution using one more or one fewer number of contributors.</td>
</tr>
<tr>
<td>Artifact peaks have been left labeled in the GeneMapper ID-X project. The peaks must be removed and re-imported into STRmix.</td>
<td>Assign the original DNA profile and Q and S markers to determine if inhibition may be present. Perform a microcon clean-up of the sample and re-amplify.</td>
</tr>
<tr>
<td>Gelman-Rubin value is &gt; 1.2.</td>
<td>Data has been removed from the GeneMapper ID-X project that is truly allelic and/or stutter. The data must be re-inserted and re-imported into STRmix.</td>
</tr>
<tr>
<td>Issue</td>
<td>Resolution</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>The 3130XL and/or GeneMapper ID-X has failed to resolve a single bp peak (either allelic or stutter). Re-amplify or re-load the sample on the 3130XL to attempt to resolve the smoothing. If unresolved, re-run the STRmix deconvolution ignoring the locus with the failed single bp resolution.</td>
<td>Consider re-running the STRmix deconvolution using an increased number of iterations.</td>
</tr>
</tbody>
</table>
| Stutter and/or allele variance significantly elevated above the mode (may occur in conjunction with a low average (log) likelihood). | Verify that data has not been removed from the GeneMapper ID-X project that is truly allelic and/or stutter.  
Allelic or stutter peak is being artificially inflated due to the additive effects of pull-up. Re-amplify or re-load the sample on the 3130XL using less template to attempt to resolve the pull-up. If unresolved, re-run the STRmix deconvolution ignoring the locus with the problematic additive pull-up. |
| LRs >1 obtained for each locus except one where the LR = 0 or LR < 1 and the POI reference is consistent with the evidentiary profile. | Verify that the data is not suffering from loss of resolution at the larger loci. If loss of resolution is occurring in a low-level or mixed sample, re-inject, re-load, or re-amplify the sample in order to resolve the issue. Robust single source samples may be interpreted with caution to ensure the final deconvolution conforms to expectation.  
Re-evaluate the number of contributors used during deconvolution. Consider re-running the STRmix deconvolution using one more or one fewer number of contributors.  
Consider amplifying a replicate of the evidence sample if one has not already been created. Utilize an increased amount of template when available. |
| The incorrect input files were selected during STRmix set-up. Verify the input files used during the run. | The 3130XL and/or GeneMapper ID-X has failed to resolve a single bp peak (either allelic or stutter). Re-amplify or re-load the sample on the 3130XL to attempt to resolve the smoothing. If unresolved, re-run the STRmix deconvolution ignoring the locus with the failed single bp resolution.  
The evidence profile contains saturated data that is not being modeled appropriately in STRmix. Re-amplify or re-load the sample on the 3130XL using less template to attempt to resolve the saturation. If
<table>
<thead>
<tr>
<th>Issue Description</th>
<th>Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unresolved, re-run the STRmix deconvolution ignoring the locus with the problematic saturation.</td>
<td></td>
</tr>
<tr>
<td>Multiple diagnostics display sub-optimal results.</td>
<td>Once all other actions have been exhausted, consider deeming the profile inconclusive due to the complexity of the data.</td>
</tr>
<tr>
<td><img src="image1.png" alt="Error message" /></td>
<td>The number of contributors designated is too few and must be increased.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Error message" /></td>
<td>“Start and Search” was clicked rather than “Start”. Analysis must be re-set up and performed again.</td>
</tr>
<tr>
<td>The STRmix run does not progress at the MCMC burn-in stage and the chains do not move. Error message also received that states Degradation started at “0”.</td>
<td>Check “allele per locus” setting for both the evidence and reference input files is set to 20.</td>
</tr>
<tr>
<td>The STRmix run does not progress past the MCMC burn-in stage and the log likelihood are listed as Infinity and/or NaN.</td>
<td>The number of contributors designated is too few and must be increased.</td>
</tr>
<tr>
<td>The &quot;GenotypePdf3T.txt&quot; file from the results folder is corrupted or missing when attempting to run an LR from Previous Analysis. Check the STRmix Run Folder for the associated deconvolution to ensure all files are present. If the file is not present, the deconvolution may need to be re-run.</td>
<td></td>
</tr>
</tbody>
</table>
Retention of Unreported STRmix Runs

STRmix output files will be maintained in the case file when all diagnostics indicate the interpretation ran appropriately, however the review of the output results in the analyst deciding to perform additional STRmix analyses or lab work. Examples include when review of the STRmix output indicates the originally assigned number of contributors may be incorrect, the decision to perform a replicate amplification, or the decision to perform an additional deconvolution with the use of conditioning. The original STRmix output file will be maintained in the case file along with documentation as to why it is not being reported.

9.7.12 Dealing with Uncharacterized Variants, Allelic and Chromosomal Abnormalities, Allele Resolution and Technical Issues in STRmix 2.4

The basis for STRmix deconvolution is that the expected height of a peak of a certain size, at a given locus, can be determined given a set of mass parameters (to include the amount of DNA template, degradation, and locus-specific amplification efficiency). In the event biological factors impact the peak height of an allele in an evidence sample, or if there are issues with the designation of the appropriate allele call in GeneMapper ID-X of an evidence sample, STRmix is unable to appropriately model the data. Examples include:

- Primer binding site mutations
- Tri-alleles
- Somatic mutations
- Null alleles
- Saturation
- Technical issues such as loci compromised by potential pull-up or poor single bp resolution. The poor single bp resolution may occur between two true peaks (ex. 9.3, 10 at TH01), or between a stutter peak and a true peak.
If it is suspected that the evidence data is affected by one of the above examples, the “Ignore Locus” function under “Run Settings” in v2.4 will be used to ignore the affected locus from an interpretation prior to deconvolution. When using the ignore locus function, all reference profiles must be manually compared to the omitted loci. A record will be made within the “Case Notes” box of the STRmix run (i.e. the “Comments” field of the STRmix output file) specifying the locus omitted and the reason for the omission. Alternatively, documentation regarding why a locus was omitted may be included on the electropherogram.

Note: In the event a sample is single source, it is not necessary to ignore a locus when an unresolved stutter peak is present on the shoulder of a true allele peak. The stutter variance may be elevated for the STRmix run, however it should not affect the ability for STRmix to appropriately assign the true genotype at the affected locus. This will be verified by the analyst in the review of the STRmix output.

Note: Mixture profiles with poor single bp resolution at a locus must be evaluated to determine whether the peak height of the unresolved allele may be considered as allelic within the profile and whether the weights of the deconvoluted genotypes are appropriately considering the possibility of a Q-allele. If the STRmix deconvolution at the affected locus does not conform to expectation, the deconvolution must be re-run omitting the locus.

Note: Mixed samples which exhibit saturated data may be re-amplified using less input DNA or may be diluted with formamide and re-loaded in an attempt to resolve the saturation issues. Alternatively, loci exhibiting saturated data may be omitted from the STRmix analysis utilizing the procedure below. No more than one locus per color channel may be omitted due to saturation. Saturated single source samples which do not exhibit any indications of containing a mixture may be interpreted with caution. The STRmix output file will be critically evaluated to ensure the deconvolution conforms to expectations.

1) Click “Run Settings” from the STRmix – Configure Analysis box and then the “Ignore Loci” icon from the STRmix – Run Settings box.
2) Select the loci to ignore and then click “>” to move them to the “EXCLUDE” box. Click “Save”.

There may be situations where it is not possible to identify the above abnormalities in the evidentiary profile prior to deconvolution and the unmasking of reference profile data (e.g. failure to recognize possible tri-allelic patterns or primer binding site mutations in mixture DNA profiles). If, after unmasking information contained within a reference standard, it appears that the original deconvolution may be affected by the presence of these abnormalities, the number of contributors used for interpretation will be re-evaluated to ensure it is still appropriate given the new information. If yes, the STRmix output will be re-verified to ensure the results are intuitively correct given the expected mixture proportions and genotypes.

Once verified, the affected locus may be ignored during the “LR from Previous” calculation. Documentation must be included in the case file as to why the locus is being omitted from the LR calculation, to include documentation that a manual comparison of the reference standard to the evidence at the omitted locus does not result in an exclusion.

In the event the number of contributors changes as a result of the unmasking, the STRmix deconvolution will be re-run using the appropriate number of contributors and the affected locus will be omitted from interpretation. Documentation must be included in the case file as to why the locus is being omitted from deconvolution. The results of the original interpretation will be retained in the case file, along with documentation as to the reason it is being rejected.

9.7.13 Off-Ladder Alleles and OMRs
Non-numeric values such as OL, < or >, or OMR (outside marker range) are not permitted within the STRmix input files. Unambiguous alleles (to include confirmed OLs) must appear in the corresponding input file as their actual allelic size designation.

Note: Peaks in stutter positions of unambiguous alleles which do not fall into bins must be manually designated as their actual allelic size designation prior to export from GeneMapper ID-X. These OL peaks do not require confirmation.
Alleles labeled OMR must be manually assigned in GeneMapper ID-X to the locus where they belong, when possible. OMRs will be treated as off-ladder alleles and require confirmation. To assign an OMR to a marker in GeneMapper ID-X:

- Click on the locus header on the electropherogram to select the locus where the OMR is to be assigned.
- Click on the OMR peak to select it and then right click and select "Add allele label".
- Manually add the allele call to the box. The marker name will be displayed where the peak will be assigned.

In the event a < or > allele or OMR falls more than two repeat units from the end of the ladder, the locus must be removed from the deconvolution using the "Ignore Locus" option above due to the possibility that the alleles are not being sized accurately. In the event it cannot be determined which locus an OMR belongs to, both loci will be removed from the deconvolution using the "Ignore Locus" function.

If a LR is calculated, the reference standard must be manually compared at all ignored loci to ensure the locus does not result in an exclusion.

**Note:** In certain circumstances, the stutter product for an OMR allele may appear as an allele assigned to the neighboring locus. Due to limitations of the GeneMapper ID-X software, it is not possible to re-assign the locus for the stutter peak to accompany its parent allele when the OMR allele ultimately is not associated with this same locus. Seek assistance from the DNA Technical Leader how to best address this rare occurrence for STRmix analysis.

- Example: The 13-allele at the D12S391 locus of QIAGEN Investigator 24plex QS profile will appear as OMR allele between D1S1656 and D12S391 while its stutter will appear as 19.3-allele at D1S1656. The OMR allele can be assigned as 13-allele of the D12S391 locus, however, the 19.3 cannot be reassigned. Moreover, a similar OMR allele determined to be 20.3 at D1S1656 can be assigned manually to accompany its stutter.

- Due to stutter filters not being applied to OMR peaks, the user must manually determine whether the stutter peak can be deleted from the locus-specific stutter filtered GeneMapper ID-X project based upon the stutter filter settings of the assigned locus.

### 9.7.14 Backwards Compatibility and Supplemental Analysis

STRmix can open files in v2.4 generated from analysis undertaken in the previous version v2.3. For example, a mixture deconvolution in Identifiler Plus in v2.3 can be used to calculate an “LR from Previous Analysis” in v2.4 by navigating to the relevant “settings.ini” file within the original Identifiler Plus run Results folder.
STRmix allows the user to calculate a likelihood ratio when the evidence and reference samples are analyzed in different amplification kits. LRs will only be provided for those loci in common between the two kits. In the event multiple reference standards are being considered in a single proposition, the calculated LR will be provided for only the loci in common between all of the references and the evidence profile.

For this analysis, both the evidence sample and the reference sample must be input from .txt files. This function also works with the “LR from Previous Analysis” provided that the .txt files have been inputted into STRmix (as created from GeneMapper ID-X), rather than .csv files. The amplification kit associated with the evidence sample must be selected in the STRmix entry screen.

**Note:** If the reference is to be used as a conditioning reference, the locus order of the reference will be adjusted during the conversion of the .txt file to a .csv file in STRmix to match the order of the evidence sample.

### 9.7.15 Use of DNA Profile Searcher for Single Source Unknown Profiles

The DNA profiles of all members of the Forensic Laboratory, crime scene analysts, sexual assault nurse examiners, detectives, and investigating agents of the LVMPD and other law enforcement agencies who have provided their DNA sample on a voluntary basis are contained within the “DNA Profile Searcher” on the H:drive for comparison to casework and database samples. In addition, profiles from unattributable contamination events and samples voluntarily provided by visitors to and vendors of the Forensic Laboratory are also contained within this searchable spreadsheet.

All unknown single source profiles and mixtures generated during in-house casework which contain component(s) with complete genotypes resolved to 100% for at least six (6) of the core CODIS loci will be searched in the “DNA Profile Searcher” prior to being reported. Loci containing obligate alleles which have exceeded the $\geq 99\%$ threshold in STRmix may be utilized to further refine your search to ensure the identified individual is a possible match. This search will help to ensure that the unknown profile does not belong to a staff member or other attributable contaminant. The completion of the search and the date will be tracked in the analyst checklist contained on the casework review form.

**Using the DNA Profile Searcher**

- Launch to “++DNA Profile Searcher++” file located at H:\Forensic Data\DNA\OTHER\Staff Index.
- The Searcher defaults to opening with a view of all of the DNA profiles contained within the spreadsheet in Identifiler Plus locus order. To begin searching a possible contaminant profile, choose the first locus where contamination may be occurring and select the first drop-down arrow on the left for that locus.
- Click “(Select All)” to uncheck the box which automatically shows all DNA profiles containing any allele at that locus.
- Click both the box denoting the smallest allele present in the possible contaminant profile and click the box denoting “(Blanks)”. Then Click “OK”.
- Select the second drop-down arrow on the right for the locus to enter the second allele and “(Blanks)”. In the event the contaminant profile is homozygous and thus only contains one allele, only the box for “(Blanks)” should be selected.
**Note:** Do not search any partial loci where there is a possibility of dropout. Only complete loci should be searched.

- Continue to add the possible contaminant DNA profile information at the additional loci where contamination may have been detected. The “DNA Profile Searcher” will automatically filter out any profile which does not meet the user designated allelic criteria.

**Note:** If more than one profile remains after searching all complete loci, manually compare the alleles at each locus from each of the remaining profiles to the partial loci in the searched profile to further eliminate/narrow down possible sources.

- When closing the “DNA Profile Searcher” program, the user will be asked if they wish to save the changes made to the program. Click “Don’t Save” to exit the program.
- The use of the “DNA Profile Searcher” must be documented on the analyst checklist contained on the casework review form along with the date the search was performed.

### 9.7.16 Deconvolution of Identifiler Plus profiles in v2.3 of STRmix

All qualifying Identifiler Plus profiles will be deconvoluted in STRmix prior to the input of reference standards and the calculation of a LR statistic. Only single source profiles with all alleles above interpretation threshold may undergo an LR calculation during a single STRmix run.

1. Log-on to the “ID PLUS_STRMIX-1 H1·X37” terminal from H:\Forensic Data\STRmix and launch STRmix from the Start Menu in the lower left hand corner.
2. To begin a new STRmix deconvolution and analysis, click “Start Mixture Analysis” from the Main Page.
3. Enter the Lab Case # and evidence item number into the “Case Number” and/or “Sample ID” field. Additional notes may be added to the “Sample ID” field such as “DECON” or into the free text “Case Notes” field, including whether conditioning is being utilized during the deconvolution.

**Important!** Do not use the “&” symbol in any of the fields. This will cause the software to error and a final report will not be accessible from the run.

**Note:** STRmix results folders are prefixed with the information entered into the Case Number field, followed by Sample ID, then the date and time in the format yyyy-mm-dd-hh-mm-ss. The Analyst’s initials may also be added prior to the case number to assist in more quickly locating the results of the STRmix run.

4. Enter the “Number of Contributors” corresponding with the profile to be interpreted and click “Confirm”.
5) In the “Step 2: Set Evidence EPGs” box, click “Add EPG” and then “Find Text File” in the box that appears. Navigate to H:\Forensic Data\STRmix\STRmix Run Files and select the file which contains the desired evidence profile for interpretation. The “Genemapper sample chooser” box will appear listing all items contained within the text file. Select the evidence profile you wish to analyze and click “OK” and then “Add EPG”.

Note: If running replicates, all evidence profiles must be added individually to this box.

6) If utilizing the assumption of a reference standard to deconvolute the profile due to the reasonable expectation for their DNA to be present on an evidence item (i.e. the victim on an intimate sample), from the “Set Reference EPGs” box click “Add EPG” and then “Find Text File” in the box that appears. Navigate to H:\Forensic Data\STRmix\STRmix Run Files and select the file which contains the desired reference standard which will be assumed during deconvolution. The “Genemapper sample chooser” box will appear listing all items contained within the
text file. Select the reference standards you wish to analyze and click “OK” and then “Add EPG”.

- To fix the reference profile to both Hp and Hd, click on the desired reference standard and select “Change Hd”. Click “Confirm Settings”.

7) If a reference standard is being used during deconvolution, verify that the “FBI Expanded Loci_African American”, “FBI Expanded Loci_Caucasian”, and “FBI Expanded Loci_SWH” populations appear as follows in the “Step 3: Population Settings” box, along with all of the following settings:
8) If a reference standard is not being used during deconvolution, the “Step 3: Population Settings” box will be greyed out.

9) Click “Start” to begin the analysis.
10) Once the analysis is complete, click “Run Report” and then “Create PDF” to generate the Advanced Report. Save the Advanced Report .pdf in the results folder by clicking “Save”. The Report will automatically open to be viewed. Close the Advanced Report box, and click “Finish”

*Note: A .pdf report cannot be created after-the-fact without re-running the STRmix analysis.*
9.7.17 Calculation of Likelihood Ratios from Previously Deconvoluted Identifiler Plus profiles in v2.3 of STRmix

1) From the main STRmix page, click “LR from Previous Analysis”.
2) Navigate to STRmix Results folder and double click on the folder for the previously deconvoluted run. Select the “Settings.ini” file contained in the run folder and click “Open”.

3) The “STRmix” box will automatically populate with the Case Number and Sample ID used during the previously run sample deconvolution.
4) Modify the “Sample ID” to include “_Compare to <insert reference Item #>”. You may type notes in the “Case Notes” field. All other fields will grey out. Click “Confirm”.

ARCHIVED
5) The “Set Evidence EPGs” box and the “Set Reference EPGs” box will automatically populate with the profiles used during the previous deconvolution.

6) In the “Set Reference EPGs” box click “Add EPG” and then “Find Text File” in the box that appears. Navigate to H:\Forensic Data\STRmix\STRmix Run Files and select the file which contains the desired reference standard which will be compared and used to calculate a likelihood ratio. The “Genemapper sample chooser” box will appear listing all items contained within the text file. Select the reference standards you wish to analyze and click “OK” and then “Add EPG”. Click “Confirm Settings”.

7) Verify that the “FBI Expanded Loci_African American”, “FBI Expanded Loci_Caucasian”, and “FBI Expanded Loci_SWH” populations appear as follows in the “Step 3: Population Settings” box, along with all of the following settings:
8) Click “Start” to begin the analysis.
9) Once the analysis is complete, click “Run Report” and then “Create PDF” to generate the Advanced Report. Save the Advanced Report .pdf in the results folder by clicking “Save”. The Report will automatically open to be viewed.

9.7.18 Review of Identifiler Plus STRmix Output
On completion of the interpretation, the Advanced Report will be generated and saved in .pdf format. The settings for the Advanced Report are given below. These setting can
be found in the “Options” when first generating the Advanced Report at the completion of STRmix analysis:

Identifiler Plus: Prior Distribution of Allele and Stutter Variance

9.7.19 Dealing with Uncharacterized Variants, Allelic and Chromosomal Abnormalities, Allele Resolution and Technical Issues in v2.3 of STRmix

The “Ignore Locus” function under “Other Setting” in v2.3 will be used to ignore the affected locus from an interpretation. When using the ignore locus, all reference profiles must be manually compared to the omitted loci. A record must be made within the “Case Notes” box of the STRmix run specifying the locus omitted and the reason for the omission.

1) Click “Other Settings” from the sample entry page and then the “Ignore Loci” icon from the Advanced Settings box.
2) Select the loci to ignore and then click “->” to move them to the “IGNORE” box. Click “Save”.

### 9.8 Interpretation of a Contaminated Control or Sample

Acceptable results for the reagent blank, negative amplification control and positive amplification control have been previously described in this manual. There are several types of contamination which can be categorized as either attributable or unattributable. Attributable contamination describes a contamination event where the source of the contamination is known and can be identified. Unattributable contamination describes a contamination event where the source of the contamination is unknown and cannot be identified.

The DNA profiles of all members of the Forensic Laboratory, crime scene analysts, nurse examiners, detectives, and investigating agents of the LVMPD and other law enforcement agencies who have provided their DNA sample on a voluntary basis are contained within the “DNA Profile Searcher” on the H:drive for comparison to casework and database samples. In addition, profiles from unattributable contamination events and samples voluntarily provided by visitors to and vendors of the Forensic Laboratory are also contained within the searchable spreadsheet.

All profiles entered into LDIS are searched against the Elimination/Staff Index prior to upload to SDIS. The Elimination/Staff Index also contains all of the profiles mentioned above, with the exception of the unattributable contamination profiles.

Moreover, many elimination and staff profiles are in GeneMapper ID-X for comparison against casework and database sample profiles. Documentation of the use of the “GeneMapper ID-X Comparison Tool” and/or “DNA Profile Searcher” will be maintained in the case file.

All reported unknown profiles generated during in-house casework which would be subject to the calculation of a single source LR will be searched in the “DNA Profile Searcher” prior to being reported to ensure that the unknown profile does not belong to a staff member or other attributable contaminant. The completion of the search and the date will be tracked in the
analyst checklist contained on the casework review form. Refer to “Use of DNA Profile Searcher for Single Source Unknown Profiles” for instructions on how to use the spreadsheet. Profiles which are found to be consistent with an individual contained in the “DNA Profile Searcher” will be reported as attributable contamination.

The Biology/DNA Detail makes the distinction between three types of attributable contamination:
1) Contamination that occurs within the DNA lab as a result of the DNA examiner’s direct handling of the sample (analyst profile in control or sample and sample-to-sample contamination)
2) Contamination that occurs prior to being processed by the DNA examiner in the DNA lab by someone with reasonable access to the evidence
3) Contamination detected using the “DNA Profile Searcher” and/or Staff Elimination Database for all other individuals

9.8.1 Attributable Contamination

Contamination by the DNA examiner(s) in the case
If contamination of any sample or any negative control can be attributed to a DNA examiner’s (e.g. Forensic Scientist, Forensic Laboratory Technologist, etc.) handling of the evidence or samples, the contamination will be documented in a case note and the sample will be re-processed through re-injection, re-amplification, re-load and/or re-extraction if possible. If resolved, the data may be used and the contamination does not need to be mentioned in the report. If the contamination cannot be resolved (i.e., no extract remaining, cannot be re-extracted), a Corrective Action Report will be documented.

If the contaminated sample is a mixture, a new buccal swab will be requested and collected from the DNA examiner for confirmation with the profile in the Staff/Elimination Index. The known DNA profile of the DNA examiner may be used to condition the STRmix deconvolution in an attempt to further resolve the mixture DNA profile. All data associated with the buccal swab confirmation will be included in the case file. The name of the DNA examiner will not be used in the naming of the Sample ID or listed with the associated with the worksheet documentation. Refer to Assumed Contributors for additional information for conditioning deconvolutions from environmental samples.

A case note will be included in the case file to thoroughly document the circumstances of the case and the course of action being taken. The title of the DNA examiner will be generically identified in the report as an assumed contributor (e.g. Forensic Scientist, Forensic Laboratory Technologist, etc.).

If the entire DNA profile can be attributed to the examiner, the sample will be reported as inconclusive and the source of the contamination will be identified in the report.

In the event, the DNA examiner refuses to provide a new buccal swab, then the contaminated evidentiary profile will be reported as inconclusive.

Refer to “Contamination Attributable to an Internal DNA Laboratory Processing Event” for reporting statements.
**Contamination by an individual with documented reasonable access to the evidence**

If contamination of a sample (to include outsourcing samples not previously searched in the “DNA Profile Searcher”) can be attributed to a member in the Elimination/Staff Index who had reasonable access to the evidence outside the control of the DNA analyst (e.g. CSA, authorized individual on scene, etc.), the contamination will be documented in a case note. The individual attributable to the exogenous DNA will be notified that the source of the contamination will be referenced in the report.

When applicable and the contaminated sample is a mixture, a new buccal swab will be requested and collected from the individual for confirmation with the profile in the Staff/Elimination Index. The known DNA profile of the individual may be used to condition the STRmix deconvolution in an attempt to further resolve the mixture DNA profile. All data associated with the buccal swab confirmation will be included in the case file. The name of the individual will not be used in the naming of the Sample ID or listed with the associated with the worksheet documentation. Refer to **Assumed Contributors** for additional information for conditioning deconvolutions from environmental samples.

The case note will thoroughly document the circumstances of the case and the course of action being taken. The title of the individual will be generically identified (e.g. Crime Scene Analyst, etc.) in the report as an assumed contributor.

If the entire DNA profile can be attributed to the individual, the sample will be reported as inconclusive and the source of the contamination will be identified in the report.

In the event, the individual refuses to provide a new buccal swab, then the contaminated evidentiary profile will be reported as inconclusive.

Refer to “**Contamination Attributable to an Individual External to the Laboratory Processing Events**” for reporting statements.

**All other attributable contamination**

If contamination of a sample can be attributed to a member in the Elimination/Staff Index who did not have direct access to the evidence (e.g. maintenance workers, etc.), the contamination will be documented in a case note.

The sample will be reported and, if applicable, the individual attributable to the exogenous DNA will be notified that the source of the contamination will be referenced in the report. Typically, these samples will not be re-processed; however, other probative evidence may be available for testing. Refer to “**Contamination Attributable to an Individual External to the Laboratory Processing Events**” for reporting statements.

**Elimination standards submitted for direct comparison**

In the event an elimination standard is received from a detective or officer with a request for the direct comparison to evidence profiles developed from the case, the sample will be reported using the results (and statistics, if applicable) of the direct comparison. A case note is not required to be included in the case file.
9.8.2 Unattributable Contamination

Evidentiary profiles processed in-house which are suspected of unattributable contamination should be entered into and compared against profiles contained in the “DNA Profile Searcher” located on the H:drive. If the profile is consistent with a profile in the spreadsheet and/or suspected of being a contaminant, the profile will not be used for case comparisons or entered into CODIS.

Reagent blanks and negative amplification controls will be examined for the presence of any true allelic peaks indicative of a profile above the kit-specific analytical threshold. An attempt should be made to remediate the contamination through re-injection, re-load or re-amplification. If resolved, the data may be used and the contamination does not need to be mentioned in the report, but must be reflected in the analyst’s laboratory notes. If the peaks are not resolved the associated samples will be reported as inconclusive and the contamination will be mentioned in the report. In extreme circumstances, the data may be reported with the documented approval of the Technical Leader. Refer to “Contamination Report Statements” for reporting statements.

The DNA Technical Leader will be notified of all unattributable contamination and the contaminant profile will be added to the “DNA Profile Searcher”. If unattributable contamination in the “DNA Profile Searcher” shows a repeat pattern, the Technical Leader will determine the next warranted action. Actions may include notifying the manufacturer of a consumable or posting such information on a DNA information website to see if other laboratories have identified the same issue. If the contamination stems from something within the control of the DNA Laboratory, a “Corrective Action Report” will be completed.

In any case of unattributable contamination, the analyst will also create a “case note” for their case file and a copy shall be forwarded to the DNA Technical Leader for approval prior to report release.

Electronic copies of affected electropherograms and any resultant case notes generated will be maintained within the “Exogenous DNA Log” (E-DNA) folder (H:\Forensic Data\DNA\OTHER\Exogenous DNA Log). A hard copy binder of E-DNA entries prior to December 2014 has been archived and will be maintained in Qualtrax for reference.
10.0 Title: Creation of Allele Tables and Use of Ribbon Accessories

The Biology/DNA Detail has developed an Excel workbook named “ALLELEigator” to summarize STR DNA typing results in a standard format, known as an allele table, to serve as documentation for case files. After using GeneMapper ID-X v1.3 to analyze electrophoresis data, the analyst will export a text file from GeneMapper that is imported into ALLELEigator to create the allele tables.

For cases interpreted using STRmix, only reference standard profiles will be contained in the allele tables included in the case files.

Note: The code and templates in ALLELEigator make several assumptions in order to automatically generate allele tables; the following considerations should be used in order to most efficiently use this workbook:

- Samples must be named consistently; ALLELEigator uses a parsing key, such as analyst initials or the word “Item” (case sensitive) to locate both sample names and event or lab numbers from exported GeneMapper .txt files
- ALLELEigator assumes that samples are named by Event # followed by sample name with a place holder in between, such as a dash “-” or underscore “_”
- ALLELEigator is only adapted to handle a maximum of 96 samples from a single event or lab number from a single GeneMapper ID-X project
- The default page setup in ALLELEigator is set to print 1 page for each allele table, although the template contains up to 12 pages of tables (reset print area as needed)

10.1 Preparing to use ALLELEigator
Refer to Appendix B to set up Excel for DNA workbook use.

10.2 Exporting GeneMapper ID-X .txt files for ALLELEigator
Ensure that the Sample Type for all APC samples is set to Positive Control and that all ANC samples and reagent blanks are set to Negative Control in the main GeneMapper ID-X application window; all ladders must be named LADDER_INV24 or LADDER_6C for the macro to work properly.
• Choose the **ALLELEigator** table setting from the drop-down menu
• Choose **File Export → Combined Table**
• Enter the name of the exported GeneMapper ID-X table and choose the destination folder
• You can use the remaining default settings
• Click the **Export Combined Table** button

### 10.3 Using ALLELEigator to Automatically Generate Allele Tables

All alleles above the 50 RFU analytical threshold are represented on the allele table.

1) Open **ALLELEigator** and select the **tiffCAKE** tab on the ribbon to access ALLELEigator’s controls.
2) Enter the parsing key (analyst initials or Item) where indicated on the ribbon; the parsing key must match up with sample names (case-sensitive).
3) Enter the GeneMapper project name where indicated on the ribbon; the name should match the name of GeneMapper ID-X project that the technical reviewer will use to review data.
4) Click the **Make my Allele Tables!** Button on the ribbon; you will be prompted to choose the exported GeneMapper ID-X .txt file—choose the correct file and click **Open** (macro will automatically generate allele tables for each event or lab number on a separate tab or prompt you to correct your GeneMapper file as needed).
5) You will be prompted to save the workbook—choose the destination and enter the workbook name and Click **Save** (the user can now modify each allele table as needed for case files).

### 10.4 Using tiffCAKE Ribbon Accessories in ALLELEigator

**WEAKER Sister-Allele Calculator**

Calculates uses the worst case PHR value observed during validation stochastic studies to extrapolate the RFU value that an allele could pair with. This function is used when considering possible genotype pairings instead of binary 55% PHR.
Allele-Specific Stutter Expectations
Calculates the expected amount of stutter associated with a peak at a locus in comparison to the locus-specific stutter value which was filtered by GeneMapper ID-X. This feature may be used to aid in the determination of whether a peak was possibly filtered as stutter due to using the “Highest Observed” locus-specific stutter values. It utilizes the allele-specific stutter values modeled during internal validation.

**Note:** STRmix may use a different expected stutter value, due to its ability to model the best explanatory variable (longest uninterrupted stretch (LUS), or average stutter). Therefore expected stutter values in STRmix may be different than those manually calculated using the tiffCAKE ribbon. Refer to the best explanatory variable table and the STRmix validation for the locus-specific slope and intercept values utilized by STRmix.

1) Select the locus of interest
2) Enter the originating allele
3) Enter the RFU value of the originating allele. The information will automatically autopopulate with the locus-specific stutter filter information that was applied as well as the expected amount of allele-specific stutter.
11.0 Title: Statistics

In forensic DNA testing, statistical calculations are performed on evidentiary DNA profiles compared to a known reference standard of the case to aid in the assessment of the significance of an inclusion. Intimate samples that are collected directly from the individual’s body, body cavity, or genitals do not require statistical calculations. Similarly, single source profiles obtained from items which are documented to have been removed from a person and/or from consensual partners do not require statistical calculations if the assumption of their DNA being present is made during interpretation. Refer to exceptions regarding the issuance of supplemental reports.

DNA profiles from evidence samples which were generated by an outsourcing lab will continue to be reported using random match probabilities (RMP) and binary likelihood ratios. The outsourcing data is not eligible for statistical calculations in STRmix. All DNA statistics reported by the LVMPD will be truncated to three significant figures.

11.1 Statistical Guidelines using STRmix

All evidence profiles interpreted using STRmix, whether single source or mixed, will be reported using a likelihood ratio statistic.

11.1.1 Database

When statistics are calculated using STRmix, the FBI Expanded Database and the NIST Database will be used for Identifiler Plus and Investigator 24plex, respectively. The FBI Expanded Database includes allele frequency data of African Americans (BLK), Caucasians (CAU), and Southwest Hispanics (SWH), whereas the NIST Database includes allele frequency data of African Americans (AA), Caucasians (CAU), and Hispanics (HSP).

11.1.2 Calculation of Likelihood Ratios in STRmix

Likelihood Ratios (LRs) provide the probability ratio of the evidence, given two competing hypotheses, typically referred to as the prosecution (Hp) and defense (Hd) hypotheses.

The following is an example of competing hypotheses:
Hp = the victim and suspect are the two contributors in the mixture versus,
Hd = the victim and an unknown individual are the two contributors in the mixture.

For the above example, the LR statistic answers the question:
“How many times more (or less) likely is it to observe the mixture DNA profile if it originated from a mixture of the victim and the suspect than if it originated from the victim and one unknown contributor?”

Note: The LR statement must be modified to reflect the sample-specific Hp and Hd hypotheses.
Various alternate hypotheses can be considered as deemed appropriate, and based on case scenario, it may be necessary to calculate and report the LR for multiple competing hypotheses in a single case.

Likelihood ratios require a fixed number of assumed contributors due to the development of the specific alternative hypotheses. In STRmix, likelihood ratios are calculated by multiplying the weight of a genotype (as determined during the MCMC process) at a locus by the probability of observing the genotypes given the proposed hypotheses.

The joint probability across all of the loci in the DNA profile is calculated by multiplying their respective frequencies together using the product rule.

\[
LR = \frac{Pr(E | H_1)}{Pr(E | H_2)} = LR_C = \sum_j W_j Pr(S_j | H_1) \sum_u W_u Pr(S_u | H_2)
\]

- **LR**: Likelihood ratio for the continuous model (STRmix)
- **Pr**: Probability of the evidence given the hypothesis, i.e. \(Pr(E | H)\)
- **W_j**: Probability weight of genotype “j”
- **W_u**: Probability weight of unknown genotype “u”
- **S_j**: Genotype “j”
- **S_u**: Unknown genotype “u”
- **H_1**: Hypothesis 1 or the prosecution hypothesis \((H_p)\)
- **H_2**: Hypothesis 2 or the defense hypothesis \((H_d)\)

### 11.1.3 Formulae for Likelihood Ratios in STRmix

STRmix utilizes the Balding and Nichols formulae (equations 4.10 from NRCII) for the calculation of genotype frequencies. For single source profiles:

For heterozygote loci (equation 1):

\[
\frac{2[\theta + (1-\theta) p_i] [\theta + (1-\theta) p_j]}{(1+\theta)(1+2\theta)}
\]

For homozygote loci (equation 2):

\[
\frac{[3\theta + (1-\theta) p_i] [2\theta + (1-\theta) p_j]}{(1+\theta)(1+2\theta)}
\]

Where \(p_i\) is the allele frequency for allele \(i\), \(p_j\) the allele frequency for allele \(j\) and \(\theta\) is the F\textsubscript{ST} value. The allele frequencies used within equations 1 and 2 are posterior mean frequencies. These are calculated using the following equation:
Where for the given locus, $x_i$ is the number of observations of allele $i$ in a database, $N_a$ is the number of alleles in that database and $k$ is the number of allele designations with non-zero observations in the database at that locus.

11.2 Statistical Guidelines for Outsourced Cases

11.2.1 Databases for Outsourced Cases
The LVMPD laboratory will utilize the FBI Popstats Database for Identifiler Plus data which includes allele frequency data of African Americans (BLK), Caucasians (CAU) and Southwest Hispanics (SWH). The LVMPD laboratory will utilize the NIST Popstats Database for Investigator 24plex data which includes allele frequency data of African Americans (AA), Caucasians (CAU), and Hispanics (HSP). A combined (COMB) NIST population group may also be calculated for use in CODIS entry but will not be reported. Other populations may be added to the Popstats file, or can be calculated manually. The allele frequency data are in the Popstats Data Files and also on file in the laboratory.

11.2.2 Random Match Probability (RMP): Calculation of Single Source Genotype Frequency for Outsourced Cases

Random match probability (RMP) calculations should be used for single-source profiles or if a single major contributor or a single minor contributor can be deduced within a mixed profile. The RMP statistic assesses the overall rarity of the DNA profile obtained from the evidence sample. The statistic answers the question: “What is the probability of randomly selecting an unrelated individual from the general population having a DNA profile that is consistent with the DNA profile obtained from the evidence sample?”

11.2.2.1 If an individual is homozygous for a particular locus, the genotype frequency is calculated as $p^2 + p(1-p)\theta$, where $p$ is the frequency of the allele and $\theta$ (theta) is used as a measure of the effects of population subdivision (inbreeding coefficient). Theta is utilized to account for population substructure: 0.01 can be used for large populations (e.g., Las Vegas) and 0.03 for small, isolated populations (e.g., Native Americans and Amish).

Example: An individual has a genotype of 13,13. The frequency of the 13 allele = 0.130.

\[
\text{Genotype frequency} = (0.130)^2 + 0.130(1-0.130)(0.01) \\
\text{Genotype frequency} = 0.0169 + 0.130(0.87)(0.01) \\
\text{Genotype frequency} = 0.0169 + 0.001131 \\
\text{Genotype frequency} = 0.018031
\]

11.2.2.2 If an individual is heterozygous at a particular locus, the genotype frequency is calculated as $2pq$, where $p$ and $q$ are the frequencies of the respective alleles.

Example: An individual has a genotype of 9, 11. The frequency of the 9 allele = 0.135 and the frequency of the 11 allele = 0.213.
11.2.2.3 The joint probability across multiple loci can be calculated by multiplying their respective frequencies together using the product rule, assuming independence of loci.

**Example:** An individual has the following types as determined by results from STR profiling:

- **Locus 1:** 12, 13 (allele frequency of 0.145 and 0.192)
- **Locus 2:** 17, 25 (allele frequency of 0.002 and 0.046)
- **Locus 3:** 17, 18 (allele frequency of 0.159 and 0.110)

**Frequency** = (Freq. of Locus 1) X (Freq. of Locus 2) X (Freq. of Locus 3)

**Frequency** = (0.05568) X (0.000184) X (0.03498)

**Frequency** = 0.000000358

**Probability** = 1 in 2,793,296.089 (1/0.000000358)

Probability of observing the given genotype is reported as rarer than 1 in 2.79 million.

**Note:** Statistical information is not utilized regarding estimated frequencies for the Amelogenin locus.

**Note:** Effective March 24, 2015, the Biology/DNA Detail stopped reporting identity statements when an RMP statistic exceeded the threshold of approximately 1 in 100 times the world’s estimated population. Therefore, reports disseminated prior to this date may exhibit identity statements for individuals who cannot be excluded from single source DNA profiles (to include major, minor and deduced components of mixtures).

11.2.3 Binary Likelihood Ratio (LR) for Mixtures for Outsourced Cases and Previously Interpreted Data

Binary likelihood ratios are typically calculated for mixtures, however, single source profiles may also be calculated using the equation below:

$$ L = \frac{P(E | C_x)}{P(E | C_y)} $$

The numerator in a likelihood calculation represents the prosecution’s hypothesis and the denominator represents the opposing (typically the defense’s) hypothesis.

The above equation describes:

- How many times more (or less) likely it is to observe the evidence profile given that the prosecution’s hypothesis is true than if the defense’s hypothesis is true?

Likelihood ratios require a fixed number of assumed contributors due to the development of the specific alternative hypotheses. Therefore special attention must be paid to potential allelic dropout and stutter, as these two occurrences cannot be factored into the calculation when using Popstats. Loci exhibiting signs of the possibility of allelic drop-out cannot be utilized when performing unrestricted likelihood ratio calculations.
11.2.4 Minimum Allele Frequency in Popstats for Outsourced Cases

A minimum allele frequency estimation is calculated for STR loci which demonstrate alleles with a low frequency of occurrence. The intent of this application is to set a lower limit for the frequency for such rare alleles and, consequently, produce a conservative allele frequency estimation that does not underestimate the allele’s frequency of occurrence. The approach utilized is a basic procedure described previously by Budowle et al, 1991 and National Research Council, 1996. The minimum allele frequency is calculated using the following expression:

\[ P_{\text{min}} = \frac{5}{2n} \]

where \( n \) represents the sample size (individuals).

The minimum allele frequency estimation is automatically utilized by the Popstats software when an allele is entered with a low frequency of occurrence.

11.2.5 Use of Popstats for Outsourced Cases

Popstats currently resides on all three of the remote CODIS Workstations. Instructions for utilizing the Popstats software can be found in the reference section on the CODIS website (also accessible through one of the remote CODIS workstations), on the “Help” menu in the Popstats window, or by utilizing the following directions:

1) After logging into a remote CODIS workstation, launch the Analyst Workbench, and open Popstats (on the lower left of Workbench Explorer) and select the type of calculation to be performed from these choices:
   - **Forensic Single Sample**: allows you to calculate a random match probability (RMP) on a single forensic sample profile. Note: A single source major, minor, or deduced profile from a mixture is data entered as a “Forensic Single Sample”.
   - **Forensic Mixture**: the likelihood ratio allows you to determine how many times more (or less) likely it is to observe the mixture DNA profile given two different hypotheses. Indistinguishable mixtures or restricted mixture profiles from mixtures with multiple significant contributors will be data entered using “Forensic Mixture”.
   - **Parentage**: allows you to perform parentage and reverse parentage calculations.
   - **Kinship**: allows you to perform single-parent calculations and evaluates the likelihood that the pair of given DNA profiles are associated by kinship vs. by chance.
   - The **Match Estimation and Partial Match** options are used to evaluate the eligibility of entering specimens into CODIS and are not reported out as statistics in reports.
   - For Forensic Single Samples, the Probability Formula under the Configuration Summary should be set to the default NRC ‘96 for the 1996 National Research Council formulae.

2) Type a valid Specimen ID (to include the event or Lab Case # and sample name) in the Specimen ID field (or names of the Biological Parent, Child and Alleged Parent, if you want the names printed on the report). If the profile is a major, minor, deduced, etc. type of profile this must be noted here or in the Comments section. In the event multiple samples possess the same DNA profile and therefore the same associated statistic, each individual sample name must be listed in the Comments section. Optional: Click “Import” and choose the .xml file exported from ALLELEigator to automatically populate the Specimen ID and Target Profile grid; modify as needed.

3) Type valid alleles in the Target Profile grid(s).
Optional: Refer to above optional import function using exported ALLELEigator .xml file.

4) Click the Calculate button.

Note: Examples of each of these types of calculations are included in the references on the CODIS website accessed from a remote CODIS workstation.

11.2.6 Popstats Mixture Calculations for Outsourced Cases

Likelihood ratios can be calculated on the probative sample when the parties involved cannot be excluded as being a contributor to the mixture profile. Only loci where all alleles present are above the interpretation threshold can be used for statistics. The data printed for the file should include the “Likelihood Ratio for Mixtures” report.

As previously discussed, Popstats utilizes the Likelihood Ratio to compare two alternative explanations for a mixture profile, and is described by the following equation:

\[ L = \frac{P(E \mid C_x)}{P(E \mid C_y)} \]

Where:

- \( C_x \) is the first explanation (the alleles of the mixed DNA profile attributed to unknown contributors under explanation \( C_x \)).
- \( C_y \) is the second explanation (the alleles of the mixed DNA profile attributed to unknown contributors under explanation \( C_y \)).
- \( x \) is the number of unknown contributors under explanation \( C_x \).
- \( y \) is the number of unknown contributors under explanation \( C_y \).
- \( P(E \mid C_x) \) is the probability of the DNA profile (E) using explanation \( C_x \).
- \( P(E \mid C_y) \) is the probability of the DNA profile (E) using explanation \( C_y \).

Likelihood ratios require a fixed number of assumed contributors due to the development of the specific alternative hypotheses. Therefore only loci that do not exhibit signs of allelic drop-out are suitable for likelihood ratio calculation.

11.2.6.1 The Likelihood Ratio Target Profile window has three grids which allow you to enter:

- The mixed DNA profile
- The alleles of the mixed DNA profile attributed to \( x \) unknown contributors under explanation \( C_x \)
- The alleles of the mixed DNA profile attributed to \( y \) unknown contributors under explanation \( C_y \)
- You must also specify the number of unknown contributors, \( x \) and \( y \), for explanations \( C_x \) and \( C_y \) respectively. Compute the minimum number of unknown contributors for each explanation as follows:

11.2.6.1.1 For the profile described by each hypothesis, divide the number of alleles at each locus by two and round up to the nearest integer.

11.2.6.1.2 The maximum computed value across all loci represents the minimum number of unknown contributors.
11.2.6.1.3 For example, if there are three alleles at locus CSF1PO, four alleles at locus D13S317, and two alleles at locus D16S539 from x contributors, then x must be equal to 2.

11.2.6.2 Select Forensic Mixture from the Popstats Calculations on the Popstats toolbar.

11.2.6.3 In the Mixture target profile grid, enter the sample name in the Specimen ID field.

11.2.6.4 On the first line in the Comments field, type in the total number of assumed contributors (TNAC) (may also use the abbreviation for assumed total number of contributors – ATNC). Press Enter to move to the second line in the Comments field and then type the hypothesis being assumed under Hp, to include the names and/or sample item numbers of the assumed contributors. Press Enter to move the third line in the Comments field and then type the hypothesis being assumed under H2, to include the names and/or sample item numbers of any assumed contributors.

Example: TNAC: 2
H1: Mixture of Summer Day (Item 1) and Daniel Day (Item 3)
H2: Mixture of Summer Day (Item 1) and 1 Unknown

11.2.6.5 Enter the mixture profile into the target profile grid. Un-check any loci that you will not use in the statistic due to possible allelic drop-out.

11.2.6.6 In the “# unknowns for H1” box, enter the number of unknown profiles in the mixture profile under the first hypothesis and in the target profile grid, enter the alleles of the unknown profile(s):

11.2.6.6.1 If the profile is consistent with a mixture of a victim and suspect, this value would be “0” since there are no unknown profiles. No alleles would be entered into the grid.

11.2.6.6.2 If the profile is consistent with a mixture of a victim, suspect, and a third unknown individual, this value would be “1” accounting for the unknown individual and you would ONLY type in the alleles unaccounted for by both the victim and suspect. Do not deduce a profile.

Example: the profile obtained at vWA is 14, 15, 16, 17, and 19. Suspect is 14, 15, victim is 17, 19. The 16 allele is unknown and would be entered into the grid.

11.2.6.7 In the “# unknowns for H2” box, enter the number of unknown profiles in the mixture profile under the second hypothesis and in the target profile grid, enter the alleles of the unknown profile(s):

11.2.6.7.1 If the profile is consistent with a mixture of a victim and suspect, this value would be “1” because the alternate hypothesis is that the profile is actually a mixture of the victim and an unknown individual. Only the unknown alleles are entered into the grid (any alleles that are not consistent with the victim’s alleles).
11.2.6.7.2 If the profile is consistent with a mixture of a victim, suspect, and a third unknown individual, this value would be “2” because the alternate hypothesis is that the profile is actually a mixture of the victim and two unknown individuals. The unknown alleles are entered into the grid (any alleles that are not consistent with the victim’s alleles).

**Example**: the profile obtained at vWA is 14, 15, 16, 17, and 19. The victim is 17, 19. The 14, 15, and 16 alleles are unknown and would be entered into the grid regardless of the suspects known profile.

**Example**: Below is an entry made of a mixture profile which includes the victim and suspect.

<table>
<thead>
<tr>
<th>Mixture Profile</th>
<th>Victim</th>
<th>Suspect</th>
</tr>
</thead>
<tbody>
<tr>
<td>vWA 14, 15, 16</td>
<td>17, 19</td>
<td>14, 15, 16</td>
</tr>
<tr>
<td>vWA 14, 15, 17, 19</td>
<td>17, 19</td>
<td>14, 15, 16</td>
</tr>
<tr>
<td>TPOX 0, 10, 11</td>
<td>0, 10</td>
<td>0, 10</td>
</tr>
<tr>
<td>D18S51 12, 14, 16, 19</td>
<td>12, 14</td>
<td>16, 19</td>
</tr>
<tr>
<td>Amelogenin X, Y</td>
<td>X, Y</td>
<td>X, Y</td>
</tr>
<tr>
<td>D5S818 5, 10, 12, 13</td>
<td>5, 10</td>
<td>22, 20</td>
</tr>
<tr>
<td>FGA 18, 22, 26</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note**: Allele 4 entries for Mixture Profile are cut-off in screen capture, however may be viewed on screen by scrolling to the right.
11.2.6.8 Once entry is complete, click the “Calculate” button on the tool bar. Print the “Likelihood Ratio for Mixtures” report. Report the most conservative LR statistic of the three population groups (CAU, AA, and SWH) calculated. The strength of the evidence is based upon the final calculated likelihood ratio.

11.3 Number Conversions

11.4 Popstats Parentage Calculations
The LVMPD may be involved in paternity and relatedness cases. In these cases, DNA evidence is generally interpreted using likelihood ratios, comparing probabilities of the evidence under alternative propositions. STRmix cannot be used to perform these types of calculations and therefore all such calculations will be performed in Popstats.

To determine if the alleged father is the true biological father, the DNA profiles of the child, mother, and alleged father are compared. A child inherits two different alleles at each genetic locus—one from the mother and one from the father.

If a child has an allele that the mother does not have, this obligate allele has to come from the biological father. The results are either an exclusion—the alleged father is not the biological father—or an inclusion.

The parentage index utilizes a likelihood ratio to calculate a standard paternity trio where the mother and child are known and the father is unknown.
The reverse parentage index is utilized in situations where the DNA profile of the child is known, however both parents are in question (e.g. abandoned baby). The reverse parentage statistics function under the “Parentage” tab in Popstats should be used to evaluate the possibility that the abandoned baby is the biological child of the suspected couple. Single parentage statistics may subsequently be used to independently evaluate the evidence against each of the suspected parents.

A single parent comparison is used to evaluate each parent independently in a reverse parentage scenario or when only one alleged parent is available for testing. This calculation is often used in cases of missing persons or potential homicides in which a body has not been located and a secondary standard is not available from the victim. The single parent comparison may be used to infer whether a single source evidence sample may be biologically related to a single alleged parent. Utilize the “Kinship” tab in Popstats to calculate the single parent statistics for parent/offspring.

When determining possible parentage based on STR profiles, an individual cannot be excluded based on a single locus difference. Exclusions are required at two or more loci. In the event a possible mutation is present, exclusions are required at three or more loci. The majority of mutations are observed as a single repeat shift in either direction, thereby resulting in an allele one repeat above or below the expected obligate allele. Double allele shifts have been observed, however are rare.

11.4.1 Calculation of Standard Parentage Trio and Reverse Parentage

To access the parentage calculations, select the “Popstats Parentage Calculation” from the Workbench Explorer pane. For Trio calculations, select the “Trio” button. The Parentage Trio calculation requires three DNA profiles: biological parent, child, and alleged parent. No more than two alleles are allowed at each locus. Because the known parent and child relationship is assumed to be certain, at least one allele of the known parent and child must match at every locus.

For Reverse Parentage Calculations, select the “Reverse button”. The Reverse Parentage calculation requires three DNA profiles: biological mother, biological father, and alleged child.

1) Enter the profile using any one of the methods listed above.
2) Repeat set 1 for the child (or biological father for Reverse Parentage) window and the alleged parent (or alleged child for Reverse Parentage) window.
3) Verify that all of the STR loci have checks in the checkboxes to the left of the locus names in the first column. Deselect the checkboxes for STR loci which will not be included in the calculation.
4) Click Calculate.
5) Print the “Parentage Trio Calculations” (parentage trio), or “Reverse Parentage Statistics” (reverse parentage) report.
11.4.3 Calculation of Single Parentage Statistics

1) To access the single parentage calculations, select the “Kinship Popstats Calculations” from the Workbench Explorer pane. The Single Parentage Statistics window is available only when the Parent-Offspring (PO) kinship relationship has been selected in the pane on the right side of the screen.
2) Enter the DNA profiles of the reference and evidence samples to be considered and select “Calculate”.

3) Select the “Single Parentage Statistics” tab under “Kinship” at the top of the screen.

This window displays the following:

For each valid combination of loci and population group:
- Probability of exclusion
- Parent offspring index
- Consistency status

For each population group:
- Combined probability of exclusion
- Combined parentage index
- Combined consistency status

Single parentage labels the per locus consistency between the genotypes of the reference and the evidence profiles using “Yes” for a locus that is consistent, and “No” for a locus that is inconsistent. This appears in “Match” column.

Popstats labels the “Combined Profile Statistics” consistency status using “Yes” when all selected loci are consistent; “Mutation” when one or two selected loci require mutation to be consistent; and “No” when three or more selected loci are inconsistent. The consistency status is labeled “Inconclusive” when one or more selected loci have no population data for a population group.
4) The Single Parentage Statistics report is only available when selecting the Parent-Offspring (PO) kinship relationship. Select “Print” and then “Popstats Single Parentage Statistics DNA Testing Results”. The report contains the following:

- The first page includes the reference and evidence profiles along with the consistency status of each locus.
- Subsequent pages display by population group and locus, and provide the PE and PI, and the combined PE and PI.

11.5 Mutation rates

The following corresponds with the mutation rates of common autosomal STR loci observed during paternity testing:

<table>
<thead>
<tr>
<th>STR System</th>
<th>Maternal Meloses (%)</th>
<th>Paternal Meloses (%)</th>
<th>Number from Either</th>
<th>Total Number of Mutations</th>
<th>Mutation Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSF1PO</td>
<td>95/304,307 (0.031)</td>
<td>982/643,118 (0.15)</td>
<td>410</td>
<td>1,457/947,125</td>
<td>0.16%</td>
</tr>
<tr>
<td>FGA</td>
<td>205/408,230 (0.050)</td>
<td>2,210/492,776 (0.32)</td>
<td>210</td>
<td>3,125/1,101,006</td>
<td>0.28%</td>
</tr>
<tr>
<td>THO1</td>
<td>31/325,172 (0.009)</td>
<td>41/452,362 (0.009)</td>
<td>28</td>
<td>100/779,554</td>
<td>0.013%</td>
</tr>
<tr>
<td>TPOX</td>
<td>18/406,061 (0.045)</td>
<td>54/457,420 (0.012)</td>
<td>28</td>
<td>100/857,481</td>
<td>0.012%</td>
</tr>
<tr>
<td>vWA</td>
<td>104/564,398 (0.003)</td>
<td>1,482/675,537 (0.17)</td>
<td>814</td>
<td>2,480/1,437,945</td>
<td>0.17%</td>
</tr>
<tr>
<td>D3S1358</td>
<td>60/408,452 (0.015)</td>
<td>713/856,036 (0.13)</td>
<td>379</td>
<td>1,182/964,288</td>
<td>0.12%</td>
</tr>
<tr>
<td>D5S818</td>
<td>111/451,736 (0.029)</td>
<td>763/656,603 (0.12)</td>
<td>385</td>
<td>1,256/1,307,339</td>
<td>0.11%</td>
</tr>
<tr>
<td>D7S820</td>
<td>59/440,562 (0.013)</td>
<td>245/644,243 (0.12)</td>
<td>285</td>
<td>1,089/1,085,305</td>
<td>0.10%</td>
</tr>
<tr>
<td>D8S1179</td>
<td>96/409,869 (0.023)</td>
<td>779/489,968 (0.16)</td>
<td>364</td>
<td>1,239/989,337</td>
<td>0.14%</td>
</tr>
<tr>
<td>D13S317</td>
<td>192/482,136 (0.040)</td>
<td>681/621,146 (0.16)</td>
<td>485</td>
<td>1,758/1,103,282</td>
<td>0.14%</td>
</tr>
<tr>
<td>D16S539</td>
<td>129/467,774 (0.009)</td>
<td>540/494,485 (0.11)</td>
<td>372</td>
<td>1,041/962,289</td>
<td>0.11%</td>
</tr>
<tr>
<td>D18S51</td>
<td>186/296,244 (0.067)</td>
<td>1,094/494,098 (0.22)</td>
<td>466</td>
<td>1,746/790,342</td>
<td>0.22%</td>
</tr>
<tr>
<td>D21S11</td>
<td>644/434,288 (0.11)</td>
<td>772/526,708 (0.15)</td>
<td>580</td>
<td>1,816/962,096</td>
<td>0.19%</td>
</tr>
<tr>
<td>Penta D</td>
<td>12/38,761 (0.003)</td>
<td>21/22,501 (0.093)</td>
<td>24</td>
<td>57/41,202</td>
<td>0.14%</td>
</tr>
<tr>
<td>Penta E</td>
<td>29/41,311 (0.006)</td>
<td>25/355,719 (0.13)</td>
<td>59</td>
<td>163/100,000</td>
<td>0.16%</td>
</tr>
<tr>
<td>D2S1338</td>
<td>15/22,343 (0.021)</td>
<td>137/152,310 (0.10)</td>
<td>90</td>
<td>262/225,140</td>
<td>0.12%</td>
</tr>
<tr>
<td>D19S433</td>
<td>39/270,801 (0.004)</td>
<td>78/103,489 (0.079)</td>
<td>71</td>
<td>187/173,490</td>
<td>0.11%</td>
</tr>
<tr>
<td>SE33 (ACTBP3)</td>
<td>0.330 (0.030)</td>
<td>330/51,610 (0.64)</td>
<td>None reported</td>
<td>330/51,940</td>
<td>0.64%</td>
</tr>
<tr>
<td>D15S106</td>
<td>0/593 (&lt;0.25)</td>
<td>0/593 (&lt;0.25)</td>
<td>0</td>
<td>0/593</td>
<td>&lt;0.25%</td>
</tr>
<tr>
<td>D12S391</td>
<td>1/3,078 (0.0022)</td>
<td>10/3,363 (0.30)</td>
<td>0</td>
<td>11/6,441</td>
<td>0.17%</td>
</tr>
<tr>
<td>D2S441</td>
<td>0/393 (&lt;0.25)</td>
<td>0/393 (&lt;0.25)</td>
<td>0</td>
<td>0/393</td>
<td>&lt;0.25%</td>
</tr>
<tr>
<td>D10S1248</td>
<td>0/393 (&lt;0.25)</td>
<td>0/393 (&lt;0.25)</td>
<td>0</td>
<td>0/393</td>
<td>&lt;0.25%</td>
</tr>
<tr>
<td>D22S1045</td>
<td>0/393 (&lt;0.25)</td>
<td>0/393 (&lt;0.25)</td>
<td>0</td>
<td>0/393</td>
<td>&lt;0.25%</td>
</tr>
<tr>
<td>D9S1013</td>
<td>0/3,078 (&lt;0.032)</td>
<td>2/3,363 (0.060)</td>
<td>0</td>
<td>2/6,441</td>
<td>0.031%</td>
</tr>
</tbody>
</table>

See also [http://www.cstl.nist.gov/strbase/mutations.htm](http://www.cstl.nist.gov/strbase/mutations.htm). Information derived from AABB 2003 annual report provided from over three dozen paternity testing laboratories. The reported mutations are divided into maternal or paternal sources or from either when the source of the mutation observed in a child could not be determined. Very little mutation rate data has been published to-date on the newer STR loci. References have been included below the locus where there are data available.
12.0 Title: Reporting Guidelines

12.1 Lab Reports

All DNA Laboratory Reports should be as clear and complete as possible. The laboratory reports will include the following criteria when applicable:

- Case identifier
- Description of evidence examined
- Methodology
- Locus or amplification system
- Results and/or conclusions
- Interpretive statement (either quantitative or qualitative)
- Date Issued
- Disposition of evidence
- Electronic signature and title of the case analyst

The issue date of a report is the date the report is published in LIMS. This is the date that is printed on the report. The address of the DNA Annex will be placed at the bottom of the first page of the lab report.

12.2 Release of Case Report Information

DNA Laboratory reports are distributed to the requesting officer and/or the Deputy District Attorney who submitted the Forensic Laboratory Examination Request. Reports generated from CSA Evidence Impound reports for certain property crime evidence types will be distributed to the Sergeant of the area command section or investigating detail of the incident. Reports generated from the submission of Volunteer Consent forms will be distributed to the officer assigned to the Event #. Upon receipt of a discovery subpoena or subpoena duces tecum, copies of the case file contents and subpoenaed records will be provided. Refer to the LVMPD Forensic Handbook for policies that govern the release of information.

12.3 Design of LVMPD Biology/DNA Forensic Casework Report of Examination

The Forensic Casework Report of Examination is divided into five (5) main sections:

1) A header which contains all of the case-pertinent information to include the report distribution date, agency, location, primary case # (and additional linked case #’s, if applicable), incident, requester, Lab Case #, and subject(s).

2) A results table which contains all of the evidence items examined in the case, their corresponding Lab Item #, associated impound information (package and item numbers), descriptions, and a summary of the examination and/or screening results or other case-specific circumstances (if applicable).

3) A “Results, Opinions, and Interpretations” section which contains the individual DNA results of each Lab Item # subjected to DNA analysis.
4) If applicable, a table which details items of evidence received, but not examined.
5) A “Notes” section which includes disclaimers, defines terms used in the report, and provides additional information to aid in the understanding of the reported results and statistics.

12.4 Violence Against Women Act (VAWA)
In the event a sexual assault kit was collected from a victim who originally invoked their right to privacy under the VAWA law, but then later filed an official report with a law enforcement agency under their own name, the issued DNA analysis report will utilize the victim's true name, rather than John or Jane Doe.

12.5 Serology Reporting Statements
Based on case documentation from investigating agents and visual examination, items will be screened for blood and/or semen accordingly. The results of all screening tests conducted will be reported. These results will appear in the “Results, Opinions, and Interpretations” column in the results table.

12.5.1 Presumptive Screening Tests
The following tests are each considered to be presumptive tests:
- Phenolphthalein (PT)
- Tetramethylbenzidine (TMB)
- Hematrace
- Acid Phosphatase (AP)
- P30
- RSID-saliva

The following statement will be placed below the results table when the results of these presumptive screening tests are being reported:
“Tests for blood, semen, and/or saliva are presumptive in nature and therefore provide an indication, but not confirmation, of the presence of a body fluid.”

The following statements will be used to populate the “Results, Opinions, and Interpretations” results field in the table for presumptive screening tests:
- Phenolphthalein (PT) or Tetramethylbenzidine (TMB) Testing:
  1) Positive presumptive blood test(s)
  2) Negative presumptive blood test(s)
  3) Inconclusive presumptive blood test(s)**

- Hematrace:
  1) Blood indicated
  2) Human blood negative
  3) Blood inconclusive**

- Acid Phosphatase (AP) Testing
  1) Positive presumptive semen test(s)
  2) Negative presumptive semen test(s)
  3) Inconclusive presumptive semen test(s)**
- P30 Testing
  1) Semen indicated
  2) Semen negative
  3) Semen inconclusive**

In certain instances additional body fluids (saliva and vaginal) have been demonstrated to yield weak P30 results which may be false positives. Based on the totality of a case (e.g. case scenario, no evidence of sperm, etc.), the analyst may choose to report the P30 results as “semen inconclusive” instead of “semen indicated”. Documentation must be included in the analyst’s notes and on the Report of Examination as to why the results are being reported as inconclusive.

- RSID-Saliva Testing
  1) Positive presumptive saliva test
  2) Negative presumptive saliva test
  3) Inconclusive presumptive saliva test**

12.5.2 Confirmatory Microscopic Sperm Search
The microscopic sperm search is considered a confirmatory test and will be reported using the following statements in the “Results, Opinions, and Interpretations”:
  1) Sperm positive
  2) Sperm negative
  3) Sperm inconclusive**

In the event a sample yields a P30 positive result, however no sperm were identified and no foreign DNA was obtained, the following statement should be placed below the results table:
“A positive P30 result in the absence of spermatozoa and foreign DNA cannot be conclusively attributed to the presence of semen. P30 can be detected in other body fluids.”

12.5.3 Inconclusive Serological Results
All inconclusive serological test(s) must include documentation of a qualitative reason for the inconclusive result. Inconclusive results should be marked with an **asterisk or other symbol to indicate that additional information/explanation will be noted below the results table (e.g. invalid color test result, sperm head morphology, only one or two sperm heads noted etc.).

The following statement(s) are examples which may be included at the bottom of the table in order to satisfy this requirement:
1) Inconclusive PT, Hematrace, AP, P30 test(s) and/or RSID-Saliva:
   The possible presence or absence of <blood/semen/saliva> could not be determined due to insufficient information obtained from the chemical analysis.
2) Inconclusive microscopic sperm search:
   The presence or absence of sperm could not be confirmed due to insufficient information obtained from the microscopic analysis.

12.5.4 Results of Visual Examinations
- Negative examination using Alternate Light Source (ALS): “No apparent semen <or saliva/blood> stain(s) observed”

- Negative visual examination for staining using the naked eye: “No apparent stain(s) observed”

12.6 Additional Summary Result Table Statements
The following table provides an overview of additional case-specific circumstances and the corresponding statements which should be placed in the “Results, Opinions, and Interpretations” column of the table, if applicable:

<table>
<thead>
<tr>
<th>Circumstance</th>
<th>Summary Result Table Statement</th>
</tr>
</thead>
<tbody>
<tr>
<td>An item of evidence was requested, but not examined</td>
<td>Not examined</td>
</tr>
<tr>
<td>An item of evidence was received, but not examined</td>
<td>Received, not examined</td>
</tr>
<tr>
<td>Additional areas of staining are identified, hairs are removed, etc. during the examination of an evidence item, which may be suitable for future testing</td>
<td>Not tested at this time</td>
</tr>
<tr>
<td>Insufficient root material present for STR analysis based on visual and/or microscopic examination of a hair</td>
<td>Not suitable for STR Testing</td>
</tr>
<tr>
<td>Item of evidence opened, however, no serological testing or DNA analysis performed</td>
<td>No further &lt;examination/testing&gt; at this time</td>
</tr>
<tr>
<td>Serological testing completed, however, no DNA analysis performed</td>
<td>No further testing at this time</td>
</tr>
</tbody>
</table>

12.7 Referencing Additional Information Within and/or Below the Results Table
At times it may be necessary to reference additional case-specific information, such as to cross-reference to another case file, previously issued reports, or name disparities. Such instances may warrant additional statements below the results table.

The following table provides an overview of case-specific circumstances in which it may be necessary to include an additional statement of explanation. In the event the statement only refers to specific sample(s), an asterisk (*) should be used in the results table and/or in the “Results, Opinions, and Interpretations” to identify the sample(s) to which the statement applies:

<table>
<thead>
<tr>
<th>Circumstance</th>
<th>Additional Statement Included Below Results Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Referencing another analyst's case file for data</td>
<td><strong>&quot;Refer to the case file for Event # &lt;XX XXXX-XXXX &gt; issued by &lt;Title, Name, P#&gt; for information related to &lt;Subject&gt;.&quot;</strong></td>
</tr>
<tr>
<td>Referencing previously issued reports</td>
<td><strong>&quot;Refer to the original/supplemental report issued by &lt;Title, Name, P#&gt; dated &lt;XXX&gt; for related information.&quot;</strong></td>
</tr>
<tr>
<td>Referencing evidence with multiple Event #s worked under one Event #</td>
<td><strong>&quot;Evidence was booked under Event # &lt;XX XXXX-XXXX&gt;.&quot;</strong></td>
</tr>
<tr>
<td>Referencing name disparities</td>
<td><strong>&quot;&lt;Last/First name&gt; spelled differently than on request.&quot;</strong></td>
</tr>
<tr>
<td>Referencing items being examined while in another analyst's custody</td>
<td><strong>&quot;Evidence was examined while in the custody of &lt;Title, Name, P#&gt;.&quot;</strong></td>
</tr>
</tbody>
</table>
### 12.8 STR Analysis Report Conclusions

General reporting guidelines are provided throughout this procedure and most reporting scenarios will fall within the recommendations of this protocol. The following sections are meant to provide guidance when writing reports and are not intended to encompass all situations. Ultimately, all statements included in the final report must accurately reflect the data observed. The style in which the items appear on the report (e.g. bold, italics, etc.) are analyst discretion, however must be consistently applied within a report.

#### 12.8.1 When STR amplification is performed using the Investigator 24plex amplification kit, the following statement is the first statement in the “Results, Opinions, and Interpretations” section of the DNA report:

“Item XXX and Item XXX (list all applicable items) were subjected to PCR amplification at the following STR genetic loci: TH01, D3S1358, vWA, D21S11, TPOX, DYS391, D1S1656, D12S391, SE33, D10S1248, D22S1045, D19S433, D8S1179, D2S1338, D2S441, D18S51, FGA, D16S539, CSF1PO, D13S317, D5S818, and D7S820. The sex-determining Amelogenin locus was also examined. Where applicable, STRmix was used for interpretation.”

#### 12.8.2 When STR amplification is performed using the PowerPlex Fusion 6C amplification kit, the following statement is the first statement in the “Results, Opinions, and Interpretations” section of the DNA report:

“Item XXX and Item XXX (list all applicable items) were subjected to PCR amplification at the following STR genetic loci: D3S1358, D1S1656, D2S441, D10S1248, D13S317, Penta E, D16S539, D18S51, D2S1338, CSF1PO, Penta D, TH01, vWA, D21S11, D7S820, D5S818, TPOX, D8S1179, D12S391, D19S433, SE33, D22S1045, DYS391, FGA, DYS576, and DYS570. The sex-determining Amelogenin locus was also examined.”
12.8.3 When STR amplification was previously performed using the Identifiler Plus amplification kit, the following statement is the first statement in the “Results, Opinions, and Interpretations” section of the DNA report:

“Item XXX and Item XXX (list all applicable items) were subjected to PCR amplification at the following STR genetic loci: D8S1179, D21S11, D7S820, CSF1PO, D3S1358, TH01, D13S317, D16S539, D2S1338, D19S433, vWA, TPOX, D18S51, D5S818, and FGA. The sex-determining Amelogenin locus was also examined. Where applicable, STRmix was used for interpretation.”

12.8.4 If comparisons are being made between questioned samples and reference standards that were amplified in two different amplification kits, the following statement will be contained just below the designation of the loci:

“Only the genetic loci contained in both the DNA profiles obtained from the evidence sample(s) and the reference standard(s) will be used for comparison.”

12.8.5 If applicable, each sample conclusion statement should include the following descriptive elements in the report language. Reporting of sample conclusions associated with evidence profiles generated from outsourcing laboratories will mimic the language as originally reported by the outsourcing laboratory.

1) A statement as to whether there is an indication of male DNA being present and the number of males indicated
2) The assumption as to the number of contributors used during interpretation
3) Whether the DNA profile is suitable for comparison
4) If the DNA profile is not suitable for comparison, whether it is due to the profile being too limited in nature or too complex

12.8.6 Unless an assumption has been made, each conclusion statement must include individual comparisons of each of the reference profile(s) to the DNA sample results. Alternatively, the following report statement may be utilized:

“All other submitted reference standards <and designated unknown profiles> are excluded as possible contributors to the DNA profile obtained.”

12.8.7 Statements for assumptions made during interpretation regarding intimate samples or personal conditional knowns

During interpretation, it is reasonable to assume the presence of the donor’s DNA profile when an item of evidence is intimate, personal in nature, or if they are a documented consensual partner. When an assumption has been made, the following notes will be included in the DNA report, as applicable:

**Note 1:** “Evidence collected directly from the body or personal items removed directly from the body are intimate samples; therefore, the donor may be reasonably assumed to be present should the item produce a DNA profile that is suitable for comparison. <DNA profiles from <environmental samples which are habitually touched or handled by an individual><documented consensual partners may also be reasonably assumed to be present.>”

**Note 2:** “In instances in which all contributors can be assumed, no statistical calculations will be reported for the assumed contributors.”
12.8.7.1 If the profile does not show signs of additional foreign contributor(s), the following report statement may be used:

Assuming Michelle Monday (Item 3) is a contributor to the DNA profile obtained <from the epithelial fraction of the vaginal swab (Item 1-EF)>, no foreign DNA results were obtained.

The DNA profile obtained <from the epithelial fraction of the vaginal swab (Item 1-EF)> is consistent with Michelle Monday (Item 3).

12.8.8 Observation of Carryover in Differentially Extracted Samples

It is reasonable to assume that samples which were differentially extracted (regardless of whether intimate, personal, or environmental in nature) may include carryover between the epithelial and sperm fractions. In instances in which carryover is determined to be present in a two-person mixture, and the opposing fraction yields a single source profile, this may be notated in the report.

Statistical calculations are not required when the assumption of both the donor and carryover can be made.

The DNA profile obtained from the epithelial fraction of the vaginal swab (Item 3.1-EF) is consistent with a mixture of two individuals with at least one being male. Assuming Viola Vegas (Item 6) is a contributor to this mixture, a foreign DNA profile was obtained. The foreign DNA profile is consistent with carryover from the sperm fraction of the vaginal swab (refer to Item 3.1-SF).

The DNA profile obtained from the epithelial fraction of the stain from the seat of the taxi cab (Item 3-EF) is consistent with a mixture of two individuals with at least one being male. Assuming Sallie Mae (Item 1) is a contributor to this mixture, the remainder of the DNA profile is consistent with carryover from the sperm fraction of the stain from the seat of the taxi cab (refer to Item 3-SF).

12.8.9 Statement for the Termination of Samples Post-Quantitation

In the event sample analysis is terminated following duplicate quantitation values obtained below the threshold for Quantifiler Trio as outlined in Chapter 5, the following statement must be included below the report table. An asterisk (*) or other symbol should be used to identify the sample(s) to which the statement applies.

"Due to an insufficient amount of DNA being detected during quantitation, PCR amplification was not performed."

12.8.10 Statements for Reference Standard Typing Results

A qualitative statement describing the DNA profile results will be included in the report table for all reference standards. This statement will include the gender of the reference standard and whether it yielded a full or partial profile.
12.8.11 Statements for the Use of Presumed Standards
In the event the DNA profile obtained from an evidence item is being utilized as a presumed standard, the following statement must be placed at the beginning of the “Results, Opinions, and Interpretations”:

“The DNA profile obtained from the <evidence item> yielded a <male/female> profile. Due to the intimate nature of this sample, it can be assumed that this DNA profile is that of the <name of the sample donor>. For comparison purposes, this DNA profile will be utilized as the presumed standard for <name of the sample donor>.”

All subsequent comparisons made to the presumed standard will utilize a variation of the following language when making inclusions/exclusions:

“The DNA profile obtained from <evidence item> is consistent with the presumed standard for <subject name>.”

12.8.12 Identical Twins
In the event a case involves confirmed identical twins, the following statement will be added as a caveat to the DNA report prior to the first reported item conclusion:

“The DNA profiles from <name of twin #1> and <name of twin #2> are confirmed as being genetically identical twins. It is therefore not possible to distinguish which individual is the contributor of the DNA profile(s) obtained. All genetic matches will be associated to both individuals.”

The DNA Technical Leader should be consulted for all cases involving confirmed identical twins. This language may be modified and tailored to the case-specific information.

12.9 Reporting of STRmix Interpretations
The following information is described when reporting STRmix results:
- The number of contributors used for STRmix interpretation, including whether there is an indication of male DNA being present.
- The approximate mixture proportions from the STRmix output for the deconvolution of mixtures.
- The names of individuals compared to the evidence profiles which are assumed, included, excluded, and inconclusive.
- The likelihood ratio value associated with all included individuals, with the exception of assumed contributors.
- A statement of propositions and likelihood ratio(s) which can explain the evidence.

The likelihood ratio in STRmix is calculating the probability of obtaining the evidence given the person of interest is a contributor against the probability of obtaining the evidence if the person of interest is not a contributor. The calculation result reflects the probability as it relates to the DNA profile as a whole (whether single source or a mixture).

Conclusions for each item will be present in the “Results, Opinions, and Interpretations” section of the report. It is acceptable to group similar conclusions for multiple items together such as with single source samples associated with the same individual. Differentially extracted samples
containing an epithelial (EF) and sperm fraction (SF) originating from a single item may be placed under a single heading.

If a case involves multiple persons of interest (POI) and multiple inclusionary likelihood ratio calculations have been performed for an item of evidence, the individual likelihood ratio calculations as well as the likelihood ratio calculation(s) considering the multiple persons of interest in combination will be included in the report. As examples, if two POIs have likelihood ratios calculated individually that both support their inclusion and a likelihood ratio is also calculated for the two POIs together in the mixture that also supports their inclusion, and all three calculations will be reported.

If likelihood ratios are performed to determine the potential inclusions of non-probative individuals (e.g., victims or consensual partners) for the purposes of conditioning a STRmix analysis, the individual likelihood ratio calculations do not need to be included in the report, but must be available in the case file.

If conversely, two individual likelihood ratios independently support inclusion, but the likelihood ratio calculated for their presence together in the mixture suggests this cannot occur (LR with an exponent of $10^{-4}$ or less), the two individual inclusionary LRs will be reported along with the information that they both cannot be contributing DNA together to the mixture.

It is recognized that different situations may require different reporting strategies, and in general, what is reported will be the most informative for the case.

If an evidence profile results in an unknown component (or components) that are searchable and uploadable to CODIS, a statement will be included in the report to notify the reader that the component(s) will be searched in CODIS.

**Assumptions**
All assumptions that are made as part of the interpretation will be stated within the report. This includes the assigned number of contributors and any assumed contributors.

**Likelihood Ratio**
- The point estimate “LR Total” will be reported for full single source Identifiler Plus and Investigator 24plex QS profiles which have been resolved in STRmix with 100% weight at every locus. This calculation includes an estimation for which a deviation of approximately ± 10-fold may exist.
- The 1-sided 99.0% lower HPD (Higher Posterior Density) LR value will be reported for partial single source (one or more loci exhibit genotype combinations with weights less than 100%), two, three, and four-person Identifiler Plus and Investigator 24plex QS profiles.
- Where applicable, the unified LR will be calculated and maintained in the case file. **Exceptions:** The unified LR may be reported on a case-by-case basis where there is indication that an alternate LR may be more suitable based on case circumstance (ex. if a LR for an untested brother of the person of interest were requested).
- Likelihood ratios are truncated to three (3) significant figures (without rounding). The most conservative (lowest) population result will be reported.
Reporting Statements

The following is the example format that will be used for reporting statements containing fully-resolved (100% weight at all loci) single source profile with the point estimate “LR Total” likelihood ratio:

**Lab Item 1.1: Swab of something**

Number of contributors: 1 female
Individually included: Jane Doe (Item 1; LR = approximately \(<\text{insert most conservative LR Total from STRmix}\)\)
Excluded: Peter Jones (Item 5), Jimmy Dean (Item 8)

The probability of observing this DNA profile is approximately \(<\text{insert most conservative LR Total from STRmix}\) times more likely if it originated from Jane Doe (Item 1) than if it originated from an unknown random contributor.

The following is the example format that will be used for reporting statements containing mixtures or partial single source profiles (one or more loci exhibit genotype combinations with weights less than 100%) with 99.0% 1-sided lower HPD:

**Lab Item 2.2: Stain from something**

Number of contributors: 3 (at least two males)
Approximate mixture proportions: 80:15:5
Assumed contributor(s): Jane Doe (Item 3)
Individually included: John Smith (Item 1; LR = at least \(<\text{insert most conservative 99.0% 1-sided lower HPD from STRmix}\)\), Susie Logan (Item 5; LR = at least \(<\text{insert most conservative 99.0% 1-sided lower HPD from STRmix}\)\)
Excluded: Mark Johnson (Item 6)
Combination of Included Individuals:
The probability of observing the mixture DNA profile is at least <insert most conservative 99.0% 1-sided lower HPD from STRmix> times more likely if it originated from Jane Doe (Item 3), John Smith (Item 1), and Susie Logan (Item 5) than if it originated from Jane Doe (Item 3) and two unknown random contributors.

**Lab Item 3.3: Swab of something**
Number of contributors: 1 male
Individually included: Peter Jones (Item 5; LR = at least <insert most conservative 99.0% 1-sided lower HPD from STRmix>)
Excluded: Jane Doe (Item 6), Jimmy Dean (Item 8)

The probability of observing this DNA profile is at least <insert most conservative 99.0% 1-sided lower HPD from STRmix> times more likely if it originated from Peter Jones (Item 5) than if it originated from an unknown random contributor.

The following is the example format that will be used for reporting statements using the **unified** likelihood ratio:

**Lab Item 4.4: Stain from something**
Number of contributors: 3 (at least one male)
Approximate mixture proportions: 68:23:9
*Assumed contributor(s):* Jane Doe (Item 6)
Individually included: Joe Smith (Item 3; LR = at least <insert most conservative unified value from STRmix>)
Excluded: Jimmy Dean (Item 8)

*With Consideration of Biological Relatives:*
The probability of observing this mixture DNA profile is at least <insert most conservative unified value from STRmix> times more likely if it originated from Jane Doe (Item 6), Joe Smith (Item 3) and one unknown random contributor than if it originated from Jane Doe (Item 6) and two unknown random contributors, to include the possibility of biological relatives of Joe Smith (Item 3).

The following is the example format that will be used for reporting likelihood statements associated with a **defined relative of interest:**

**Lab Item 4.6: Stain from something**
Number of contributors: 2 (at least one male)
Approximate mixture proportions: 78:22
*Assumed contributor(s):* Jane Doe (Item 6)
Individually included: Joe Smith (Item 3; LR = at least <insert most conservative LR value of untested biological relative of interest from STRmix>)
Excluded: Jimmy Dean (Item 8)
The probability of observing this mixture DNA profile is at least $<\text{insert LR value of relative of interest}>$ times more likely if it originated from Jane Doe (Item 6) and Joe Smith (Item 3) than if it originated from Jane Doe (Item 6) and an untested $<\text{insert biological familial relationship}>$ of Joe Smith (Item 3).

**Reporting Deconvolutions without inclusionary LR Calculations**

The following are example formats that will be used for reporting profiles which have been deconvoluted only and have not had a likelihood ratio calculation:

**Lab Item 5.5: Swab from something**

Number of contributors: 2 (at least one male)
Approximate mixture proportions: 50:50
Assumed contributor(s): Monica Jackson (Item 9)

Assuming Monica Jackson (Item 9) is a contributor, a foreign contributor was detected.

**Lab Item 5.9: Swab from something**

Number of contributors: 2 (at least one male)
Approximate mixture proportions: 50:50
Excluded: John Smith (Item 5)

No additional conclusions can be made regarding the contributor(s) to this DNA profile at this time.

**Reporting Inconclusive LRs $10^3$ to $10^{-3}$**

Propositions which result in likelihood ratio values with exponents between $10^3$ to $10^{-3}$ will be considered inconclusive and will be reported using the following statement:

“It is inconclusive whether <insert name and item# of contributor> is a contributor to the DNA results obtained because the likelihood ratio does not provide sufficient support for inclusion or exclusion.”

Individuals who are independently determined to be inconclusive will not be considered in additional propositions in combination with included contributors.

The following is the example format that will be used for inconclusive reporting statements:

**Lab Item 6.6: Swab of something**

Number of contributors: 2 (at least one male)
Approximate mixture proportions: 98:2
Individually included: Peter Jones (Item 5; LR = at least $<\text{insert most conservative 99.0% 1-sided lower HPD from STRmix}>$)
Excluded: Jane Doe (Item 9)
Inconclusive: John Deere (Item 7)
The probability of observing this mixture DNA profile is at least \textit{insert 1-sided 99\% HPD from STRmix} times more likely if it originated from Peter Jones (Item 5) and one unknown random contributor than if it originated from two unknown random contributors. It is inconclusive whether John Deere (Item 7) is a contributor to the DNA results obtained because the likelihood ratio does not provide sufficient support for inclusion or exclusion.

\textbf{Reporting Exclusionary LRs 10^{-4} or less}\n
Propositions considering individual contributors which result in likelihood ratio values with exponents of 10^{-4} or lower will be reported as exclusions.

\textbf{Exclusion of Multiple Individuals to the same DNA profile}\n
In the event that multiple individuals are excluded as contributors to the same DNA profile, it is permissible to state “All other submitted reference standards” rather than individually list the excluded individuals and their item numbers.

\textbf{Profiles deemed unsuitable for STRmix analysis due to an undetermined number of contributors}\n
In the event a profile is determined to be unsuitable for STRmix interpretation due to not being able to determine the likely number of contributors, the following descriptive elements will be stated and the following report wording will be used:

- Whether the sample yielded a DNA profile or a mixture DNA profile.
- A statement as to whether there is an indication of at least one (1) male individual being present
- The report statement: “Due to the \textit{limited or complex} nature of this profile, it is unsuitable for interpretation. The likely number of contributors to this profile cannot be determined.”

The following is the example report statement that will be used for \textit{profiles deemed unsuitable for STRmix due to having an undetermined number of contributors}:

\textbf{Lab Item 7.7: Swab of something}\n
“The DNA profile obtained is consistent with a mixture, including at least one male contributor. Due to the complex nature of this profile, it is unsuitable for interpretation. The likely number of contributors to this profile cannot be determined.”

\textbf{Mixture profiles of five or more contributors deemed unsuitable for STRmix analysis}\n
In the event a profile exhibits characteristics of five or more contributors, the following descriptive elements will be stated and the following report wording will be used:

- A statement that the sample yielded a mixture DNA profile.
- A statement that there are at least five contributors present.
- A statement as to whether there is an indication of at least one (1) male individual being present
- The report statement: “Due to the complexity of the data, no additional conclusions can be made regarding this mixture DNA profile.”

The following is the example report statement that will be used for \textit{profiles deemed unsuitable for STRmix due to having five or more contributors}:

\textbf{Lab Item 8.1: Swab of something}
“The DNA profile obtained is consistent with a mixture of at least five contributors with at least one being male. Due to the complexity of the data, no additional conclusions can be made regarding this mixture DNA profile.”

No DNA profile obtained
The following report statement will be used when DNA typing results were not obtained:

**Lab Item 8.5: Swab of something**
“A DNA profile was not obtained.”

Presence of single source contributor with up to two additional alleles
The following report statement may be used in the event a DNA profile is consistent with a single source contributor, however there are one or two additional alleles present below the 100-RFU drop-in cap that have been appropriately modeled in STRmix. This statement may also be adjusted for use with single source assumed contributors that have one or two minor alleles present, even when not interpreting the profile in STRmix:

“<One additional allele/Two additional alleles> <above/below> the interpretation threshold <was/were> detected in this sample, however due to the limited data available, no additional conclusions can be made regarding the source of <this allele/these alleles>.”

Calculation of more than one inclusionary likelihood ratio
In the event more than one likelihood ratio results in an inclusion for a particular piece of evidence, each of the individual likelihood ratios will be reported along with likelihood ratios for the different combinations of included contributors:

The following is the example format that will be used when reporting multiple combinations of inclusionary likelihood ratios:

**Lab Item 9.1: Swab of something**
- Number of contributors: 4 (at least two males)
- Approximate mixture proportions: 45:41:10:4
- Individually included:
  - Peter Jones (Item 3; LR = at least <insert most conservative 99.0% 1-sided lower HPD from STRmix>)
  - Annie Barf (Item 9; LR = at least <insert most conservative 99.0% 1-sided lower HPD from STRmix>)
  - Joe Smith (Item 4; LR = at least <insert most conservative 99.0% 1-sided lower HPD from STRmix>)
- Excluded: Jimmy Dean (Item 8)

**Combinations of Included Individuals:**
The probability of observing this mixture DNA profile is at least <insert 1-sided 99% HPD from STRmix> times more likely if it originated from Peter Jones (Item 5), Annie Barf (Item
9) and two unknown random contributors than if it originated from four unknown random contributors.

The probability of observing the mixture DNA profile is at least $\text{<insert 1-sided 99\% HPD from STRmix>}$ times more likely if it originated from Peter Jones (Item 3), Joe Smith (Item 4) and two unknown random contributors than if it originated from four unknown random contributors.

The probability of observing the mixture DNA profile is at least $\text{<insert 1-sided 99\% HPD from STRmix>}$ times more likely if it originated from Annie Barf (Item 9), Joe Smith (Item 4) and two unknown random contributors than if it originated from four unknown random contributors.

The probability of observing the mixture DNA profile is at least $\text{<insert 1-sided 99\% HPD from STRmix>}$ times more likely if it originated from Peter Jones (Item 3), Anne Barf (Item 9), Joe Smith (Item 4), and one unknown random contributor than if it originated from four unknown random contributors.

Reporting two interpretations differing in the number of contributors or the use of conditioning

In the event an analyst chooses to report two viable STRmix interpretations differing in the assumed number of contributors for the same item of evidence or if they wish to report an interpretation with and without conditioning, the number of contributors, approximate mixture proportions, and individual reference comparisons for each STRmix analysis will be reported.

The following is the example format that will be used when reporting two interpretations differing in the number of contributors:

**Lab Item 10: Swab of something (differing in number of contributors)**

Number of contributors: 3 (at least one male)

Approximate mixture proportions: 79:16:5

Individually included: Donald Baker (Item 5; LR = at least $\text{<insert most conservative 99.0\% 1-sided lower HPD from STRmix>}$)

Excluded: Stacy Monroe (Item 3)

The probability of observing this mixture DNA profile is at least $\text{<insert 1-sided 99\% HPD from STRmix>}$ times more likely if it originated from Donald Baker (Item 5) and two unknown random contributors than if it originated from three unknown random contributors.

Number of contributors: 4 (at least one male)

Approximate mixture proportions: 79:16:4:1

Individually included: Donald Baker (Item 5; LR = at least $\text{<insert most conservative 99.0\% 1-sided lower HPD from STRmix>}$)

Excluded: Stacy Monroe (Item 3)
The probability of observing this mixture DNA profile is at least \textit{<insert 1-sided 99\% HPD from STRmix> times more likely if it originated from Donald Baker (Item 5) and three unknown random contributors than if it originated from four unknown random contributors.}

The following is the example format that will be used when \textit{reporting two interpretations differing in the conditioning of the item}:

\textbf{Lab Item 10.1: Swab of something (with and without assumptions)}

\textit{Interpretation with Assumptions:}
Number of contributors: 2 (at least one male)
Approximate mixture proportions: 7:93
Assumed contributor(s): Marcy Thompson (Item 1)
Individually included: Donald Baker (Item 5; LR = at least <insert most conservative 99.0\% 1-sided lower HPD from STRmix>)
Excluded: Stacy Monroe (Item 3)

The probability of observing this mixture DNA profile is at least \textit{<insert 1-sided 99\% HPD from STRmix> times more likely if it originated from Marcy Thompson (Item 1) and Donald Baker (Item 5) than if it originated from Marcy Thompson (Item 1) and one unknown random contributor.}

\textit{Interpretation without Assumptions:}
Number of contributors: 2 (at least one male)
Approximate mixture proportions: 93:7
Individually included: Donald Baker (Item 5; LR = at least <insert most conservative 99.0\% 1-sided lower HPD from STRmix>)
Excluded: Stacy Monroe (Item 3)

The probability of observing this mixture DNA profile is at least \textit{<insert 1-sided 99\% HPD from STRmix> times more likely if it originated from Marcy Thompson (Item 1) and Donald Baker (Item 5) than if it originated from two unknown random contributors.}

\textit{Reporting multiple independently included individuals, but a combined exclusion}
In the event two (or more) individual likelihood ratios support inclusion with an item of evidence, but the likelihood ratio calculated for the presence of the individuals together in the mixture suggests that this cannot occur (exponent of LR is 10^{-4} or less), the following report wording will be included in the report:

“Though there is support for the individual inclusions of <name (Item #)> and <name (Item #)> to the mixture DNA profile, these individuals cannot be present in the mixture together. Refer to the independent inclusionary statistics above.”

\textit{Reporting multiple independently included individuals who are biologically related}
In addition, in situations in which documentation exists regarding the biological relatedness between the two individually included contributors, the following disclaimer will be included in the report:

“In DNA mixtures of closely-related individuals (such as parents, offspring, and siblings), false inclusions of other closely-related family members can occur due to the elevated sharing of genetic information between relatives.”

The following is the example format that will be used when multiple individuals are independently included, but result in a combined exclusion:

**Lab Item 11.1: Swab of something**

Number of contributors: 4 (at least one male)

Approximate mixture proportions: 68:22:7:3

Assumed contributor(s):

Individually included:

- Thomas Parson (Item 12; LR = at least <insert most conservative 99.0% 1-sided lower HPD from STRmix>)
- Benjamin Bell (Item 13; LR = at least <insert most conservative 99.0% 1-sided lower HPD from STRmix>)

Excluded:

- Laura Fink (Item 2)

Though there is support for the individual inclusions of Thomas Parson (Item 12) and Benjamin Bell (Item 13) to the mixture DNA profile, these individuals cannot be present in the mixture together. Refer to the independent inclusionary statistics reported above.

Reporting full single source unidentified contributors

If a full single source DNA profile does not match a known reference standard, this unknown profile will be assigned a sequential number based on gender (Male #1/Female #1). Amelogenin and/or the DYS391 locus may be utilized for gender determination. In the event Amelogenin and the DYS391 locus do not yield interpretable results above the analytical threshold, an item may be simply referred to as an “unknown individual”.

The following is the example format that will be used when reporting full single source unidentified contributors:

**Lab Item 12: Swab of something**

Number of contributors: 1 male

Excluded:

- Laura Fink (Item 2)

The DNA profile obtained is consistent with a single unknown male contributor (Male #1).

All reported full single source unidentified contributors will be searched in the “DNA Profile Searcher” prior to being reported to ensure that the unknown profile does not belong to a staff member or other known contaminant. The completion and date of the search will be documented on the analyst checklist contained on the casework review form.
The following report statement will be included at the end of the report to document that the unknown individual was not included in the likelihood ratio calculation(s) for mixture profiles due to not having an official reference standard for this individual:

“No conclusions can be reached at this time regarding whether <insert unknown profile and number (refer to Item #)> can be considered a possible DNA contributor to the other DNA profile(s) reported in this case. Should this individual be identified, please submit reference buccal swabs and a new Laboratory Request <in Property Connect> to perform comparisons.”

**Surreptitious standards**

In the event a single source DNA profile obtained from an evidence item is being utilized as a surreptitious standard, the following statement must be placed at the beginning of the “Results, Opinions, and Interpretations”:

“The DNA profile obtained from the <evidence item> yielded a <male/female> profile. For comparison purposes, this DNA profile will be utilized as the surreptitious standard for <subject name>.”

All subsequent comparisons made to the surreptitious standard will utilize a variation of the following language when making inclusions/exclusions:

The probability of observing this DNA profile is <approximately/at least> <insert LR Total/1-sided 99.0% HPD from STRmix> times more likely if it originated from the donor to the <evidence item> than if it originated from...

**Report disclaimers included at the end of reports which contain STRmix interpretations**

The following statements will be included at the end of reports, as applicable:

1) When likelihood ratios have been reported for known reference standards, add the following two statements:

   “Where applicable, likelihood ratios (LR) were calculated to assess whether each submitted reference standard is statistically included or excluded, individually, as a contributor to the reported DNA profile(s). The reported LR value for an “Individually Included” reference standard is reflective of the likelihood ratio calculation associated with the listed individual, without being considered in combination with other reference standards, except where an “Assumed Contributor” is denoted.”

   “The likelihood ratios are based upon propositions that can explain the evidence. This includes assumptions as to the number of contributors present in the DNA profile and, unless otherwise noted, that each unknown contributor is unrelated to the named reference standards. Since a range of propositions might explain the evidence, either interested party to this case, prosecution and/or defense, may request an additional likelihood ratio that incorporates an additional proposition more accurately representing their position. All requests must be submitted in a timely manner, must be reasonable given the test results, and must be within the capability and validated application of the program used.”

2) When mixture proportions are included in the report, add the following statement:

   “Mixture proportions signify the approximate percentage of each contributor to the mixture DNA profile.”
Request for buccal swabs
When STRmix analysis has yielded unidentified components or a surreptitious standard has been used for comparison purposes, the following statement will be added to the end of the report:

“For comparison purposes, please collect reference buccal swab(s) from <the consensual partner or> individuals believed to be involved in (or who have had reasonable access to) this incident. When a reference buccal swab is obtained, please submit a Forensic Laboratory Request <in Property Connect> to complete the case.”

Statistical statements
For all situations in which statistics were calculated and reported using STRmix, the following statement must be included at the end of the report depending on the population database utilized:

- **Expanded FBI Population Database for Identifiler Plus**
  “Statistical probabilities were calculated using the recommendations of the National Research Council (NRC II) utilizing the FBI database (Moretti, T.R., Moreno, L.I., Smerick, J.B., Pignone, M.L., Hizon, R., Buckleton, J.S., Bright, J.A., Onorato, A.J. (2016) Population data on the expanded CODIS core STR loci for eleven populations of significance for forensic DNA analyses in the United States. Forensic Sci. Int. Genet. 25: 175-181). The probability that has been reported is the most conservative value obtained from the US Caucasian (CAU), African American (BLK), and Southwest Hispanic (SWH) population databases. All likelihood ratios calculated by the LVMPD are truncated to three significant figures.”

- **NIST Population Database for Investigator 24plex QS**
  “Statistical probabilities were calculated using the recommendations of the National Research Council (NRC II) utilizing the NIST database (Hill, C.R., Duewer, D.L., Kline, M.C., Coble, M.D., Butler, J.M. (2013) U.S. population data for 29 autosomal STR loci. Forensic Sci. Int. Genet. 7: e82-e83 and Steffen, C., Coble, M., Gettings, K., Vallone, P. Corrigendum to ‘U.S. Population Data for 29 Autosomal STR Loci’ [Forensic Sci. Int. Genet. 7 (2013) e82-83]. Forensic Sci Int. Genet. 31 (2017) e36-e40). The probability that has been reported is the most conservative value obtained from the US Caucasian (CAU), African American (AA), and Hispanic (HSP) population databases. All likelihood ratios calculated by the LVMPD are truncated to three significant figures.”

12.10 Statistical Report Statements using Popstats for Outsourced Cases

12.10.1 Random Match Probability (RMP)
The following statement should be utilized when a Random Match Probability has been calculated for a sample:

“The probability of randomly selecting an unrelated individual from the general population having a DNA profile that is consistent with the <full/partial/major/minor/deduced> DNA profile obtained from the evidence sample is approximately 1 in <insert most conservative Popstats calculation truncated to three (3) significant figures (without rounding)>.”
12.10.2 Likelihood Ratio (LR) for Outsourced Cases

The following statement should be utilized when a Likelihood Ratio (LR) has been calculated for a sample.

“The mixture DNA profile obtained is consistent with originating from the known DNA profiles of <name #1> and <name #2>. The probability of observing this mixture DNA profile is <insert most conservative Popstats calculation truncated to three (3) significant figures (without rounding)> times more likely if the mixture originated from <name #1> and <name #2> than if it originated from <name #1> and an unrelated individual randomly selected from the general population.”

12.10.2.1 The LR statement above must be modified to reflect the sample-specific H1 and H2 hypotheses.

12.10.3 For all situations in which statistics were calculated and reported utilizing the Popstats software, the following statement must be included at the end of the report depending on the population database utilized:

**FBI Amended Population Database for Identifiler Plus:**

“Statistical probabilities were calculated using the recommendations of the National Research Council (NRC II) utilizing the FBI database (J Forensic Sci 44 (6) (1999): 1277-1286 and J Forensic Sci doi: 10.1111/1556-4029.12806; J Forensic Sci 46 (3) (2001) 453-489 and Forensic Science Communications 3 (3) (2001)). The probability that has been reported is the most conservative value obtained from the US Caucasian (CAU), African American (BLK), and Southwest Hispanic (SWH) population databases. These numbers are an estimation for which a deviation of approximately +/- 10-fold may exist. All random match probabilities and likelihood ratios calculated by the LVMPD are truncated to three significant figures.”

**NIST Population Database for Investigator 24plex:**

Statistical probabilities were calculated using the recommendations of the National Research Council (NRC II) utilizing the NIST database (Hill, C.R., Duewer, D.L., Kline, M.C., Coble, M.D., Butler, J.M. (2013) U.S. population data for 29 autosomal STR loci. Forensic Sci. Int. Genet. 7: e82-e83 and Steffen, C., Coble, M., Gettings, K. Vallone, P. Corrigendum to ‘U.S. Population Data for 29 Autosomal STR Loci’ [Forensic Sci. Int. Genet. 7 (2013) e82-83]. Forensic Sci Int. Genet. 31 (2017) e36-e40). The probability that has been reported is the most conservative value obtained from the US Caucasian (CAU), African American (AA), and Hispanic (HSP) population databases. These numbers are an estimation for which a deviation of approximately +/- 10-fold may exist. All random match probabilities and likelihood ratios calculated by the LVMPD are truncated to three significant figures.”
12.11 Amended Reports
Amended reports will be issued when an error is identified associated with a previous report. These errors may be either administrative or technical in nature. The purpose is to retract the information contained in the original report and supersede it with the information contained in the amended report.

12.11.1 Amended Reports due to Re-Evaluation of Previously Reported Data
A Forensic Scientist has the right to retract data previously reported data that is no longer supported by significant evolution in technology or fundamental practices. An amended report will be issued which details the specific item numbers which were re-evaluated and the amended results.

The following disclaimer will be used:
“This lab report amends the previous lab report dated <original report date>. The originally generated data associated with <insert item #> was subjected to re-evaluation on <insert date>. The results of this re-evaluation are reported below.”

12.11.2 Amended Reports due to FBI Amended Allele Frequency Data
Due to the June 2015 release of amended allele frequencies associated with the FBI population databases utilized in the Popstats software for Identifiler Plus profiles, the LVMPD will re-calculate DNA statistics for all potentially affected DNA cases with upcoming court dates, discovery requests, or if a case is otherwise requested by legal counsel. The amended reports fall into one of the following two categories and will utilize the following reporting disclaimers and statistical citations:

12.11.2.1 Report Disclaimer and statistical statement for amended reports with statistics that change from that previously reported:
“This lab report amends the previous lab report dated <original report date> due to the release of amended allele frequencies associated with the FBI population database used for the previously reported statistical calculations.

On June 3, 2015, the FBI provided a pre-publication copy of the erratum regarding the original publication “Population data on the thirteen CODIS core short tandem repeat loci in African Americans, US Caucasians, Hispanics, Bahamasians, Jamaicans and Trinidadians” (J Forensic Sci 1999;44(6):1277-86). The erratum notes and amends several errors made in the original allele frequency data published in 1999 and utilized within the Popstats software. This software program is used by the LVMPD to calculate reported statistics. The underlying data that created the allele frequencies employed by the Popstats software is provided from and maintained by the FBI.

The below amended report utilizes the amended allele frequency data for all statistical calculations. These amended allele frequencies have been internally performance checked by the LVMPD to demonstrate that they have been successfully updated in the Popstats software. All reported statistical calculations will be reported using the same number of significant
figures <and/or identity thresholds> as originally reported on <insert date of original report>.

Statistical probabilities were calculated using the recommendations of the National Research Council (NRC II) utilizing the FBI database (J Forensic Sci 44 (6) (1999): 1277-1286 and J Forensic Sci doi: 10.1111/1556-4029.12806; J Forensic Sci 46 (3) (2001) 453-489 and Forensic Science Communications 3 (3) (2001)). The probability that has been reported is the most conservative value obtained from the US Caucasian (CAU), African American (BLK), and Southwest Hispanic (SWH) population databases. These numbers are an estimation for which a deviation of approximately +/- 10-fold may exist."

12.11.2.2 Report Disclaimer and statistical statement for amended reports with statistics that do not change from that previously reported:

“This lab report amends the previous lab report dated <original report date> due to the release of amended allele frequencies associated with the FBI population database used for the previously reported statistical calculations.

On June 3, 2015, the FBI provided a pre-publication copy of the erratum regarding the original publication “Population data on the thirteen CODIS core short tandem repeat loci in African Americans, US Caucasians, Hispanics, Bahamians, Jamaicans and Trinidadians” (J Forensic Sci 1999;44(6):1277-86). The erratum notes and amends several errors made in the original allele frequency data published in 1999 and utilized within the Popstats software. This software program is used by the LVMPD to calculate reported statistics. The underlying data that created the allele frequencies employed by the Popstats software is provided from and maintained by the FBI.

On <insert date of new calculations>, the originally reported data associated with this case file was subjected to recalculation using the amended allele frequency data for all previously performed statistical calculations. Based upon this recalculation event, the statistical values did not change from those previously reported by the LVMPD on <insert date of original report>.

Statistical probabilities were calculated using the recommendations of the National Research Council (NRC II) utilizing the FBI database (J Forensic Sci 44 (6) (1999): 1277-1286 and J Forensic Sci doi: 10.1111/1556-4029.12806; J Forensic Sci 46 (3) (2001) 453-489 and Forensic Science Communications 3 (3) (2001)). These numbers are an estimation for which a deviation of approximately +/- 10-fold may exist.”

12.11.3 Amended Reports due to NIST Amended Allele Frequency Data
The LVMPD will only re-calculate DNA statistics upon request for Qiagen Investigator 24plex QS profiles generated prior to August 29, 2017. The amended reports fall into one of two categories and will utilize the following reporting disclaimers:

**12.11.3.1 Report Disclaimer and statistical statement for amended reports with statistics that change from that previously reported:**
“This lab report amends the previous lab report dated <original report date> due to the release of amended allele frequencies associated with the NIST population database used for the previously reported statistical calculations.

The below amended report utilizes the amended allele frequency data for all statistical calculations. These amended allele frequencies have been internally performance checked by the LVMPD to demonstrate that they have been successfully updated in the Popstats software. All reported statistical calculations will be reported using the same number of significant figures <and/or identity thresholds> as originally reported on <insert date of original report>.

Statistical probabilities were calculated using the recommendations of the National Research Council (NRC II) utilizing the NIST database (Hill, C.R., Duewer, D.L., Kline, M.C., Coble, M.D., Butler, J.M. (2013) U.S. population data for 29 autosomal STR loci. Forensic Sci. Int. Genet. 7: e82-e83 and Steffen, C., Coble, M., Gettings, K. Vallone, P. Corrigendum to 'U.S. Population Data for 29 Autosomal STR Loci' [Forensic Sci. Int. Genet. 7 (2013) e82-83]. Forensic Sci Int. Genet. 31: e36-e40). The probability that has been reported is the most conservative value obtained from the US Caucasian (CAU), African American (AA), and Hispanic (HSP) population databases. All likelihood ratios calculated by the LVMPD are truncated to three significant figures. These numbers are an estimation for which a deviation of approximately +/- 10-fold may exist. All likelihood ratios calculated by the LVMPD are truncated to three significant figures.”

**12.11.3.2 Report Disclaimer and statistical statement for amended reports with statistics that do not change from that previously reported:**
“This lab report amends the previous lab report dated <original report date> due to the release of amended allele frequencies associated with the NIST population database used for the previously reported statistical calculations.

On <insert date of new calculations>, the originally reported data associated with this case file was subjected to recalculation using the amended allele frequency data for all previously performed statistical calculations. Based upon this recalculation event, the statistical values did not change from those previously reported by the LVMPD on <insert date of original report>.

Statistical probabilities were calculated using the recommendations of the National Research Council (NRC II) utilizing the NIST database (Hill, C.R., Duewer, D.L., Kline, M.C., Coble, M.D., Butler, J.M. (2013) U.S. population data for 29 autosomal STR loci. Forensic Sci. Int. Genet. 7: e82-e83 and
Steffen, C., Coble, M., Gettings, K. Vallone, P. Corrigendum to ‘U.S. Population Data for 29 Autosomal STR Loci’ [Forensic Sci. Int. Genet. 7 (2013) e82-83]. Forensic Sci Int. Genet. 31: e36-e40). The probability that has been reported is the most conservative value obtained from the US Caucasian (CAU), African American (AA), and Hispanic (HSP) population databases. All likelihood ratios calculated by the LVMPD are truncated to three significant figures. These numbers are an estimation for which a deviation of approximately +/- 10-fold may exist. All likelihood ratios calculated by the LVMPD are truncated to three significant figures.”

12.12 Supplemental Reports
Supplemental reports represent additional information (new evidence, new comparisons to reference standards, additional interpretation) as it pertains to a previously reported case. Supplemental reports do not retract previously reported data or supersede previously reported results.

Required Changes When Writing Supplemental Reports
In the event a supplemental report is required due to the submission of additional evidence items and/or reference standards for analysis/comparison for a case, changes are not required to be made to the original evidence interpretations or reporting style with the exception of the following items:

1) Where applicable, previously-reported RMP statements will be updated to reflect non-identity statements, truncated to three significant figures.
2) Previously-issued CPE statistics will be converted to CPI using the originally generated Popstats data.
3) Inconclusive report statements must be updated to include the qualitative reason for deeming the profile (or a portion thereof) as inconclusive.
4) Previously reported and designated unknown profiles (e.g. Unknown Male #1, Unknown Female #1, etc.) must be searched in the “DNA Profile Searcher” and documented in the Analyst Checklist.
5) All previously-issued statistics calculated prior to the June 2015 allele frequency update will be re-calculated utilizing the updated FBI amended allele frequencies.
6) If a DNA profile was entered into CODIS the CODIS statement will be repeated with the following modifications:
   “The <major/partial/minor/deduced/a portion of the mixture> DNA profile was searched against the Local DNA Index System (CODIS) and was uploaded to the <State/National> DNA Index System (CODIS) for comparison. You will be notified of any match(es).”

12.12.1 Supplemental Reports and STRmix
If a reference standard is received to be compared to an item which was previously interpreted prior to the use of STRmix and determined to be eligible for single source or mixture-level statistics, however the statistic was not calculated (RMP, CPI or LR) or an unknown component was determined to be present, the item may be re-analyzed and compared to the reference standard in STRmix based on analyst discretion. Alternatively, the evidence may utilize the interpretation guidelines that were adopted in the Technical Manual at the time of the original analysis (to include the use of Popstats for statistical calculations). Analysts may refer to these archived Technical Manuals for guidance.
Items of evidence which were previously-reported as inconclusive (or a portion thereof) or where a CPI was calculated, but resulted in a low statistic may be re-analyzed in STRmix based on analyst discretion. These items will be reported using the results of STRmix analysis.

Whenever STRmix is used for reinterpretation, the injection list and electropherograms for data re-analyzed in GeneMapper ID-X and exported into STRmix will be printed for the supplemental case file.

When a reference standard is received for comparison to a previously reported unknown single source evidence profile and a STRmix deconvolution has not yet been performed, the GeneMapper ID-X STRmix injection list from the original analysis will be printed for the supplemental case file, along with a copy of the previously reported evidence electropherogram. This documentation will be re-paginated in the supplemental case file in support of the new STRmix run and comparison to the reference standard.

If the evidence sample was not previously analyzed using the necessary STRmix analysis parameters, the sample will be re-analyzed in GeneMapper ID-X and exported to STRmix in accordance with Chapter 8. The new STRmix injection list and electropherogram will be printed for the supplemental case file.

**Supplemental Report Disclaimer for Reinterpretation in STRmix based on Analyst Discretion**

When an analyst re-evaluates their previously reported data and determines it to be suitable for STRmix reinterpretation, the following disclaimer will be used:

“The data originally generated in <insert year of original analysis> associated with <insert item #> was subjected to re-evaluation and re-analysis using the STRmix software adopted by the Biology/DNA Detail on September 18, 2017. The results of this re-analysis are reported below.”

**STRmix Re-Analysis Due to Lieutenant Written Request or Legal Court Order**

Only items which were previously reported as inconclusive (or a portion thereof) will be considered for re-analysis using STRmix. If statistics were previously reported (RMP, CPI, or LR using Popstats), the item will not be re-analyzed in STRmix.

- The supplemental report will only include the results of the specific items re-analyzed and not all items contained within the original report.
- The following disclaimer will be used when STRmix analysis is performed:
  “A <request or court order> for re-analysis of <insert item #> was received on <insert date>. The data originally generated in <insert year of original analysis> associated with this item # was subjected to re-analysis using the STRmix software. The results of this re-analysis are reported below.”
- The following disclaimer will be used when re-evaluation of the original data does not support the use of STRmix:
  “A <request or court order> for re-analysis of <insert item #> was received on <insert date>. Based on a re-evaluation of the quality of the data originally generated and the laboratory’s policies and procedures associated with the validated use of the STRmix software, it was determined that <insert item #> is not suitable for re-analysis.”
12.12.2 Supplemental Report Disclaimer for Reinterpretation of Legacy Data (Profiler Plus/COfiler, Identifiler, or Identifiler Plus)

Based on the SWGDAM “Clarification on the Reinterpretation of Data Typed with Legacy Amplification Test Kits” released in June 2016, the following will be used as a definition for reinterpretation: “Assessing/evaluating allele calls, genotype calls (to include potential allelic drop-out), a change in the assumptions used, or removing alleles (or entire loci) from statistical estimates from legacy amplification test kit data, are all considered reinterpretation.”

If a supplemental report is being issued in which comparisons are made to legacy data that has had the original interpretation modified in any way (whether manually or with STRmix), the following statement must be included as a disclaimer in the report:

“Due to the receipt of a supplemental request, this report supersedes all previously issued DNA results and conclusions. The below reinterpretation is based on guidance set forth by the Scientific Working Group on DNA Analysis Methods (SWGDAM) and a review of the validations and standard operating procedures in place at the time the original/supplemental report was issued on <XXX>.”

12.12.3 Supplemental Report Disclaimer for Reinterpretation using a Requested Alternative Set of Propositions

The LVMPD allows either interested party to a case, the prosecution and/or defense, to request an additional likelihood ratio calculation that incorporates an additional proposition which more accurately represents their position. In cases in which such a request is received, the following statement will be included as a disclaimer on the report:

"A request for an additional likelihood ratio calculation for <insert Lab Case # and Item #> was received on <insert date>. The data originally generated in <insert year of original analysis> associated with this item # was subjected to re-evaluation to determine whether the requested alternative likelihood ratio is reasonable given the previously reported test results. The results of the two alternative evaluations of the <insert Lab Case # and Item #> are reported below. These evaluations differ in <insert the difference between the originally reported proposition and the requested proposition (e.g. the number of contributors which can explain the observed mixture DNA profile)>.”

12.13 Modification of Identity Statements

When issuing a supplemental or amended report for reports issued prior to March 24, 2015 in which additional comparisons/interpretations are taking place AND identity statements were previously reported, the following statement will be added to the DNA report prior to the first reported item conclusion in order to explain the modification from identity statements:

“This report supersedes all previously issued DNA results and conclusions based on modifications to the Biology/DNA policies and procedures effective March 24, 2015.

On March 24, 2015, the Biology/DNA Detail ceased reporting identity statements when an individual could not be excluded from a DNA profile that was rarer than approximately 1 in 100 times the world’s estimated population. Where applicable, the below reported conclusions represent the original statistical calculations performed on <insert date from Popstats print-out> without being truncated for identity purposes. Modified statistical statements will be delineated using an <asterisk (*)>.”
12.13.1 The modification to the new RMP report statement will also extend to supplemental or amended reports in which additional comparisons/interpretations take place and non-identity RMP statements were previously reported. The language will be modified from “…rarer to 1 in XXX” to the updated RMP statement “The probability of randomly selecting an unrelated individual from the general population having a DNA profile that is consistent with…”

12.14 Evidence Disposition and Case File Disclaimers
The following statements will be added above the signature line at the end of the report in the following order:
1) “The evidence is returned to secure storage.”
2) “---Start date of testing: <insert date Unit Record was assigned in LIMS>---”
3) “---This report does not constitute the entire case file. The case file may be comprised of worksheets, images, analytical data and other documents.---”

Note: It is permissible to remove the flanking “---” from the second and third statements above based on analyst discretion.

The following statements will be added to the end of each report, as applicable:
- “DNA extracts generated during the analysis of this case and/or cuttings taken from the evidence may be available for future testing.”

12.15 Parentage Report Statements

12.15.1 Parentage Index
If the alleged father cannot be excluded as the biological father, the following statement should be utilized:

"It is <XXX (insert parentage index)> times more likely to observe the DNA profile obtained from <Child> if <Alleged Father> is the biological father than if a random, untested man in the general population who is unrelated to <Alleged Father> is the biological father.

The probability of paternity is <XX.XXXXX% (insert probability of parentage)> (assuming a prior probability of 0.50) as compared to a random, untested individual from the general population.”

If the alleged father can be excluded as the biological father, the following statement should be utilized:

“The DNA profiles obtained from <Child XXX> and <Mother XXX> were compared with that of <Alleged Father XXX>. <Alleged Father XXX> is excluded as the biological father of <Child XXX>.”

12.15.2 Reverse Parentage Index and Reverse Probability of Paternity
If the alleged couple cannot be excluded as the biological parents of the child, the following statement should be utilized:

"It is <XXXXX (insert reverse parentage index) times more likely to observe the DNA profile obtained from <Child> if they are the biological child of <Alleged Mother> and <Alleged Father>
than if the DNA profile originated from a random, untested individual from the general population.

The probability of paternity is <XX.XXXXX% (insert probability of parentage)> (assuming a prior probability of 0.50) as compared to a random, untested individual from the general population.”

If the alleged couple can be excluded as the biological parents of the child, the following statement should be utilized:

“The DNA profile of <Child XXX> was compared with that of <Alleged Mother XXX> and <Alleged Father XXX>. <Child XXX> is excluded as the biological child of <Alleged Father XXX> and <Alleged Mother XXX>.”

12.15.3 Single Parent Comparison

In cases of missing persons or potential homicides in which a body has not been located and a secondary standard is not available, the single parent comparison may be used to infer whether a single source evidence sample may be biologically related to a single alleged parent.

If the alleged parent cannot be excluded as the biological parent of the child, the following statement should be utilized:

“The DNA profile of <Alleged Parent> was compared with that of <Child>. <Alleged Parent> cannot be excluded as the biological <mother/father> of <Child>.

It is <XXXXX (insert single parentage index)> times more likely to observe the DNA profile obtained from <Child> if <Alleged Parent> is the biological <mother/father> of <Child> than if a random, untested <woman/man> from the general population is the biological <mother/father>. The probability of excluding a random <woman/man> from the general population as the biological <mother/father> given the alleles of the child is greater than <XX.X (insert single parentage probability of exclusion)>%.”

If the alleged parent can be excluded as the biological parent of the child, the following statement should be utilized:

“The DNA profile of <Alleged Parent> was compared with that of <Child>. <Alleged Parent> can be excluded as the biological <mother/father> of <Child>.

12.16 Mutation Statements

Refer to mutation rates observed in the Popstats program.

If two (2) or fewer possible mutations are observed, in the conclusions state “The presence of a possible mutation was observed in the DNA profile of <XXX>. This was taken into consideration when performing statistical calculations.”

12.17 Contamination Report Statements

There are several types of contamination which can be categorized as either attributable or unattributable. Attributable contamination describes a contamination event where the source of the contamination is known and can be identified. Unattributable contamination describes a
contamination event where the source of the contamination is unknown and cannot be identified.

12.17.1 Contamination Attributable to an Internal DNA Laboratory Processing Event

- If contaminated reagent blanks and/or controls cannot be resolved through re-analysis, the following report statement will be used:
  “Due to an associated control failure, no conclusions will be made with regard to <XX>.”

- If contaminated samples cannot be resolved through re-analysis (whether due to internal sample-to-sample contamination, contamination by a member of the Biology/DNA Detail, sample switch, etc.), the following report statement will be used:
  “Due to a sample contamination issue, no conclusions will be made in regard to <XX>.”

- If a buccal swab has not been provided for confirmation from the DNA examiner to be used to attempt to resolve mixture DNA profiles, the following statement will be used:
  “A <insert job title> with the LVMPD Forensic Laboratory cannot be excluded as a contributor to the DNA profile obtained from <XXXX>. No additional conclusions can be made regarding this mixture.”

- If a DNA examiner (Forensic Scientist, Forensic Laboratory Technologist, etc.) in the Biology/DNA Detail contaminated a sample and their known DNA profile was subsequently confirmed and used to condition the deconvolution, the following disclaimer will precede the reporting of the STRmix results:
  “A <insert job title> with the LVMPD Forensic Laboratory cannot be excluded as a contributor to the DNA profile obtained from <XXXX>. This individual’s DNA profile was utilized to further interpret the evidence DNA profile. The results of this interpretation are reported below.”

  The name of the DNA examiner will not be listed in the report. Only the title of their position (e.g. Forensic Scientist, Forensic Laboratory Technologist, etc.) will be reported when identifying that an assumed contributor was used for interpretation.

12.17.2 Contamination Attributable to a Sample Switch Occurring within the Laboratory

  “Due to a sample contamination issue, no conclusions will be made in regard to <XX>.”

12.17.3 Contamination Attributable to an Individual External to the Laboratory Processing Events

- If contamination is identified by a search of the “DNA Profile Searcher” elimination database with any individual other than the DNA examiner and a buccal swab has not been provided for confirmation from the individual identified as the potential source of the contamination, the following report statement will be used:
  “An individual contained within the LVMPD elimination database cannot be excluded as a contributor to the DNA profile obtained from <XXXX>. No additional conclusions can be made regarding this mixture.”

- If an individual had documented reasonable access to the evidence and their known DNA profile was subsequently confirmed and used to condition the deconvolution, the following disclaimer will precede the reporting of the STRmix results:
“An individual associated with the LVMPD elimination database cannot be excluded as a contributor to the DNA profile obtained from <XXXX>. This individual’s DNA profile was utilized to further interpret the evidence DNA profile. The results of this interpretation are reported below.”

The name of the individual will not be listed in the report. Only the title of their position (e.g. Crime Scene Analyst, etc.) will be reported when identifying that an assumed contributor was used for interpretation.

- In the event a sample is entered into CODIS and later hits on an elimination standard, an additional report will be issued to reflect the detection of the contamination. The affected sample(s) and/or case(s) will be re-analyzed when possible. The contaminated profile will be removed from CODIS.

12.17.4 Unattributable Contamination
Examples include contaminated reagent blanks and/or controls which cannot be resolved through re-analysis. In the “Results, Opinions, and Interpretations” state: “Due to an associated control failure, no conclusions will be made with regard to <XX>.”

12.18 CODIS Report Statements
Anytime a DNA profile is searched in the CODIS database a statement to that effect must be included in the report. The following statements will be utilized when a DNA profile will be entered into CODIS. Reference standards requiring the below statements will be added to the report using the Lab Item # as a heading:

12.18.1 Regular or Supplemental Search
“The <major/partial/minor/deduced/a portion of the mixture> DNA profile <will be/was> searched against the Local DNA Index System (CODIS) and <then/was> uploaded to the <State/National> DNA Index System (CODIS) for comparison. You will be notified of any match(es).”

12.18.2 Volunteer Sample
“The DNA profile obtained from the volunteer sample submitted from <XXX> will be searched against the Local DNA Index System (CODIS) and then uploaded to the State DNA Index System (CODIS) for comparison. You will be notified of any match(es).”

12.18.3 Juvenile Volunteer Sample
“The DNA profile obtained from the volunteer sample submitted from <XXX> cannot be entered into CODIS because <he/she> was a juvenile at the time of consent.”

Note: In the event the above statement is not utilized, documentation must be retained in the case file regarding the notification of the Detective and/or investigating agent.

12.18.4 Sample Removal Statements
“The DNA profile was removed from the <National DNA Index System (CODIS) and/or State DNA Index System (CODIS)> and will be retained at the Local DNA Index System (CODIS) because <insert reason>.”
Biology/DNA Procedures Manual
Document Number: 36710

Approval Date: 01/23/2019
Approved By: Jessica Charak, Kellie Gauthier,
Kim Murga, Cassandra Robertson
Date Published: 01/23/2019

Revision Number: 6

AR

CH
IV

ED

“The <major/partial/minor/deduced/a portion of the mixture> DNA profile obtained from <XX>
was removed from the <Local/State/National> DNA Index System (CODIS). This profile is not
suitable for searching in CODIS because <insert reason>.”

Uncontrolled Copy if not located in Qualtrax

Page 209 of 298


13.0 Title: CODIS Policies and Procedures

13.1 CODIS Policies: LVMPD and CODIS Responsibilities

- Receive and store DNA samples from convicted persons pursuant to NRS 176.0913, convicted offenders from out-of-state on probation or parole pursuant to NRS 176.0916, sex registrants pursuant to NRS 179D.240, 179D.443, and 179D.460, and persons arrested for a felony pursuant to NRS 176.09123.

- Provide a repository of DNA profiles from convicted persons, persons required to register as sex offenders, and persons arrested for a felony, for entry into CODIS at the Local level for upload to the State and National levels.

- Provide a repository of DNA profiles from forensic cases, unidentified human remains, relatives of missing persons, and voluntary samples for comparison in the Local CODIS system and possible upload to the State and National CODIS systems, if eligible for comparison.

- Ensure that the laboratory is in compliance with National DNA Index System (NDIS) regulations.

- Provide information to investigators to assist in the investigation of crimes and identification of recovered human remains.

- Access to the CODIS program is limited to the CODIS Administrator, alternate administrators, and other approved CODIS users to include the analysts, Biology/DNA Detail Laboratory Manager, Biology/DNA Detail Supervisor and Technical Leader. No instrument or software may be linked or interfaced to the CODIS PC or software.

- Court orders may also be received for expungement of database, voluntary, or forensic samples from the database.

- The only persons permitted to provide information to outside agencies are the Laboratory Director, the CODIS Administrator, alternate administrators, and other CODIS users to include the analysts, Biology/DNA Detail Laboratory Manager, Biology/DNA Detail Supervisor and Technical Leader.
  
  a. The identity of any person/agency making a request for information should be verified prior to the release of any information.
  
  b. The release of information is restricted to appropriate criminal justice agencies.

- All DNA records and DNA samples submitted to the LVMPD shall be exempt from the public records law (NRS239.010-239.030). DNA records and DNA samples submitted in association with CODIS to the LVMPD may only be released for the following authorized purposes:
  
  a. For law enforcement identification purposes, including the identification of human remains;
  
  b. For criminal defense and appeal purposes, to a defendant, who shall have access through proper legal proceedings to samples and analyses performed in connection with the case in which such defendant is charged or was convicted; and
  
  c. To criminal justice agencies, if personally identifiable information is removed, for forensic validation studies, forensic protocol development or quality control purposes and establishment or maintenance of a population statistics database.
Rules of Authority

- The CODIS program and DNA Databasing Laboratory are part of the Biology/DNA Detail of the LVMPD Forensic Laboratory. Each DNA analyst has casework and/or database duties depending on competency and proficiency status for the STR amplification kit used in each workflow.
- To further the goals and objectives of the CODIS program the Laboratory Director has delegated the authority for running and maintaining the program to the CODIS Administrator.
- If two analysts are in disagreement over a problem, a third qualified DNA analyst, the Technical Leader or the CODIS Administrator may be requested to resolve a technical issue.
- The Nevada CODIS State Administrator at the WCSO Forensic Sciences Division will also be the "Designated State Official" (DSO) for communications with NDIS. The responsibilities of this position include: uploading data from the local LVMPD and WCSO databases to the state and national databases, performing auto searches of the state database, and keeping the computer systems functional and secure. The State Administrator communicates information from national CODIS State Administrator meetings and is available by phone or email for technical assistance.
- Requests for searches will be directed to the Biology/DNA Detail of the LVMPD and the WCSO laboratory.

LVMPD Forensic Lab Workflow
LVMPD is a local user of CODIS. LVMPD participates at the LDIS (Local DNA Index System) level and eligible profiles are then uploaded to the SDIS (State DNA Index System) level which is maintained by the Washoe County Sheriff’s Office (WCSO). The SDIS level, WCSO, then uploads the profiles up to the NDIS (National DNA Index System) level which is maintained by the Federal Bureau of Investigation (FBI) if they meet the appropriate criteria.

The Biology/DNA Detail processes several types of samples for entry into CODIS, each categorized into one of two groups: casework or database (includes convicted offenders and felony arrestees). The database samples are entered into the Local DNA Index System (LDIS) through a direct electronic “Import” by the CODIS Administrator (or alternate) using the Convicted Offender or Arrestee specimen categories assigned during technical review. The casework samples are entered by STR Data Entry.

Further classification occurs when a sample ‘hits’ in CODIS. An “Offender Hit” occurs when an unsolved casework DNA profile is connected to a convicted offender DNA profile. An “Arrestee Hit” occurs when an unsolved casework DNA profile is connected to an arrestee DNA profile. Typically these two kinds of hits come from database samples. “Forensic Hits” occur when casework DNA profiles match from one case to another.

Elimination Database
The LVMPD Forensic Lab maintains a database of employee profiles to identify any biological contamination that may occur. The Elimination Index includes the DNA profiles of all members of the Forensic Laboratory and Crime Scene Analysts of the Criminalistics Bureau of the LVMPD required to provide a sample, as well as DNA profiles of lab vendors, detectives, investigating agents of the LVMPD, nurse examiners and other Law Enforcement personnel from outside jurisdictions who have provided their DNA sample on a voluntary basis for entry into the index. The Elimination Index is used for screening purposes only. The index is not used for investigative
purposes, and profiles that reside in the Elimination Index of CODIS cannot be uploaded to SDIS or NDIS.

13.2 Casework Samples
This group consists of forensic known and unknown samples, as well as volunteer samples, that may originate from evidence and reference standards collected during any law enforcement agency investigation.

Samples will be analyzed using the DNA procedures developed for casework. Analysis will be attempted at the original STR core CODIS loci: D3S1358, VWA, FGA, D8S1179, D21S11, D18S51, D5S818, D13S317, D7S820, CSF1PO, TPOX, TH01 and D16S539 and the Amelogenin sex indicator. The Qiagen Investigator 24plex QS kit also tests at SE33, D1S1656, D2S441, D2S1338, D10S1248, D19S433 and D22S1045, as well as a Y-marker DYS391.

Analysis results will be maintained in the original laboratory case file or scanned into the Object Repository of the LIMS, and in electronic format in the DNA laboratory.

A CODIS Data Entry packet is created for those samples that are eligible for keyboard STR Data Entry (SDE form).

No CODIS entries may be made until the case file have been technically reviewed by a qualified DNA Analyst. Casework samples are not uploaded to the State DNA database (SDIS) until after administrative review. The DNA section uses these criteria and also checklists on review forms to ensure proper review of CODIS eligible samples.

Volunteer Index
Known samples, also called Voluntary or Volunteer samples, can originate from any law enforcement agency or CSI and are considered evidentiary. Typically these are buccal swabs and require an accompanying signed consent form from the donor. Volunteer samples are processed as part of a case and are tracked as evidence; they are not processed as Database samples. Juveniles are not allowed to be entered as a volunteer sample at this time. If the consent form is signed by a juvenile or with the parents’ consent the sample will NOT be entered into the Volunteer Index.

All reference standards with a signed volunteer consent will be entered into CODIS with the exception of the following:

1) The individual signing the volunteer consent form also signed a victim consent form.
2) If a Volunteer Consent Form is received from the listed victim in the case, the Detective will be contacted to determine if the individual should be entered. In the event a response is not received by the time the case is completed, the profile will not be entered into CODIS. The profile may be entered at a later date if a response is received from the Detective.
3) If a Volunteer Consent Form is received from an elimination or consensual partner in the case, the Detective may be contacted to determine if the individual should be entered. In the event a response is not received by the time the case is completed, the profile will be entered into CODIS. The profile may be deleted at a later date if a response is received from the Detective.
Documentation of all discussions with the Detective regarding the Volunteer Consent Form will be included in the case file or OR.

Samples that consist of single source DNA profiles from volunteer reference standard samples that contain complete results for D2S1338, D19S433 and all 13 core CODIS loci for upload only to SDIS and will **NOT** be uploaded to NDIS. If a case has both a CODIS eligible volunteer sample and a forensic sample that is a benchmark match to the volunteer, the sample that will go to the higher level of CODIS for searching will be entered and uploaded.

**Forensic Indexes**
Evidence collected at crime scenes during any law enforcement agency investigation may be suitable for DNA analysis and entry into CODIS. These samples are typically forensic unknowns and are run against the offender, arrestee, volunteer, and all forensic unknown indexes in CODIS if they meet specific eligibility criteria. Not all samples will qualify as CODIS has strict requirements for what is allowed for entry into the indexes.

Some samples may match a known buccal swab in the case but the evidence profile may still be eligible to be entered in the Forensic indexes.

- **Forensic Unknown Index**
  Consists of single source DNA profiles from forensic samples that contain complete results for all 13 original CODIS core loci.

- **Forensic Partial Index**
  Consists of single source DNA profiles from forensic samples that do not contain complete results for all 13 original CODIS core loci and/or that may indicate a possibility of allelic dropout (e.g. the +). In order to search/upload a forensic partial profile at SDIS or NDIS the moderate match estimation must be calculated first. If a sample is not eligible for upload to SDIS or NDIS but will be retained in the LDIS, it will be entered in this index but will not be marked for upload.

- **State Only Forensic Partial Index**
  Consists of samples as described above that do not meet the NDIS moderate match estimation calculation requirements.

- **Forensic Mixture Index**
  Consists of DNA profiles from forensic samples that contain DNA contributed from more than one source, typically two individuals. In order to search/upload a forensic mixture profile at SDIS or NDIS the moderate match estimation must be calculated first. If a sample is not eligible for upload to SDIS or NDIS it will be entered in this index but will not be marked for upload.

- **State Only Forensic Mixture Index**
  Consists of samples as described above that do not meet the NDIS match estimation calculation requirements.

**Other Casework CODIS Indexes**

- **Unidentified Human** - samples originating from a deceased person’s tissue, bone, tooth or hair sample
- **Relatives of Missing Persons** - samples originating from primary reference standards such as buccal swabs or blood cards; these are from 1st degree relatives such as a biological mother, biological father, sibling, or biological child
- **Missing Persons** - samples originating from an alleged missing person’s property such as a hair brush, toothbrush, saved teeth, etc

The following table lists the minimum number of required loci needed for entry into each successive level of CODIS from LDIS to SDIS and finally to NDIS.

**Note**: References made to D2 and D19 are specifically for D2S1338 and D19S433, respectively.

<table>
<thead>
<tr>
<th>Category/Indexes</th>
<th>LDIS (Local)</th>
<th>SDIS (State)</th>
<th>NDIS (National)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forensic</td>
<td>Minimum of 13 complete original CODIS core loci</td>
<td>Minimum of 13 complete original CODIS core loci</td>
<td>Minimum of 13 complete original CODIS core loci</td>
</tr>
<tr>
<td>Forensic Partial</td>
<td>Minimum of 6 original CODIS core loci and/or D2 and D19, and MME value greater than 1.0000E+003</td>
<td>N/A (See State Only Forensic Partial)</td>
<td>Minimum of 8 original CODIS core loci and MME value greater than 1.0000E+007</td>
</tr>
<tr>
<td>State Only Forensic Partial</td>
<td>N/A (if the profile is only going to reside at LDIS use Forensic Partial and do not mark for upload)</td>
<td>Minimum of 6 original CODIS core loci and MME value greater than 1.0000E+004</td>
<td>N/A (only for profiles being retained at SDIS)</td>
</tr>
<tr>
<td>Forensic Mixture</td>
<td>Minimum of 6 original CODIS loci and/or D2 and D19, and MME value greater than 1.0000E+003</td>
<td>N/A (See State Only Forensic Mixture)</td>
<td>Minimum of 8 original CODIS core loci and MME value greater than 1.0000E+007</td>
</tr>
<tr>
<td>State Only Forensic Mixture</td>
<td>N/A (if the profile is only going to reside at LDIS use Forensic Mixture and do not mark for upload)</td>
<td>Minimum of 6 original CODIS core loci and MME value greater than 1.0000E+004</td>
<td>N/A (only for profiles being retained at SDIS)</td>
</tr>
<tr>
<td>Volunteer</td>
<td>Minimum of 10 complete original CODIS core loci and/or D2 and D19</td>
<td>Minimum of 13 complete original CODIS core loci and Amelogenin</td>
<td>N/A (not eligible for NDIS)</td>
</tr>
<tr>
<td>Unidentified Human (remains)</td>
<td>Minimum of 8 complete original CODIS core loci and Amelogenin</td>
<td>Minimum of 8 complete original CODIS core loci and Amelogenin</td>
<td>Minimum of 8 complete original CODIS core loci and Amelogenin</td>
</tr>
<tr>
<td>Missing Persons</td>
<td>Minimum of 8 complete original CODIS core loci and Amelogenin</td>
<td>Minimum of 8 complete original CODIS core loci and Amelogenin</td>
<td>Minimum of 8 complete original CODIS core loci and Amelogenin</td>
</tr>
<tr>
<td>Relatives of Missing Persons</td>
<td>13 complete original CODIS core loci and Amelogenin</td>
<td>13 complete original CODIS core loci and Amelogenin</td>
<td>13 complete original CODIS core loci and Amelogenin</td>
</tr>
</tbody>
</table>
13.2.1 Assessment of Data for CODIS Eligibility – In-House and Outsourced

The analyst, CODIS Administrator, or DNA Lab Manager may assess the eligibility of profile entry into CODIS. In the event CODIS eligibility has not already been documented by the submitting officer, a note with initials/P# and the date should be added to the “Comments” section of the LIMS Unit Record regarding where eligibility documentation can be found for each item being entered (e.g., CODIS eligibility documented on: CSA impound report and email in RFLE scan, under Profile Detail on worksheet, in email from Detective in Object Repository, on CODIS SDEs, etc.).

Analysts are bound by the requirements of the “Annual Review of DNA Records Acceptable at NDIS.”

- The CODIS Decision Tree was developed to establish rules for what is eligible for upload. This is a summary of the general principles:
  a. Evidence profile must come from a crime investigation
  b. Benchwork match samples are allowed
  c. Profiles, especially from mixtures, are assessed and only those alleles that must have come from the perpetrator are allowed
  d. Victim profiles on suspect’s clothing (probative) are NOT allowed
  e. Suspect’s profile on suspect’s belongings found in suspect’s possession are NOT allowed unless additional details may be provided [example: through a sexual assault victim’s statement that the assault occurred in defendant’s vehicle (scene of the crime) and the semen stain recovered from the vehicle contains a mixture of the suspect and the victim]
  f. Forensic unknown DNA records awaiting elimination samples/standards may be entered as long as the laboratory has requested the elimination samples/standards and the request is documented.
  g. Crime scene reports stamped with “BTB from suspect” are not sufficient documentation to satisfy CODIS eligibility. Additional information as to why the item is believed to be from the suspect must be documented.

Outsourced cases are assessed for CODIS eligible profiles. An Outsourcing Laboratory Technical and Administrative Review Form is used to document the review of CODIS eligibility and placed on the right hand side of the file or scanned into the Object Repository of the LIMS with other administrative paperwork.

Once the case has been technically reviewed, a CODIS Data Entry packet will be created for those samples that are eligible for keyboard data entry. The technical reviewer will sign off and enter the profile into CODIS, assigning it to themself. A CODIS Entry report will be written to be sent out for all outsourced cases that have an eligible CODIS profile to notify the investigators that a profile will be searched in the local/state/national DNA Index System (CODIS); this report is generated outside of the LIMS and scanned into the Object Repository after distribution. The CODIS Data Entry packet with the Specimen Details report print-out attached and CODIS entry report will be administratively reviewed prior to upload to SDIS/NDIS if eligible.

13.2.2 Casework Sample Entry

A CODIS Data Entry packet is created for those samples that are eligible for keyboard STR Data Entry (SDE). Prior to technical review, the packet includes:

- CODIS SDE form
• Copy of the electropherogram for all partial profiles, mixture profiles, or deduced profiles
• Copy of Match-Estimation Report for partial and mixture profiles (if applicable)
• Copy of the contributor-specific “Component Interpretation” section and the “Contributor Genotype Summary >=99%” section of the STRmix Advanced Report for partial DNA profiles or mixtures (if applicable)

Printed electropherograms are not required for full single source evidence sample profiles. The first page of the packet (the SDE form) must be initialed by the analyst.

After technical review, the profile is entered into the CODIS software and a copy of the LDIS Specimen Details Reports is attached to the packet for administrative review.

13.2.2.1 Naming the Casework Specimen
The forensic specimen number will be entered into the Specimen ID field and will consist of the following if applicable:
• The case type prefix, according to the list below:
  AS- Assault (other than sex assault), AH- Attempted Homicide, AUTO- Auto Theft, B- Burglary, FA- Firearms, GL- Grand Larceny, H- Homicide Cold Case, HI- Home Invasion, KD- Kidnapping, M- Miscellaneous Other, R- Robbery, SA- Sex assault, SC- Sex Crimes (other than sex assault), V- Volunteer, UHR- Unidentified Human Remains, MP- Missing Person
  Note: Samples entered prior to October 2007 have the analyst’s initials as the prefix.
  Samples processed outside of the LIMS will have the Event # in the specimen name, while samples processed in the LIMS will have the LAB #. Samples entered prior to 2001 may have the LVMPD WinACE sample number rather than the Event #.
• If the specimen has been matched to a suspect, (“Benchwork” match), then the Specimen ID will have a “K” after the case type (e.g. SAK). It is not necessary to enter “VK” for volunteer samples.
• Cases from outside jurisdictions such as North Las Vegas or Henderson will include the abbreviation of the submitting agency in the Specimen ID (e.g. SAKHPD).
• The lab # without any dashes, will follow next (e.g. SAKHPD1316643).
• Then a dash followed by the item # will be next (e.g. SAK1316643-1B). This includes if it is a sperm fraction or epithelial fraction (e.g. SAKHPD1316643-1B-SF or 1B-EF).
• If the sample was booked under one lab number but processed under a different lab number, then an “-X” will be added to the item # (e.g. SAKHPD1316643-2-X). The lab number used in the specimen name should be the one it’s being processed/reported under. The lab number the sample is booked under will then be added to the comments field for cross-reference.
• If needed, add additional information such as: minor profile (-MIN), major profile (-MAJ), deduced profile (-DED), contributor 1 (-C1).

13.2.2.2 Determining DNA profile for entry (Refer to 13.2.2.3 if using STRmix for Entry)
For partial single source evidence sample profiles: When a locus has only one peak called below the kit-specific interpretation threshold, the single allele may be entered with the addition of a “+” symbol indicating there is the possibility of an additional allele not being called. A printed electropherogram should be included with the packet.

If a profile has complete data at the original 13 CODIS core loci but has drop-out at other non-core loci it should still be entered in the Forensic Unknown specimen category, rather than the
Forensic Partial or State Only Forensic Partial specimen categories. A moderate match estimation (MME) calculation, described further below, does not need to be calculated for these profiles.

**For distinguishable mixture evidence sample profiles where a partial single source major profile can be deconvoluted:** When one or both of the major contributor peaks are interpretable, the allele(s) may be entered into CODIS. A printed electropherogram and any relevant mixture deconvolution worksheets should be included with the packet.

A single major allele may be entered with the addition of a “+” symbol if there is an assumed minor contributor that determines the single allele is an obligate allele of the foreign contributor.

**For 2-person distinguishable mixture evidence sample profiles where a partial single source minor profile can be deconvoluted:** When one or both of the minor contributor peaks are called below the kit-specific interpretation threshold, the allele(s) may be entered into CODIS. If there is only one minor peak detected below the interpretation threshold in combination with the presence of 1 or 2 major peaks, the minor allele may be entered one of two ways:

- The minor allele may be entered with the addition of a “+” symbol thereby indicating the possibility of an additional allele not being called or being shared with the major contributor or,
- In the event it is possible to deconvolute a genotype for the minor component, both minor alleles may be entered. A printed electropherogram and any relevant mixture deconvolution worksheets should be included with the packet.

**For 2-person indistinguishable mixture evidence sample profiles with an assumed contributor where a partial single source foreign profile can be deduced:** When one or both of the foreign contributor peaks are called below the interpretation threshold the allele(s) may be entered into CODIS. If there is one foreign contributor allele detected below the interpretation threshold in combination with the presence of 1 or 2 assumed contributor peaks, the foreign allele may be entered one of two ways:

- The foreign contributor allele may be entered with the addition of a “+” symbol indicating there is the possibility of an additional allele not being called or being shared with the assumed contributor or,
- In the event it is possible to deconvolute a genotype for the foreign contributor, both foreign alleles may be entered. A printed electropherogram and any relevant mixture deconvolution worksheets should be included with the packet.

**For mixture samples being entered into CODIS in the Forensic Mixture or State Only Forensic Mixture specimen categories,** the “+” symbol may be used to designate certain alleles to be required to match in the event only an obligate allele based on an assumed contributor and not the complete unknown genotype can be deconvoluted from the rest of the mixture. The “+” symbol should not be used to indicate possible drop-out in mixtures unless only a single allele is being entered at the locus where it is used.

### 13.2.2.3 Using STRmix to Determine DNA Profile for Entry

For single source profiles having alleles below the stochastic threshold and mixtures, genotypes or a combination of genotypes having a combined weight of 99% may be entered into CODIS. The “Contributor Genotype Summary >=99%” portion of the advanced STRmix report as well as
the individual contributor weights for each locus will be reviewed when making determinations for CODIS entry. 

**Note:** It is not required to perform a STRmix deconvolution of a full single source unknown profile prior to CODIS entry. This is analyst discretion.

**Examples**

- If a single source sample has a single 10-allele below the stochastic threshold at D5S818 and the STRmix “Contributor Genotype Summary >=99%” lists the genotype as 10,10, the analyst should enter a 10 homozygote at D5S818.
- If a single source sample has a 21-allele below the stochastic threshold at FGA and the STRmix “Contributor Genotype Summary >=99%” lists the genotype as 21+, the analyst should enter a 21+ at FGA and mark the partial locus indicator.
- If, in a mixture sample, a genotype of 19,+ is listed in the STRmix “Contributor Genotype Summary >=99%” for Contributor 1 at vWA, the analyst should enter a 19+ at vWA and mark the partial locus indicator. Alternatively, if the “Contributor Genotype Summary >=99%” lists a 19,+ but the contributor-specific “Component Interpretation” lists the top weights for this locus as 19,19 (50.10%) and 19,20 (49.10%), the analyst may enter a 19+,20 into CODIS as the combined genotype weights are 99.20%, which meets the >=99% threshold. This will be entered into the Forensic Mixture index.
- If, in a mixture sample, a genotype of -- is listed in the STRmix “Contributor Genotype Summary >=99%” for Contributor 1 at D3S1358 and the individual contributor-specific “Component Interpretation” locus weights are 15,16 (40.10%), 16,17 (30.20%), and 15,17 (29.40%), the analyst may enter 15,16,17 into CODIS as the combined genotype weights are 99.70%, which meets the >=99% threshold. This will be entered into the Forensic Mixture index.

**Refining contributor genotypes using conditioning for searching purposes**

It is possible to assume that an interpreted profile from a victim, POI, or an unidentified person is a contributor to a sample in order to resolve additional unidentified contributors for the purposes of searching the CODIS databases. For example, if the victim is present in a DNA mixture, the mixture may be conditioned on the victim's profile in order to refine the genotypes of the other non-victim contributor(s). Additionally, if the component interpretation of a DNA mixture yields a single genotype with a weight greater than 99% at all or most loci, one may condition the MCMC on the genotypes for this contributor to refine the genotypes for the other contributor(s). This is for CODIS upload purposes only. The analyst will document the steps performed to generate the searchable profile in the CODIS SDE packet.

For instances in which the ≥ 99% is an unidentified contributor, the analyst must manually create a .txt reference file for this contributor so that it may be used as an assumed contributor in a regular STRMix deconvolution. The .txt file will contain the marker, allele, and size of information for the ≥ 99% contributor.

- Reference standards or interpreted single contributor in a case which contain complete genotypes for at least 8 of the CODIS core 13 loci can be used as an assumed contributor to an evidence profile for the purposes of interpreting another profile for searching CODIS.
- A printout of the STRmix deconvolution including the component interpretation supporting the assumption will be included in the case file if it is an unambiguous inclusion based on the comparison of the deconvoluted ≥ 99% genotypes to the contributor-specific >=99% genotypes.
13.2.2.4 Match Estimation for Forensic Partial and Forensic Mixture Profiles

For forensic partial or forensic mixture profiles (including State Only specimen categories) a moderate match estimation (MME) must be calculated prior to technical review to determine the correct specimen category (i.e. LDIS, SDIS or NDIS). In CODIS, click on Popstats on the bottom
left side and then click on the Match Estimation on the top left hand side. Enter the sample name in the Specimen ID field, leave the population size default in the Database Specimen Count field set by CODIS, and choose the appropriate Number of Loci Allowed to Miss depending on which database (NDIS, SDIS or LDIS) it is being calculated for (see table below). Only data from the original CODIS core 13 loci being searched in each database should be entered for SDIS and NDIS calculations. Only data from the original CODIS core 13 loci and/or D2S1338 or D19S433 should be entered for LDIS calculations.

The required minimum number of loci for each database must be entered to meet the completeness definition for each database regardless of what the match estimation calculation is (see table below). In the event a profile is shown to be eligible for entry into NDIS or SDIS, it is not necessary to perform an additional calculation to show it would be eligible for LDIS entry allowing 1 locus to mismatch. The CODIS Administrator will notify DNA analysts via email if the number of loci allowed to miss or completeness definition change in between manual revisions.

A moderate match estimation (MME) threshold will be used to determine whether a partial or mixture profile is eligible for LDIS, SDIS or NDIS. The MME is automatically calculated based on NDIS core loci requirements during STR Data Entry using the combined (COMB) population group of the NIST population database. However, it can be calculated prior to entry to determine the correct specimen category using the Match Estimation tool in Popstats which also uses the set NIST population database to calculate the average inverse match rarity estimate (MRE), which is the same result as a MME. Obtaining the same result for the COMB population group is dependent on the analyst to only enter data for the original 13 CODIS core loci.

A moderate match estimation (MME) threshold will be used to determine whether a partial or mixture profile is eligible for LDIS, SDIS or NDIS. The MME is automatically calculated based on NDIS core loci requirements during STR Data Entry using the combined (COMB) population group of the NIST population database. However, it can be calculated prior to entry to determine the correct specimen category using the Match Estimation tool in Popstats which also uses the set NIST population database to calculate the average inverse match rarity estimate (MRE), which is the same result as a MME. Obtaining the same result for the COMB population group is dependent on the analyst to only enter data for the original 13 CODIS core loci.

<table>
<thead>
<tr>
<th>Database</th>
<th># of Loci Allowed to Miss</th>
<th># of Loci required</th>
<th>MME (COMB Inverse MRE)</th>
</tr>
</thead>
<tbody>
<tr>
<td>NDIS</td>
<td>0</td>
<td>8 original core</td>
<td>&gt; 10,000,000 (1.000E+007)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(no D2S1338/D19S433)</td>
<td></td>
</tr>
<tr>
<td>SDIS</td>
<td>0</td>
<td>6 original core</td>
<td>&gt; 10,000 (1.0000E+004)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(no D2S1338/D19S433)</td>
<td></td>
</tr>
<tr>
<td>LDIS</td>
<td>1</td>
<td>Any 6 original core</td>
<td>&gt; 1,000 (1.0000E+003)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>and/or D2S1338/D19S433</td>
<td></td>
</tr>
</tbody>
</table>

After entering the profile, click Calculate and print the Match-Estimation Report to attach to the SDE packet for technical review.

Note: On the Match-Estimation Report print-out, the number listed for the “total number of loci in target specimen” refers to the number of loci with allele entries in the Popstats calculation regardless of whether they’ve been unchecked for the calculation (i.e. D2S1338, D19S433 and Amelogenin). It is not necessary for analysts to enter allele calls into the Match Estimation tool in Popstats for loci other than the original CODIS core loci simply for the purpose of making this number accurate, nor hand correct the print-out. This number has no effect on the calculation.

The official MME will be calculated automatically during STR data entry. This calculation automatically excludes any loci besides the original CODIS core 13, so the complete profile as it will be uploaded should be entered. If a sample is being considered for only LDIS entry with data at D2S1338 or D19S433 the Combined (COMB) Inverse MRE calculated in the Match Estimation tool should be used for determining whether the profile will be entered into CODIS because D2S1338 and D19S433 would not be included in the MME calculation done during STR Data Entry.
If a partial or mixture profile is obtained from an item of evidence that would be CODIS eligible based on the case scenario, however it does not meet the required MME for entry into at least the LDIS database then a print-out of the match estimation report must be included within the casefile or scanned into the O.R. to show that CODIS entry was considered but not allowed because the profile was not suitable for entry.

13.2.2.5 STR Data Entry of Casework Samples in CODIS Software

Samples will be entered into LDIS after technical review through “STR Data Entry” or by direct electronic import, using the Forensic Partial, Forensic Unknown, Forensic Mixture, or other specimen categories.

- The Specimen ID field will be the specimen name including prefix, case number and sample item number.
- The Specimen Category can be picked from the drop down menu.
- The source ID and partial profile fields can be picked from a drop down menu of either “Yes” or “No”. A profile being entered in the Forensic Unknown specimen category with complete data at the original 13 CODIS core loci but possible drop-out at other loci should have “Yes” selected in this drop-down. This selection will not affect how the profile is searched.
- The case ID field will consist of the actual event/agency case number (e.g. 091104-1604).
- The comments field should be filled out with where the profile came from (example: “Major profile from sperm fraction of vaginal swabs” or “volunteer sample”). No names should be used in any field.
- Click on the second blank next to Amelogenin, type in the results with a comma in between the alleles of a heterozygote. For a homozygote, type a single allele. Fill in the first vertical column, then the next column is a data entry double-check. You will be prompted if there is a disagreement between the readings, if the alleles do not match those accepted for the locus, or if an allele entry is known to be a rare allele. Data entry can be double-checked by using the arrow keys to go backwards and then forward again through the column.
- If the profile is from a male and the Qiagen Investigator 24plex kit was used for analysis, the Y-STR result can be entered below the list of autosomal loci.
- For partial profiles, the Partial Profile indicator drop-down should be changed to Yes for applicable loci to allow for moderate stringency searching at these loci.

**Note:** On a Match Detail Report a partial locus entry will be indicated with a “{(P)}” symbol.

The forensic DNA profile will be entered into LDIS according to the CODIS operating procedures and the “Annual Review of DNA Records Acceptable at NDIS”. Once entered the STR data will be saved and a LDIS Specimen Detail Report will be printed and placed with the packet for review in the case file.

**Note:** After clicking Save, the moderate match estimate (MME) will be calculated for partial and mixture DNA profiles only. Verify that the appropriate threshold estimated using Match Estimation is still met for the selected category. If it does not, the specimen category will have to be corrected which will require a change on the FRED worksheet and in the lab report.

13.2.2.6 Upload of DNA profile to SDIS and/or NDIS

The CODIS Data Entry packet, consisting of the CODIS Data Entry SDE form, printed electroherograms and mixture deconvolution worksheets (if applicable), Specimen Detail Report, and Match Estimation Report (if applicable) will be administratively reviewed for typographical accuracy.
After confirmation that the report has been released, the CODIS Data Entry will be given to the CODIS Administrator at which time it will be “Marked for Upload” into CODIS. After being marked for upload the packet is stored on the left side of the case file or scanned into the Object Repository of the LIMS. Forensic samples will be uploaded into the State (SDIS) and National (NDIS) database at least monthly.

13.2.3 Administrative Sample Removal

A forensic or volunteer sample may be removed when both the DNA analyst and the CODIS administrator have evaluated the sample and agree upon its removal. A sample may also be removed if the investigator submits a CODIS Hit Disposition Form after receiving a CODIS hit report and determines that the individual identified is not a suspect. A “CODIS Deletion Approval” form will be filled out and approved by the CODIS Administrator, Technical Leader and DNA Lab Manager. The approval form, CODIS Hit Disposition Form (if applicable), and CODIS Deletion Report print-out then become a part of the case file along with the technical and administrative review forms when a supplemental report is issued indicating the disposition of the CODIS entry. The CODIS Deletion Report will also be archived in the CODIS computer.

A volunteer sample may also be removed at the written request of the volunteer, the volunteer’s legal counsel or a court order.

13.3 Database Samples

The majority of known samples, also called database samples, come from convicted offenders, sexual registrants, and felony arrestees collected throughout southern Nevada’s jails, prisons, courts, parole and probation offices, and law enforcement agencies. Individuals who provide a DNA sample for inclusion in the DNA database are selected pursuant to NRS 176.0913 (convicted offenders), NRS 176.0916 (convicted offenders from out-of-state on parole/probation in NV), NRS 179D.240,179D.443, and 179D.460 (sex registrants), and NRS 176.09123 (arrestees). These samples are buccal swabs, FTA card collection devices, or blood samples collected by the various agencies and retrieved by or sent to the LVMPD Forensic Lab on a regular basis.

The specimen biographical information submitted with each collection kit for all database samples is maintained in the Sample Tracking and Control Software (STaCS) which is a state-wide database that is accessed through a virtual private network (VPN) to the Washoe County Sheriff’s Office where the server is stored. Prior to 2013, the information was stored in an Access Database; however, all information in the Access Database has been transferred over to the STaCS database and LIMS.

Samples will be analyzed using any of the validated extraction DNA procedures developed for databasing. Analysis of the original CODIS core STR loci will be completed for each sample: D8S1179, D21S11, D7S820, CSF1PO, D3S1358, TH01, D13S317, D16S539, vWA, TPOX, D18S51, D5S818, FGA and the Amelogenin sex indicator. Additional loci provided by the PowerPlex Fusion 6C kit: D1S1656, D2S441, D2S1338, D10S1248, D12S391, D19S433, D22S1045, Penta D, Penta E, DYS391, DYS570, and DYS576. Results at all loci tested will be exported from GeneMapper ID-X and imported into CODIS. Data analysis results will be maintained in electronic format.
DNA results will be technically reviewed by a second qualified DNA Analyst. If the two analysts do not agree on the interpretation, the sample can be re-injected, re-amplified, or re-isolated. For the “Technical Review Checklist-Database Knowns”, the technical reviewer will sign and date the review form where indicated.

Note: The technical review of database-specific proficiency tests will be documented utilizing the “Database Proficiency Technical Review Checklist” instead of the “Technical Review Checklist-Database Knowns”.

After technical review, the GeneMapper ID-X (GMID-X) CODIS Export Table is converted to a Common Message Format (CMF) file and saved onto the H:drive (refer to Data – CODIS Export). The CODIS Administrator (or alternate) imports the CMF files in to the CODIS workstation.

The Convicted Offender/Registrant/Arrestee samples are considered to be “reference materials”. The Database laboratory currently does not process Casework reference samples.

Database Sample Indexes
- **Offender Index**
  Consists of single source DNA profiles from convicted offenders or sex registrants.

- **Arrestee Index**
  Consists of single source DNA profiles from persons arrested for a felony offense.

- **Multi-Allelic Offender Index**
  Consists of DNA profiles from offenders (arrestee or convicted offender) with three or more alleles at two or more loci.

The following table lists the minimum number of required loci needed for entry into each successive level of CODIS from LDIS to SDIS and finally to NDIS. (Note: References made to D2 and D19 are specifically for D2S1338 and D19S433, respectively)

<table>
<thead>
<tr>
<th>Category/Indexes</th>
<th>LDIS (Local)</th>
<th>SDIS (State)</th>
<th>NDIS (National)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convicted Offender/Arrestee/ Multi-Allelic Offender</td>
<td>Minimum of 10 complete original CODIS core loci and/or D2 and D19</td>
<td>13 complete original CODIS core loci and Amelogenin</td>
<td>13 complete original CODIS core loci</td>
</tr>
</tbody>
</table>

13.3.1 Receipt of Arrestee Samples into the Laboratory
1) DNA samples on FTA cards will be collected using the DNA collection kit approved by the laboratory. The appropriate information will be filled out on the collection kit bi-fold or printed and attached to the collection kit at the time of collection. A pre-printed NV seven-digit barcode number (e.g. NV1234567) is on the bi-fold and collection device.
2) DNA samples may be submitted in whole blood collection kits if the subject refuses to provide a sample on an FTA card. This blood collection kit will contain a purple-topped tube(s) and have the NV seven-digit barcode number associated with the collection kit bi-fold written on the outside of the box at the time of collection. A collection kit bi-fold will be submitted with the appropriate information filled out or attached.
3) Samples accepted at the laboratory will fall into two categories:
a. Samples to be destroyed within 5 business days after notice because probable cause (PC) could not be established and no other felony arrests have occurred that require sample collection (NRS 176.09123 2d). The biographical information entered into STaCS at the time of collection associated with an NV number printed on the collection kit will have to be rejected from the STaCS database. If an outside agency takes care of destroying the sample themselves, they will notify the LVMPD Forensic Lab that the information needs to be rejected from STaCS.

b. Samples to be processed awaiting an administrative message (AM) from the State Repository that the fingerprints using the LiveScan have been confirmed to the individual. If LiveScan is used during collection there may not be inked prints collected at the same time on the bi-fold. Collection kits will have PC paperwork attached or available in OnBase for verification, or if the person is arrested pursuant to a warrant, then the warrant will be attached or available in OnBase. Upon receipt into the lab these samples will be counted.

- If PC cannot be established because proper documentation is not available for verification, then the collecting agency will be contacted to submit paperwork or give approval for destruction and rejection in STaCS.

- The AM message received will contain the state identification (SID) number, process control number (PCN), date of arrest, originating agency case (or identification) number (OCA), and name of the individual. This information will be used to match it up with one of the collection kits received which will have at least the PCN and name of the individual written on the outside. The AM message will be retained in OnBase or imported into the Object Repository of the LIMS following receipt into STaCS at the lab. If an AM message is not automatically received then the PCN can be queried through J-LINK to see if an SID was returned. Due to fingerprint processing errors, the SID may also be provided by LVMPD AFIS after the error is researched and cleared by them.

4) Upon receipt of the AM messages (or manual verification via J-LINK), the kits associated with the AM will be received in STaCS and assigned a received date.

- Databasing: The specimen information from the collection bi-fold in the kit or the attached paperwork will be accepted/entered into STaCS by first scanning the unique NV barcode pre-printed on the collection bi-fold which is also present on the FTA card. After verifying that all of the information is correct and accepting the sample, an additional STaCS number (e.g. 2014-012345) will be assigned and five new barcode labels will be printed. One will be attached to the paperwork attached to the outer envelope to assist in scanning into the LIMS, one will be affixed as a label on the upper right hand corner of the outer envelope, one will be affixed on the outside top left of the collection bi-fold, and the other two will be placed inside of the envelope to be applied to the FTA card and a coin envelope added later to package the sponge applicator when the kit is opened for sampling, or to the bloodstain card prepared and a coin envelope added to the package to store it.

The STaCS number becomes the unique specimen number that will be used in the LIMS as the “LAB #” and used to identify the specimen in CODIS. The information from STaCS can be imported directly into the LIMS via Excel. Any paperwork attached to the outside of the kit upon receipt will be scanned into the specimen’s Object Repository in the LIMS if it is not already in OnBase.
• Accessioning: The additional STaCS barcode labels will be affixed to the FTA card and a coin envelope that is added to package the blue collection device containing the sponge applicator for long-term storage. If the FTA card is sampled at this time, a sample punch will be made into a labeled, sterile microcentrifuge tube or plate.

For whole blood samples, a bloodstain card will be spotted using blood from one of the tubes from which a punch can be made into a labeled, sterile microcentrifuge tube for manual extraction. The additional STaCS barcode labels will be affixed to the bloodstain card and a coin envelope added to package the bloodstain card for long-term storage. The blood tube(s) will be stored in a refrigerator temporarily until after passing data is obtained, at which time it may be destroyed.

5) The collection envelope containing the bi-fold, FTA card, sponge applicator, and any other paperwork will then be placed in secured storage, arranged in ascending numerical order. The samples will be available for database match confirmation and retained in storage indefinitely.

• For whole blood samples, the bi-fold, coin envelope containing the bloodstain card, and any other paperwork will be re-packaged in the white envelope with a “Biohazard” sticker label and then placed in secured storage, arranged in ascending numerical order with the FTA collection envelopes. The samples will be available for database match confirmation and retained in storage indefinitely.

6) Incidents relating to problematic collection of database samples will be documented in the “Database Problem Sample Log” kept in the CODIS Administrator’s office or in the “STaCS Rejections & Destinations” spreadsheet maintained by the CODIS Administrator on the H:drive.

13.3.2 Sample Removal – Expungement of Arrestee Samples

Expungement of the DNA record, profile, and specimen will occur when:

Pursuant to NRS 176.09125, a person whose DNA record or DNA profile has been included in the state DNA database in accordance with NRS 176.09123 requests the expungement of their DNA profile through the official form maintained by the Central Repository of Nevada Records of Criminal History, a division of the Nevada Department of Public Safety.

OR, a certified copy of a court order to expunge a person’s DNA record or profile that has been included in the state DNA database is received by the Forensic Lab indicating that a felony arrest no longer qualifies or the person has not been convicted pursuant to the excerpt from the amendments made by the DNA Fingerprint Act of 2005 detailed below. All documentation received by the Forensic Lab will be forwarded to the Central Repository for their record maintenance.

Amendments made by the DNA Fingerprint Act of 2005 (P.L. 109-162) require expungement if “the person has not been convicted of an offense on the basis of which that analysis was or could have been included in the index, and the responsible agency or official of that State receives, for each charge against the person on the basis of which the analysis was or could have been included in the index, a certified copy of a final court order establishing that such charge has been dismissed or has resulted in an acquittal or that no charge was filed within the applicable time period.” (see 42 U.S.C.§14132(d)(2)(A)(ii))
• Per NRS 176.09125 subsection 3, the forensic laboratory shall not destroy a biological specimen or purge the DNA profile of a person if the forensic laboratory is notified by a law enforcement agency that the person has a prior felony, a new felony arrest or a pending felony charge for which collection of a biological specimen is authorized.

• If the Central Repository determines that expungement is necessary, a copy of the expungement form will be forwarded to the LVMPD Forensic Lab within six weeks of the written request with the identifying details of the sample to expunge and the reason for its expungement.

• Within thirty business days of the receipt of the expungement form from the Central Repository or a certified court order received directly at the Forensic Lab, the LVMPD Forensic Lab will run an NCIC report and research court records to see if the subject has another qualifying offense that would allow the state to keep the DNA profile and sample, in accordance with NRS 176.09125 subsection 3.
  ➢ If an alternative qualifying offense exists, the Central Repository will be notified within the same thirty business days by returning the form with “Denied” circled or forwarding the court order with an expungement form completed by the Forensic Lab with “Denied” circled. The sample and DNA profile will be retained by authority of the alternate offense. The Central Repository will notify the arrestee that the request for expungement is denied and the sample will not be destroyed.

  ➢ If no alternative qualifying offense exists, within the same thirty business days the laboratory will expunge from CODIS (LDIS, SDIS, and NDIS), LIMS, and STaCS databases all pertinent records associated with the request in accordance with local, state, and national requirements (NDIS Expunge a DNA profile – Operational Procedure).

A copy of the expungement form or court order and a print-out of CODIS generated delete report will be retained in the DNA section and the Central Repository will be notified that expungement has been completed by returning the form with “Granted” circled or forwarding the court order with an expungement form completed by the Forensic Lab with “Granted” circled. The Central Repository will notify the arrestee the request for expungement has been granted. The collection kit and sample will be destroyed.

In LIMS, the name of the arrestee will be changed to “Arrestee (first name) EXPUNGEMENT (last name)”. All other identifying information including the date of birth, State ID number, social security number, and CS number, will be manually deleted. The date of expungement will be entered in the “Date of Death” field.

Pursuant to NDIS procedures, if the LVMPD expunges a DNA record, other than a forensic unknown, forensic mixture or forensic partial that has generated an interstate candidate match, the LVMPD will notify the any other laboratory involved in the candidate match that an expungement is being performed. The LVMPD will notify the State CODIS Administrator of any such expungements so that the NDIS custodian is notified of any candidate matches associated with the expunged record that need to be deleted from NDIS.

13.3.3 Receipt of Convicted Offender/Registrant Samples into the Laboratory
1) DNA samples (swabs or FTA cards) will be collected using the DNA collection kits approved by the laboratory. The appropriate forms will also be filled out or printed and attached to the collection kit at the time of collection.
   - The contents of a kit received with swabs are stored in the original envelope that has the offender’s information written on the outside and a SN barcode affixed to the envelope, as well as the fingerprint form and swab box.
   - The contents of a kit received with an FTA card are stored in an envelope that contains a bi-fold with the offender’s information written on it or with attached paperwork. A pre-printed NV number is on the bi-fold and FTA card.

2) Upon receipt, the kits will be counted.

3) Databasing: The specimen information submitted with the collection kit will be accepted/entered into STaCS by first scanning the unique NV barcode pre-printed on the outer envelope which is also present on the FTA card; this assigns a received date to the kit. After verifying that all of the information is correct, or entering the information if it was not entered electronically at the collection site, and accepting the sample, an additional STaCS number (e.g. 2014-012345) will be assigned and four new barcode labels will be printed. One will be affixed as a label on the upper right hand corner of the outer envelope, one will be affixed on the outside top left of the collection bi-fold, and the other two will be placed inside of the envelope to be applied to the FTA card and a coin envelope added later to package the sponge applicator when the kit is opening for sampling. The STaCS number becomes the unique specimen number that will be used in the LIMS as the “LAB #” and used to identify the specimen in CODIS.

For older collection kits received containing swabs, the information filled out on the outside of the envelope will be manually entered into STaCS to assign the STaCS number. Barcode labels will be printed to affix to the outside of the envelope, fingerprint form, and swab box. The STaCS number becomes the unique specimen number that will be used in the LIMS as the “LAB #” and used to identify the specimen in CODIS.

STaCS specimen information can be imported directly into the LIMS via Excel or manually entered into the LIMS.

Note: For swab samples received prior to 2014, the unique specimen number consists of “SN”, for Southern Nevada, followed by a five-digit sequential number (e.g. SN12345). The SN barcodes are affixed as labels to the upper right hand corner of the collection envelope and the swab box. All of the information from these samples was entered into an Access Database which has been transferred over to the LIMS and STaCS databases.

4) Accessioning:
   a) During accessioning for the kits with swabs the additional barcode labels are affixed to the fingerprint form and swab box. The two swabs contained in the kit are retained in the original swab box. If swabs are sampled at this time, one of the two swabs is cut with a disposable scalpel into a labeled, sterile microcentrifuge tube or plate. The other swab can be re-tested later during the confirmation procedure should a match occur.
   b) During accessioning for the kits with the STaCS number the additional STaCS barcode labels will be affixed to the FTA card and a coin envelope that is added to package the blue collection device containing the sponge applicator for long-term storage. If the FTA card is sampled at this time, a sample punch will be made into a labeled, sterile microcentrifuge tube or plate.
5) The DNA collection kit containing the swabs/FTA card and any other paperwork will then be placed in secured storage, arranged in ascending numerical order. The samples will be available for database match confirmation and retained in storage indefinitely.

6) Incidents relating to problematic collection of database samples will be documented in the “Database Problem Sample Log” kept in the CODIS Administrator’s office or in the “STaCS Rejections & Destructions” spreadsheet maintained by the CODIS Administrator on the H:drive.

13.3.4 Sample Removal – Expungement of Offender Samples

The LVMPD Forensic Lab routinely receives lists from the Nevada State Administration of persons whose personal information for DNA work entered into CODIS must be completely removed (expunged) and any related database samples destroyed. The LVMPD Forensic Lab still tracks the statistics and accounts for the work performed but does not allow personnel to see anything that relates to the biographical or genetic information to a particular person. A mandatory reason for expungement is recorded.

A person whose DNA records or DNA profile has been included in the State DNA database in accordance with NRS 176.0913, NRS 179D.240, NRS179D.443, and NRS 179D.460 may request a court order for expungement of their sample and DNA profile.

- Upon receipt of a valid court order or letter from Nevada State Administration, the LVMPD Forensic Lab will run an NCIC report and research court records to see if the offender/registrant has another qualifying offense that would allow the state to keep the DNA profile and sample.
  - If an alternative qualifying offense exists, the Court issuing the expungement order will be notified by letter that another qualifying offense exists and the sample and DNA profile are being retained by authority of the alternate offense.
  - If no alternative qualifying offense exists, the laboratory will expunge from the CODIS (LDIS, SDIS, and NDIS), LIMS, and STaCS databases all pertinent records associated with the request in accordance with local, state, and national requirements (NDIS Expunge a DNA Profile – Operational Procedure).

A copy of the court order or letter, and a print-out of the deletion report will be retained in the DNA section. The collection kit and sample will be destroyed.

In LIMS, the name of the arrestee will be changed to “Offender [or Registrant] (first name) EXPUNGEMENT (last name)”. All other identifying information including the date of birth, State ID number, social security number, will be manually deleted. The date of expungement will be entered in the “Date of Death” field.

Pursuant to NDIS procedures, if the LVMPD expunges a DNA record, other than a forensic unknown, forensic mixture or forensic partial that has generated an interstate candidate match, the LVMPD will notify the any other laboratory involved in the candidate match that an expungement is being performed. The LVMPD will notify the State CODIS Administrator of any such expungements so that the NDIS custodian is notified of any candidate matches associated with the expunged record that need to be deleted from NDIS.
13.3.5 Database Sample Entry

1) Import Specimens: On the CODIS workstation - Open the Analyst Workbench. Click on the Specimen Manager on the left bottom side of the screen. The default screen appears with a number of specimens filling the screen. Select Specimen Manager > Import Specimens from the top menu. In the pop-up window, navigate to the CMF file(s) on the H:drive. Highlight the file(s) and select Import CMF Files. In the Assign file to: pop-up window, scroll down to the user name of the analyst who processed the samples and click OK. The import process will complete and a message will be sent to the Message Center. Close the Specimen Manager window.

Open Message Center and click on Import STR Files. The messages that have not been executed will be in bold. Double-click on each file, starting from the bottom, to execute the messages. The new import will load to populate the next step. Click on Import Reports and again double-click each file to execute. The file will then load (this step is the one that loads the samples into Specimen Manager). Print the first page of the “LDIS Import Reconciliation Report”. The Import Report print-out is attached to the data packet that then goes into a folder labeled for the week showing imported database samples and auto searches that is kept indefinitely.

Note: if there are any error messages on the Import Report. Most of the time the error will be an FGA-extended ladder allele that was not converted to “>30” or other loci in which your allele is “< or >” the ladder. If there are error messages, the time to correct them is now by going back to GeneMapper ID-X and ascertaining the error. Then open the sample in Specimen Manager and select “Edit STR/YSTR Specimen” to manually make the correction to the locus before performing any searches or marking the sample for upload. When the import is done, close Message Center.

2) Verify Imported Specimens: Open Specimen Manager. Select File>New and then click on the DNA Typing System tab to create a view that is for samples assigned to the analyst on the date of the import. Click OK. The screen fills with the samples in numerical order. Scroll down and confirm that the appropriate user name and specimen category is assigned to each specimen. Also verify that all re-processing suffixes (e.g. -RL, -RI, etc) have been removed. If they have not, open the sample in Specimen Manager and select “Edit STR/YSTR Specimen” and then rename the specimen. Close Specimen Manager when finished.

After the new samples are imported into CODIS, the CODIS Administrator (or alternate) will perform an AutoSearch named “Std. to Std.”, to check for “Offender Duplicates” (example: offender sample to an offender or arrestee sample; there is not an “Arrestee Duplicate” disposition) and conviction matches (example: volunteer sample to an offender/arrestee sample). Refer to Database Autosearch.

After database samples have been imported into CODIS the sample information in the STaCS database needs to be updated using the “CODIS upload query” in the “Offender Dynamic Search” menu option. A range of numbers can be queried to list them in an Excel worksheet where the upload date can be added and then imported into the “CODIS Update” menu option.

13.3.6 Sample Sealing
Database samples are not collected with a chain of custody and are not considered evidentiary in nature. Therefore, they do not require the evidence sealing provision outlined in the LVMPD Forensic Handbook. Database samples are collected individually in gum-sealed envelopes. After the samples have been returned to the envelopes after processing, the envelopes are resealed with clear tape.

**13.3.7 Destruction or Administrative Removal of Ineligible Database Samples**

Upon verification of the fact that a DNA record is not eligible for inclusion in CODIS, the sample will be subjected to an administrative removal of the sample from CODIS and destruction of the DNA sample collection kit.

Documentation associated with why the sample is not eligible for inclusion in CODIS, and when the sample was administratively removed and destroyed will be retained by the Biology/DNA Detail.

A list of expungements/ineligible database samples will be maintained by the CODIS administrator. The collection kit and sample will be destroyed. CODIS Deletion Reports will be maintained in the weekly upload folder.

**13.4 CODIS Searches**

Entry of newly developed profiles will be conducted as soon as possible after Technical Review. Both Database and Casework Searches are conducted by the CODIS Administrator (or alternate) at least monthly using AutoSearcher for all new profiles entered. Searches are only performed at the local level.

**13.4.1 Database Autosearch**

All database sample batches will be searched using AutoSearcher, “Std. to Std.”. The search for duplicates within the batch serves two purposes: a within-run check for inadvertent duplications and a random re-analysis since recidivists’ samples occur within almost every batch of samples tested.

In AutoSearcher, double-click on the file called “Std. to Std.” and then AutoSearcher>Perform Search from the top menu. This will search all new data from offender, arrestee, multi-allelic offender, volunteer or elimination standards that have been entered since the previous auto search against the Offender, Arrestee, Multi-Allelic Offender, Volunteer and Elimination indexes. Only profiles that are considered complete will be auto searched. A profile is considered complete for LDIS searches in the Offender, Arrestee, Volunteer and Elimination Indexes if it includes at least 10 loci (including D2S1338 and D19S433).

After the search is complete, go to the Message Center and select AutoSearcher Reports. Double-click on the recent search to execute the message and load the matches into Match Manager. A copy of the Std. to Std. AutoSearcher Report should be printed to verify name/IDs and filed in a folder for the week showing imported database samples and auto searches that is kept indefinitely. It is mandatory that a name/ID check is performed before a specimen is “Marked for Upload” by the CODIS Administrator (or alternate).
A Match Detail Report is printed for conviction matches involving volunteer samples. The verified name is written on the print-out and filed on the left side of the case file or scanned into the Object Repository in the LIMS.

After the name/ID check is performed, the convicted offender and arrestee DNA profiles will be marked for upload to SDIS according to the CODIS operating procedures and the "CODIS Standards for Acceptance of DNA Data at NDIS". This is done by highlighting all of the new samples in Specimen Manager, then right-click and select Mark Specimen For Upload.

### 13.4.2 Casework Autosearch

All casework profiles entered into CODIS Local Database will be searched against the entire local database, including the Elimination Index.

In AutoSearcher, double-click on the file called “NewSearch 121417” and then select AutoSearcher>Perform Search from the top menu. This will search all new data that has been entered (after Technical Review is complete) since the previous auto search against the entire local database. Only profiles that are considered complete will be auto searched. A profile is considered complete for LDIS searches in the Forensic Partial, Forensic or Forensic Mixture Indexes if it includes at least 6 loci (may include D2S1433 or D19S433). This search also allows for one mismatch (in case of typographical error at DNA entry) at any of the 6 loci. A profile is considered complete for searches in the Missing Persons and Unidentified Humans Remains Indexes if it includes at least 8 loci (excluding D2S1338 and D19S433).

After the search is complete, go to the Message Center and select AutoSearcher Reports. Double-click on the recent search to execute the message and load the matches into Match Manager. No one will use the Remote Search on any data that has not been through Technical Review. (CODIS-NDIS #BT110806).

### 13.4.3 Keyboard Searches

A keyboard search is a manual search of a forensic DNA profile in the Nevada CODIS state database or other state database. A request for a keyboard search may be made when the investigation warrants an immediate search of the database. This search allows the Forensic Lab flexibility of searching a DNA profile in which a threat to the community substantiates an immediate search. CODIS eligibility rules still apply.

- The agency must submit the request for a keyboard search through the Local CODIS Administrator via email or letter to the CODIS State Administrator. This request must include the reason for the keyboard search, origin of the DNA profile, and verification the DNA profile has been technically reviewed.
- Keyboard searches are only performed after technical review and if a profile will ultimately be entered into CODIS. Therefore, while the initial search is a “one time event”, ultimately the sample will be entered into the database and automatically searched against the database on some routine basis.
- In the event a keyboard search is performed, a printout of the matches (if any) will be printed and retained in the case file as a record. In the event there are no matches, this record would serve as a negative database search.
- In special circumstances, SDIS labs can be sent a technically reviewed DNA profile and request the profile to be keyboard searched at NDIS or in other states. This request is
conducted through the NV State CODIS Administrator in writing and if approved, the NV state administrator submits the request to all the other labs and informs the LVMPD of any hits.

13.5 CODIS Hits and Match Confirmation Procedures
When a match, or hit, occurs in CODIS, there are several steps that must be followed to confirm and report out the DNA match. These procedures differ based upon the source of the DNA profile, database or casework, and whether the case(s) are solved or unsolved. In the event a submitted buccal swab is associated with CODIS investigative leads for multiple cases, the requestor for each affected case will be notified via email that the Biology/DNA Detail will be issuing a supplemental report. A copy of this email will be maintained in the Object Repository of each affected case in LIMS.

13.5.1 Offender/Arrestee to Unsolved Case(s)
If a LDIS match occurs between an offender or arrestee and an unsolved forensic case, the following steps will be followed:
1) STR technology- the allele designations will be confirmed through the comparison of analyzed data.
2) The forensic specimen case file is pulled and a determination is made whether a match confirmation is necessary.
   a. If the sample hits against duplicate database samples from the same person, only a fingerprint match and biographical information check between the multiple collection kits is required. The specimen details for all samples involved must also be updated.
   b. If a sample hits against a database sample that has already been confirmed, the prior match data is used and the specimen details for all samples involved must be updated.
3) If a match confirmation is necessary, a lab member will retrieve the envelope containing the DNA sample swab box or FTA card and the fingerprint form, if collected. A copy of the biographical information will be printed from STaCS or photocopied from the envelope and fingerprint form (after comparison by a member of the Latent Print detail, if applicable) to include in the hit report file. Re-analysis of the database DNA sample will be conducted as soon as possible. Any of the validated extraction and STR amplification methods for reference standards can be used. A full profile is not required but there must be enough data to show concordance with the original profile in CODIS. The DNA match confirmation data is subject to technical review, signed and dated.
   a. A national criminal history check will be performed using the National Crime Information Center (NCIC) or Interstate Identification Index (III). Documentation of this check will be performed as follows:
      • Arrestee: Note added to Comments field in STaCS prior to printing for CODIS hit packet.
      • Convicted Offender: Note added to outer envelope of SN samples or back of bi-fold for STaCS samples, prior to photocopying for inclusion in CODIS hit packet.
4) Fingerprint comparison is used to help with the confirmation process when possible. If the fingerprint is not comparable due to quality, the match is still valid. Fingerprints confirmed via LiveScan at the time of collection do not need to be re-confirmed.
5) An administrative CODIS hit data packet is prepared by the CODIS Administrator for the analyst who will write the report and includes the following:
   a. Database Hit Review Form (CODIS Administrator completes Database Task Checklist on top portion). This form lists the applicable LIMS lab numbers involved in the hit(s) and
serves as a coversheet for the documentation being scanned into the LIMS under each lab number listed.
b. Copy of Local Match Detail Report(s) with updated Source ID and Disposition
c. Copy of outer envelope and fingerprint form (after comparison by member of the Latent Print Detail) for swab samples, or copy of both sides of bi-fold for FTA card samples (after comparison by member of the Latent Print Detail, if applicable), or copy of STaCS print-out.

**Note:** For arrestee samples, fingerprints are being verified via Livescan and therefore there may not be any additional verification by the Latent Print Detail. In these instances, only the updated STaCS print-out is needed.
d. Copy of District Court print-out showing sentencing requirement to provide a DNA sample, if applicable

**Note:** For arrestee samples because sample eligibility is being determined up front with probable cause paperwork, no print-outs of this verification will be required in the hit data packet.
e. Copy of Technical Review Checklist-Database Knowns form used for technical review of sample when it was re-tested

f. Electropherogram of sample when it was re-tested
g. Copies of LDIS Specimen Details Report(s) with updated Source ID and STR/Y-STR Comments fields

6) A CODIS Hit Notification report will be prepared and sent by a member of the Biology/DNA Detail to the appropriate investigator informing them that a match has been detected. The following biographical information will be relayed, if available:
a. The name of the convicted offender or arrestee, state identification (SID) number, social security number (SSN), qualifying offense and date of birth.
b. This information is to be used as investigative information and may be used as probable cause to obtain a search warrant for a DNA sample for the purposes of comparison.
c. The investigator will be informed that confirmation of the match for future legal proceedings will require a suspect reference standard (buccal swab collection), which can be submitted to LVMPD via standard evidence submission procedures.
d. All paperwork associated with the match confirmation will be administratively reviewed prior to the report being distributed. The reviewer will complete the Database Administrative Review Checklist on the bottom part of the Database Hit Review Form.
e. This paperwork will be retained utilizing the same document retention policies set forth for the case file in which it resides.

The paperwork should be page numbered and initialed with the total number of pages written on the first page. The paperwork will be scanned into the Object Repository of the LIMS for the case(s) involved in the hit(s). These are approved by the CODIS Administrator or by the analyst writing the hit report. If being scanned into the LIMS, the lab # only needs to appear on the front page.

**Note:** For cases worked outside of the LIMS this paperwork is filed on the left side of the case file. If any of the paperwork does not include the unique case/lab identifier somewhere on the page then it should be written on the bottom right hand corner of the page.

After the CODIS Hit Notification report is released, a follow-up e-mail with a CODIS Hit Disposition form will be sent to the investigator to determine the disposition of the investigative lead. The
CODIS Hit Disposition form returned to the CODIS Administrator will be scanned into the Object Repository in the LIMS and approved by the CODIS Administrator (or alternate).

13.5.2 Unsolved Cases to Solved Cases
If a LDIS match occurs between an unsolved case and a solved case, either a benchwork match to a known reference sample (“Forensic Hit”) or a volunteer sample (“User Defined #1” or “Volunteer Hit”), the following procedure is used:
1) The case data from both cases are compared and reviewed.
2) The original requestor for the unsolved case will be notified via email that based on a CODIS investigative lead, the Biology/DNA Detail will be issuing a supplemental report for the case. Documentation of this email communication will be maintained in the case file or the case’s Object Repository.
3) The allele table of the reference standard from the solved case is placed within the unsolved case’s file and statistics are performed if necessary. Copies of the Local Match Detail Report(s) and LDIS Specimen Details Report(s) with updated Source ID, Disposition, and Comments fields are also included within the case file or placed in the unsolved case’s Object Repository.
4) A supplemental report is prepared and then technical and administrative review takes place. The submitting investigators of all cases associated with the hit(s) will be contacted, via report or electronically by the CODIS Administrator or casework analyst. Information from each case to be included: event #, crime type, sample name, and sample description. Documentation of this contact will be retained in each file or scanned into the Object Repository of the LIMS.

13.5.3 Solved Cases to Solved Cases
If a LDIS match occurs between two or more solved cases (each already includes a statistical comparison to an evidentiary reference standard), the following procedure is used:
1) The case data from all cases are compared and reviewed.
2) The original requestors for each case are notified via email that the cases have hit to each other and have already been compared to buccal swabs. Information from each case to be included: event #, crime type, sample name, and sample description.
3) A copy of the email and CODIS Match Details Report will be included within the case file or placed in each case’s Object Repository.

13.5.4 Unsolved Case to Unsolved Case
If a LDIS match occurs between two unsolved cases (“Forensic Hit”) the following procedure is used:
1) The case data from both cases are compared and reviewed.
2) An administrative CODIS hit data packet is prepared by the CODIS Administrator for the analyst who will write the report and includes the following:
   a. Database Hit Review Form (CODIS administrator completes Database Task Checklist on top portion). This form lists the applicable LIMS lab numbers involved in the hit(s) and serves as a coversheet for the documentation being scanned into the LIMS under each lab number listed.
   b. Copy of Local Match Detail Report(s) with updated Disposition
   c. Copies of LDIS Specimen Details Report(s) with updated STR/Y-STR Comments field
3) This paperwork will be retained utilizing the same document retention policies set forth for the case file in which it resides.
The paperwork should be page numbered and initialed with the total number of pages written on the first page. The paperwork will be scanned into the Object Repository of the LIMS for the case(s) involved in the hit(s). These are approved by the CODIS Administrator or by the analyst writing the hit report. If being scanned into the LIMS, the lab # only needs to appear on the front page.

**Note:** For cases worked outside of the LIMS this paperwork is filed on the left side of the case file. If any of the paperwork does not include the unique case/lab identifier somewhere on the page then it should be written on the bottom right hand corner of the page.

4) A CODIS Hit Notification report will be prepared and sent by a member of the Biology/DNA Detail to the appropriate investigators informing them that a match has been detected between the unsolved cases.

**13.5.5 Forensic or Offender/Arrestee – Interstate Matches**

If the match involves either a forensic or offender/arrestee profile developed by another forensic lab:

- The verification procedures will be similar to those above, except that the two agencies will share portions of the procedures. The DNA case analysts or the CODIS Administrators of the respective labs will communicate using the format described in the NDIS Manual, “Confirm an Interstate Candidate Match”. Match Data Requests and Match Data Responses are typically sent via electronic mail, faxed and/or sent by regular mail.

- If the LVMPD receives a match request to confirm a database sample from an outside agency, the match confirmation information will be stored in the weekly folders containing database sample data packets and autosearches maintained by the CODIS Administrator. An administrative CODIS hit data packet similar to those generated for LDIS matches will be prepared by the CODIS Administrator, including updated Local Match Detail Report(s) and LDIS Specimen Details Report(s). A letter will be sent to the requesting laboratory with all biographical information available on the database sample collection kit. This letter is administratively reviewed prior to release. The CODIS hit data packet will be scanned into the Object Repository of the LIMS for the database sample.

- If the LVMPD receives a request to exchange case information for a match between two unsolved cases, an administrative CODIS hit data packet will be prepared by the CODIS Administrator including updated Local Match Detail Report(s) and LDIS Specimen Details Report(s). Case information may be exchanged electronically via email or a letter may be sent to the requesting laboratory with the case and investigating agency information available. Additionally, a CODIS Hit Notification report is written to notify the case investigator of the LDIS case of the other agency’s case information. The CODIS Hit Notification report is administratively reviewed prior to release. The CODIS hit data packet will be scanned into the Object Repository of the LIMS for the LDIS case.

If the match involves a northern Nevada (NN) offender sample owned in CODIS by the LVMPD:

- Requests for match confirmation of northern Nevada offender samples will be forwarded to the Washoe County Sheriff’s Office (WCSO) for confirmation. Once the confirmation and they will forward a copy of the match response letter after the confirmation is completed so that the LVMPD has documentation the match was addressed. Documentation will be maintained in the 1-CODIS folder on the H:drive.
If the match involves a southern Nevada (SN) offender sample owned in CODIS by the Washoe County Sheriff’s Office (WCSO):

- Requests for match confirmation of southern Nevada samples will be forwarded to the LVMPD for confirmation and a copy of the match response letter will be forwarded to the WCSO after the confirmation is completed so they have documentation the match was addressed. Email documentation of the sent letter will be maintained in the Object Repository of LIMS of the SN sample.

13.5.6 Solved Cases to Offender/Arrestee/Volunteer and Intrastate Offender/Arrestee to Offender/Arrestee Hits

**Benchwork Match or Previous Hit** - If the match involves any previously solved case to an offender, arrestee or volunteer, all involved cases and samples will be researched to ensure the provided biographical information matches (e.g. name, DOB, SSN, etc.). The verification of the biographical information will be noted on the Match Detail Report by the CODIS Administrator or the DNA analyst. The Match Detail Report generated in CODIS will be placed on the left hand side of the appropriate case file or scanned into the Object Repository of the LIMS. These matches are dispositioned as a “Conviction Match” in the Match Manager program in CODIS.

If there is a discrepancy in the biographical information, the reason for the discrepancy will be evaluated and parties involved (e.g. detectives, P&P, Prisons) will be notified as appropriate.

**Offender/Arrestee to Offender/Arrestee Match** – If the match involves an offender/arrestee to offender/arrestee match within Nevada, the SN, NN (for Northern Nevada) or STaCS number will be checked in the respective database to ensure the biographical information provided on the envelope matches (e.g. name, DOB, SSN, etc.). These matches are dispositioned as an “Offender Duplicate” in the Match Manager program in CODIS; there is no “arrestee duplicate” disposition option in CODIS.

If there is a discrepancy in the biographical information, fingerprint forms will be checked for offenders or the administrative message (AM) will be checked for arrestees. If needed, all parties involved (e.g. P&P, Prisons) will be notified and re-collection will take place, if possible.

13.5.7 Interstate Offender/Arrestee to Solved Case(s)

**LVMPD Solved Case** – If the match involves a solved case worked by the LVMPD, the other state will be informed of the name of the person from the solved case (e.g. benchwork match or confirmed database sample). This is done via electronic mail. The other state will then confirm if that name matches their offender/arrestee. These matches are dispositioned as a “Conviction Match” in the Match Manager program in CODIS. The Match Detail Report generated in CODIS will be placed on the left hand side of the appropriate case file or scanned into the Object Repository of the LIMS.

If there is a discrepancy (the other state informs us the biographical information does not match), the other state would be asked to perform a confirmation match on the offender/arrestee. All parties involved will be notified and further action will be taken.

**LVMPD Database Sample** – If the match involves a LVMPD database sample with another state’s solved case, the other state will inform us of the biographical information via electronic mail. The
LVMPD will confirm if the provided name matches our offender/arrestee via electronic mail. These correspondences are kept indefinitely in a folder maintained by the CODIS Administrator. These matches are dispositioned as a “Conviction Match” in the Match Manager program in CODIS.

If there is a discrepancy (the biographical information does not match), the other state will notify the LVMPD and relay what further action they require (e.g. confirm the sample, send report, etc.).

13.5.8 Hits to Ineligible Samples
In the event a hit occurs to a sample that is deemed ineligible to be retained in CODIS, a hit notification report will be issued to the investigating agent advising them of the hit. In addition, the sample will be deleted and a supplemental DNA report will be issued stating the sample has been removed from CODIS because it is no longer eligible. Refer to Administrative Sample Removal (casework samples) or Destruction or Administrative Removal of Database Samples (database samples).

13.5.9 Record Keeping, Hit Reporting and Administrative Review of CODIS Hit Reports
Copies of match documents are kept indefinitely in electronic formats, and in the file maintained by the CODIS Administrator or in the case files or Object Repository of the LIMS.

An NDIS required tally of hits is sent to the State Administrator each month.

A list of conviction matches is recorded each month for LDIS database and forensic samples that occur with other LDIS, SDIS, or NDIS samples.

The technical review of database samples is recorded on the “Technical Review Checklist-Database Knowns” form.

The administrative review of CODIS hit reports and associated paperwork is documented on the “Database Review” form and will include a review of the eligibility of the CODIS profile, CODIS Hit Notification report or letter for clerical errors, a review of the individual’s biographical data, qualifying offense and the DNA profile generated.

Match documents are filed in the case file or if involving a database sample only, in the DNA Databasing Laboratory by the month in which the match report is generated or within the LIMS Object Repository of the database sample. Electronic copies of hit notification reports and letters are stored by case Event #, by year or within the LIMS.

A candidate match shall be dispositioned as soon as possible in the Match Manager program in CODIS. A good faith effort shall be made to perform internal match confirmation processing, data review and completion of a CODIS Hit Notification report within 30 days.

13.5.10 Elimination (Staff) Index Hits
The Forensic Laboratory is committed to being proactive and taking the necessary steps to reduce the possibility of biological contamination of evidence or reference samples by field and laboratory staff. The Laboratory will use a database of employee profiles to help identify any biological contamination that does occur. Currently all Forensic Laboratory employees and CSI employees who routinely handle evidence are required to provide a sample. Other members of
the Law Enforcement community may provide samples on a voluntary basis. Contamination events will be documented on a “Corrective Action Report” or on a “case note” in the case file.

The Biology/DNA Detail will make every effort to protect the identity of the staff’s personal genetic information, and will refrain from turning over the entire index at the request of an agent.

The Elimination Index is used for screening purposes only. The index is not used for investigative purposes and profiles that reside in the Elimination Index of CODIS cannot be uploaded to SDIS or NDIS. In addition, the Biology/DNA Detail is prohibited from releasing DNA profiles contained in the index unless a court order directs the lab to do so.

In the event there is a match between an evidentiary sample and the Elimination Index, the following will take place:

a. It will be determined if the staff member handled the evidence at any time: either at the scene of the crime or in the laboratory. The profile will be deleted from CODIS. The case will be re-worked, if possible, and a supplemental DNA report will be issued if it is not caught prior to the original report being released.

b. If a forensic profile already resides in CODIS and is found to match an employee staff member, it will be determined if the staff member handled the evidence at any time: either at the scene of the crime or in the laboratory. The case will be re-worked, if possible, and the DNA profile will be deleted from CODIS. A supplemental DNA report will be issued.

Refer to Interpretation of a Contaminated Control or Sample and Contamination Report Statements for interpretation criteria and report wording associated with Elimination Index hits.
Appendix A  Title: GeneMapper ID-X and STRmix Settings

ALLELEigator Table Setting: (Investigator 24plex or Fusion 6C)

Samples Tab

Genotypes Tab
Investigator 24plex Size Standard Settings

![Diagram of Investigator 24plex Size Standard Settings]
Investigator 24plex INV24PLEX50_170401 Analysis Method

**Allele Tab**

**Peak Detector Tab**
**Investigator 24plex Panel Settings**

<table>
<thead>
<tr>
<th>Sample</th>
<th>Name</th>
<th>Size Quality</th>
<th>Overridden (SQO)</th>
<th>Off-scale (SOS)</th>
<th>Sizing Quality</th>
<th>Outside Marker Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample1</td>
<td>123</td>
<td>150</td>
<td>Yes</td>
<td>No</td>
<td>90</td>
<td>Yes</td>
</tr>
<tr>
<td>Sample2</td>
<td>456</td>
<td>180</td>
<td>Yes</td>
<td>Yes</td>
<td>80</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Investigator 24plex Plot Settings**

There are custom INV24PLEX print plot settings: (rfu only) and (rfu & bp)

- **Sample Header** tab: Sample File, Sample Name, Size Quality Overridden (SQO), Sample Off-scale (SOS), Sizing Quality (SQ), and Outside Marker Range (OMR) checkmarked
- **Genotype Header** tab, all but Sample File check-marked
- **Sizing Table** tab: Sample File Name, Marker, Allele, Size, and Height checkmarked

**Labels tab:**

- (rfu only) Label 2: Height
- (rfu & bp) Label 2: Size
- Label 3: NONE

**Display Settings tab:**

- [Image of display settings]
Fusion 6C Size Standard Settings
Fusion 6C Analysis Method

**Allele Tab**

**Peak Detector Tab**

**Peak Quality Tab**
Plot Setting: Data Interpretation
There is a custom Data Interpretation plot setting: Fusion 6C Review with BP.

Under the Sample Header tab, the following items should be check-marked: Sample File, Sample Name, Sample Off-scale (SOS), Sizing Quality (SQ), Sample Spike (SSPK), Mixed Source (MIX), Outside Marker Range (OMR) and Composite GQ (CGQ).

Under the Genotype Header tab, all but Sample File should be check-marked.

Under the Sizing Table tab, the following items should be check-marked: Sample File Name, Marker, Allele, Size and Height.

Under the Labels tab, the following should be selected from the different drop down menus: Assigned Allele: Allele Call, Size, and Height; Custom Allele: Allele Call, Size, and Height; Allelic Ladder: Allele Call and Height; and Artifact: Artifact Label, Size, and Height. Dye Color-Border should be selected from the Label Color drop down menu.
The **Display Settings** tab should look like the following:

![Display Settings tab](image)

**Plot Setting:** Fusion 6C Print with BP (used to print electropherograms with no artifacts shown)

Under the **Sample Header Tab**, the following items should be check-marked: Sample File, Sample Name, Sizing Quality Overridden (SQO) and Sizing Quality (SQ).

Under the **Genotype Header** tab, all but Sample File should be check-marked.

Under the **Sizing Table** tab, the following items should be check-marked: Sample File Name, Marker, Allele, Size, and Height.

The **Labels** tab should look like the following:

![Labels tab](image)
The **Display Settings** tab should look like the following:

Plot Setting: Fusion 6C Ladder for OL (used to print Ladder electropherograms for off-ladder alleles)

Under the **Sample Header Tab**, the following items should be check-marked: Sample File, Sizing Quality Overridden (SQO) and Sizing Quality (SQ).

Under the **Genotype Header** tab, Sample File, Sample Name, Sizing Quality Overridden, Sample Off-Scale, Sizing Quality, Outside Marker Range should be check-marked.

Under the **Sizing Table** tab, all items should be check-marked.
The **Labels** tab should look like the following:

![Labels Tab Screenshot]

The **Display Settings** tab should look like the following:

![Display Settings Tab Screenshot]

Run Parameter Settings for Investigator 24plex QS in v2.4 of STRmix
The following run parameter settings will be used for the interpretation of Investigator 24plex QS profiles. The stutter values are published in the Biology/DNA Detail’s STRmix Parameter document. These values can be found by selecting “Settings” from the main menu, then “Add/Edit DNA Profiling Kit” from the Settings Main Menu. The “LVMPD Qiagen_Investigator_24plex I” kit must be selected from the DNA profiling kit dropdown to view the settings.

**Default Investigator 24plex QS Interpretation Parameters in v2.4:**

The following values can be found by selecting “Settings” from the main menu, then “Set STRmix defaults” from the Settings Main Menu.

**Investigator 24plex QS Population Parameters in v2.4:**
The following population parameters (sub populations, theta and details to calculate a unified LR) are provided below. These values can be found by selecting “Settings” from the main menu, then “Edit/View population” from the Settings Main Menu.

**Investigator 24plex QS LR Options in v2.4**
The settings for calculating a LR are shown below.
Run Parameter Settings Identifiler Plus in v2.3 of STRmix

The following run parameter settings will be used for the interpretation of Identifiler Plus profiles. The stutter values are published in the Biology/DNA Detail’s STRmix Parameter document. These values can be found by selecting “Settings” from the main menu, then “Add/Edit DNA Profiling Kit” from the Settings Main Menu. The Identifiler Plus kit must be selected from the DNA profiling kit dropdown to view the settings.

Default Identifiler Plus Interpretation Parameters in v2.3:

The following values can be found by selecting “Settings” from the main menu, then “Set STRmix defaults” from the Settings Main Menu.
Identifiler Plus Population Parameters in v2.3:
The following population parameters (sub populations, theta and details to calculate a unified LR) are provided below. These values can be found by selecting “Settings” from the main menu, then “Edit/View population” from the Settings Main Menu.
Identifiler Plus LR options in v2.3:
The settings for calculating a LR are shown below:
Appendix B: Title: USE OF DNA WORKBOOKS

The Biology/DNA Detail has developed several Excel workbooks to assure quality and enhance efficiency through automation of laboratory processing documentation and calculation assistance. The master templates of all such workbooks are electronically secured on the forensic lab’s H:drive with read-only access restricting workbook users from making unauthorized changes to the templates. Password-protected and/or full read-write access is granted only to the CODIS Administrator, the DNA Lab Supervisor, the Technical Leader, the DNA Lab Manager, the Forensic Lab’s Quality Manager, and/or designee(s) responsible for updating the workbooks. The workbooks currently used by the Biology/DNA Detail are briefly outlined below.

Resource Management/Distribution & Performance Check Workbooks
- **huLOTapai**: centralized utility that manages DNA resources (reagents, instruments and settings, and their associated expiration and/or maintenance dates); distributes resources to respective laboratory processing workbooks and restricts analysts from using expired resources or resources that haven't yet been approved for usage
- **LADDERpillar**: collection of integrated workbooks monitoring 3130xl performance using allelic ladder measurements
- **KoalaManderCuda**: collection of integrated workbooks normalizing 3130xl injection conditions for DNA interpretation using amplified DNA dilution series

DNA Databasing & Forensic Casework Workbooks
- **CONFIRMadactyl**: documents p30/microscopic sperm/RSID/hematrace screening
- **EXTRACTasaurus or DB EXTRACTasaurus**: documents DNA extraction
- **TRIOceratops**: documents Quantifiler Trio DNA quantification
- **makeiTWORK**: documents Qiagen re-purification/cleanup and/or DNA concentration
- **AMPalatypus & cattyRUNpas**: documents Investigator 24plex amplification/electrophoresis
- **dazedNconFUSION**: documents Fusion 6C amplification/electrophoresis
- **ALLELEigator**: converts GeneMapper ID-X data into allele table summaries

**Important**: Within the DNA workbooks, **never** “cut” and/or “paste,” **never** “delete” and/or “insert” rows/columns/cells, **never** “sort,” and **never** “fill-down” unless specifically noted these actions are permissible… **always** instead use “copy” and “paste special values” (or “copy” and “DNA paste” from the customized ribbon) to move data and only in the specific locations designated for user-input (deleting data inside these user-input fields is ok as long as it does not cause a “shift” event to the cells/columns/rows of the workbook or any linked formulas)

**Important**: DNA workbooks utilize a protective “printblocker” feature ensuring that only completed worksheets are printed for case files—any incomplete worksheets are automatically printed/marked **DRAFT** to clearly identify incomplete worksheets… if any resources or results are not applicable, the user must still enter something (such as “N/A” or “---”) to satisfy the printblocker’s protective logic so that the worksheet no longer prints as a draft
B.1 Preparing to use DNA workbooks and DNA workbook maintenance

B.1.1 Update Excel security settings for DNA workbook use

**Note:** security settings must be modified before using DNA workbooks; each user will need to do this once per each computer

- Open Excel; Click the **File** tab on the top navigation ribbon then **Options** from the navigation menu on the left; Choose **Trust Center** from the navigation menu on the left side and then click the **Trust Center Settings** button on the right side (another smaller window will open)
- Choose **Macro Settings** from the navigation menu on the left side of the new window and then **Enable all macros** on the right side
- Choose **External Content** from the navigation menu on the left side of this same window and then **Enable all Data Connections** and **Enable automatic update for all Workbook Links** on the right side
- Click the **OK** button twice to close both windows and then exit/close Microsoft Excel—the updates will take effect the next time you open Microsoft Excel

B.1.2 Maintaining protective drop-down list selection features of DNA workbooks

**Note:** DNA workbooks retrieve resources (pipets, reagents, instruments etc.) from huLOTapai found on the H:drive, requiring network access to leverage its protective management of drop-down lists

- When opening DNA workbooks you will be prompted whether to update links…
  - If you will be selecting resources click **Update**
  - If you don’t need to select any resources, you can click **Don’t Update**

B.1.3 Setting up an external USB drive for DNA workbook use

**Note:** DNA workbooks may require access to E:\QUANTS\do not delete.txt and E:\RUNS\do not delete.txt if network instrument access is blocked (the drive may be “E” or a different letter for each user/computer/USB combination)

- Copy the **QUANTS** and **RUNS** folders from H:\Forensic Data\DNA(\DNA WORKBOOKS)(\RESOURCES)USB setup\ directly onto your USB drive
- Do not move/delete these folders or the “do not delete.txt” files inside them (workbooks will not be able to utilize your backup USB drive)

B.1.4 Optional: Importing a customized ribbon to simplify workbook transcription

**Note:** These customization steps add a tiffCAKE menu to the **Hom** tab of the ribbon featuring **DNA paste** and **ALLELEigator paste** buttons—DNA paste is used in all DNA workbooks except ALLELEigator while ALLELEigator paste should only be used within the ALLELEigator workbook; each user will need to do this one time per computer (as desired)

- Open Excel; Click the **File** tab on the top navigation ribbon and then click **Options** from the navigation menu on the left (a new window will open)
- Choose **Customize Ribbon** from the new window’s navigation menu on the left side, select **Main Tabs** under the top right ribbon customization drop-down list, select **Home** from the ribbon navigation tree located immediately below, then click the **Import/Export** button further below, and select **Import Customization File** (a window will open to select customization file)
B.2 Using DNA workbooks to Print Labels for Tubes, Slides, or P30/Hematrace/RSID

Note: for convenience, multiple workbooks include automatic label makers utilized according to the same steps outlined below

- Select the LABELS tab and designate first on the label template in the position on the label sheet from which labels should start—if using a new label sheet no changes are needed since the template is initialized to generate labels from the first label position
- Click the Make Labels button—verify/modify the sample names on your labels as needed then load the printer with label sheets and print

Note: if labels fit on one page (second page isn’t needed) DO NOT REDESIGNATE the print area or your samples will not line up properly with the labels; instead adjust the settings in the print dialog window to print Pages 1 to 1

B.3 CONFIRMadactyl

Note: Appendix B.3 procedures are simply used to streamline worksheet documentation; refer to the relevant sections of Biology/DNA Procedures Manual for Forensic Biology Screening procedures
B.3.1 Creating a lab processing worksheet to document forensic screening

- Enter sample ID’s and descriptions (or Event #s, item numbers, and descriptions) in the designated area on the INPUT tab—the information will be automatically transferred to the lab worksheet on the WORKSHEET tab.
- Pick the screening types from the drop-down menus on the WORKSHEET tab—the worksheet will automatically update itself to match the screening types so that you are prompted to record the respective resources and complete the respective result fields.
- Enter the date on the WORKSHEET tab in the format m/d/yy to automatically restrict expired/invalid resources from the drop-down lists; use the drop-down lists to record the resources used for screening on the WORKSHEET tab.
- Record screening results and extraction info for each sample in the designated area on the WORKSHEET tab—when the worksheet is complete it should be printed for the case file.
- Refer to B.2 for label printing instructions.

B.3.3 Using CONFIRMadactyl’s utility tab to prepare sample lists for extraction

- Sample and extraction info is automatically transferred from the WORKSHEET tab to the UTILITY tab for you—you can select the list in the designated area as instructed on the UTILITY tab then choose Sort from the ribbon’s Data tab to sort using headers by the EXTRACTasaurus tool column as shown below.

- use copy and DNA paste (or copy and paste special values) to transfer samples from the UTILITY tab of CONFIRMadactyl to the INPUT tab of EXTRACTasaurus

B.4 EXTRACTasaurus and DB EXTRACTasaurus

Note: Appendix B.4 procedures are simply used to streamline worksheet documentation; refer to the relevant sections of the Biology/DNA Procedures Manual for Extraction procedures.

B.4.1 Creating a lab processing worksheet to document DNA extraction

- Pick the extraction type from the drop-down menu on the INPUT tab—the worksheet will automatically update itself to match the extraction type’s required documentation fields.
- Enter sample ID and description (or Event #, item number, and description as applicable) in the designated area on the INPUT tab—the information will be automatically transferred to the lab worksheet on the WORKSHEET tab and create the reagent blank for you.

Note: only enter the sample names one time for differential sets—the worksheet will automatically duplicate the set and append “-EF” and “-SF” accordingly.

Note: re-isolates should be appended with Ri# (use 1, 2, etc. in place of #)
• Enter the date on the WORKSHEET tab in the format m/d/yy to automatically restrict expired/invalid resources from the drop-down lists; use the drop-downs to record resources used as well as incubation times, tube numbers, and elution volume in the designated fields
• When the worksheet is complete it should be printed for the case file

B.4.2 Using EXTRACTasurus’s utility tab to prepare sample lists
• Tube numbers and sample names are automatically transferred to the UTILITY tab for you—choose tube number/dilution factor naming preferences from the drop-down
• Copy and DNA paste (or copy and paste special values) from the UTILITY tab into other DNA workbooks

B.4.3 Using EXTRACTasaurus to print storage logs and/or tube labels
Note: This function is not applicable to DB EXTRACTasaurus
• Use each sample’s drop-down list on the UTILITY tab to specify whether you need to store/label extract vs. substrate and extract
• Select the FREEZER TEMPLATE tab, designate first on the template position matching the starting position inside the box then click the Add samples to box(es) button and verify/modify the samples as needed—print the log(s) and place inside the lab’s binder (remember to record the storage box’s label on the worksheet)
• Refer to B.2 for label printing instructions; labels will print in duplicate for samples marked “SUB+EXT” on the utility tab

B.5 TRIOceratops
Note: Appendix B.5 procedures are simply used to streamline worksheet documentation and interface with 7500 software; refer to the relevant sections of the Biology/DNA Procedures Manual for Quantifiler Trio quantification and 7500 operation procedures

B.5.1 Creating a lab processing worksheet to document quantification
• Enter the sample names and the plate ID into the designated areas on the Quant list tab—you can copy and DNA paste (or paste special values) samples from other workbooks. You must include “TRIO” within the plate ID.
  Note: the sample names and plate ID will automatically populate the worksheet; the master mix preparation will also automatically calculate for you
• Enter the date on the Quant Setup tab in the format m/d/yy to automatically restrict expired/invalid resources from the drop-down lists; use the drop-down lists to records the resources used for quantification
  Note: the workbook automatically detects diluted extracts when colons appear in sample names to prompt the user to record the diluent used and dilution details; the default diluent can be toggled between TE and H2O
• When the worksheet is complete it should be printed for the case file
B.5.2 Exporting a sample setup file for the 7500

- Enter the “backup drive letter” in the designated area on the Quant list tab that currently corresponds to your pre-formatted and unlocked USB drive (refer to B.1.3)
- Click the EXPORT.TXT button on the Quant list tab; you will be prompted to save your quant workbook and the sample setup .txt file will be automatically sent to the import folder of the 7500 instrument recorded on Quant Setup tab

**Note:** if the instrument is inaccessible for any reason, the sample setup .txt file will transfer to the optional backup drive instead—if no backup drive was entered the workbook will alert you to re-export the .txt file

B.5.3 Importing a sample setup file onto the 7500 for quantification

- Launch the 7500’s HID software; click File → New
- Choose the “Quantifier Trio” icon from the home page
- Enter the experiment name (should match plate ID in TRIOceratops workbook)

- Click File → Import; Choose the exported .txt file from B.5.2

**Note:** the file can be found on the desktop on the instrument laptop, within the “Import” folder
- Verify that the plate setup is correct (correct samples, wells, tasks, detectors)
- Save the plate setup as an EDS document in the appropriate “DNA lab runs” folder

B.5.4 Exporting results from HID software and importing them into TRIOceratops

**Note:** The workbook automatically summarizes the quantification results from the HID software on the Quant Results tab

- After analyzing data using the HID software, highlight the entire plate (under the View Plate Layout tab with the Analysis drop down) click Export (top toolbar). The only box that should be clicked under Export Properties is Results. Click on the Customize Export tab and ensure the columns to be exported are in the correct orientation as defined in the relevant sections of the Biology/DNA Procedures Manual for Quantifier Trio quantification and 7500 operation procedures. Once everything is correct, define the location you wish to export to.
B.5.5 Viewing quantification results in TRIOceratops

- Open the quant workbook created in B.5.2 and select the Quant list tab; Click the Import .xls button and save the workbook when prompted--choose the .xls results exported from the HID software in step B.5.4
- The quant results are summarized and Auto:Y ratios automatically calculated--the Auto:Y ratio will display “---” if the Y target does not contain a quantification value; the workbook also automatically predicts each sample’s next action using the following logic:
  - Samples with quant values >50 ng/µL are automatically assigned Dilute → Re-Quant
  - Samples (>5 ng/µL) with IPC C_T values > 1.0 cycle above the average IPC C_T are flagged for possible inhibition and automatically assigned QIA→ Re-Quant
  - Samples (small target undetermined or <5 ng/µL) with IPC C_T values > 0.5 cycle above the average IPC C_T are flagged for possible inhibition and automatically assigned QIA → Re-Quant
  - Samples (IPC C_T values ≤ average IPC C_T) with quant values <0.125 ng/µL for the small target and <0.15ng/µL for the large target are automatically assigned CONC
  - All other samples are automatically assigned a default dilution depending on the chosen amp kit and degradation index

Note: The average IPC C_T is calculated using standards 2-5 because the standards do not contain inhibitors; standard 1 is omitted from the average because its higher concentration of human DNA competes with the IPC for amplification causing IPC C_T delays; samples with a degradation index greater than or equal to 1.5 will automatically be flagged by the workbook in order to alert the analyst

B.5.6 Assigning actions and automatically calculating amp dilutions

Important: The Quant Results tab must be reviewed carefully to determine the next steps in processing—the workbook predicts next-actions to streamline analysis but the analyst must carefully review and update/override the automatically predicted actions as needed/desired using each sample’s drop-down list and/or comment field

- Use the Action drop-downs (listed below) and Comments fields as needed to document the next action for each sample or RB—the DNA and H2O/TE columns update automatically

<table>
<thead>
<tr>
<th>Samples:</th>
<th>Samples or RB’s:</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.1 ng/µL d/l’n (XXX ng MAX)</td>
<td>Target Max (XXX ng)</td>
</tr>
<tr>
<td>0.125 ng/µL d/l’n (XXX ng MAX)</td>
<td>CONC</td>
</tr>
<tr>
<td>0.15 ng/µL d/l’n (XXX ng MAX)</td>
<td>QIA → Re-Quant</td>
</tr>
<tr>
<td>0.2 ng/µL d/l’n (XXX ng MAX)</td>
<td>QIA + CONC → Re-Quant</td>
</tr>
<tr>
<td>0.3 ng/µL d/l’n (XXX ng MAX)</td>
<td>Re-Quant</td>
</tr>
<tr>
<td>0.4 ng/µL d/l’n (XXX ng MAX)</td>
<td>No Action Now</td>
</tr>
<tr>
<td>0.5 ng/µL d/l’n (XXX ng MAX)</td>
<td>----</td>
</tr>
<tr>
<td>0.6 ng/µL d/l’n (XXX ng MAX)</td>
<td>(dynamically calculated using QT value or selected amp kit)</td>
</tr>
<tr>
<td>No d/l’n (XXX ng MAX)</td>
<td>Dilute → Re-Quant</td>
</tr>
</tbody>
</table>

Uncontrolled Copy if not located in Qualtrax
Note: The MAX template choices reflect the max volume added to the amplification reaction depending which kit is selected; therefore, the actual MAX varies depending on the volume amplified (the analyst can use each sample’s comment field to note amp volume/target adjustments)

- The analyst is alerted whenever an impossible dilution target is mistakenly chosen (Example: a sample with 0.4ng/µL quant value cannot be diluted to make 0.6ng/µL dil’n (XXXng MAX)

- The analyst can also scale the amp dilutions up or down by simply adjusting the DNA volume—the H2O/TE volume will automatically adjust according to the chosen “Action” and the volume reflected in the DNA column

Note: The formulas in the Action drop-down and DNA column are replaced by text whenever you modify them—this means that manually modified DNA volumes will no longer automatically adjust for newly chosen actions; however, the diluent volume will still alert the analyst automatically if the new action’s target cannot be achieved (for this reason it’s recommended that analysts avoid adjusting the H2O/TE volumes manually for dilutions)

B.5.7 Documenting amp dilutions and printing the quantification results

Important: The bottom of the Quant Results tab is reserved for documenting the resources used to prepare amplification dilutions; refer to the section of the technical manual for the respective STR kit that will be used for amplification to determine which diluent(s) can/should be used; analysts should use the same diluent/lot for dilution that they will use for ANC during subsequent amplification

- Enter the date the dilutions are being prepared in the designated field on the Quant Results tab in the format m/d/yy—this date will automatically restrict expired/invalid resources from the drop-down lists

- The Quant Results tab’s default diluent for making subsequent amp dilutions can be toggled between TE and H2O

- Record the dilution resources on the Quant Results tab; IF NO dilutions are being performed, simple enter “N/A” or “---” (or similar) in the designated fields

- When the worksheet is complete it should be printed for the case file

B.6 makeiTWORK

Note: Appendix B.6 procedures are simply used to streamline worksheet documentation; refer to the relevant sections of the Biology/DNA Procedures manual for Qiagen Cleanup and Microcon/Centrivap concentration

B.6.1 Creating a lab processing worksheet for Qiagen cleanup and/or DNA concentration

- Enter the sample names in the designated area on the “input” tab using the following rules:
  - Qiagen cleanup samples must include QIA in their names
  - Microcon concentration samples must include MC in their names
  - Centrivap concentrations samples must include VAP in their names

Note: The QIA & MC & VAP tab automatically updates itself to reflect each sample’s relevant documentation fields and required resource documentation
B.7 AMPalatypus & cattyRUNpas

Note: Appendix B.7 procedures are simply used to streamline worksheet documentation and interface with 3130XL Data Collection software; refer to the relevant sections of the Biology/DNA Procedures Manual for amplification and electrophoresis procedures.

B.7.1 Creating a lab processing worksheet to document amplification and/or electrophoresis

- Select whether to create an Amp only, Run only, or Amp + Run worksheet using the Amp & Inj list tab’s drop-down menu—the worksheet will automatically format itself to match.
- Enter the sample names as well as the Amp ID and/or run name in the designated areas—you can copy and DNA paste (or paste special values) samples from other workbooks; the sample names and plate ID will automatically populate the worksheet and/or plate record; the master mix preparation(s) will also automatically calculate for you.
  - LADDER or APC or ANC (workbook will append ID’s automatically for you BUT the analyst must manually enter the full APC/ANC name including the Amp ID for reloads for Run only workbooks)
  - Alternate amplifications should be appended with AMP# (use 1, 2, etc. in place of #)
  - Reamplifications should be appended with RA# (use 1, 2, etc. in place of #)
  - Reinjections should be appended with RJ# (use 1, 2, etc. in place of #)
  - Reloads are designated using each sample’s drop-down menu on the Amp & Inj list tab—you can copy and DNA paste (or paste special values) samples/amplification wells from their original amplification workbooks and the new workbook will automatically reflect the amplification plate and well for cherry-picking amplicons during setup.

Important: the workbook can only accommodate 1 through 9 (single digits) for any AMP#, RA#, RJ#, RI# samples—if sample names require more than 1 digit, both the worksheet that is printed for the case file and the plate record imported onto the instrument will have to be manually corrected by analysts; analysts should verify the sample names/well locations on the worksheet and on the imported plate record to ensure samples are named correctly and match their well order.

- Enter the date(s) on the LAB worksheet tab in the format m/d/yy to automatically restrict expired/invalid resources from the drop-down lists; use the drop-down lists to record the resources used for amplification and/or electrophoresis and the corresponding run numbers (if applicable)
- When the worksheet is complete it should be printed for the case file.
B7.2 Exporting a plate record for the 3130XL
- Enter the backup drive letter in the designated area on the Amp & Inj list tab that currently corresponds to your pre-formatted and unlocked USB drive (refer to B.1.3)
- Click the EXPORT 3130 plate record! button on the Amp & Inj list tab; you will be prompted to save your workbook and the plate record will be automatically exported to the import folder of the 3130XL instrument recorded on the LAB worksheet tab
  Note: if the instrument is inaccessible for any reason, the plate record will transfer to the optional backup drive instead—if no backup drive was entered the workbook will alert you to re-export the plate record

B.7.3 Importing a plate record onto the 3130XL for electrophoresis
- Click Plate Manager in left navigation pane of 3130XL data collection software
- Click the “import” button; choose the .txt plate record exported in step B.7.2
C.1 7500 Maintenance using HID v1.2 Software

The following table displays the recommended 7500 instrument and laptop maintenance schedule when using the HID v1.2 software. Monthly, quarterly, semi-annual, and annual maintenance tasks should be performed using the listed steps/reference information at the frequencies indicated by the table. Documentation including Field Service/Maintenance Reports, maintenance checklists, and Corrective Action Reports (if required) will be maintained in the “ABI 7500 HID Maintenance Logbook.”

<table>
<thead>
<tr>
<th>Frequency</th>
<th>HID Maintenance Task</th>
<th>See Step</th>
<th>Reference*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monthly</td>
<td>Hardware/function test</td>
<td>C.1.1</td>
<td>56-57</td>
</tr>
<tr>
<td></td>
<td>Check lamp status (replace lamp if needed)</td>
<td>C.1.2</td>
<td>58 / 63-65</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> lamp replacement must be followed by ROI calibration/optical calibration/dye calibration— steps/references are noted in semi-annual task list of this maintenance table</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Decontaminate block</td>
<td>C.1.3</td>
<td>59-62</td>
</tr>
<tr>
<td></td>
<td>Background calibration</td>
<td>C.1.5</td>
<td>19-24 / 30</td>
</tr>
<tr>
<td></td>
<td>Reboot laptop and wipe surface of 7500 with lint-free cloth</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Quarterly</td>
<td>Disk cleanup/defragment disks/archive data</td>
<td>C.1.10</td>
<td>6</td>
</tr>
<tr>
<td>Semi-Annually</td>
<td>1) Hardware/function test</td>
<td>C.1.1</td>
<td>30-34</td>
</tr>
<tr>
<td>(In noted order)</td>
<td>2) Check lamp status (replace if needed)</td>
<td>C.1.2</td>
<td>121-125</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> lamp replacement must be followed by ROI calibration/optical calibration/dye calibration— steps/references are noted in semi-annual task list of this maintenance table</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3) Decontaminate block</td>
<td>C.1.3</td>
<td>59-62</td>
</tr>
<tr>
<td></td>
<td>4) ROI calibration**</td>
<td>C.1.4</td>
<td>7-17</td>
</tr>
<tr>
<td></td>
<td>5) Background calibration</td>
<td>C.1.5</td>
<td>19-24 / 30</td>
</tr>
<tr>
<td></td>
<td>6) Optical calibration**</td>
<td>C.1.6</td>
<td>19 / 25-29</td>
</tr>
<tr>
<td></td>
<td>7) Dye calibration: ABY, JUN, MP, FAM, VIC (Quantifiler Trio)**</td>
<td>C.1.7</td>
<td>31-44</td>
</tr>
<tr>
<td></td>
<td>8) Reboot laptop and wipe surface of 7500 with lint-free cloth</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Annually</td>
<td>Performed by AB technician; includes all semi-annual procedures</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>As needed</td>
<td>Decontaminate block</td>
<td>C.1.3</td>
<td>59-62</td>
</tr>
<tr>
<td></td>
<td>Check lamp status (replace lamp if needed)</td>
<td>C.1.2</td>
<td>58 / 63-65</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> lamp replacement must be followed by ROI calibration/optical calibration/dye calibration— steps/references are noted in semi-annual task list of this maintenance table</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Frequency

<table>
<thead>
<tr>
<th>HID Maintenance Task</th>
<th>See Step:</th>
<th>Reference*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replace 7500 fuses</td>
<td>---</td>
<td>66-67</td>
</tr>
<tr>
<td>RNase P verification</td>
<td></td>
<td>C.1.9</td>
</tr>
<tr>
<td>(Note: RNase P verification is typically only performed at the request of AB Technical Support for troubleshooting purposes)</td>
<td></td>
<td>45-54</td>
</tr>
<tr>
<td>Update windows operating system</td>
<td>call AB</td>
<td>---</td>
</tr>
<tr>
<td>Update 7500 software</td>
<td>call AB</td>
<td>---</td>
</tr>
<tr>
<td>After fatal error alert - reboot laptop/7500</td>
<td>---</td>
<td>---</td>
</tr>
</tbody>
</table>

^ Reference page numbers refer to the “Applied Biosystems 75010/7500 Fast Real-Time PCR Systems Maintenance Guide” (PN# 4387777 Rev. D)

** The ROI calibration plate is used to perform both ROI and Optical calibration procedures. This plate, as well as the Quantifiler dye calibration plates, can be used to calibrate up to three freeze/thaw cycles and must be stored frozen, although they can remain at room temperature up to 8 hours between calibrations if protected from light exposure.

### C.1.1 HID Function Test

In the 7500 Software, Select **Instrument ► Function Test** from the top navigation bar.

Click the **All Tests** button; the software will indicate whether each function tested has passed or failed; refer as needed to the “Applied Biosystems 7500/7500 Fast Real-Time PCR Systems Maintenance Guide” (PN# 4387777 Revision D) to address any failures.

Click **CLOSE** when finished to close the function test dialog box.

### C.1.2 HID Lamp Status and Replacement

**Note:** Gloves must be worn at all times while handling the halogen bulb; oil/lotion transferred from the hands to the bulb may cause the bulb to burst during operation **HID Check Lamp Status**

In the 7500 software, select **Instrument ► Lamp Status/Replacement** from the top navigation bar to determine the status of the halogen bulb—a dialog box will open displaying the following:

- **Condition** (indicating one of the following):
  - **Good** – the lamp is functioning well and does not need to be replaced
  - **Failed** – the lamp bulb must be replaced; see step C.1.2 to replace the lamp
  - **Change Soon** – the lamp usage exceeds the 2000 hour replacement recommendation
  - **Usage** – total hours of lamp illumination
  - **Date Last Replaced** – date of last lamp replacement

Click **Close** when finished to close the lamp status dialog box; you can close the plate document without saving OR you can keep the plate document open to perform additional maintenance tasks.

**HID Lamp Removal**
1) Power off/cool the 7500 instrument then open the main access door by inserting a swab stick into the pinhole on the edge of the access door and pushing until the mechanism unlatches

2) Remove the bulb by opening the access door, moving the lamp release lever downward then sliding the bulb up/out of the slotted mount

HID Lamp Installation
1) Return the lamp release lever to the upward position–place the new bulb in the slotted mount and carefully slide the bulb down into place

2) Close the main access door and power on the 7500; launch 7500 software.

HID Verifying Lamp Installation
1) Select Instrument ► Instrument Maintenance Manager from the top navigation bar ► ROI (left hand pane) to launch the ROI Inspector dialog box; in the dialog box select Lamp Control ► Idle then look through the vents at the top of the access door and verify whether the lamp illuminated (light is visible) then click OK

If the lamp did NOT illuminate:
1) Repeat lamp replacement procedures above using a second new halogen bulb to determine whether the first replacement bulb is defective
   Note: If the second bulb also doesn’t illuminate check instrument fuses for failures and replace as needed before repeating the lamp replacement procedures again (see pages 66-67 of the “Applied Biosystems7500/7500 Fast Real-Time PCR System Maintenance Guide” PN# 4387777 Revision D); if all attempts to achieve illumination are unsuccessful, call Applied Biosystems Technical Support

2) Once the lamp successfully illuminates, select Instrument ► Lamp Status/Replacement from the top navigation bar; click Reset Lamp Timer in the dialog box, then OK; close the plate document without saving and perform the following calibrations (in order)
   - Regions of Interest (ROI) Calibration
   - Background Calibration
   - Optical Calibration
   - Dye Calibration
   OPTIONAL: RNaseP Verification (omitted unless requested by AB Technical Support)

C.1.3 HID Decontaminate the Sample Block
Identify the contaminated wells of the sample block
1) In the 7500 software, click Instrument ► Instrument Maintenance Manager from the top navigation bar ► ROI (left hand pane) ► Start Manual Calibration.
2) Select “Move block up” button
3) Select Filter A then click Snapshot in the dialog box.
4) Repeat for each filter
   Note: Keep track of the wells exhibiting significantly higher signal compared to majority of wells’ signal
(contamination) and then perform decontamination steps below

**Decontaminate the instrument block**

1) Open the main access door by inserting a swab stick into the pinhole on the edge of the access door and pushing until the mechanism unlatches
2) Lift the silver latch knob on the heated cover then push the heated cover door toward the back of the 7500
3) Clean the contaminated wells by swabbing with molecular grade water or pipetting a small volume of molecular grade water up and down (remove any excess)
4) Pull the heated cover door to the front of the instrument then lift the latch and secure the heated cover door to the cross bar; close the main access door to the instrument

**Verify that contamination was eliminated from affected wells**

In the ROI Inspector dialog box, change the lamp control setting drop-down menu from Off to **Idle**; click **Snapshot**

If new wells exhibit contamination:
1) Repeat decontamination using deionized water
2) Verify that contamination was eliminated

If the contamination remains in the same wells after deionized water decontamination:
1) Repeat decontamination using 95% ethanol
2) Verify that contamination was eliminated

If the contamination remains in the same wells after 95% ethanol decontamination steps:
1) Repeat decontamination using 10% bleach solution (followed by deionized water rinses)
2) Verify that contamination was eliminated
After successful decontamination, ensure that the heated cover door and main access door are both completely closed and latched (otherwise the 7500 will display an error message)

Click Done to close the ROI Inspector dialog box; you can close the plate document without saving OR you can keep the plate document open to perform additional maintenance tasks.

C.1.4 HID ROI Calibration

**Note:** Do not remove the ROI calibration plate from its packaging until you are ready to load the instrument – light exposure affects the plate’s performance; this plate will be used for both ROI and Optical calibrations for up to a maximum of 3 instruments.

1) Obtain the ROI calibration plate from the freezer and warm to room temperature; vortex then centrifuge 2 minutes at less than 1500rpm.

2) In the 7500 software, select Instrument ► Instrument Maintenance Manager from the top navigation bar ► ROI (left hand pane) to launch the ROI screen.
   a. Right click on the black area of the dialog box and choose “Display Properties” to launch the Viewer Control Properties dialog box.
   b. Check Auto Contrast, Zoom, Show Saturation and enter “4000” in the “Sat. Threshold” field; click OK to close the Viewer Control Properties dialog box.

3) In the ROI Inspector screen, click Start Calibration and follow the wizard in the software system for automatic instrument ROI Calibration. Click Start Run when prompted.
   - When the calibration is complete check the calibration status (Passed/Failed). If the calibration is not passing refer to page 17 of the “Applied Biosystems 7500/7500 Fast Real-Time PCR System Maintenance Guide” PN# 4387777 Revision D; if all attempts to achieve illumination are unsuccessful, call Applied Biosystems Technical Support.

**Note:** Manual ROI calibration can be done. Refer to pages 13-15 of the “Applied Biosystems 7500/7500 Fast Real-Time PCR System Maintenance Guide” PN# 4387777 Revision D).

C.1.5 HID Background Calibration

**Note:** Background plates are included in the calibration kit. Alternatively, 50 µL of molecular grade water may be pipetted into each well of a 96-well plate and sealed with optical adhesive.

**Frozen kit plates** – Can be used multiple times prior to expiration of the Spectral kit; warm to room temperature before using. Check to ensure there is not any evaporation in the wells.

1) Centrifuge the background plate 2 minutes at < 1500g; load the plate onto the instrument

2) In the 7500 software, select Instrument ► Instrument Maintenance Manager from the top navigation bar ► Background (left hand pane) to launch the background screen.

3) Click Start Calibration and follow the wizard in the software system for automatic instrument Background Calibration.
   - When the calibration is complete check the calibration status (Passed/Failed). If the calibration is not passing refer to page 30 of the “Applied Biosystems 7500/7500 Fast Real-Time PCR System Maintenance Guide” PN# 4387777 Revision D); if all attempts to achieve illumination are unsuccessful, call Applied Biosystems Technical Support.

**Note:** DO NOT complete the background plate wizard. Once the run is complete and the window appears stating the background plate passed, close out the window using the “x” at the top right corner.
C.1.6 HID Optical Calibration

**Note:** Since the ROI plate is used for both ROI and Optical calibration, the C.1.4 step 1 ROI plate does not have to be re-frozen between each calibration if less than 8 hours has passed since thawing

1) Load the ROI calibration plate into the instrument; see ROI calibration for instructions related to plate preparation
2) In the 7500 software, select Instrument ► Instrument Maintenance Manager from the top navigation bar ► Optical (left hand pane) to launch the optical screen.
3) Click Start Calibration and follow the wizard in the software system for automatic instrument Optical Calibration.
   - When the calibration is complete check the calibration status (Passed/Failed). If the calibration is not passing refer to page 30 of the “Applied Biosystems7500/7500 Fast Real-Time PCR System Maintenance Guide” PN# 4387777 Revision D); if all attempts to achieve illumination are unsuccessful, call Applied Biosystems Technical Support

C.1.7 HID Dye Calibration

**Note:** Do not remove any dye calibration plates from their packages until ready to be loaded on the instrument – light exposure affects each plate’s performance. Quantifiler-associated dye plates can be used for a maximum of 3 freeze/thaw cycles

1) Remove the ABY, JUN, MP, VIC, and FAM dye plates from the calibration kits in the freezer and allow them to warm to room temperature; vortex and centrifuge for 2 minutes at less than 1500 rpm just before use
2) In the 7500 software, select Instrument ► Instrument Maintenance Manager from the top navigation bar ► Dye (left hand pane) to launch the dye screen.
3) Select Custom Dye Calibration and choose ABY, JUN, or MP dye plate and load onto the instrument. Check the box labeled “The custom dye plate is loaded into the instrument” and then click finished
4) Click Start Calibration and follow the wizard in the software system for automatic instrument Dye Calibration.
   - When the calibration is complete check the calibration status (Passed/Failed). If the calibration is not passing refer to page 43 of the “Applied Biosystems 7500/7500 Fast Real-Time PCR System Maintenance Guide” PN# 4387777 Revision D); if all attempts to achieve illumination are unsuccessful, call Applied Biosystems Technical Support.
5) Repeat steps 1 through 4 for the other two dyes.
6) In the 7500 software, select Instrument ► Instrument Maintenance Manager from the top navigation bar ► Dye (left hand pane) to launch the dye screen.
7) Select System Dye Calibration and only select FAM and VIC from the list of options.
8) Click Start Calibration and follow the wizard in the software system for automatic Dye Calibration of FAM and VIC.
   **Note:** FAM and VIC will be performed back to back within the software system calibration (in this order).

### C.1.8HID Reference Dye Spectra

![ABY dye Filter C (3)](image1)

![JUN dye Filter D (4)](image2)

![MP dye Filter E (5)](image3)

![FAM dye Filter A (1)](image4)
C.1.9 HID RNaseP Verification

Note: RNaseP Verification is not associated with regular maintenance procedures; it is only typically performed when directed by AB Technical Support for troubleshooting purposes.

a. Prepare the RNaseP plate by centrifuging 2 minutes < 1500 rpm; load the plate onto the 7500
b. In the 7500 software, select Instrument ▶ Instrument Maintenance Manager from the top navigation bar ▶ RNase P (left hand pane) to launch the dye screen.
c. Complete the calibration as instructed by the wizard.
d. When the calibration is complete check the calibration status (Passed/Failed). If the calibration failed refer to page 51 of the “Applied Biosystems7500/7500 Fast Real-Time PCR System Maintenance Guide” PN# 4387777 Revision D); if all attempts to achieve illumination are unsuccessful, call Applied Biosystems Technical Support.
e. For a passing calibration, analyze the plate
f. Select the Standard Curve tab. Click the upper-left corner of the Plate Layout to select all wells. Verify the R2 value is greater than or equal to 0.990.
   Note: If the R2 value is less than 0.990, repeat the RNase P experiment using a different RNase P plate. If the problem persists, contact Applied Biosystems Technical Services.
g. Click Next, remove the calibration plate, and discard.
h. Click Finish, then Yes when prompted to save the experiment.

C.1.10 HID Laptop Maintenance - Disk Cleanup/Defragmentation/Data Archival

HID Disk Cleanup
1) From the Windows start menu, select All Programs ▶ Accessories ▶ System Tools ▶ Disk Cleanup
2) Select the first drive/partition from the drop-down list and click OK (click OK for any additional prompts); ensure that all item checkboxes are selected, then click OK
3) Repeat for each additional drive/partition until all have been cleaned up

HID Defragment drives
1) On the laptop’s desktop view, right click on All Programs ▶ Accessories ▶ System Tools ▶ Disk Defragmenter
2) Select the first drive/partition in the upper right volume pane then click Defragment (repeat for each additional drive/partition displayed in the volume pane until all have been defragmented)
HID Archive data
1) Create a new folder within the archive folder named according to the date in YYMMDD format
2) Move all files (since last archival) from the import folder and each analyst's folder to the newly created folder in the archive folder
3) Reboot the computer.

C.2 Thermalcycler Maintenance
Hardware diagnostics tests and system performance tests are conducted quarterly for all validated thermalcyclers. Temperature tests using the Driftcon® Temperature Verification System are also conducted quarterly. The Driftcon® Temperature Verification System must be calibrated annually (when in use) through an external vendor. Thermalcycler maintenance is documented using “9700 TC Quarterly Maintenance” forms.

C.2.1 Hardware Diagnostics
Display Test
1) Using the thermalcycler’s on-screen menus and corresponding function buttons (top row buttons labeled F1 through F5) select Util ► Diag ► Hard ► Disp from the main menu
2) Follow the thermalcycler’s displayed instructions to complete the display test and record the result on the maintenance form (PASS indicates no dead pixels)
3) Select Exit ► Exit ► Exit to go back to the thermalcycler’s main menu

Keypad Test
1) Using the thermalcycler’s on-screen menus and corresponding function buttons (top row buttons labeled F1 through F5) select Util ► Diag ► Hard ► Keypad from the main menu
2) Follow the thermalcycler’s displayed instructions to complete the keypad test; record the result on the maintenance form (PASS indicates all keys detected)
3) Select Exit ► Exit ► Exit to go back to the thermalcycler’s main menu

C.2.2 System Performance Tests
Cycle Test
1) Place an empty 96-well plate onto the sample block and close/latch the cover if possible
2) Using the thermalcycler’s on-screen menus and corresponding function buttons (top row buttons labeled F1 through F5) select Util ► Diag ► System ► Cycle ► Cont
3) The thermalcycler will automatically display the results; record them on the maintenance form and evaluate the status (PASS indicates results within the form’s noted “Acceptable Range”)
4) Select Cancel ► Exit ► Exit ► Exit to go back to the thermalcycler’s main menu

C.2.3 Driftcon® Temperature Verification System
IMPORTANT: the multi-probe must rest in its rack while not in use to prevent damage; only when necessary, gently clean individual probes using a kimwipe dampened with distilled water

Driftcon® Set-Up
1) Obtain current temperature (convert from Fahrenheit to Celsius) and % humidity from the thermostat in the room containing the thermalcyclers (may use same values for all thermalcyclers in a single day)
2) Use the off-white cable to connect the multi-probe to the black box, and use the black serial cable to connect the black box to the laptop
3) Prepare thermalcycler for Driftcon® run
   a. Turn on thermalcycler and push back lid
   b. Level the multi-probe on the thermalcycler block (connector on right side) ensuring each individual spring-loaded probe isn’t “sticking” and that all probes are resting evenly
   c. Press F5 and change user to drift and press F1 to accept
   d. Wait to start run until software is launched
4) Launch the Driftcon® software
   a. Click the Driftcon® icon for the Mr. A. Admin account to display the password field; enter the password driftcon
   b. Press Synchronize on main menu; make sure both boxes for Application Data and User Data are checked, and then press Sync
   c. Click the bottom login button to launch the main Driftcon® software

Performing Driftcon® Temperature Verification Tests
1) Click the Start button on the Driftcon® main menu
2) Choose qPCR then click next
3) “Hardware box” information (informs user of measurements or credits left); click next
4) Select TC# using dropdown then click next
5) Choose Driftcon (default) then click next
6) “Layout” information will appear; click next
7) Enter the “instrument settings” as Standard/Max Mode from the dropdown menu; enter humidity and °C room temperature; set “heated lid” to off or on depending on type of probe; then click next
8) Enter any notes/comments (optional) then click next
9) Click finish to begin
10) Start the Driftcon program on the thermalcycler (the Driftcon® software automatically starts capturing/displaying data once the program begins)
   a. The Driftcon® software automatically generates a report when testing is complete; however, the thermalcycler program will continue and begin another cycle that isn’t needed—you can stop the thermalcycler program early as soon as the software opens the results window

OPTIONAL: the user may choose to monitor the measurements in real-time during data collection but it is not required—tips and hints for viewing:

Driftcon Information
1) Step Info: Indicates the current protocol stage of data collection
2) Fixed Info: General test/probe information
3) Surface View: Pictorial representation of block temperatures
4) Actual View: Quantitative representation of block temperatures
5) Measurement Locations: each probe’s well assignment

Probe Information
Displays exact temperature readings for every probe at every measurement
6) Click the Print icon button on the bottom-right of the results window; choose Cute PDF Writer, then Apply and Print to launch a SaveAs window allowing you to enter a filename (use TC# in name) and choose its file path to save in appropriate location
Reviewing Driftcon® Results Reports

Pages 1 through 3 identify/summarize:
- Testing date/time, thermalcycler, and manufacturer/model
- Driftcon® Verification System, software version, and calibration information
- Protocol, probe locations, environmental conditions, and analysis specifications

Pages 4 through 9 summarize:
- Measurements/results for 6 different temperature targets (one per page)
  - Note: Passing results are indicated by green checkmark -- exclamation point and/or question mark icons are also ok; failing results are indicated by red “x” icons
- Values after 30 seconds: Verify that the status for all probes on every page is “Active”
- Step results: Verify that pages 4 through 9 display passing results for “Hold time” and “Max. overshoot”, “Avg. overshoot”, “Max. undershoot”, and “Avg. undershoot” items; also verify that page 4 displays a passing result for “Heat rate” and page 5 displays a passing result for “Cool rate” items
  - Note: The Driftcon® software may report a red “x” for the “overshoot” parameters at 95°C, 90°C, and 70°C when the measured temperature is greater than the upper limit of the specification range. Similarly, a red “x” may be reported for the “undershoot” parameters at 30°C, 50°C, and 60°C when the measured temperature is less than the lower limit of the specification range. These results are acceptable as the measured value is better than the specification.
- Accuracy results: Verify that pages 4 through 9 only display passing results
- Uniformity results: Verify that pages 4 through 9 only display passing results

Driftcon® Temperature Verification System References
CYCLERtest BV and GENO-Tronics BV. The Netherlands. Manual may be found at the following website: https://www.cyclertest.com/documentation/driftcon/manual.aspx

C.3 3130XL Instrument Maintenance

C.3.1 Daily Water and 1X Running Buffer Exchange

The instrument’s water reservoirs and 1X running buffer reservoir/buffer jar should be rinsed and replenished with fresh water/1X running buffer each day the instrument is used; reservoirs and reservoir septa must be replaced, at minimum, one per month.

1X running buffer (stored in the refrigerator) is prepared by diluting 10X running buffer with molecular grade water and recorded on the “1X 3130 Buffer” log sheet:
- Full liter: pour four full bottles of 10X running buffer into a preparation bottle and add 900 mL of molecular grade water. Mix thoroughly.
- Half liter: pour two full bottles of 10X running buffer into a preparation bottle and add 450 mL of molecular grade water. Mix thoroughly.

Each preparation of 1X running buffer must be labeled with its assigned running buffer lot number, date of preparation, date of expiration (1 month after preparation), and initials of preparer.

Consult the maintenance checklist in the instrument’s binder to verify whether 1X running buffer/water was changed on the current day of operation.

1) No further action is needed if 1X running buffer/water has already been changed; perform maintenance steps 2 through 7 to change 1X running buffer/water if not already completed.
2) Press the round tray button on the front left of the instrument and wait for the autosampler to finish moving forward.

3) Open the instrument doors and remove all reservoirs from the autosampler and the anode buffer jar from the lower polymer block.

4) Empty and rinse the reservoirs/buffer jar with distilled water; dry thoroughly with a kimwipe.

5) Fill two reservoirs with molecular grade water to the marked fill-line; fill the third reservoir and the buffer jar with 1X running buffer to the marked fill-lines.

6) Re-install the buffer jar/reservoirs to their respective positions.

7) Update the maintenance checklist in the instrument’s binder (remember to record water/buffer lot numbers if different than previously recorded)

C.3.2 Check/Replenish Polymer Supply

The polymer must be changed weekly as part of weekly maintenance. In addition, the instrument’s polymer supply should be checked prior to starting each run to ensure sufficient polymer is available to complete the runs(s) without drawing air into the polymer delivery pump.

1) Observe the supply of polymer contained in the pump chamber and supply bottle; when full, the pump chamber contains sufficient polymer to inject two full plates or 12 total injections (approximately 1 mL of polymer).

If the pump is less than half full:

1) Check the polymer supply bottle – ensure that there is sufficient polymer in the bottle to fill the pump without aspirating air bubbles (indicated by a red line in the diagram)

2) If the polymer supply bottle does not contain sufficient polymer to fill the pump, replenish the polymer

3) Remove a bottle of POP4 polymer from the refrigerator and swirl gently to pool all droplets and dissolve any deposits; loosen the cap and allow the polymer to reach room temperature

   **Important:** Loosening the cap/warming the polymer ensures that gasses will be released from the polymer before it is added to the instrument; otherwise, bubbles may form in the pump chamber over time (may cause the instrument to malfunction)

4) In the left navigation pane of the data collection software, click the instrument’s name; select **Wizards ► Replenish Polymer Wizard** from the top file menu of the program window

5) Follow the instructions prompted by the wizard’s dialog boxes

6) If the anode buffer jar overflows during bubble removal attempts, replenish the 1X running buffer in buffer jar and autosampler reservoir (see C.3.1)
7) Record the polymer addition on the maintenance checklist in the instrument’s binder (remember to record the lot number if different than previously recorded)

C.3.3 Check/Remove Bubbles

Note: The instrument should be checked for bubbles prior to starting each run to ensure successful operation and prevent arcing/damage to the instrument

1) Inspect all channels/tubing of the pump delivery system for bubbles. Bubbles should be removed under the following circumstances:
   - Bubbles in tubing or lower polymer block channel (shown in red)
   - Bubbles larger than 0.2 mm in the array port (shown in orange)
   - Bubbles smaller than 0.2 mm in the array port (shown in orange) if they could enter the capillaries or tubing/lower polymer block
   - Bubbles larger than 0.2 mm in the pump chamber (shown in yellow)

Exception: Bubbles in the pump chamber or array port that do not migrate during bubble removal attempts are also not likely to move during normal instrument operation; analysts may ignore these persistent bubbles (refer to the maintenance checklist in the instrument’s binder to verify the persistence of any bubbles)

Note: The bubble remove wizard may consume polymer supply depending how much polymer is in the pump/supply bottle—in these instances the analyst may instead choose to perform the replenish polymer wizard (see C.3.2) instead of performing the bubble removal steps below

2) If bubbles need to be removed, click the instrument’s name in the left navigation pane of the data collection software; select Wizards ▶ Bubble Remove Wizard from the top file menu of the program window
3) Follow the instructions prompted by the dialog boxes
4) If the anode buffer jar overflows, replenish the 1X running buffer in buffer jar and autosampler reservoir (see C.3.1)
5) Update the maintenance checklist in the instrument’s binder; also record any bubble removal attempts and their results (bubbles removed or bubbles persisted)

C.3.4 Water Wash Wizard and Trap Flush

Note: The water wash wizard and trap flush procedures should be performed weekly to ensure successful instrument operation; the wizard includes steps to wash the delivery pump, install new polymer, remove bubbles, flush the array port, replenish water/1X running buffer, and wipe the instrument clean. Monthly, the array should be removed from the upper polymer block (UPB) and the array knob/ferrell/UPB cleaned with warm water to remove dried polymer and then dried and re-assembled. This must be completed prior to beginning the water wash wizard.
1) Remove a bottle of POP4 polymer from the refrigerator and swirl gently to pool all droplets and dissolve any deposits; loosen the cap and allow the polymer to reach room temperature (loosening the cap/warming the polymer helps release gas before it is added to the instrument; otherwise, bubbles may form and cause the instrument to malfunction)

2) Fill a clean glass beaker with molecular grade water and use a hot-plate or microwave to warm the water; fill the instrument's designated maintenance bottle with a portion of the warm water

3) Click the instrument’s name in the left navigation pane of the data collection software; select Wizards ▶️ Water Wash Wizard from the top file menu of the program window

4) Follow the instructions prompted by the wizard’s dialog boxes—you will need:
   a. The designated instrument maintenance bottle/warm water and polymer
   b. 1X running buffer and molecular grade water to replenish the autosampler reservoirs and anode buffer jar. The reservoirs and the septa should be replaced monthly
   c. Moistened kimwipe/lint-free swab to clean instrument/capillary tips

5) To flush the trap, fill the designated 20 mL Luer lock syringe with molecular grade water and expel any bubbles (warmed water from water wash wizard step C.3.4.2 can also be used if available)

6) Hold the front port fitting of the polymer delivery pump stable while screwing the filled syringe onto the fitting; once attached, open the port by twisting the fitting one-half turn counterclockwise

7) Open the side port fitting by twisting the fitting one-half turn counterclockwise; you will need something to catch liquid waste as it exits the trap. Carefully use the syringe to slowly flush bubbles/water/diluted polymer from the trap; it should take approximately 30 seconds to flush 5 mL of water through the trap

   IMPORTANT: Exceeding these flow rate/pressure limits may damage the pump’s seal

8) Discard waste; close the front port fitting first, then the side port fitting (do not over-tighten) and then hold the front port fitting stable while removing the syringe; update the maintenance checklist in the instrument’s binder

9) Discard waste; close the front port fitting first, then the side port fitting (do not over-tighten) and then hold the front port fitting stable while removing the syringe; update the maintenance checklist in the instrument’s binder

C.3.5 Spatial Calibration

Note: Spatial Calibrations should be performed weekly, after changing a capillary array, and/or re-positioning the array’s detection window
1) Click “Spatial Run Scheduler” in the left navigation pane of the data collection software.

2) Select the instrument protocol from the drop-down list on the right side of the run scheduler view, then click “OK” and wait for run to finish.

   **Note:** “3130SpatialFill_1” must be selected for the first spatial calibration attempt if the array has not been filled with fresh polymer.

3) Evaluate the spatial calibration; if the spatial calibration passes, skip to step 4.

**Passing spatial calibration criteria:**
- Sixteen single, sharply-defined peaks
- Orange cross placed at the top of each peak
- Similar peak heights (no extreme outliers)
- Spacing values *between* all capillaries is 13-16 pixels

**OPTIONAL:** If the spatial calibration repeatedly fails – click “Reject” and then...

   - Open the instrument’s doors; open the oven door and the detection cell block, then release the array’s detection window (may need to loosen the array port knob to alleviate tension).
   - Use a lint-free swab to gently scrub the window with methanol or carefully pipette ~30 μL of methanol into the groove on the back of the window and wait for the methanol to evaporate completely.
   - Re-position the detection window, close the detection cell block/oven door and tighten the array knob.

4) Click “Accept” and update the maintenance checklist in the instrument’s binder.

**C.3.6 Re-booting the instrument/software/computer**

   **Note:** The software/instrument/computer should be rebooted weekly, while in use, as part of preventive maintenance procedures to promote optimal performance. The instrument/software/computer may also be rebooted as needed to clear errors (instrument displays a “blue error screen,” or the instrument flashes the red status light, or the bottom of the software data collection window displays a blinking red icon).
Note: Information in the error log may indicate that additional troubleshooting should be performed in addition to rebooting the instrument/software/computer; refer to the “Applied Biosystems 3130/3130XL Maintenance, Troubleshooting, and Reference Guide” as necessary. Select “Event log” under “Instrument Status” from the left navigation menu; scroll through the event log info and record any pertinent error information before clearing errors or restarting the software/instrument.

1) Close the data collection software window then click the “stop all” button in the service console window; wait for all applications to de-activate (icons will turn red)

2) Turn off the instument by pressing the round on/off button on the front bottom left of the instrument; when the instrument has shut off completely, close the service console window.

3) Re-boot the computer; enter the respective log-in information when prompted (found in the respective instrument’s binder).

4) After the computer completely finishes booting, turn on the instrument by pressing the round on/off button on the front bottom left of the instrument; wait for the green status light to illuminate.

Note: If the yellow status light remains flashing or the red status light illuminates, refer to pages 38-40 of the “Applied Biosystems 3130/3130XL Maintenance, Troubleshooting and Reference Guide” to perform troubleshooting procedures before continuing.

5) After the instrument’s green status light illuminates, launch the desktop’s “3130XL Data collection v4.0” shortcut; after all service console icons turn green, the data collection software window will automatically appear; expand all subfolders in the left navigation pane, minimize the Service Console and update the maintenance task list in the instrument’s binder.

C.3.7 Capillary Array Installation

Note: The capillary array should be changed if a particular capillary repeatedly displays poor resolution or fails to inject sample over the course of several consecutive runs.

1) Click “Instrument Status” in the left navigation pane; record the number of runs for the currently installed array (if less than 100 runs have been completed, the array is eligible for free replacement).

2) Press the round tray button on the front left of the instrument and wait for the autosampler to finish moving forward.

3) Click the instrument’s name in the left navigation pane of the data collection software; select Wizards ► Install Array Wizard from the top file menu of the program window.

4) Follow the instructions prompted by the wizard’s dialog boxes to remove the current array and install the new array.

5) Perform spatial calibration (section C.3.5)

Optional recommendation: perform spectral calibration (section C.3.8)

6) Update the maintenance checklist in the instrument’s binder.

C.3.8 Spectral calibration
**Note:** Spectral Calibrations are performed after all laser/optical adjustments and/or whenever color separation quality decreases (elevated baseline or increased pull-up between channels). A spectral calibration is performed monthly for all instruments utilized for Investigator 24plex QS.

**Spectral Dye/Plate Preparation**

**Note:** Matrix standard BT6 is used to prepare Investigator 24plex spectral calibrations. Store the kit in the freezer until manufacturer’s listed expiration date. Fusion 6C Matrix Standard is used to prepare Fusion 6C spectral calibrations. After first use, store the kit in the refrigerator. Refer to the expiration date on the matrix kit box.

**Investigator 24plex Dyes**

1. Thaw formamide and Matrix Standard BT6 at room temperature
2. Vortex the dye tube (Matrix Standard BT6) then dilute in formamide using the following:

<table>
<thead>
<tr>
<th>Component</th>
<th>Volume</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hi-Di Formamide</td>
<td>198 µL</td>
</tr>
<tr>
<td>Matrix Standard BT6</td>
<td>15.8 µL</td>
</tr>
</tbody>
</table>

3. Vortex the diluted dye/formamide cocktail and dispense 12 µL per well into entire injection (two columns) of a 96-well plate

**Fusion 6C dyes**

1. Thaw 6C Matrix Mix, Matrix Dilution Buffer and formamide completely
2. Vortex the 6C Matrix Mix for 10-15 seconds prior to use. Add 10µL of 6C Matrix Mix to one tube of Matrix Dilution buffer
3. Vortex for 10-15 seconds
4. Add 10µL of diluted 6C Matrix Mix to 500µL of formamide. Vortex 10-15 seconds
5. Add 15µL of the Matrix Mix/Formamide solution into the first two columns of a 96-well plate

**DO NOT denature/snap cool the plate**

**Investigator 24plex/Fusion 6C**

1. Cover the plate with a septa and centrifuge to remove bubbles/pool liquid into the bottom of the wells
2. Denature 3 minutes (approximately 95°C) and then chill at least 3 minutes (except Fusion 6C)
3. Assemble the “3130 plate sandwich”
4. Place the plate in the black base, matching the notched corner orientation
5. Place the white retainer on top of assembly
6. Line up the retainer holes with the septa holes while pushing downward until the retainer locks into place

**Instrument/Spectral Plate Record Preparation**
1) Change water/1X running buffer (section C.3.1), check/replenish polymer supply (section C.3.2), and check/remove bubbles (section C.3.3) as needed
2) Pre-heat the oven to 60°C
3) Click “Manual Control” in the left navigation pane then select “Oven” from the upper drop-down list
4) Select “Set oven temperature” in the lower drop-down list then enter the value “60” and click the “Send Command” button
5) Select “Turn On/Off oven” in the lower drop-down list, select the value “On” and click the “Send Command” button
6) To create a new plate record, click “Plate Manager” in the left navigation pane then click the “New” button to launch the New Plate Dialog window; enter/select the following and then click the OK button:
   Name:
   - INV24PLEX-SPECTRAL <date>
   - FUSION6C-SPECTRAL <date>
   (or similar name; must include “spectral” and date)
   Application: Spectral Calibration
   Plate Type: 96-well
   Owner Name: LVMPD
   Operation Name: <initials>
7) The Spectral Calibration Plate Editor window will automatically open; enter the following information for wells A01 through H02 and then click the OK button:
   Sample Name: <can be anything>
   Priority: “100”
   Instrument Protocol: “SpectralG5_ID” or “SPECTRAL-INV24” or “Promega J6
8) Search for the pending spectral plate record
9) Select “Plate View” under “run Scheduler” from the left-side navigation
10) Select “Advanced” from the drop-down menu and then select “=” for the Status/Condition and “pending” for the Status/Value 1
11) Click the “Search” button to display the current list of pending plate records
Spectral Plate Injection
1) Load the “plate sandwich” onto the autosmapler deck (position A or position B)
2) Press the instrument’s “Tray” button and wait for the autosampler to finish moving forward
3) Orient the “Plate sandwich” noth away from you to match the deck (shown in orange in the diagram) and then carefully lower into place
4) Link the loaded spectral plate into the pending plate record
5) In the data collection software click the plate graphic then click the matching plate record
   Note: the plate graphic will turn from yellow to green to indicate successful linkage; be sure to link the correct deck position if more than one plate is loaded onto the deck.
6) Record run numbers and then click the green “play” button at the top of the window; proceed to step C.3.8 to evaluate the calibration results

Review Spectral Calibration Results
1) Select “Spectral Viewer” from the left navigation pane; the default display is usually the most recently run spectral calibration info, but the user can also control the display (if needed) using the indicated dye set and calibration drop-down lists
2) The plate graphic will display a green well for passing capillaries and brown well for failing capillaries; clicking each individual well displays its respective capillary results
3) Evaluate the spectral calibration using the flow chart to determine pass/fail status; perform any additional steps as listed in the flow chart to complete spectral calibration procedures
Are there 14 or more passing capillaries ("green wells") in the plate graphic?

Yes

No

Are there two or less total capillary failures?

Yes

No

NOTE: an individual capillary failing multiple criteria should be counted as a single capillary failure

Spectral calibration failed; delete plate record to remove the run from the list of available spectral calibrations...

- Select "Plate Manager" from the left hand navigation pane
- Search for the failed run's associated plate record
- Click "Delete" then "OK"


Do all remaining capillaries exhibit unsaturated dye peaks in the spectral profile? (touch the upper 1.0 threshold at single point)

Red dye is saturated in this example

Yes

No

Spectral calibration passed; update maintenance checklist in the instrument binder and "maintenance notes" card on the instrument's doors

(Images of graphs and data analysis results are included, indicating data analysis steps and visualizations relevant to the decision-making process.)
C.3.10 Quarterly Computer/Instrument Maintenance

Archive the Instrument’s Data

1) Navigate to the folder C:\BACK-UP ARCHIVE\data on the instrument
   - Create a new folder named by current date in the format YYMMDD (Example: 110721)
2) Open a second window and navigate to the instrument’s data directory
   E:\AppliedBiosystems\UDC\DataCollection\data
   - Move all current data folders in this directory into the newly created archival folder within
     the “BACK-UP ARCHIVED” folder on the C:\drive except “ga3130XL” folder

Archive the instrument’s Run Logs

1) Navigate to the folder C:\BACK-UP ARCHIVE\data\ga3130xl\RIO on the instrument
   Note: “RIO” folders/filenames in these directories will actually be named differently on each
   instrument according to the respective instrument name
   - In the “ARCHIVED” folder in this directory, create a new folder named by current date in
     the format YYMMDD (Example: 110721)
2) Open a second window and navigate to the instrument’s data directory
   E:\AppliedBiosystems\UDC\DataCollection\data\ga3130xl\RIO
3) Move all of the folders containing the instrument name into the newly created archival folder
   on the C:\drive
4) Upon completion of the four previous archival steps, update the maintenance checklist in the
   instrument’s binder

Archive the Instrument’s Data Collection Logs (Part 1)

1) Navigate to the folder C:\BACK-UP ARCHIVE\Log on the instrument
   - Create a new folder named by current date in the format YYMMDD (Example: 110721)
2) Open a second window and navigate to the instrument’s data directory
   E:\AppliedBiosystems\UDC\DataCollection\Log
   - Move all “RunViewer3100...txt” files in this directory into the newly created archival folder
     within the “BACK-UP ARCHIVED” Log folder on the C:\drive except the most recent
     RunViewer .txt file
   - Copy “fiorano.log” and “foundationviewer.log” and “jboss.log” and “RIO.log” and the most
     recent RunViewer log into the newly created archival folder on the C:\drive
   Note: The “.log” file will be named differently according to the respective instrument
   name for each 3130XL

Archive the Instrument’s Data Collection Logs (Part 2)

1) Within the data collection log directory folder named for the archival date (C:\BACK-UP
   ARCHIVE\Log\110721), create a folder for the instrument name (e.g. RIO)
2) Open a second window and navigate to the instrument’s data directory
   E:\AppliedBiosystems\UDC\DataCollection\Log\RIO
   - Move all of the .txt files from this location into the archival folder on the C:\drive except the
     most recent .txt file
   - Copy the most recent .txt file into the newly created archival folder
   Note: The folders/filenames in these directories will be named differently on each
   instrument according to the respective instrument name
Clean-up Data Collection Database

**Note:** Cleaning up the database removes all temporary raw data files that are extracted into .fsa files for downstream GeneMapper data analysis; any runs that failed to extract (produce .fsa files) must be “re-extracted” prior to cleaning up the database

1. Select “Database Manager” from the left navigation pane
2. Click “Cleanup Processed Plate” button
3. Update the maintenance checklist in the instrument’s binder
4. Once cleanup is complete, run numbers will re-start at 1

Clean-up/Defragment Drives

1. From the Windows start menu, select Disk Cleanup
2. Select the first drive/partition from the drop-down list and click OK (click OK for any additional prompts); repeat for each additional drive/partition then click Exit when finished
3. From the Windows start menu, select “Auslogics Disk Defrag”.
4. Select the first drive/partition in the upper right volume pane then click Defragment; repeat for each additional drive/partition displayed in the volume pane
5. Update the maintenance checklist in the instrument’s binder
6. Reboot the computer and the 3130XL.

C.4 Maintenance of Mini-CrimeScope MCS-400

**Replacing the 400W etal halide bulb**

1. The 400W bulb should be replaced after 3-3.5 years of use.
2. Make sure unit is completely cooled before replacing the bulb. Disconnect the power cord.
3. Open the side door.
4. Unplug the power cable for the lamp. Unscrew the top right hand thumbscrew by hand or by using small flat blade screwdriver.
5. Pull the lamp assembly up and out of the lamp compartment and lay flat on a table.
6. Use the screwdriver if needed and remove the last two thumbscrews. Pull the mounting ring up and away from the lamp and power cable.
7. Remove the old lamp from the frame and replace with the new unit.
8. Seat and rotate the new lamp with the return lead in the upper right hand corner.
9. Replace the lamp mounting ring and align the lamp return lead with the notch in the ring. Tighten the thumbscrews by hand and then tighten until snug with the screwdriver.
10. Slide the unit back into the holder in the lamp compartment and tighten the last thumbscrew.
11. Reconnect the lamp power cable, close the door, and lock with the screwdriver.

**Cleaning the filters and optics**

Both ends of the light guide should be cleaned on a regular basis or when needed (spots in the beam image) with lens paper (or tissue) with ethanol

C.5 Maintenance of Crime-Lite 80S

Remove dust and deposits from external surfaces using a soft dry cloth or paper tissue. When necessary, use a soft cloth or paper tissue dampened with a mild cleaning solution. Allow all
surfaces to dry thoroughly before resuming use. Water-based solutions should contain only a little liquid soap, detergent or mild bleach. Alcohol-based cleaning agents may eventually degrade the surface of some types of plastic and should be used sparingly on such materials.

The unit contains no user serviceable parts. Do not drop, handle with care and allow for ventilation of the unit. There is an internal mechanism that will power the unit off in case of overheating.
LVMPD FORENSIC LABORATORY
DNA PROCEDURE MANUAL
BIOLOGY/DNA

Appendix D: Title: USE OF FRED (LIMS)

The Laboratory Information Management System FRED (Forensic Request for Examination Database) will be used by the Biology/DNA Detail for creation of worksheets and for generating the final report of analysis.

D.1 Casework Worksheets
D.1.1 Screening

- Be consistent with the custom description in the worksheets and report. Throughout the rest of the case file descriptions can be truncated.
- Only use items (Item 1) and sub-items (Item 1.2) within the evidence exams section of the worksheet.
  - Custom designators (e.g. KG1A) may only be used for case/items previously worked outside of FRED.
- Use "swab from" in the custom description when referring to a swab received in-house that has been collected elsewhere by a CSA, detective or other lab personnel and "swabbing from" in the custom description when a DNA analyst performs the swabbing of an item for touch/non-visible DNA.
  - Do not use dashes in item custom descriptions as it will interrupt the grammatical flow in the body of the report.
  - Use "from" or "of" in either of these phrases as long as it is consistently used within the same case.
  - It is permissible to refer to an item as "stain from" or "swabbing from stain" when visible staining is present regardless of whether collected via cutting or swabbing.
- It is analyst discretion whether or not to imbed the link to their photos directly into the worksheet. As long as the raw images are in the Object Repository, they do not need to be imbedded.
  - Do not attach PowerPoint presentations containing item photos in the Object Repository.
  - If the print outs of the PowerPoint are in the printed case file and the raw images are in the Object Repository, no additional effort is required.
- If any change (edit custom description or change in the dash of an Event #) is made within the Evidence Exams section, hit Refresh and manually toggle on/off the drop down for each sample a change was made for.
- It is analyst discretion whether or not they want to use the Item notes field in the outer packaging section (below where the WinACE item description is automatically populated).
- DNA detail is NOT to be used for the parent item if sub-items are being created.
  - Use "Add Item Note/Photos" and click "No further examination at this time", utilize the screening/sampling detail and click "No further testing at this time", or use the "Not examined at this time" check box next to the parent drop down and document the “reason” in the box that appears.
  - The Note/Photos field allows for documentation of any ALS/visual examinations that do not coincide with additional screening tests and/or screening dates.
• All WinAce descriptions will be edited with a custom description for consistency. There should be no descriptions changed and some left all uppercase.
• Re-isolate a sample: report out the sample being used for reporting purposes and make a separate note in the open notes field with accompanying dates for all of the initial testing. Note everything that would have been reported for the first isolation (with date) and note a reason for the re-isolate (e.g. “RI due to unexpected results”).
• “No further analysis” needs to be recorded in Batching comments and manually added to the table, after P30, RSID-saliva and microscopic sperm search exams, if the sample is being dropped.

When to Make Sub-Items:
Note: For all examples shown below dashes are used, however indentation, bullets, two dashes, etc. can be used for formatting the description; this is analyst discretion.

If a section of an evidence item or a specific stain(s) on an item are screened [whether or not the screening results are positive or negative] a sub-item is required (e.g. only the crotch on a pair of shorts is overlayed; PT test a RBS on a t-shirt, etc.). That testing is isolated to one specific area of the entire item and must be documented as a subset of that item.

The following evidence item(s) were received and examined:

If an entire item is screened with negative results, a sub-item is not required (e.g. AP overlay on an entire pair of underwear/shorts, but the results were negative). This can be recorded under the parent because the entire parent item is what is being examined. In this instance only, do not click “no further testing” on the worksheet because there is further testing and the presumptive test will trigger the item to appear on the report table. If a swabbing for touch/wearer is done after screening, the swabbing will require a sub-item.

The following evidence item(s) were received and examined:

If an item is screened (e.g. water bottle, sock/shirt) for saliva/wearer/touch only and there are no additional stains that could be tested in the future, sub-items are not required, but the swabbing of the item must be added to the report to include the locations of the item specifically swabbed (e.g. swabbing taken from mouth area of water bottle, swabbing taken from inside neck/collar-area of shirt, swabbing taken from grips, trigger, slide serrations of gun, etc.).
If a t-shirt is swabbed for wearer only, but there is a bloodstain that was not requested, a sub-item is required in the event the blood stain is requested at a later date.

All negative stains, using the same presumptive tests, can be clumped together into one negative sub-item. This also applies to multiple screening tests. All stain(s) taken on for DNA will then be a separate sub-item(s).

Multiple positive stains, using the same presumptive test, can be clumped together into one sub-item. However, the analyst must describe where each of the additional stains is located on the item. In the event one (or more) of those stains is requested at a later date, it will become a sub-item of the original sub-item. This information must be listed on the worksheet as well as the report.

<table>
<thead>
<tr>
<th>Lab Item #</th>
<th>Impound Pkg #</th>
<th>Impound Item #</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item 5</td>
<td>013572-1</td>
<td>1</td>
<td>Hoccio</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Swabbing of inside collar, cuffs, armpits, and drawstring</td>
</tr>
</tbody>
</table>

Multiple positive stains, using the same presumptive test, can be clumped together into one sub-item. However, the analyst must describe where each of the additional stains is located on the item. In the event one (or more) of those stains is requested at a later date, it will become a sub-item of the original sub-item. This information must be listed on the worksheet as well as the report.

<table>
<thead>
<tr>
<th>Lab Item #</th>
<th>Impound Pkg #</th>
<th>Impound Item #</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item 5</td>
<td>9288-1</td>
<td>1</td>
<td>Bed comforter</td>
</tr>
<tr>
<td>Item 5.1</td>
<td>13573-1</td>
<td>8</td>
<td>Grey ‘Hanes’ T-shirt</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Additional stains from the shoulder (S2), from the front bottom hem (S3), from the left chest (S4), from the right chest (S5)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Positive presumptive blood test(s)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• No further examination at this time</td>
</tr>
<tr>
<td>Item 5.1.1</td>
<td></td>
<td></td>
<td>• Stain from left chest (S4)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Positive presumptive blood test(s)</td>
</tr>
<tr>
<td>Item 5.2</td>
<td></td>
<td></td>
<td>• Stain from collar (S1)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Positive presumptive blood test(s)</td>
</tr>
</tbody>
</table>
It is analyst discretion if they wish to create a sub-item for everything, if not required as stated above.

**Making Sub-Items:**

**Note:** When making the sub-items in the evidence exams, an asterisk (*) may be placed in the five required fields (Event #, impound officer, impound package, impound item, and WinAce number) instead of the actual impound information.

**Option 1:**
1) From within the worksheet tab in the Unit Record, click on the particular worksheet containing the item that needs to be sub-itemized.
2) Click on the clipboard icon near the top of the window for "Assign Exams to Worksheet." Another window will appear that contains the entire list of evidence items that have been entered for this event. This is also the same window that is used to assign/unassign evidence to the worksheet. Be careful NOT to check/uncheck the boxes at this time. Check marks only appear next to the items that have been assigned for DNA analysis.
3) Click on the item which needs a sub-item and click on the little box icon near the top with the green + sign to add a sub-item. A "New Evidence" window will appear.
4) Enter the appropriate information to make the sub-item and then click "Add".
5) Once finished with all of the sub-items, close the "New Evidence" window.
6) Mark the box next to the sub-item(s) added and close the "Assign Exams" window.
7) The sub-items will appear under "All Exams" in the worksheet tab. Right click on the sub-item(s) that were added (under the "All Exams") and transfer them to the same worksheet the parent item(s) is on by clicking "Add items to worksheet". The sub-items will now appear with the parent item under the worksheet (# X).
8) Open the worksheet the sub-item(s) were added to. All sub-item(s) added are now available in the drop down lists to add for examination.

**Option 2:**
1) From within any worksheet click "Evidence Exams".
2) Click on the item which needs a sub-item and click on the little box icon near the top with the green + sign to add a sub-item. A "New Evidence" window will appear.
3) Enter the appropriate information to make the sub-item.
4) Once finished with all of the sub-items, close the "New Evidence" window.
5) Mark the box next to the sub-item(s) added and close the "Assign Exams" window.
6) Save and Close the worksheet and re-open before selecting the sub-item(s) from any drop down within the worksheet. Once re-opened, in the worksheet toggle off/on in order for the evidence information to appear on the report.

**D.1.2 Reagents**

The worksheet must contain all lot numbers associated with screening methods that are not otherwise captured in the CONFIRMadactyl workbook (e.g. Phenolphthalein, AP Overlay, molecular grade water, etc.)

- If two different lot numbers of the same reagent are used on the same day, click "Add Screening/Test Reagent" and enter the additional lot numbers.
- If screening reagents were not added at the time of screening and they have expired, hand enter them in the comments field to the right of the reagent.
• If the reagent is visible and correct on the printed version of the worksheet, DO NOT add the lot number to the comments field. The reviewer can open the resource repository to verify the correct lot, if necessary.

D.1.3 Results

Note: Sections of the LIMS worksheet used to document the reported profile results may be used to automatically populate the report. Alternatively, Forensic Scientists may manually populate report statements using those “Reporting Guidelines”.

• Use Generate Results and Review Results prior to drafting the reports.
• Exclusions: exclude everyone from everything (regardless of gender) with the only exception being single source intimate body samples that are consistent with the person they were collected from and no indication of the presence of a foreign contributor(s).

D.1.4 Sexual Assault Kits

The LIMS worksheet for sexual assault kits does not include a field to specifically capture the items of evidence received, but not examined. It is necessary to capture this information as it will be added to a table in the report to detail these items.

The information may be captured one of two ways:

1) Documenting Items Not Examined in Worksheet as Sub-Items or Lab Items:
   • If not already done so in WinACE, the contents of the sexual assault kit may be designated in the worksheet by making sub-items for all items received in the kit, including those items that will not be tested. Only those items deemed appropriate for work based on the SAK workflow will be screened and analyzed. For those items not being tested, check the box “No further examination at this time” in the worksheet.

   • Sexual assault kits which have their contents designated on the outside of the kit have already been entered into WinACE and each item has been assigned a Lab Item number. While processing, each Lab Item number may be added to the worksheet, including those items that will not be examined. For those items not being examined, check the box “No further examination at this time” in the worksheet.

   Each of these items will ultimately populate in the report. These items will be moved from the main results table to the table which denotes items of evidence received, but not examined (Refer to Table of Items Received, Not Examined).

2) Documenting Items Not Examined in Worksheet without Making Sub-Items:
   Items received, but not examined may be documented in the notes section of the sexual assault kit worksheet, without being sub-itemized. The information for each of these items will then be used to manually populate the report table which denotes items of evidence received, but not examined (Refer to Table of Items Received, Not Examined).

For all sexual assault kits:
• Place copies of the nurse’s notes/SAK paperwork on the left hand side of the file folder for review. Due to privacy laws, these notes must be shredded and discarded (do not paginate or add to object repository) after the report has been released.
• With the exception of SAKs collected by Crime Scene Analysts at autopsy, when entering the booking information for a SAK in the Evidence Exams section, the officer is the SANE nurse (e.g. Dermanelian) and list the package as SAK. The report will show “Dermanelian – SAK”.

The following evidence item(s) were received and examined:

<table>
<thead>
<tr>
<th>Lab Item #</th>
<th>Impound Pkg #</th>
<th>Impound Item #</th>
<th>Description</th>
<th>Results, Opinions, and Interpretations</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Sexual Assault Kit from Aysa Castro</td>
<td>• Full female profile</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Breast swabs</td>
<td>• Negative presumptive saliva test</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Oral swabs</td>
<td>• Semen negative</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Fingerinal swabs</td>
<td>• Sperm negative</td>
</tr>
</tbody>
</table>

Tests for blood, semen, and/or saliva are presumptive in nature and therefore provide an indication, but not confirmation, of the presence of a body fluid.

D.1.5 Packages Containing Uninventoried Items Without Impound Item Numbers (Backpacks, Bedding, Clothing, Gun/Magazine/Ammunition, etc.)
All items contained in packages without unique impound item numbers (e.g. items contained in backpacks, bedding, clothing, gun/magazine/ammunition, etc.) must be inventoried to include items not examined. This may be achieved one of two ways:
1) Item may be designated in the worksheet by making sub-items, for all items received, including those items that will not be examined. It is permissible to make one sub-item to encapsulate all items that are not being examined, rather than making separate sub-items per item. For those items not being tested, check the box “No further examination at this time” in the worksheet. Each of these items will ultimately populate in the report. These items will be moved from the main results table to the table which denotes items of evidence received, but not examined (Refer to Table of Items Received, Not Examined).

2) Alternatively, the items received, but not examined may be documented in the notes. The information for each of these items will then be used to manually populate the report table which denotes items of evidence received, but not examined (Refer to Table of Items Received, Not Examined).

• Items not requested will be notated in the worksheet.

D.1.6 Packages Containing Multiple Impound Items Not Requested
All impound items contained within a package, but not requested will be notated in the worksheet in the “Insert Items Not Requested” field (with the exception of sexual assault kit worksheets, which does not include this field). Manually enter the Impound Item # and Description for these items contained within the package, but were not requested.
- The information for each of these items will then be used to manually populate the report table which denotes items of evidence received, but not examined (Refer to Table of Items Received, Not Examined).

D.1.7 Buccal Swab Kits and Reference Standards
- Sub-items DO NOT need to be created for the buccal swab kits where there are multiple swab boxes (usually seen with OJs). The check boxes within the template reflect multiple boxes and this is adequate.
- Regardless of cellular type (buccal, blood, etc.), all standards must be renamed to “reference standard” for all custom descriptions.
- The “Name” box in BSK should only be typed in if the volunteer statement is going to appear on the report.

D.1.8 Cross-Referencing Items from Different Cases
When an item of evidence is booked under an additional Event #, it will appear in the worksheet as "Item # (lab case it is booked under)” (eg: Item 1 (13-06123)). In order to cross-reference, samples must be delineated in some manner in the extraction workbook and forward: "Lab case worked under - Item # (Lab case booked under)" (eg: 14-00017 - Item 1 {14-00018} where 14-00017 is what it is worked under and 14-00018 is what it was booked under). The dash before “Item” can be a dash, space or underline.

Note: Brackets [ ] will not import into the HID software on the 7500 and therefore should be avoided. The use of parentheses may result in an error with the allele table macro when also utilizing tube numbers at the end of the sample names.

D.1.9 OJ’s
- Ensure the OJ Event # formatting found within the auto-populated fields of the worksheet have been corrected, using or deleting zeros if necessary (usually within outer packaging description), to reflect the appropriate event for the lab case.
- OJ packages/evidence: the evidence info fields (e.g. booking officer, pkg #, item #) should correspond with the item of evidence. Change within the worksheet and Evidence Exams if they do not match.
  - Be aware if there are no package or item number(s) on the evidence. If there is no package number, the report and chain of custody form should look like: 9288/1. If there is no item number, the report and chain of custody should look like: 9288-1. The worksheet may be overwritten once populated for outer packaging.

D.1.10 Printing or Saving
Remember to expand all collapsed fields in the worksheet before printing or saving. If a field is left collapsed it will not be seen when the worksheet is printed and published upon release of the report.

D.1.11 Additional Notes
- DO NOT delete any drop down sections in the worksheet that control for logic (e.g. the profile detail section when reporting out a buccal swab outside of the buccal swab template for a SAK). If deleted an error will be generated and will not allow "Generate Results/Review
Results” to be viewed. If not readily identified and rectified, it’s possible the worksheet will have to be recreated from scratch as the error will be saved in the logic.

- **DO NOT** close the entire system if an error is encountered within the worksheet. Close the worksheet, re-launch, and attempt the recovery option, if necessary. If FRED is closed the recovery option is no longer possible within the worksheet.
- If an item is not being worked that has already been assigned to the Unit Record, un-assign it from the Unit Record. It is not appropriate to assign an item to a worksheet, without any analysis taking place. Remove it from the assigned analyses by clicking on the “Assign Evidence” and unchecking the box of the item not being worked. Make a note (with date/initials) in the details tab of the Unit Record as to why it isn't being worked, if there isn't a note there already.
- If a worksheet is opened after a draft has already been generated to make changes to any of the conclusions, custom description or evidence information in “Evidence Exams” (profile or screening sections), click “Generate Results” even if another version of the draft is being checked in. The “Review Results” view (which is submitted for discovery) will more accurately reflect what will be on the draft. If only the notes are being fixed it is not necessary to click review results as those fields do not populate on the report when re-drafted.

### D.2 Reports

#### D.2.1 Headers

- For cases involving OJ events, manually correct the Event # in the header of the report to include any dashes.
  
  **Note:** Subsequent report pages cannot be changed.

- In the event an Event # is not showing up in the header **DO NOT** manually enter it.
- If two related Event #s are being worked together as one, simply adding a “Related Lab Case” will NOT suffice for getting the additional Event # on the report.
  - Under Lab Case Details click on the tab for Lab Request and open it. In the Lab Request, click on the “+” button next to the Agency.
  - The Manage Agencies box will pop up and click "Add." Lab Request Agency box will appear. Fill out as shown below.
  - Click OK. Verify the primary Event # is still marked as primary.
  - Save and close all the way out. The other Event #(s) will now appear on the report.
• If the requestor (and requestor only) is listed incorrectly in the header of the report, change manually on the report to accurately reflect the correct requestor. The system will always pull the first requestor listed in the first lab request and places that on the report even though exams could have been requested in the 2nd lab request. The requestor will be notified of the completed exams (as long as they are entered as a requestor or CC) so the name on the actual report is not a cause for concern.

• **Victim and Suspect Names** – if neither is listed in FRED, no additional research is necessary. State of Nevada and Business Names CANNOT be added as victims in FRED. If the names are not there, do not add them. If they are incorrect based on the evidence or other documents, check Onbase, or contact the detective to verify the details. **Note**: For any supplemental work where the original report listed a business as the victim in the header of the report (previously done outside of FRED) the analyst can manually add a business into the header of the FRED report, however this is not required.

D.2.2 Results Table

• Table header will state: “The following evidence item(s) was (were) received and examined.” It is permissible to change this header statement to be singular, rather than plural, based on the case-specific circumstances. **Note**: In the event a report is only comparing previously generated DNA profiles with a reference standard processed with a different case, the header statement will be modified to: “The following results, opinions, and interpretations are reported below.”

• **Items will be left in the order** that the FRED system places them on the results table of the report, with the exception of buccal swabs. Buccal swabs should be reported at the end of the table even if the buccal swabs were analyzed in the middle of the worksheet.

• **Do not hand type rows into the table** on the report. If a draft report is created and something is missing from the table, cancel, evaluate and re-draft.

• Custom descriptions created in “Evidence Exams” in worksheets will match descriptions in report table.

• **Bullets** will be put in the short results table in the “Results, Opinions, and Interpretations” column.
DNA results for reference standards (e.g. Full male profile, Full female profile.) will be left populated in the table.

FRED automatically reports "presumptive test(s)" in the short results table on the report. The "(s)" may be left regardless of how many presumptive tests were actually performed. It is analyst discretion if they wish to remove the "(s)" if only one test was performed.

If any of the "Additional Report Statements" are chosen, they will auto-populate below the evidence disposition statement in the body of the report. Any statement that shows in the body of the report should be moved above the evidence disposition statement or to the table depending on where it is appropriate.

When referring to any additional statement included below the table use a * or other symbol to reflect this (e.g. * - Evidence was booked under Event # <XX XXXX-XXXX>). A symbol should be used whenever an additional statement is used to show what is being referenced.

If another Event # needs to be referenced within the report, use the real Event # and not the Lab Case # so it is clear to the client what is being referenced. It is analyst discretion if they wish to include the Lab Case # in addition to the Event #, however this is not required.

Bold lines will be placed around each package on the table.

Merge the repetitive package information so it is not listed more than once.

Merge the repetitive item information together (e.g. multiple sub-items from one parent item)

If the results table is longer than one page on the report, add the table header to each additional page.

Items which were received, but not examined which were either designated with a sub-item or with a Lab Item # (to include items not examined from a sexual assault kit) will be manually moved from the Results table to the table documenting items of evidence which were received, but not examined (Refer to Table of Items Received, Not Examined).

Example:
The following evidence item(s) were received and examined:

![Image of results table]

The following evidence item(s) were received, but not examined for the purposes of this report:

![Image of table of items received, not examined]

D.2.3 Results, Opinions, and Interpretations

- Remove item descriptions from the PCR paragraph and leave only the Item #'s in the order that corresponds with the order of the items in the table.
- Add **Lab Item X: and the description of the item** as a header for each paragraph describing the conclusions for that item.

- **Items will be left in the order** that the FRED system places them in the body of the report which should be the same as the above table.
  
  **Note**: Exception is when a presumed or surreptitious sample is being reported. In this case it will be the first Item listed.

- Where applicable, manually spell “Epithelial Fraction” or “Sperm Fraction” to the body of the report for each sample that underwent a differential extraction (e.g. Item 3.1-EF).

- Custom descriptions created in “Evidence Exams” in worksheets can be truncated within the body of the report.

- Volunteer samples can be combined into one statement in the body of the report.

- The evidence disposition statement is set for the entire laboratory and may not be modified.

- While drafting new reports, add the following statement to every reported generated with the exception of CODIS reports, reports issued by outsourcing laboratories, and CODIS entry reports performed outside of FRED by clicking the box:

- When referring to samples previously worked from a different case, cross referenced lab case # or report (e.g. original report) using a * or other symbol to reflect this (e.g. Item 1*). This should point the reader to the table which will summarize what the symbol is referring to.

**D.2.4 Table of Items Received, Not Examined**

When physical custody is taken of items of evidence which were not specifically requested for examination (e.g. one sealed brown paper bag containing five individually sealed manila envelopes, each containing an item of evidence, or a single package containing a gun, magazine, and ammunition where only the gun is requested, etc.) or were not tested due to workflow (e.g. evidence items contained in a sexual assault kit not tested due to scenario), a separate table will be manually created in the report below the “Results, Opinions, and Interpretations” section. This table will document those items which were received, but were not examined at this time.

The table will appear as follows, to include the use of the disclaimer “The following evidence item(s) was (were) received, but not examined for the purposes of this report:"

<table>
<thead>
<tr>
<th>Lab Item #</th>
<th>Impound Pkg #</th>
<th>Impound Item #</th>
<th>Description</th>
<th>Results, Opinions, &amp; Interpretations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item 1.2.3</td>
<td>Demanetian-SAK</td>
<td>Cervical swabs</td>
<td></td>
<td>Received, not examined</td>
</tr>
</tbody>
</table>

- This table will include the following information, as applicable: Impound package #, Impound Item #, Lab Item #, Description (may be generic WinACE description), and the “Results, Opinions, and Interpretations” of “Received, not examined”

- The symbol “---“ may be utilized in the table when an item of evidence does not have a Impound Package #, Impound Item #, or Lab Item # associated with it.
Note: Items which were removed from an item of evidence during examination (e.g. hairs removed from a shirt and re-packaged in a petri dish, etc.) or areas of possible staining identified on an item of evidence during examination that could be tested in the future will remain in the main results table under the entry for the examined item. These items will not be included in the table of items received, not examined.

D.3 Technical and Administrative Reviews
If the technical reviewer needs to re-sign off on the review in FRED because the administrative reviewer flagged something to be changed in the report or worksheet, save a copy of the old draft report and/or notes so the technical reviewer can verify the changes were necessary.